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Preface

The Oracle AutoVue User Manual explores AutoVue's key capabilities and is designed to
help you get the most out of AutoVue's extensive functionality.

For the most up-to-date version of this document, go to the AutoVue Documentation Web
site on the Oracle Technology Network at http://www.oracle.com/technetwork/documen-
tation/autovue-091442.html.

Audience

This manual is intended for Oracle AutoVue end users.

Document Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible to
all users, including users that are disabled. To that end, our documentation includes
features that make information available to users of assistive technology. This documenta-
tion is available in HTML format, and contains markup to facilitate access by the disabled
community. Accessibility standards will continue to evolve over time, and Oracle is actively
engaged with other market-leading technology vendors to address technical obstacles so
that our documentation can be accessible to all of our customers. For more information,
visit the Oracle Accessibility Program Web site at
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise
empty line; however, some screen readers may not always read a line of text that consists
solely of a bracket or brace.

3/1/11
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Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or organizations
that Oracle does not own or control. Oracle neither evaluates nor makes any representa-
tions regarding the accessibility of these Web sites.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within

the United States of America 24 hours a day, 7 days a week. For TTY support, call
800.446.2398. Outside the United States, call +1.407.458.2479.

Related Documents

For more information, see the following documents in the Oracle AutoVue documentation
library:

Installation and Configuration Guide
Release Notes

Supported Formats List

ActiveX - Feature Matrix

Product Variations - Feature Matrix
Performance Related INI Options
VCET API Manual

Markup Control API Manual

Conventions

The following text conventions are used in this document:

14
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Convention Meaning
boldface Boldface type indicates graphical user interface elements associated with
an action, or terms defined in text or glossary.
italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.
monospace Monospace type indicates commands within a paragraph, URLs, code in

examples, text that appears on the screen, or text that you enter.

3/1/11
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Introduction

Oracle's AutoVue suite of enterprise visualization solutions provides native document
viewing, markup and real-time collaboration capabilities that enable Web-based document
review on hundreds of native document types, including 2D/3D CAD, EDA, Office and
graphic formats. AutoVue enterprise visualization solutions address the challenge of
accessing, reviewing and collaborating on documents, both internally and with globally
dispersed teams and partners, in a secure and reliable manner without compromising secu-
rity or precision. Improved team productivity, reduced errors, and accelerated innovation
and time to market are just a few of the business benefits organizations can expect to
achieve.This manual explores AutoVue's key capabilities and is designed to help you get the
most out of AutoVue's extensive functionality.

Oracle AutoVue

Oracle AutoVue is a viewing and markup application that has been developed for both
business and technical users. AutoVue is capable of displaying hundreds of file formats
without the authoring application. Supported file types include Text, Office, Graphics,
EDA, 2D Engineering Drawings, and 3D Models. Even contents of archive files can viewed
in AutoVue.

NOTE: Although not required, we recommend that file names include their standard file
extensions. If the file extensions are not included, AutoVue may require additional time to

load a file.

Oracle AutoVue is available in various product variations. Refer to the “AutoVue Product
Variations — Feature Matrix” chapter at the end of this document to see what features are
available for each variation.
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MARKING UP DOCUMENTS

Marking Up Documents

AutoVue has the ability to create markups for all its readable file formats without the docu-
ment's authoring application. AutoVue creates markups for different formats without
modifying the original file.You can attach comments, notes, and drawings to any file you
display in AutoVue. This is called “marking up a file”, commonly known as annotating or
redlining. A markup is an object or entity that you attach to a file. All markups are saved in
a separate file called a Markup or a Markup file. When you display a file with its markups,
the markups are overlaid as a layer on top of the drawing. AutoVue provides a variety of
flexible, user-friendly entities. To name a few, there are circles, clouds, polygons, and
leaders. You can also attach text to entities, insert a note for longer comments, add attach-
ments, or add a stamp such as a company logo. In addition, you can create measurement
markup entities and hyperlinks that link between the current file and other associated files
or applications.
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AutoVue Basics

This section introduces the basics of working in AutoVue; such as starting and exiting
AutoVue, the help menu, changing the locale of AutoVue, displaying file versions informa-
tion, and the AutoVue graphical user interface (GUI). The section on the AutoVue GUI
discusses the included menu bars, tool bars, navigation panel, and navigation tree.

Starting AutoVue

To start AutoVue, you have one of two options:

TASK

1. From the Windows Start menu, select Programes, select AutoVue, Desktop
Version, and then select AutoVue, Desktop Version.

2. From the Windows Start menu, select Run, and then enter the path and filename
for avwin.exe.

3. Click OK.

STEP RESULT: The main AutoVue window appears.

RESULT:

After starting AutoVue, an AutoVue icon [®] appears in the system tray located on the far
right side of the task bar. This icon is always accessible after exiting AutoVue since
AutoVue continues running until you close AutoVue completely. Right-click the AutoVue
icon to access the system tray Quick Menu. To resume working with AutoVue, double-click
the icon or right-click the icon and select Restore AutoVue from the Quick menu.
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EXITING AUTOVUE

Exiting Autovue

Help

To exit AutoVue:

TASK

. From the File menu, select Exit. The AutoVue icon remains in the system Tray. or

. Click Close i in the upper right corner of the AutoVue window. The AutoVue icon
remains in the system Tray. or

. From the system tray, right-click the AutoVue icon [= and select Close AutoVue.
AutoVue closes completely and the icon disappears from the system tray.

AutoVue provides a Help menu that allows you to easily access information on how to use
AutoVue.

The About dialog box, which is accessed by selecting About from the Help menu, provides
information about your current installation of AutoVue. Information such as the variation
of AutoVue you are using, the version, the build number, and the current language that
AutoVue is running is displayed. From the About dialog box, you can also change the local-
ization of the AutoVue user interface.

Changing the Locale of AutoVue

AutoVue supports different localizations for the User Interface. AutoVue supports the
following languages: English, French, German, traditional and simplified Chinese, Japa-
nese and Korean.

NOTE: When you change from one language to another, all toolbar customizations are reset
to their default settings.

TAsK
1. From the Help menu, select About.
STeEP RESULT: The About dialog box appears displaying the language options.

20
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2.  Click Change Language.
STEP RESULT: The Language Change dialog box appears.

Current language: | < Default =

Mew language: A
[ (8] l [ Cancel ]
3. From the New Language list, select the language you want.
4. Click OK.
5.  Click OKin the About dialog box.
6. Restart AutoVue for the new localization to take effect.6

AutoVue Version Information

The About dialog displays AutoVue version and build information. You can also view the
version, build number, and build date of components that are shipped with AutoVue. You
can also export this information into a text file.

Viewing Version and Build Information

To view product version information:

TASK
1. From the Help menu, select About.

STEP RESULT: The About dialog appears and displays the AutoVue version number and
build date.

2.  Toview version and build information for components, click Version Info.

3.  To export the version information click Export.
STEP RESULT: The Export dialog appears.

4. Navigate and select the directory to which you want to export the list.

Enter a file name (the default name is fverinfo.txt).

3/1/11
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6. Click Save.
STEP REsULT: The list is exported to the specified file.

7. When you are finished viewing the file version information, click Close.

8.  Click OK to exit the About dialog.

AutoVue Graphical User Interface

This section introduces you to the basics of working with AutoVue’s graphical user inter-
face (GUI). The following image displays the AutoVue GUI for a 3D drawing:

© AutoVue Electro-Mechanical Professional - [AutoCad3D. dwg]

: File Edit Wew Manipulate Analysis  Markup  Collaborate  Tools  Options  Window  Help
_ 4/3'. @R MmmP & ) O a @I
? % Untitlzd2 b B I u Sansserif
@o Bookmarks LS
1 Model
EI:0 Mode
e
oss
v
)
k24
|Markups -~
Markup Entity Authar ILastModifiedA IPage ILaper |
2 Untitled2
4 | ¥
Madels | Views | Bookmarks r
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Menu Bar

The menu bar is the main access to all the menu commands. The selection of commands
changes according to the tasks being accomplished by AutoVue. In addition, the menu bar
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Toolbars

can be configured to include and exclude items via DDE scripting capabilities. For more
information, refer to the AutoVue API Manual.

AutoVue has three toolbars: AutoVue toolbar, Markup Properties toolbar, and Markup
Entity toolbar. The toolbars are fully adaptable to individual work preferences and can be
easily customized, moved or removed. The toolbar buttons offer easy access to the options
presented in the menus found in the menu bar.

Adding buttons to a toolbar

To add buttons to a toolbar:

TASK
1. Right-click anywhere on the toolbar and select Customize Toolbar.
STEP RESULT: The Customize dialog box appears.

2. Select a menu option from the Categories list and a corresponding button from
the Commands list.

STeEP RESULT: A brief description of the button is provided in the Description field.
Drag and drop the required buttons from the Commands list to the toolbar.

4.  Click Close to exit the Customize dialog box.

ADDITIONAL INFORMATION: To reset the toolbar to its default setup, right-click anywhere on
the toolbar and select Reset All Toolbars.

AutoVue Toolbar

The AutoVue toolbar displays below the menu bar when you open AutoVue. It is the default
toolbar and includes the most commonly used functions when viewing a file—open a file,
create a new markup, print, zoom, and many others. Depending on the file that is opened,
the toolbar buttons will change. For example, the following image shows the AutoVue
toolbar when a 3D file is open:
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Markup Properties Toolbar

The Markup Properties toolbar displays below the AutoVue toolbar when you enter
Markup mode. It includes the available property and formatting options for the markup

3/1/11
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entities—save markups, change font, fill type, line style, and many others. The following
image shows the default Markup Properties toolbar:
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Markup Entity Toolbar

The Markup Entity toolbar displays by default on the left side of the AutoVue window when
you enter Markup mode. It includes all the available markup entities for the opened file.
Depending on the file that is opened, the toolbar buttons will change. For example, the
following image shows the Markup Entity toolbar when a 3D file is open:
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Navigation Panel

The Navigation Panel displays by default on the left-hand side of the AutoVue workspace
when you view a drawing. For example, when viewing an EDA drawing, it allows you to
navigate through a list of component instances, nets, and the associated pins and net nodes
(pins connected to a net) present in the current schematic drawing or Printed Circuit Board
(PCB) design.

NOTE: To hide or display the Navigation Panel, click lﬁﬂ.

The columns displayed in the Navigation Panel are determined by the profile of the entity
types in the current schematic drawing or PCB design. Lists can be sorted in order to group
similar component instances.
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You can also use the Navigation Panel to select (highlight) single or multiple components

or entities; zoom to a component or entity, and query entity information.
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Bookmarks Tab

The Bookmarks tab lists links to specific views (Draft views, 2D plans, 3D Views of an EDA

design) or pages or bookmarks structure that is saved in files such as PDF.
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Navigate between the pages or files or views by clicking the appropriate link. Bookmarks
lead to various views of CAD files such as AutoCAD file Model Space, the 3D model of a
file and associated 2D engineering drafts.

If a plus sign appears to the left of a bookmark, click it to expand and view the lower book-

mark levels. If a minus sign appears to the left of the bookmark, click it to collapse the lower
bookmark levels.

To go to a destination specified by a bookmark, click the bookmark text or the page icon
located to the left of the bookmark text.

Components Tab

NOTE: The Components tab displays only for the EDA pages of a drawing.

The Components tab lists component instances and the associated pins.The top portion of
the tab lists all the instances of the currently displayed page of the drawing. The lower
portion of the tab lists the associated pins for selected instances.

When you select a component, it appears highlighted on the drawing. To select more than
one component, press the Shift or Control key while selecting. All the selected components
and their associated pins are highlighted.
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Nets Tab

NOTE: The Nets tab displays only for EDA drawings.

The Nets tab lists nets and associated net nodes (pins connected to a net). The top portion
of the tab lists all the nets of the drawing’s currently displayed page. The lower portion of
the tab lists the associated net nodes for the selected nets.
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All selected nets are highlighted on the drawing. To select more than one net, press the Shift
or Control key while selecting. Alternately, in the Nets panel, you can click and drag in the
Navigation Panel list to select multiple nets. The Nodes on Net panel lists the associated
nodes for the selected nets.
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Models Tab and Model Tree

The Models tab displays the Model Tree. The tree displays the model’s hierarchy, inter-rela-
tion of different parts, assemblies, and bodies. The tree also indicates if a required external
reference (XRef) is missing. With the tree, you can select different parts and modify their
attributes such as color, visibility, render mode or transformation.

See “Displaying XRefs”for more information on XRefs.
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NOTE: The Models tab displays only for 3D drawings.

=
O

|

Views Tab

Maodels W ,ﬁ

=i [#]Page 1 Fl F

= W [#]5olidEdge_ilearn-se.z [ []

]

]

L]

i

= W []bottom ]

0, [v]3050lidEdge_stor [ []

0, [v]3050lidEdge_ga_ [] []

0, [v]3050lidEdge_arre [ []

i+ W [w] 305olidEdge_scre [ []
Models | Yiews

The Views tab lists the standard, native, and user-defined views. You can switch to a stan-

dard, native, or user-defined view, as well as add or delete user-defined views.

NOTE: The Views tab displays only for 3D drawings.
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Markup Navigation Tree

When you are in Markup mode, a Markup Navigation Tree appears below the workspace.
If the tree does not appear, from the Options menu, select Show Panel, and then select

Markup Panel.
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The tree displays a hierarchy of markups or comments created by users. You can navigate
through the markups. A set of properties is generated for each markup. You can sort the

markups in the tree according to each property by clicking the column headers. These
properties are:

Property Description
Markup Entity Type of markup entity created.
Author The name of the user who created the markup entity.
Last Modified The date and time the markup entity was last modified.
Page Page number of the original document on which the markup entity is created.
Layer Markup layer on which the markup entity is created.

When a markup entity is created, it appears in the tree and the information is recorded and
saved in the Markup file.

NOTE: Hover your mouse over an entity to display its author and date properties.

Status Bar

When in View mode or Markup mode, the status bar is located at the bottom of the main
window. The fields displayed from left to right on the status bar are: marker, current active
filename, file type, zoom factor, current page and total number of pages, current active file

size, file creation date, and cursor’s coordinate position. The following image shows the
status bar:
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There are three markers that may be present on the status bar: the Markup Indicator icon
indicates associated markups, the Missing Resource icon ¥ indicate missing resources,
and the Substituted Resource icon - indicates substituted resources.

The Markup Indicator # indicates that the current active file has associated markups.
While in View mode, click the Markup Indicator icon to view the Markup Files dialog, then
select a Markup file or group of Markup files to open.

The Missing Resource icon ¥ indicates that some main resources required to properly
display the current active file are not available. To identify the missing resources, click the
Resource icon to display the Properties dialog.

has replaced it with another resource. To identity the substituted resources, click the Substi-
tuted Resource icon to display the Properties dialog.

Quick Menus

One of the quickest ways to access options is through Quick Menus or context-sensitive
shortcut menus. These are the menus you see when you right-click in the workspace,
Markup Navigation Tree, and Model Tree. The available Quick Menu options depend on
the location where you right-click.

Opening Files

You can open base files and Markup files from the File menu and Markup menu, respec-
tively. Additionally, you can browse files in a directory, open files simultaneously, and view
the contents of archive files.

Opening a File

TAsK

1. From the File menu, select Open.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Open 5.
STEP RESULT: The Open dialog box appears.

30
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2. Enter afile name or browse to locate the file that you want to open.
3. Click Open.

RESULT:

The file appears in the AutoVue workspace.

Opening Multiple Files

By default, AutoVue keeps one file open at a time. If you open a new file, the currently
opened file is replaced with the new file. However, it is possible to have multiple files open
by creating windows within AutoVue.

TAsSK
1. From the Window menu, select New Window.
STEP RESULT: A new window appears on top of the opened file.
2.  From the File menu, select Open.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Open _"

STEP RESULT: The Open dialog box appears.
Enter a file name or browse to locate the file that you want to open.

4.  Click Open.

RESULT:
The file appears in the new window.

NOTE: You can open as many windows as you like by repeating steps 1 through 4.

Switching to Another Window

From the Window menu, select the file that you want to display from the bottom of the list.
The file is displayed and a check mark appears beside the filename in the Window menu
list.

Viewing Multiple Files at the Same Time

You can arrange the files so you can view them at the same time.
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From the Windows menu, select Cascade if you want the files to appear on top of each
other, Tile Horizontally if you want the files to appear side by side, and Tile Vertically if
you want the files to appear above each other.

Streaming Files

AutoVue generates streaming files for most supported file formats. When a file is accessed
by AutoVue for the first time, a streaming file is generated. The streaming file contains file
data and provides the benefit that AutoVue can access the streaming file much faster than
it can the native file. As a result, rendering time is significantly faster when loading from the
streaming file.

If the native file changes or its external resource files change or if an INI option changes,
the streaming file is invalidated. In this case, AutoVue opens the display from the native file
and generates a new streaming file.

Browsing Files

When you use the Browse option, all files and folders in the current directory are displayed
in the Browse dialog box and the last file opened is highlighted.

TASK
1.  From the File menu, select Browse.

STEP RESULT: The Browse dialog box appears listing the files located in the current active
directory.

2.  Tochangethe current active directory, type the full path of the directory in the text
field at the top of the Browse dialog box.

STEP RESULT: The list of files contained in the directory appear.

3.  Select the file that you want to view.
STEP RESULT: The file is displayed in the AutoVue workspace.

4.  Continue selecting and viewing files as often as you like since the Browse dialog
box floats over the other AutoVue windows.

5.  Click Close to exit the Browse dialog box.

RESULT:

The last file displayed remains open.
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Archive Files

The full archive file directory displays in the AutoVue window. It is not necessary to decom-
press the file. Double-click a file to display it within AutoVue. If you would like to markup
an archived file, the file must be made accessible to AutoVue in a decompressed form.

File Properties

From the File menu, select Properties to open the Properties dialog. The Properties dialog
provides information specific to the current active file, such as filename, file size, date of
creation, and file type. The file properties that you can view are:

Property Tab Description

File Properties Information specific to the current active file, such as filename, file size, date of
creation, file type, number of pages, and x, y & z dimensions. It also indicates if
the file is loaded from a streaming file.

Resource Information Resources specific to the current active file, such as text font, shape file, line
style, and external reference files.

Native Properties Custom properties for file types, such as last person who saved the file,
signature verification, and author comments.

DMS If AutoVue is integrated with a backend DMS/PLM/ERP system, a DMS tab
appears that lists file attributes retrieved from the backend system.

NOTE: The Properties dialog varies for each file format that is open. As a result, some property
tabs may be absent when viewing a file.

Viewing File Properties

To view file properties:

TASK
1. From the File menu, select Properties.
STEP RESULT: The Properties dialog appears.
2. Toview the file properties, click the File Properties tab.

STEP REsuLT: The File Properties tab displays the file name, file size, date last modified, file
type, and number of pages the document contains.

3. Toview resource information, click the Resource Information tab.

Step ResuLT: Allincluded resources are listed in the Resource Information tab. If a resource
that s required to fully display the file is missing, it is listed with the Missing Resource icon
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X . If a resource is found it appears with the Found Resource icon ##. If a required
resource is missing and AutoVue substitutes it with another resource, the Substituted

Resources icon ! appears.

.............

4.  To view native properties, click the Native Properties tab.

Click OK to close the Properties dialog.
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Working With 2D Files

When working with vector and non-vector 2D files in AutoVue, you can instantly change
how the active file is displayed in the workspace by choosing from a number of different
view options. For example, you can zoom into an area of the drawing, magnify a part of the
drawing, and rotate a file’s orientation clockwise, counterclockwise, or flip a file’s orienta-
tion along the horizontal or vertical axis.

When viewing 2D vector files, you have access to entity information, views saved in the
drawing, and the ability to “intelligent snap” when performing measurements. All the
information is obtained by AutoVue by referencing various sources; either internal files or
external reference files that are located outside the file.

In addition to the features mentioned, this chapter provides detailed information on how
you can modify AutoVue to suit your needs and preferences through a broad range of
configuration options.

Searching Text

You can perform a text search on 2D vector and text-based documents.

AutoVue provides search options that you can use to customize a search. These options are
as follows:

NOTE: You cannot perform a text search on raster files.
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Option Description
Match Whole Word Only Match a complete word.
Match Case Search for a word or text string with specific
capitalization.
Up Search backward in the document.
Down Search forward in the document.

TASK
1. From the Edit menu, select Find Text.
STEP RESULT: The Find dialog appears.

2. Enter the word or phrase that you want to find in the Find What field.

ADDITIONAL INFORMATION: If you are searching in a vector file, select a text string from the list.
You can refine your search by selecting Match Whole Word Only or Match Case.

4.  Click Find Next.
STEP RESULT: AutoVue highlights the text and zooms into the text area.

5.  Click Close to close the Find dialog.

Selecting in 2D Files

The Select option is available when viewing graphic and non-graphic files.

NOTE: For non-graphic files, you can only select text.

TASK
1.  From the Edit menu, select Select.
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2. Make your selection:
. In a graphicfile, click the entity or click and drag the area you want to select.

. To select a block of text, position the cursor at the beginning of the block, click and
drag to highlight.
3.  Tocopy the selected data, from the Edit menu, select Copy or press the keyboard
shortcut Control+C.
STEP RESULT: The data is sent to the clipboard.

4. To paste the copied data, from the Edit menu, select Paste or press the keyboard
shortcut Control+V.

2D Viewing Options

From the View menu, you can change how the active file is displayed in the workspace. For
example, you can zoom into an area of the drawing, magnify a part of the drawing, and
rotate a file’s orientation clockwise, counterclockwise, or flip a file’s orientation along the
horizontal or vertical axis.

You can access these options from the View menu. The options are:

3/1/11

37



WORKING WITH 2D FILES
2D VIEWING OPTIONS

Menu Sub-Menu Description

Zoom Zoom Box Click and drag to draw a box
around an object that you want
to enlarge to fill the window.
From the Autovue toolbar, you

can also click 4 or right-click
in work-space and select from
pop-up menu.

Zoom In Zoom in by a factor of 2.
From the AutoVue toolbar, you

can also click @

Zoom Out Zoom out by a factor of 2.
From the AutoVue toolbar, you

can also click Q .

Zoom Previous Reverts to the previous zoom
level.
From the AutoVue toolbar, you

can also click @ .

NOTE: You can also right-click
the workspace and select Zoom -
Previous.

Full Resolution Display the file at full resolution.
From the AutoVue toolbar, you

can also click Q
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Menu

Sub-Menu

Description

Fit

Horizontal

Fit the image horizontally in the
active window. The vertical
dimensions of the image are
zoomed proportionally but may
be too large or small for the
window.

NOTE: You can also right-click
the workspace and select Zoom -
Page Width.

Vertical

Fit the image vertically in the
active window. The horizontal
dimensions of the image are
zoomed proportionally but may
be too large or small for the
window.

Both

AutoVue finds the best fit for the
current file with respect to both
its vertical and horizontal
dimensions.

From the AutoVue toolbar, you

can also click |‘i’|.

NOTE: You can also right-click
the workspace and select Zoom -
Fit.

Magnify Glass

Magnify an area of the file that is
specified by the cursor location.
See “Using the Magnify Glass”
for more information.

Magnify Window

Magnify a selected area of a file
and displays it in the Magnify
Window.

See “Using the Magnify
Window”for more information.

Pan and Zoom Window

Display a close-up view of a
particular area of a file while
maintaining a view of the entire
file.

From the AutoVue toolbar, you

can also click @ .

NOTE: The Pan and Zoom
Window option is disabled for
text-based documents and
spreadsheets.

See “Using the Pan and Zoom
Window” for more information.

3/1/11
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Using the Magnify Glass

Menu

Sub-Menu

Description

Pan

Click and drag to move the
drawing. To exit right-click.
From the AutoVue toolbar, you

. Iy
can also click J

NOTE: The Rotate option is disabled

for archived files, text-based documents and spreadsheets.

Rotate

Rotate Clockwise

Rotate the file 90 degrees
clockwise.
From the AutoVue toolbar, you

can also click &fe.

Rotate Counter Clockwise

Rotate the file 90 degrees counter
clockwise.
From the AutoVue toolbar, you

can also click gfs.

Flip

Horizontal Axis

Flip the drawing on its
horizontal axis.
From the AutoVue toolbar, you

can also click /4.

Vertical Axis

Flip the drawing on its vertical
axis.
From the AutoVue toolbar, you

.
can also click = =.

The Magnify Glass view option displays the magnified area at the cursor location. You can
view the details of a selected area of a file while maintaining a full view of the file.

TASK

1.
2.
3.

From the View menu, select Magnify Glass.

Click and hold the left mouse button.

Move the cursor to the area that you want to magnify.

ADDITIONAL INFORMATION: To view different areas of the file, click and drag the mouse.

STEP RESULT: The magnified area appears in the Magnify Glass.

Right-click to exit Magnify Glass view.

40
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Using the Pan and Zoom Window

The Pan and Zoom Window view option allows a close-up view of a particular area of a file
while maintaining a full view of the file. The Pan and Zoom Window displays a miniature
version of the file and has a movable box frame on top of the miniature to indicate the area
of the file displayed in the AutoVue workspace.

NOTE: The Pan and Zoom Window option is disabled for text-based documents and spread-
sheets.

TASK
1.  From the View menu, select Pan and Zoom Window.

ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Pan and Zoom
Window @ .

STEP RESULT: The Pan and Zoom window appears displaying a full view of the file.
2. From the Options menu, select Dynamic to view the changes in “real time”.

3. Toview aclose-up of a specific area of the file in the AutoVue workspace, minimize
the frame box by clicking and dragging the frame handles.

4. Toview a different area of the file in the AutoVue workspace, click and drag the
frame box to the area that you want to view.

ADDITIONAL INFORMATION: If you perform a zoom function in the AutoVue workspace, the
area displayed in the workspace is highlighted by the frame box in the Pan and Zoom
Window.

5.  From the Pan and Zoom menu, select Exit to close the window.

RESULT:

The last view performed remains in the AutoVue workspace.

Using the Magnify Window

The Magnify Window option displays the magnified area in a window that updates dynam-
ically. You can click and drag the window to any location on your screen, view the details
of a select portion of the displayed file while maintaining the display of the full file.

TASK
1. From the View menu, select Magnify Window.
STEP RESULT: The Magnify Window appears.

2. Move the cursor to the area that you want to magnify in the current active file.

3/1/11
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3. (lickonce.
STEP RESULT: The area appears magnified in the Magnify Window.

4.  Right-click to exit the Magnify Window.

Selecting Views

The Views option allows you to access different named views of a file.

TASK
1. From the View menu, select Views.
STEP RESULT: The Select a Named View dialog appears.

2. From the list, select the view that you want to display.
3. Click OK.

RESULT:
The selected view is displayed.

NOTE: To return to the default view, select Default View.

Specifying a View Point

The View Point option allows you to render a drawing from a selected viewpoint.

TASK
1.  From the View menu, select View Points.
STEP RESULT: The View Point dialog appears.

2.  EntertheX, Y and Z coordinates for the view point with which you want to render

the drawing.
3. Click OK.
RESULT:

The drawing is displayed from the selected view point.

42
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Working with 2D Vector Files

In addition to all the features that are available for generic 2D files, AutoVue provides the
ability to access entity information, access views saved in the drawing, and the ability to

<« . » :
intelligent snap” when performing measurements.

AutoVue references various sources to obtain all data required to completely and accu-
rately display vector files. These sources can be internal to the file—like layers, blocks, and
overlays—or external reference files (XRefs) that are located outside the file.

Manipulating 2D Vector Files

The Manipulate menu option allows you to manipulate how the current active file is
displayed. For example, you can select which layers, blocks, and external reference files

(XRefs) to display.

The Manipulate menu options are:

Menu

Sub-Menu

Description

Visibility Control

Layers

Select and display different layers
of a drawing.
From the AutoVue toolbar, you

can also click {H
See “Displaying Layers” for more
information.

Blocks

Select and display a block from a
drawing.

From the AutoVue toolbar, you
can also click ._E'J.

See “Selecting Blocks” for more
information.

XRefs

Select the XRefs to display in the
drawing.

See “Displaying XRefs” for more
information.

Overlays

Select an overlay to modify.
See “Adding an Overlay” for
more information.
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Displaying Layers

Use this option to configure the layers to display of the current active file.

TASK
1.

From the Manipulate menu, select Visibility Control, and then select Layers.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Layers &.

STEP RESULT: The Select the Layers to Display dialog appears listing the layers and layer visi-
bility for the current active file.

To sort the list of layers in the dialog, click Name to sort alphabetically or numeri-
cally, or click Status to sort by visibility.

You can modify the visibility of a layer or layers by doing one of the following:
. Deselect/select the Status check box beside the layers that you want to hide/display.

. Click All On to display all the layers or click All Off to hide all the layers.
. Select a layer from the dialog and then click Toggle to hide/display the layer.

Click OK to close the dialog and to apply your changes.

Selecting Blocks

Use this option to select a block to display from the current active file.

TAsK
1.

From the Manipulate menu, select Visibility Control, and then select Blocks.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Blocks &g

STEP REsULT: The Select a Block to Display dialog appears listing the blocks for the current
active file.

2. From the list, select the block that you want to display.
3. Click OK.
STEP RESULT: The selected block is displayed.
Displaying XRefs

AutoVue references various sources to obtain all the data required to completely and
correctly display files. These sources can be internal to the file, like layers and blocks.
External reference files (XRefs) are located outside the file.
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Use the XRefs option to display the external references of the current active file.

TASK
1. From the Manipulate menu, select Visibility Control, and then select XRefs.

STEP RESULT: The Select the External References to Display dialog appears listing the
external reference files associated with the current active file.

2. You can modify the visibility of the XRefs by doing one of the following:
. Deselect/select the Status check box beside the XRef that you want to hide/display.

. Click All On to display all the XRefs or click All Off to hide all the XRefs.
. Select a XRef from the dialog and then click Toggle to hide/display the XRef.

3.  (lick OKto close the Select the External References to Display dialog.

RESULT:

The selected XRefs are displayed.

Displaying Details About Resources

Resource information for a file is displayed in the left of the AutoVue status bar. If a file is
missing resources the Missing Resource icon 3 appears to the left of the AutoVue status bar.
These missing resources can be XRefs, text fonts, linestyles, or shape files. If a missing

appears.

NOTE: In order to correctly display a file, you must make sure all required resources are
provided to AutoVue.

See “Viewing Missing XRef Notification Icon” for information on missing XRefs.

TASK

1. Click the Missing Resource icon ¥ or the Substituted Resource icon . on the
AutoVue status bar.

ADDITIONAL INFORMATION: From the File menu, you can also select Properties.
STEP RESULT: The Properties dialog appears.

2. Click the Resource Information tab to display details about missing or substi-
tuted resource information required to properly display this file.

ADDITIONAL INFORMATION: A green check mark # indicates the resources that AutoVue is
able to access. A red ¥ indicates that resources are not accessible. A yellow exclamation

3.  Click OK to close the Properties dialog.
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Adding an Overlay

When working with 2D vector files, you can overlay other files over the current active file.
You can also adjust an overlay, move an overlay, and scale an overlay by defining the X and
Y coordinates and the scaling factor.

NOTE: When working with a raster file, it should be used as the base file because raster
formats are opaque and would hide files underneath them.

TASK
1.

Open the file that you want to use as the base file for the overlay.

2. From the File menu, select Import File as Overlay.
STEP RESULT: The Overlays dialog appears.
3. Click Add.
STEP RESULT: The Please Select an Overlay File dialog appears.
4,  Select afile to overlay and then click Open.
To add another file, repeat steps 3 through 4.
6.  When done, click OK to close the Overlays dialog.
RESULT:

The base file is displayed with the selected overlay files on top of it.

Modifying an Overlay

TAsK
1.

From the Manipulate menu, select Overlays.
STEP RESULT: The Modify Overlay dialog appears.

Select the overlay that you want to modify.
Click the Action that you want to apply to the overlay.

Click Move if you want to move the overlay. Click a point on the base file where
you want to set the lower left corner of the overlay. Click another point where you
want to set the upper right corner of the overlay.

ADDITIONAL INFORMATION: As you select the point to define the position of the upper right
corner, you can resize the destination box.

Click Scale if you want to resize the overlay. Enter the XOffset and YOffset coordi-
nates and/or the Scale Factor.

ADDITIONAL INFORMATION: - XOffset and YOffset are relative to the base drawing and all
options are displayed at their current values.
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Click Warp to adjust the overlay. Click a point on the overlay and drag the cursor
to where you want the overlay starting point. Click another point and drag the
cursor to where you want the overlay to end.

ADDITIONAL INFORMATION: The overlay’s size is scaled to accommodate the origin and desti-
nation points you defined

Click OK.
ADDITIONAL INFORMATION: To modify other overlays, repeat steps 2 to 4.
STEP RESULT: The changes are applied to the selected overlay.

Removing an Overlay

TASK
1.

From the File menu, select Import File as Overlay.
STEP RESULT: The Overlays dialog appears.

2. Select the overlay that you want to remove.
3. Click Remove.

STEP REsULT: The overlay is removed from the list.
4. Click OK.
RESULT:

The overlay is removed from the display.

Analyzing 2D Vector Files

With the analysis functionality, you can measure entities, compare two files, or view
drawing information. These options are available under the Analysis menu.

The following table lists all the options from the Analysis menu:

Menu Sub-Menu Description

Measure Measure the distance, area,

angle, and arc of an entity.
From the AutoVue toobar, you

can also click .l':!
See Also “Measuring in 2D Files”
for more information.
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Menu Sub-Menu Description

Compare Compare two files.
See “Comparing 2D Files” for
more information.

Show Drawing Information Select Single Entity Scale or translate a file in order
to compare files accurately.

See Also “Viewing Details of a
Single Entity” for more
information.

List Tags/Attributes List block attributes and tags.
See Also “Viewing
Tags/Attributes” for more
information.

Entity Information View information of a set of
entities.

See Also “Viewing Information
for a Set of Entities”for more
information.

Comparing 2D Files

AutoVue provides the ability to visually compare two files and display color-coded compar-
ative data. When you compare two files, AutoVue displays three windows, the first
containing the original file, the second containing the file you compared the original
against, and the third containing the comparison results.

In the Comparison Result window you can specify whether you want to display only the
additions, deletions or unchanged, or any combination of the three. To access these
options, right-click in any window and select an option from the pop-up menu.

The comparison results are displayed in different colors to differentiate the results of the
file comparison. The comparison options and corresponding colors are:
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Option Color Description
View Additions Green Indicates the something has been
added.
View Deletions Red Indicates that something has
been deleted.
View Unchanged Blue Indicates that there is no change.

TASK
1.

2.

View the base file in AutoVue.

From the Analysis menu, select Compare.

STEP RESULT: The Open dialog box appears.

Enter the file name or browse to select the file that you want to compare with the
current active file.

Click OK.

ADDITIONAL INFORMATION: If you apply a change from the View menu, all three windows
display the synchronized change.

STEP RESULT: AutoVue displays three windows, the first displaying the original file, the
second displaying the compare file and the third displaying the comparison results.

To access the Compare options, right-click in any of the windows.

ADDITIONAL INFORMATION: To maximize a window, click on the [g] button on the title bar of
the window. To minimize a window, click on the [=] button. To restore the window, click
on the @) button.

STEP RESULT: A menu appears displaying the Compare options.

When comparing AutoCAD files, you can view a file without viewports. To do so,
from the View menu, select View Without ViewPorts.

To maximize any of the windows, double-click the title bar of the window that you
want to maximize. To restore the window, double-click the title bar.
To exit Compare mode, from the File menu, select Exit Compare.

ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Exit Compare Mode
BD.

RESULT:

The original file appears in the workspace.
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Drawing Information

The Drawing Information option is available with AutoCAD and MicroStation drawings,
and is accessed from the Analysis menu. The Drawing Information options available are:
Select Single Entity, List Tags/Attributes, and Entity Information.

Viewing Details of a Single Entity

The Select Single Entity option allows you to view information of a single entity.

TASK
1.

From the Analysis menu, select Show Drawing Information, and then select
Select Single Entity.

Click the entity for which you want to view information.

If you did not select an entity, a message appears informing you that no entities
were found and prompts you to select again.

The Get Entity Info dialog appears displaying the information for the selected
entity. The Extended Data (XData) button appears if additional information exists
for that entity. Click XData to view the information.

Click OK to close the Get Entity Info dialog.

Viewing Tags/Attributes

The List Tag/Attributes option allows you to view information on block attributes and tags.

TASK
1.

From the Analysis menu, select Show Drawing Information, and then select List
Tags/Attributes.

Click in the area of the file for which you want to view information on block attri-
butes and tags.

ADDITIONAL INFORMATION: If there are no entities within the selected box, a message appears
informing you that no entities were found and prompts you to select again.

STep REsuLT: The Block Attributes dialog appears displaying the attributes/tags for the
selected entity.

Click OK to close the Block Attributes dialog.
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Viewing Information for a Set of Entities

The Entity Information option allows you to view information of a set of entities contained
in a specific area of a drawing.

TASK
1.

From the Analysis menu, select Show Drawing Information, and then select
Entity Information.

Click and drag to highlight the entities for which you want to view entity informa-
tion.

ADDITIONAL INFORMATION: If there are no entities within the selected area, a message appears
informing you that no entities were found and prompts you to select again. To exit,
right-click the mouse anywhere in the workspace.

STEP RESULT: The List Entities dialog appears displaying the information of all the selected
entities.

Click OK to close the List Entities dialog.

Measuring in 2D Files

AutoVue provides the ability to perform measurements in 2D files. Measurement options
vary between vector and non-vector files.

For vector files, AutoVue provides the option to “snap” to fixed points on the
drawing.

For non-vector files, the Snapping Modes option is disabled. However, you can free
snap to any point on the drawing.

AutoVue provides several measure options that you can choose from.You can access the
measure options from Analysis menu and selecting Measure, or from the AutoVue
toolbar, click Measure ,]:!

The measure options are as follows:

Name Description

Distance Measure the distance between two points.

See “Distance in non-Vector Files”
“Distance in Vector Files”
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Name Description

Area Measure selected area.
See “Area in non-Vector Files”
“Area in Vector Files”

Angle Measure the angle between selected points or
between two lines.
See “Angle in non-Vector Files”

“Angle in Vector Files”

Arc Measure an arc entity.
See “Arc in non-Vector Files”
“Arc in Vector Files”

2D Vector Snapping Modes

The available snapping modes allow you to click to precise geometrical points on a
drawing. For example, if you select Snap to End-Point and you move the cursor over an
end-point of a line, the end-point will be highlighted by a snap box.

The snapping modes allow you to snap to the mid, center, and end-points of an entity:

Button Snap to Description

End-point Geometric snap mode where a snap box appears when moving
the cursor near a linear component’s end point.

o

Mid-point Geometric snap mode where a snap box appears when moving
the cursor near the halfway point of a linear component.

Jof

Center-point Geometric snap mode where a snap box appears when moving
the cursor near the center of an elliptical component.

®

Free snap Allow snapping at any point on the drawing.

X

NOTE: When selecting a snapping mode you also have the option to select all snapping modes
(All On) or to turn off snapping modes (All Off)

The below table lists snapping locations for certain measurements:

Measurement Snapping Location

Area Snaps to a shape on the drawing.
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Measurement Snapping Location
Arc Snaps to an arc on the drawing.
Angle Snap to two non-parallel lines.

Distance in non-Vector Files

Use the Distance option to measure the distance between two specific points.

TASK
1.

From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure ,]:!
STEP RESULT: The Measurement dialog appears displaying the measurement options.

Click the Distance tab.

In the Measure Distance Units list, select a unit of measurement.

ADDITIONAL INFORMATION: If you want to measure the distance along a path, select the
Cumulative check box.

Click a point on the drawing to define the starting point.

Click another point on the drawing to define the end point.

ADDITIONAL INFORMATION: If you selected Cumulative, continue clicking points along the
path that you want to measure.

Right-click to complete the measurement.
ADDITIONAL INFORMATION: Click Reset to take another measurement.

STEP RESULT: The points are joined by a line. The measured distance, Delta-X, and Delta-Y
appear in their respective fields in Distance tab.

Click Close to close the Measurement dialog.

Distance in Vector Files

Use the Distance option to measure the distance between two specific points.

TASK
1.

From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure .]'j

STEP RESULT: The Measurement dialog appears displaying the measurement options.

Click the Distance tab.
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Select the snapping modes that you want to use for measuring.
4. Toselectall snapping modes click All On. To clear all snapping modes click All Off.

From the Measured Distance Units list, select the units of measurement.

ADDITIONAL INFORMATION: If you want to measure the distance along a path, select Cumula-
tive.

6. Click a point on the drawing to define the starting point.

7.  Click another point on the drawing to define the end point.

ADDITIONAL INFORMATION: If you selected Cumulative, continue clicking points along the
path that you want to measure.

8.  Right-click to complete the measurement.
ADDITIONAL INFORMATION: Click Reset to take another measurement.

STEP RESULT: The points are joined by a line. The Measured Distance, Delta-X, and Delta-Y
appear in the Measurement dialog.

9. Click Close to close the Measurement dialog.

Calibrating Distance

Calibrate the distance measurement.

TASK
1. Measure distance between two points or measure cumulative distance.

2.  From the Distance tab, click Calibrate.

STeEP RESULT: The Distance Calibration dialog appears displaying the measured distance
From the Units list, select the unit to which you want to calibrate the distance.

4.  Select Calibrate to and enter a value if you want to calibrate the distance to a
value.

5. Select Set Factor and enter a value if you want to calibrate the distance by a factor.

6. Click OK.
STEP RESULT: The calibration result appears in the Measurement dialog.

7. Click Close to close the Distance tab.
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Area in non-Vector Files

Use the Area option to measure the area and perimeter of a region.

TASK
1.

From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure ,]:!

STEP RESULT: The Measurement dialog appears displaying the measurement options.
Click the Area tab.

In the Area Units list, select a unit of measurement in which to measure the area of
the region.

In the Perimeter Units list, select a unit of measurement in which to measure the
perimeter of the region.

ADDITIONAL INFORMATION: In the Net Area Result group, select Add to cumulate a net area
result of different areas, select Subtract to subtract an area from the net area result, and
select Clear to clear the Net Area Result field.

Click a point on the drawing to define the starting point.

Continue clicking points on the drawing to define the region you want to measure.

STEP RESULT: Each point is joined by a line. The area and perimeter measurements appear
in their respective fields in the Area tab.

Right-click to complete the measurement.
ADDITIONAL INFORMATION: Click Reset to take another measurement.

Click Close to close the Measurement dialog.

Area in Vector Files

Use the Area option to measure the area and perimeter of a region.

TASK
1.

From the Analysis menu, select Measure.

ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure .]'j
STEP RESULT: The Measurement dialog appears.

Click the Area tab.

Select Between Points if you want to measure the area between points on a
drawing.

ADDITIONAL INFORMATION: Snapping modes are displayed.
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4.  Select the snapping modes that you want to use for measuring:See “2D Vector
Snapping Modes” for more information.

Option Descriptions
All On Select all snapping modes.
All Off Clear all snapping modes.

5. Select Shape if you want to measure the area of a predefined shape on the
drawing.

6. From the Measured Area Units list, select the unit in which you want to measure
the area.

7. From the Perimeter Units list, select the unit in which you want to measure the
perimeter.

8. To cumulate a Net Area Result of different areas, click Add.

To subtract an area from the Net Area Result, click Subtract.
ADDITIONAL INFORMATION: Select Clear to clear the Net Area Result.

10. If you selected Between Points, click points on the drawing to define the area.

STEP RESULT: Each point is joined by a line. The area and perimeter measurements appear
in the Measurement dialog.

11. Right-click to complete the measurement.

12.  If you selected Shape, click the edge of the predefined shape.

STePREesuLT: The shape is highlighted and the area and perimeter measurements appearin
the Measurement dialog.

13. Click Reset to take another measurement.

14. Click Close to close the Measurement dialog.

Angle in non-Vector Files

Use the Angle option to measure the angle between points on a drawing.

TAsK

1. From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure ,J‘j
STEP RESULT: The Measurement dialog appears displaying the measurement options.

2.  Click the Angle tab.

3.  Select a unit of measurement from the Units list.
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4.  Click points on the drawing to define the angle you want to measure.
ADDITIONAL INFORMATION: Click Reset to take another measurement.

STEP RESULT: Angle arms appear with an arc connecting them. The angle measurement
appears in the Angle tab.

5.  Click Close to close the Measurement dialog.

Angle in Vector Files

Use the Angle option to measure the angle between points on a drawing.

TASK
1. From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure .J'j
STEP RESULT: The Measurement dialog appears displaying the measurement options.
2.  Click the Angle tab.

3.  From the Angle Definition section, select one of the following:
. From 3 Points: Measure the angle between three points.

. Between 2 Lines: Measure the angle between two non-parallel lines.
4,  Select the snapping modes that you want to use for measuring.

To select all snapping modes click All On, To deselect all snapping modes click All
Off. See “2D Vector Snapping Modes” for more information.

6. Select Between 2 lines if you want to measure the angle between two lines.
7. From the Measured Angle Units list, select the unit.

8. Ifyou selected From 3 Points, click three points on the drawing to define the
angle.

9. Ifyouselected Between 2 Lines, click two lines on the drawing to define the angle.
ADDITIONAL INFORMATION: Click Reset to take another measurement.

STEP RESULT: Angle arms appear with an arc connecting them. The angle measurement
appears in the Measurement dialog.

10. Click Close to close the Measurement dialog.
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Arc in non-Vector Files

Use the Arc option to define an arc in the drawing and calculate its arc center, radius, diam-
eter, and arc length.

TAsK
1. From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure .]'j
STEP RESULT: The Measurement dialog appears displaying the measurement options.
2. Click the Arc tab.

3. Inthe ArcInfo section, select a unit of measurement from the Length Units list in
which to measure the length of the arc.

4. Inthe Measured Angle section, select a unit of measurement from the Sweep Units
list in which to measure the angle of the arc.

5. Click points on the drawing to define the arc.
ADDITIONAL INFORMATION: To take another measurement click Reset.

STEP RESULT: The points are joined by an arc. The measurements for center point coordi-
nates, radius, diameter, arc length, start and end of angle, and sweep appear in the Arc tab.

6. Click Close to close the Measurement dialog.

Arcin Vector Files

Use the Arc option to define an arc in the drawing and measure its radius, center, arc
length, start and end of angle, sweep, and diameter.

TAsK

1. From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure ,I':!
STEP RESULT: The Measurement dialog appears.

2.  Click the Arc tab.

3. Select From 3 Points if you want to measure the arc between three points. Snap-
ping modes are displayed

4.  Click the snapping modes that you want to select as the points for the measure-
ment.

ADDITIONAL INFORMATION: To select all snapping modes click All On. To clear all snapping
modes click All Off. See “2D Vector Snapping Modes"” for more information.

5. Select Arc Entity if you want to measure a predefined arc.
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6.  From the Arc Info Unit list, select the unit in which you want to measure the
distance.

7. From the Measure Angle Units list, select the unit in which you want to measure
the angle.
8. Ifyou selected From 3 Points, click three points on the drawing to define the arc.

STEP RESULT: The points are joined by an arc. The measurements for center point coordi-
nates, radius, diameter, arc length, start and end of angle and sweep appear in the
Measurement dialog.

9. Ifyou selected Arc Entity, click the edge of the arc that you want to measure.
ADDITIONAL INFORMATION: To take another measurement click Reset.

STEPRESULT: The arcis highlighted. The measurements for center point coordinates, radius,
diameter, arc length, start and end of angle and sweep appear in the Measurement dialog.

10. Click Close to close the Measurement dialog.

Calibrating an Arc

TASK
1. Measure an arc in the drawing.

2. From the Arc tab, click Calibrate.
STEP REsULT: The Radius Calibration dialog appears displaying the measured distance.

3. Fromthe Units list, select a unit of measurement to which you want to calibrate the
distance.

4.  Click Calibrate to and enter a value if you want to calibrate to a value.
Click Set Factor and enter a value if you want to calibrate by a factor.

6. Click OK.
STEP RESULT: The calibration results appear in the Arc tab.

7.  Click Close to close the Measurement dialog.
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Working with EDA Files

In addition to all the features that are available for generic 2D files, AutoVue also provides
intelligent querying for EDA files; you can create/modify layer sets, generate BOM, verify
EDA designs, perform intelligent measurements, analyze nets and components, set
enhanced display options and global transparency, and much more. For information on the
available features for EDA files, refer to the following sections.

See “Appendix B: Gerber Layer File Format™for information on the Gerber Layer File
(GBL) format.

Navigation Panel

The Navigation Panel displays by default on the left-hand side of the AutoVue workspace
when you view a drawing. For example, when viewing an EDA drawing, it allows you to
navigate through a list of component instances, nets, and the associated pins and net nodes
(pins connected to a net) present in the current schematic drawing or Printed Circuit Board
(PCB) design.

g(]

NOTE: To hide or display the Navigation Panel, click .

The columns displayed in the Navigation Panel are determined by the profile of the entity
types in the current schematic drawing or PCB design. Lists can be sorted in order to group
similar component instances.
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You can also use the Navigation Panel to select (highlight) single or multiple components
or entities; zoom to a component or entity, and query entity information.

Components * 0

Components

RefDes | Part Type | Locatio
114 BAFPCE... |[29.000
C1 CAPAET... [[571.000
Cz2 CAPCIZT... |[7.0000
C3 CAPCIZT... |[7.0000
C4 CAPCIZT... |[7.0000
1 SOPE3F... |[B0.000
Iz SOPE3F... |[B0.000
113 SSOPS0.. |[B0.000
15 SS50OP50... |[50.000
R4 RESCIE... |[7.0000
R3 RESCIE... |[7.0000
Rz RESCIE... |[7.0000
A1 RESCIE... |[7.0000
RM1 RESCAx... [[9.0000
RAkZ RESCAx... [[9.0000
RM3 RESCAx... [[9.0000
R4 RESCAx... [[9.0000
J1 FOL-541... [[30.000
51 S SMA.. (11000
52 S SMA.. | [49.000
J2 ISBAF [23.0001
DISPLAYT | FSEGSMD | [29.0000

£ >

Component Ping

M ame | Location |'W'ith ”
1151 [47.1500... |falze
5.2 [47.1500... |falze
5.3 [47.1500... |falze
5.4 [47.1500... |falze
55 [47.1500... |falze
56 [47.1500... |falze

Customizing

In the Navigation Panel, you can sort a column, change column order, or hide/show a

column.

TASK

1. Tosorta column, click the column heading.

2. Tochange the column order or to show/hide a column, right-click a column
heading and select Customize. The Customize Columns dialog box appears.

3.  Toshow orhide acolumn, select the check box beside the column or columns you
want to show.

4.  Deselect the check box beside the column or columns you want to hide.

ADDITIONAL INFORMATION: To show all columns, click Show All. To hide all columns, click Hide
All.
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5. Tochangethe column order, select the column you want to move, then click Move
Up to move the column up in the list or click Move Down to move the column
down in the list.

6. Click OK.

RESULT:

The changes appear in the Navigation Panel.

Components Tab

NOTE: The Components tab displays only for the EDA pages of a drawing.

The Components tab lists component instances and the associated pins.The top portion of
the tab lists all the instances of the currently displayed page of the drawing. The lower
portion of the tab lists the associated pins for selected instances.

When you select a component, it appears highlighted on the drawing. To select more than
one component, press the Shift or Control key while selecting. All the selected components
and their associated pins are highlighted.

Components v 0
Components
RefDes ||:|:umpu:un... |Lc -

C345 CAP-0402 (2
C344 CAP-0402 111
C343 CAP-0402 111
C342 CAP-0402 111
C360 CAP-0402 111

CAP-D402 | 1]
< »
Component Fing
M arme | Met | Pir :
C3dd +3.WDC  |UNSF
C3d.2 GHD IJMSF
< ¥

Components | Meks | Bookmarks
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Nets Tab

NOTE: The Nets tab displays only for EDA drawings.

The Nets tab lists nets and associated net nodes (pins connected to a net). The top portion
of the tab lists all the nets of the drawing’s currently displayed page. The lower portion of

the tab lists the associated net nodes for the selected nets.

All selected nets are highlighted on the drawing. To select more than one net, press the Shift
or Control key while selecting. Alternately, in the Nets panel, you can click and drag in the
Navigation Panel list to select multiple nets. The Nodes on Net panel lists the associated

nodes for the selected nets.
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Bookmarks Tab

The Bookmarks tab lists links to specific views (Draft views, 2D plans, 3D Views of an EDA
design) or pages or bookmarks structure that is saved in files such as PDF.

Bookmarks

“Boson

L 18 30 Madel

Components | Mets | Bookmarks

Navigate between the pages or files or views by clicking the appropriate link. Bookmarks
lead to various views of CAD files such as AutoCAD file Model Space, the 3D model of a
file and associated 2D engineering drafts.

If a plus sign appears to the left of a bookmark, click it to expand and view the lower book-
mark levels. If a minus sign appears to the left of the bookmark, click it to collapse the lower
bookmark levels.

To go to a destination specified by a bookmark, click the bookmark text or the page icon
located to the left of the bookmark text.

Selecting Entities

Selecting an entity or entities is often the first step to many of the operations that you
perform with EDA files. The following sections provide information on how to select enti-
ties from the workspace, Navigation Panel, and the Entity Search dialog. To specify which
types of entities you can or cannot select, use the Entity Filter dialog.

See “Filtering Entity Types”for more information on the Entity Filter dialog.

Once an entity is selected, you can zoom to it in the workspace and perform other opera-
tions with the EDA file.
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From the Navigation Panel

To select an entity from the Navigation Panel, perform the following steps:

To select one entity, click the component, net, associated pin, or net node in the Navigation
Pane.

To select multiple entities, press the Shift or Control key while selecting.

The selected entity or entities are highlighted in the workspace. If the selected entity is
small, a flash box appears indicating the location of the highlighted entity in the workspace.

See “Zooming to a Selected Entity”

From the Workspace

To select an entity from the workspace, perform the following steps:

Click an entity in the workspace to select it. To select more than one entity, press the Shift
or Control key while selecting.

The selected entity or entities appear highlighted in the workspace and in the Navigation
Panel. If the selected entity is small, a flash box appears indicating the location of the high-
lighted entity in the workspace.

You can also apply selection filters when selecting entities in the workspace.
See “Filtering Entity Types”

When you hover the mouse over an entity in the workspace, a tooltip with information
about the entity’s attributes appears. The tooltip displays whether or not you select the
entity.
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From the Entity Search Dialog

To select and entity from the Entity Search dialog, perform the following steps:

TASK
1. Perform an attribute-based or entity type-based search using the Entity Search
dialog.

2. Select an entity or entities from the Entity Types list or the Attributes list of the
Entity Search dialog. To select more than one entity, press the Shift or Control key
while selecting.

RESULT:

The selected entity or entities appear highlighted in the workspace and in the Navigation
Panel.

If the selected entity is too small, a flash box appears indicating the location of the high-
lighted entity in the workspace.

See “Searching Using Entity Search”

Filtering Entity Types

With the Entity Filter option, you can choose to display certain entity types while hiding
others. You can also limit the types of entities you can select in the workspace.

TASK

1. From the Manipulate menu, select Visibility Control, and then select Entity
Filter.

STEP RESULT: The Entity Filter dialog appears.

2. Under the Visibility column, perform one of the following:
. Select the check box beside the entity types you want to display in the workspace.
. Deselect the check box to hide the entity types.

3. Under the Selection column, perform one of the following:

. Select the check box beside the entity types that you want to be able to selectin the
workspace.

. Deselect the check box beside the entity types that you do not want to select.

ADDITIONAL INFORMATION: To select all entity types, select the column header check box.
Deselect the column header check box to deselect all entity types.
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4.  Click Apply to apply the changes.
5.  Close OK to close the Entity Filter dialog.

RESULT:
Only the selected entity types remain displayed in the workspace.

When you click in the workspace, only the entity types checked in the Entity Filter dialog
will be highlighted.

Zooming to a Selected Entity

To zoom to a selected entity, perform the following steps:

TASK

1. If you selected an entity from the workspace or Navigation panel, right-click and
select Zoom Selected.

2. Ifyouselected an entity from the Entity Search dialog, right-click and select Zoom
Selected.

RESULT:

AutoVue zooms to the selected entity in the workspace.

Entity Properties

The Entity Properties dialog displays detailed information about any selected entity in the
current schematic drawing or PCB design. To view the Entity Properties dialog, first select
an entity from the workspace and then from the Analysis menu select Show Entity Prop-
erties.

NOTE: You can also double-click an entity in the workspace, or right-click an entity in the
workspace, Navigation Panel, or Entity Search dialog, and then select Show Entity Proper-
ties.
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On the left side of the Entity Properties dialog, a tree displays all the entities associated with
the entity you selected. The entity you selected is the root of the tree, and all the associated
entities (grouped by their type) are shown as its children.

The attributes of the entity display to the right of the tree, under Entity Info. In the tree,
select any associated entity to display its attributes under Entity Info.

You can also view entity attributes in the workspace. When you hover the mouse over an
entity in the workspace, a tooltip with commonly used entity information appears. You can
turn these tooltips off or on from the Configuration dialog.

See “Configuring AutoVue” for more information on the Configuration dialog.

Viewing the Properties of an Entity

The Entity Properties dialog displays detailed information about any selected entity in the
current schematic drawing or PCB design.

TASK

1. Select the entity in the workspace or from the Navigation Panel or Entity Search
dialog.

3/1/11

69



WORKING WITH EDA FILES
ENTITY PROPERTIES

Right-click and select Show Entity Properties.

ADDITIONAL INFORMATION: You can also double-click the entity in the workspace to view its
entity information.

STEP RESULT: The Entity Properties dialog displays the selected entity and its associated
entity.

Select any associated entity in the tree to display its attributes.

To view all associated entities for any given entity in the tree, select the entity and
click Expand.
ADDITIONAL INFORMATION: To view the entity properties for the previous entity, click the back

arrow [_=_]. To return to the entity properties displayed before you clicked the back arrow,
click the forward arrow [_=_]

Click OK to close the Entity Properties dialog.

Showing Net Connectivity

You can view the net connectivity of an entity such as a pin, via, or trace with the Show Net
Connectivity option.

NOTE: Show Net Connectivity is disabled when more than one entity is selected.

TASK
1.

Select an entity such as a pin, via, or trace from the workspace or the Navigation
Panel.

STEP RESULT: The corresponding entity is highlighted in the workspace and in the Naviga-
tion Panel.

2. From the View menu, select Show Net Connectivity.
ADDITIONAL INFORMATION: From the workspace or Navigation Panel, you can also right-click
the selected entity, and then select Show Net Connectivity.

RESULT:

The graphical entities belonging to the connected nets are highlighted.

Displaying the Entity Properties of a Net

You can view the properties of a net via the Show Entity Properties option.
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NOTE: The Show Entity Properties is disabled when more than one net entity is selected.

TASK
1.

Select an entity such as a pin, via, or trace from the workspace or the Navigation
Panel.

STEP RESULT: The corresponding net is highlighted in the workspace and in the Navigation
Panel.

From the workspace or Navigation Panel, right-click the selected net, and then
select Show Entity Properties.

STEP RESULT: The Entity Properties dialog appears displaying the properties of the selected
net.

Click OK to close the Entity Properties dialog.

Show Net Instances

You

can display the instances of a net in a multi-page file.

TASK
1.

From the Navigation Panel, click the Nets tab and select the net you want to view.
STEP RESULT: The net is highlighted in the Navigation Panel and in the workspace.

From the View menu, select Go to Net Instances, or right-click the highlighted net
from the Navigation Panel or workspace and select Go to Net Instances.

STEP RESULT: AutoVue highlights the instance or instances of the selected net. If the
selected net appears on multiple pages the Go to Net Instances dialog appears.

Pleaze select a page:

33
4.4

Cancel

3.

Select the page on which you want to view the net instance, then click OK.

RESULT:

The

selected page is displayed and the instance of the selected net is highlighted.
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Navigating Design Hierarchy

AutoVue supports navigation through the hierarchical structure of a schematic drawing. A
hierarchical block in a schematic is a symbol that refers to a child schematic.

Navigating using Descend Hierarchy

With the Descend Hierarchy option, you can navigate to a child schematic.

On the parent page of your schematic’s design hierarchy, select any hierarchical block in
the workspace or in the Navigation Panel, then right-click and select Descend Hierarchy.

AutoVue opens the page with the selected child schematic.

NOTE: You can also select the hierarchical block in the Entity Search dialog box, then
right-click and select Descend Hierarchy.

Navigating using Ascend Hierarchy

With the Ascend Hierarchy option, you can navigate from the child schematic to the parent
page.

On the child page of your schematic’s design hierarchy, select an entity in the workspace or
in the Navigation panel and then from the View menu select Ascend Hierarchy. AutoVue
returns to the parent page.

NOTE: You can also right-click an entity in the workspace or in the Navigation panel and
select Ascend Hierarchy = .
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If you select an entity that has multiple parents, the Ascend Hierarchy dialog appears
displaying the parent pages. Select the Parent page you want to go to, then click OK.
AutoVue returns to the selected parent page.

Ascend Hierarchy g|

Pleaze select a page:

15 Channel CO Data Flow
17: Channel A8 Data Flow
18: Channel EF Data Flow
20: Channel GH Data Flow

Cancel

NOTE: You can also select the entity in the Entity Search dialog, then right-click and select
Ascend Hierarchy.

When working with EDA files, AutoVue lets you view all the physical layers and associated
logical layers of the EDA drawing; you can view all layer sets for that file, or create your
own. Additionally, from the Layers option, you can manipulate certain layer attributes,
such as visibility, color, polarity, and ordering. To display the Layers dialog, from the
Manipulate menu, select Visibility Control, and then select Layers. From the AutoVue
toolbar, you can also click Layers =3

NOTE: For drawings that do not contain layers, the Layers menu option and button are
disabled.

The Layers dialog has a Physical Layers section and a Logical Layers section. You can
display and hide these sections by clicking Expand & and Collapse &, respectively.

Physical and Logical Layers Sections

The Logical Layers section displays the layers in the order they display in the workspace.
The Physical Layers section displays the layers in the order they appear in the layer stackup
when manufactured.

The Physical Layers section displays a matrix with a mapping of physical layer names to
entity types. Each row in the matrix corresponds to a physical layer in the board. Each
column in the matrix lets you control the visibility of an entity type, such as pin, via, or
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trace. The entity types that display depend on the entities available in the open file. Select a
physical layer to change its visibility, layer order, and color. Select or deselect the entity type
of a physical layer to affect its visibility separately from the other entities of the layer.

When you select a physical layer from the Physical Layers section, the associated logical
layers are also selected in the Logical Layers section. You can also select individual logical
layers from the Logical Layers section, or press the Shift or Control key to select multiple
logical layers.

NOTE: One physical layer can be selected at a time.

The Logical Layers section displays a list of logical layers and the layer attribute options you
can modify: visibility, order, color, and polarity.

To modify the attributes for both physical and logical layers, first select the layers you want
to modify, and then use the settings to make the changes you want.

When you select physical layers and modify settings from the Layers dialog, a message
displays at the bottom of the dialog to indicate your last action.

When you are satisfied with the changes, click Apply to make the changes in the workspace.
You can also create layer sets to save your modified layer settings to reuse them later.

When you open a file, it displays all layer sets for that file. You can choose the layer set you
need, or create your own.

Changing the Order of Layers

You can change the order in which layers display in the workspace. Specifically, you can
change the z-order of layers.

TAsK

1. From the Manipulate menu, select Visibility Control, and then select Layers =3
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Layers &
STEP RESULT: The Layers dialog opens.

2. Ifthe Logical Layers section is not open, click Expand &.
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Modifying Vis

Select the layer or layers that you want to move. To do so, you can do one of the

following:

. Select a physical layer from the Physical Layers section. Logical layers associated
with the selected physical layer are also selected. When you make changes to a
selected physical layer, the logical layers associated with it are also affected.

. Select one or multiple logical layers from the Logical Layers section. To select
multiple logical layers, press the Shift or Control key while selecting.

Click one of the following buttons:
. Click Bring to Front % |to move all selected layers to the front in the workspace. In
the Logical Layers section, these layers move to the top of the list.

. Click Up _* to move selected layers up one layer.
. Click Down ﬂ to move selected layers down one layer.

ADDITIONAL INFORMATION: You can also drag and drop selected logical layers in the Logical
Layers section.

Click Apply to see the changes in the workspace.

STEP RESULT: The file now displays according to the layer scheme you arranged. Also,
logical layers are renumbered in the Order column of Logical Layers section.

You can now save your changes as a user-defined layer set.

Click Close to close the Layers dialog.

ibility for Physical Layers

Use the Layers dialog to hide or display specific physical layers in the workspace.

TASK
1.

From the Manipulate menu, select Visibility Control, and then select Layers.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Layers &.
STEP RESULT: The Layers dialog opens.

2. Inthe Physical Layers section, you can show or hide the following:
Option Description
All physical layers Click the All column header.
One physical layer Select the check box to the left of the layer name. You can also select a layer
and click Visibility |
One entity type for all Click the column header. For example, click the Trace column header to
physical layers show or hide all trace entities of all physical layers.
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Option Description
One entity type for one Click a specific check box.
physical layer

Click Apply to view the changes in the workspace.
4.  You can now save your changes as a user-defined layer set.

Click Close to close the Layers dialog.

ADDITIONAL INFORMATION: Check boxes for physical layers can have four states: checked,
unchecked, gray checked, and gray unchecked. Check boxes that are checked and gray
indicate that the entities of a physical layer are neither all visible nor all hidden. Gray
unchecked check boxes that you cannot select indicate that there is no entity of that type
for that layer.

Modifying Visibility for Logical Layers

Use the Layers dialog to hide or display specific logical layers in the workspace.

TASK

1. From the Manipulate menu, select Visibility Control, and then select Layers.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Layers &.
STEP RESULT: The Layers dialog opens.

2. Ifthe Logical Layers section is not open, click Expand &.

3. Inthe Logical Layers section, you can show or hide the following:
Option Description
One logical layer

Select the check box in the Visibility column ﬂ

Multiple logical layers | To select more than one layer, press the Shift or Control key while selecting,
and then click Visibility ﬂ

4.  Click Apply to view the changes in the workspace.
5. You can now save your changes as a user-defined layer set.

6. Click Close to close the Layers dialog.

76 3/1/11




WORKING WITH EDA FILES
LAYERS

Modifying Polarity

From the Logical Layers section of the Layers dialog, you can invert the polarity of the
selected layer (if polarity exists in the selected file).

TASK

1. Select the layer and then click the Polarity icon to toggle the polarity, or
select/deselect the checkbox in the Polarity column.

. When positive polarity is selected, the layer appears as is.

. When negative polarity is selected, the layer image is inverted; the entities in the
layer are displayed as transparent and the remainder of the layer appears as a solid
color.

Changing Layer Color

You can modify the color of any physical or logical layer from the Layers dialog.

TASK

1. From the Manipulate menu, select Visibility Control, and then select Layers.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Layers &.
STEP RESULT: The Layers dialog opens.

2. If necessary, click Expand & to open the Logical Layers section.

ADDITIONAL INFORMATION: Select the layer or layers for which you want to change the color.
You can select a physical layer from the Physical Layers section; logical layers associated
with the selected physical layer are also selected. You can also select individual logical
layers from the Logical Layers section, or press the Shift or Control key while selecting to
select multiple layers.

3. Afteryou select a layer, yoi1 can do one of the following to modify its color:

. Click Modify Color Q and then select a color from the palette. Use this button if
you want to change the color of all logical layers associated with a selected physical
layer, or to change the color of many selected logical layers at the same time.

. Double-click a square in the Color column 0 |ofthe Logical Layers section and then
select a color from the palette. Use this option to change the color of individual
logical layers.

STEP RESULT: The color of all selected layers changes in the Color column.

4.  Click Apply to save the changes.

STEP RESULT: The display updates in the workspace based on the changes you made to the
layer color.
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5. You can now save your changes as a user-defined layer set.

6. Click Close to close the Layers dialog.

Sorting Logical Layers

You can sort the list of logical layers in the Logical Layers section by name, visibility, color,
or physical layer.

TAsK

1. From the Manipulate menu, select Visibility Control, and then select Layers.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Layers &.
STEP RESULT: The Layers dialog opens.

2. Ifthe Logical Layers section is not open, click Expand &.

3.  Click the column header of an attribute.

REsuLT:
Layers are sorted according to the attribute header you click.

For example, if you click the Color ﬂ column header, the logical layers in the section are
grouped according to their color.

NOTE: To restore the original sort order, click the Order column header.

Layer Sets

A layer set is comprised of all the physical and logical layers in the drawing. Layer sets differ
in the attributes of the different layers; for example, z-order, visibility, and color. You can
also define your own layer sets to control which layers you can view and print.
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Viewing Layer Sets

AutoVue lists top, bottom, and default layer sets, as well as any layer set that is stored in the
file. You can choose to display any layer set you need. You can also create user-defined layer
sets and display them later. To view a layer set, take the following steps:

TASK

1. From the Manipulate menu, select Visibility Control, and then select Layers.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Layers &.
STEP RESULT: The Layers dialog opens.

2. From the Layer Sets list, select the layer set you want to display.

3.  Click Apply.
STEP RESULT: The selected layer set displays in the workspace.

4. Torestore the default layer set, from the Layer Sets list, select (Default).

Click Close to close the Layers dialog.

ADDITIONAL INFORMATION: You can also view the layer sets from the Layers list beside the
Layers button &% on the AutoVue toolbar.

Creating User-Defined Layer Sets

You can define a layer set and save it for the duration of the session. The layer set you
defined is added to the Layer Sets list in the Layers dialog and to the Layers list on the
AutoVue toolbar. By default the Top, Bottom and Default layer sets and any other layer sets
belonging to the file are listed in the Layer Sets list.

TAsK
1. From the Manipulate menu, select Visibility Control, and then select Layers.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Layers .
STEP RESULT: The Layers dialog opens.
2. Click Add.
STEP RESULT: The Add Layer Set dialog appears.
Enter the layer set name.
4. Click OK.
STEP RESULT: The new layer set appears in the Layer Sets list.

5. Tomodify the attributes of the new layer set, select one or more layers and change
the Visibility, Order, or Color.

6. Click Apply to save the changes and to display the new layer set in the workspace.
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7.  To define more layer sets, repeat steps 2 to 6.
8.  Click Close to close the Layers dialog.
RESULT:

The new layer set appears in the Layers list beside the Layers Control button & on the
AutoVue toolbar.

Deleting User-Defined Layer Sets

To delete a user-defined layer set, perform the following steps:

TASK
1.

From the Manipulate menu, select Visibility Control, and then select Layers.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Layers &.

STEP RESULT: The Layers dialog opens.

From the Layer Sets list, select the user-defined layer set you want to delete.
ADDITIONAL INFORMATION: You can only delete user-defined layer sets.

Click Delete.

ADDITIONAL INFORMATION: The layer settings of the deleted layer set remain displayed on the
screen until you select another layer set.

Click Apply to save the changes.

Click Close to close the Layers dialog.

Saving User-Defined Layers Sets with Markups

You can save user-defined layer sets using Markup files.

TAsK
1.

2.

Create custom layer sets.

From the Markup menu, select New.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Markup 2.

Create any markup entities that you need.

80

3/1/11



WORKING WITH EDA FILES
MANIPULATING EDA VIEWS

4.  From the Markup menu, select Save As.
STEP RESULT: The Save Markup File As dialog appears.

5.  Enterthe markup information and click OK to close the Save Markup File As dialog.

RESULT:

The Layer sets you created are saved with the Markup file. When you reopen the file during
a different session, you can view the Layer sets when you open the Markup file.

See “Markups”

Manipulating EDA Views

As with any 2D file, with the View options, you can instantly manipulate how the current
active file is displayed. For example, you can rotate a file’s orientation clockwise or
counter-clockwise by 90 degrees, and flip a file’s orientation horizontally, vertically or both
simultaneously.

See “2D Viewing Options” for more information on View options.

AutoVue provides several ways to change the view size of a selected area of a file, display
different views, layers and blocks of the current active file. You can also navigate from one
page to another page of a multi-page file.

3D View

For some ECAD formats, AutoVue supports 3D views of PCB boards.

TASK
1. Inthe Navigation Panel, click the Bookmarks tab.

2.  Select 3D Model from the navigation tree.

RESULT:

The 3D view of the PCB board is displayed in the workspace.
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NOTE: 3D view can also be accessed from the View menu, selecting Page, and then selecting
Next, or from the AutoVue toolbar and then clicking Next Page [ ]

Cross Probing

Cross probing is the ability to select elements in the schematic and have them mapped to the
corresponding components in the layout drawings and vice versa.

The following sections provide information on cross probing between two or more EDA
files, displaying the net connectivity when cross probing, and cross probing between 2D
and 3D views of the same file.

Cross Probing Between Two or More EDA Files

The Cross Probe option lets you select entities in the schematic drawing or the PCB design
to highlight in all the open files.

TAsK
1. Open an EDA file to cross probe.

2. From the Analysis menu, select Cross Probe.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Cross Probe <5;.
STEP RESULT: The Cross Probe dialog appears.

Click Add File.

4. IntheOpendialogthatappears, enter the file name or browse to locate the file you
want to cross probe, then click Open.

ADDITIONAL INFORMATION: To add multiple files to the Cross Probe dialog repeat steps 3 and
4. When adding multiple files from the same directory, press Shift while making your
selection.

5. Click OK.

STEP RESULT: Each file you select appears in a new window. A dialog appears for each new
window which lets you change the view or page for each file. Each dialog has the Auto-
matic option selected by default. When the Automatic option is selected for each dialog,
you see different behavior depending on the files you cross probe.

6. If you cross probe a schematic and PCB, one window automatically displays a 2D
PCB and the other window displays a schematic. The same is true if either file
contains a PCB and a schematic. Whereas, if files A and B contain both a schematic
and a PCB and they are cross probed, one of the files displays the schematic page
and the other displays the 2D PCB.
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10.

If you cross probe two PCBs, one window automatically displays a 2D PCB and the
other window displays a 3D PCB.

If you cross probe two schematics, both are set to schematic.

To change the view of a file in a window, do the following:
a Deselect the Automatic option in the dialog for the window you want to change.

b From the Type list, select Schematic, PCB, or PCB 3D View. These options are avail-
able in the Type list only when the views are present in the file.

STEP RESULT: The view of the file changes in the window.
To switch between multiple occurrences of a selected component, do the
following:

a From the Navigation Panel, select a component in one file that has multiple compo-
nent occurrences in the other file.

b From the dialog of the file with multiple component occurrences, select one of the
components from the Occurrences list or click Next or Previous to switch
between component occurrences.

Chapter 6.scm g|

Scope
Aukornakic  Type:

QCcurrences

Counker: MET19 W

11.

Select any entity in the schematic drawing.

RESULT:

The same entity is highlighted in the PCB design.

Cross Probing Between 2D and 3D Views of the Same File

The Cross Probe option lets you select entities to highlight in the 2D and 3D views of the
same file.

TASK
1.

From the Analysis menu, select Cross Probe.

ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Cross Probe %
STEP RESULT: The Cross Probe dialog appears.

Click Add File.

In the Open dialog that appears, select the same file, then click Open.
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4. Inthe Cross Probe dialog, click OK.

STEP REsuLT: The file appears in a new AutoVue window. The views that display in each
window depend on the contents of file you are cross probing.

5. Ifthefile does not contain a schematic, one window shows the 2-dimensional view
of the PCB and the other shows the 3-dimensional view of the PCB.

6. Ifthefile contains a schematic as well as a PCB, the schematic view displays in one
window and the 2D PCB view displays in the other window. In this case, take the
following steps to see the 2D and 3D views of the PCB:

a In the window’s dialog, deselect the Automatic option.

b Select a different view from the TYPE list. For example, you can switch between
Schematic and PCB 3D View.

7.  Select an entity in the 3D view.

RESULT:
The same entity is highlighted in the 2D view of this file.

NOTE: You can select entities in the 2D view or 3D view of the file. The selected entities are
highlighted in both open views of this file.

Showing the Net Connectivity when Cross Probing

To display the net connectivity of the design when cross probing, perform the following
steps:

TASK
1. Select an entity or entities in any open file.

2. Right-click and select Show Net Connectivity.

RESULT:

The net connectivity for the entity or entities that you selected are highlighted in all the files.

Zooming when Cross Probing

When you are cross probing files, you can zoom in on the entities you select.

Zoom in on a selected entity or entities:

. When cross probing between a schematic drawing and a PCB design.
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. When cross probing between the 2D and 3D views of the same file.

TASK
1. Select an entity or entities in either one of the open files or views.

ADDITIONAL INFORMATION: If you are cross probing between a schematic drawing or a PCB
design, you can select entities in either file. You can also select entities in any open view
when cross probing the 2D view and 3D view of the same file.

2.  Right-click and select Zoom Selected.

RESULT:
AutoVue zooms to the same entities in all the open file or views.

See Also “Configuring Zoom Behavior when Cross Probing” for more information.

Comparing a PCB with Artwork

You can visually compare PCB designs with artwork. In Compare mode for EDA files, EDA
options such as Select Entity, Entity Search dialog and Entity Filter are available.

TASK
1. Open the PCB file that you want to compare with the artwork.
2. From the Analysis menu, select Compare.

STEP RESULT: The Open dialog appears.

3.  Enterthe file name or browse to locate the artwork file you want to compare with
the PCB file.

4. Click Open.
STEP RESULT: The PCB-Artwork Comparison dialog appears.

5.  From the box, select the PCB Physical layer that represents the artwork.
ADDITIONAL INFORMATION: For example, TOP or BOTTOM.

6. Click OK.

STEP RESULT: AutoVue displays three windows, the first displaying the original PCB
drawing, the second displaying the Artwork drawing, and the third the Comparison Result
window.

3/1/11
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7.  Toexit Compare mode, from the File menu, select Exit Compare.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Exit Compare [ET).

RESULT:

The original file appears in the AutoVue workspace.

Generating Bill of Material (BOM)

For EDA files, you can obtain a list of the components and parts required for manufac-
turing the item featured in the schematic drawing or PCB design.

The Bill of Material (BOM) report produces a count of the unique components or parts
needed for manufacturing. It lists the quantity required, component name, reference desig-
nators, value (for resistors and capacitors), size, and descriptions. When determining the
uniqueness of a component, the count considers only the attributes chosen for inclusion in
the report output. It includes only those attributes that provide the most accurate and
unique component quantities.

TASK
1. From the Analysis menu, select Generate Bill of Material.

STEP RESULT: If you are generating a BOM for a schematic with multiple pages, a dialog
appears prompting you to select the BOM scope: Current page or Entire design.

Generate BOM... E]

BOM Scope

G' Entire design

[ 8] ] [ Cancel
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2. Click OK after making your selection.
STEP REsULT: The Generating BOM dialog appears listing the attributes of the file.

Please select attributels) that determine the uniqueness of a
component [ part:

Attribute
Part Type
Locakion
Fokation
Component Definition
Glued
Layer
Mumber of Connections
Geometry, Height

[ Close l ’ Help ]

Select the attributes that you want to appear in the report.

4. C(Click Generate.

ADDITIONAL INFORMATION: To sort a column by alphanumerical or alphabetical order, click on
the column heading.

STEP RESULT: The Bill of Material dialog appears listing the count for each component or
part possessing the attributes you selected. There are also columns displaying the values
of the attributes you selected.

5. Tosave the BOM, click Export.
STEP RESULT: The Export BOM dialog appears.

6.  Specify the directory where you want to store the file, the file name and extension,
then click Save.

ADDITIONAL INFORMATION: You can specify either .pdx (Product Data Exchange) or .csv
(Comma Separated Values) for the extension.

STEP RESULT: AutoVue automatically saves the results in a file with the specified extension.

7.  Click Close to close the Bill of Material dialog.

Design Verification

Design verifications are operations that check the electrical design of a PCB against a set of
rules defining physical and electrical design constraints. Performing these checks prevent
short circuits and process errors. The types of design rules are as follows:
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Design Rule Type

Description

Clearances

The minimum spacing (air gaps) allowed between
two sets of entities in the design. These sets can
belong to the same type of entity or to different

types.

Electrical

Targets certain properties of the nets.

Manufacturing

Targets the physical properties of a particular

entity.

Design Rule Checks

For design rule checks that have values, you can set the global unit of measurement. The

available design rule checks are:

Type

Design Rule Check

Description

Clearance 1

Minimum Clearance
(Pad > Pad)

Specify the minimum
distance between the
pad outline and the
outline of its drill hole
on all physical layers.
NOTE: The two outlines
(geometries) are part of
the pin (pad) entity but
on different logical
layers.

Minimum Clearance
(Pad > Trace)

Specify the minimum
pad to trace clearance
and pads on the same
physical layer.

NOTE: Only the pad
outline is considered.
Does not take into
account traces
connected to a pin (pad)
on the same net.
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Type

Design Rule Check

Description

Minimum Clearance
(Trace > Trace)

Specify the minimum
trace to trace clearance
on the same physical
layer.

NOTE: Does not take
into account directly
connected traces.

Minimum Clearance
(Component >
Component)

Specify the minimum
component to
component clearance
on the same physical
layer (component top
side or component
bottom side).

NOTE: Only the logical
layer that defines the
actual outline of the
component is
considered.

A component entity is
usually made up of
geometries on different
logical layers (silkscreen,
keepout, and so on.), but
only the logical layer
that defines the actual
outline of the component
is considered.

Manufacturing

Minimum Annular
Ring

Specify the minimum
distance between the
pad outline and the
outline of its drill hole
on all physical layers.
NOTE: The two outlines
(geometries) are part of
the pin (pad) entity but
on different logical
layers.

Minimum Pad
Diameter

Specify the minimum
diameter of a pad.
NOTE: Only applicable
to rounded pads.
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Type Design Rule Check Description
8 Acute Angle (in Specify the minimum
degrees) acute angle between
connected traces on the
same physical layer.
NOTE: Only two traces
belonging to the same
net are considered.

9 Minimum Drill Hole Specify the minimum

Size diameter of the drill
hole size allowed.
NOTE: Only applicable
to rounded pads.

10 Maximum Drill Hole Specify the maximum

Size diameter of the drill
hole size allowed.
NOTE: Only applicable
to rounded pads.
Electrical 7 Maximum Via Count Specify the maximum
via count allowed for a
net.

11 Minimum Route Width | Specify the minimum
route (trace) width
allowed in the design.

12 Maximum Route Width | Specify the maximum
route (trace) width
allowed in the design.

13 Minimum Route Specify the minimum

Length route (trace) length
allowed in the design.

14 Maximum Route Specity the maximum

Length route (trace) length
allowed in the design.

15 Empty Nets Select this check box if

you want to check for
any nets that are not
connected to any pin,
via, trace and
power/ground plane.
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Type

Design Rule Check

Description

16

Un-routed Traces

Select this check box if
you want to check for
any trace segment that
is not connected to
another trace segment,
pin, via on either end.

17

Single Connection

Select this check box if
you want to check for a
net connected to only
one pin.

NOTE: Power and
ground nets are the
exception.

18

Short Circuit

Select this check box if
you want to check for
intersections (on the
same layer) of traces
that belong to different
nets.

NOTE: Trace entities will
be divided into n sets
where n is the number of
nets in the design.

19

Unconnected Pin

Select this check box if
you want to check for
any pin (pad) that is not
graphically intersected
with any traces on the
same physical layer.

Verifying a Design

The following steps describe how to verify a design.

TASK

1. From the Analysis menu, select Verify Design.

STEP RESULT: The Verify Design dialog appears.

2. Toenable a design rule, select the associated check box in the Design Rules

section of the dialog.
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10.

To disable a design rule, deselect the check box.

ADDITIONAL INFORMATION: You can sort the design rules by clicking the column headings for
Enabled, Description, or Value.

To add a value to the selected design rule, double-click the corresponding row of
the Value column and enter a value.

ADDITIONAL INFORMATION: The selected design rule must be enabled to be able to add a
value.

In the Maximum Violations field, enter the maximum number of results you want
to display in the Results list.

From the Distance Units list, select the unit you want to use as the unit of measure.

Click Verify.

ADDITIONAL INFORMATION: The Verify button changes to Stop. To stop the Design Verification
process at any point, click Stop.

When the process is complete, the total number of errors found during the Design Verifi-
cation process, up to the maximum number specified in the Maximum Violations field
appear in the Results list.

To view the description of a violation result, select the violation from the Results
list.

STEP RESULT: The description appears in the Description field. The description includes
information such as the type of violation, the location where it occurs (x- and y-coordi-
nates), the component or entity it affects, and the actual value measured.

When you select a violation result, AutoVue zooms to the entity or set of entities that were
affected and highlights them on the drawing.

Continue to select violation results to view its description.
ADDITIONAL INFORMATION: Click Reset to restart a new check.

Click Close to close the Verify Design dialog.

Exporting the Design Verification Results

You can export the design verification results into a text file.

TASK
1.

2.

Verify the design.

In the Verify Design dialog, click Export.
STEP RESULT: The Export Results dialog appears.

Navigate and select the directory where you want to export the results.

Enter a file name.
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5. Click Save.

STEP RESULT: AutoVue saves the design verification results in a .txt (text) or a .csv (Comma
Separated Values) file listing each violation result and its description.

6. Click Close to close the Verify Design dialog.

Searching Using Entity Search

You can search for an entity in a schematic drawing or a PCB design using the Entity Search
option. To filter entities, apply attribute, or entity type filters as search criteria. You can
select entities from the results list to highlight them in the workspace and the Navigation
Panel. You can also export the search results to a .csv file.

NOTE: If the selected entity is small, a flash box appears indicating the location of the high-
lighted entity in the workspace.

To open the Entity Search dialog, from the Edit menu, select Entity Search. From the
AutoVue toolbar, you can also click Entity Search €. If your schematic has multiple
pages, a Defining Scope dialog appears.

Defining Scope g|

Scope
* Current Schematic Page

(" Entire Schematic Design

Zancel

Select Current Schematic Page to browse through only one page. Select Entire Schematic
Design to browse through all schematic pages.
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Click OK after making your selection. The Entity Search dialog appears.

Entity Search §|
Entity Types | Attributes
Attribute: | M arme -
Entity Types: | Met
Walue: v
MHame Pir List et Class .
$38 EC1BICI241..  Unclassed Attibute Value
sa] IC36IC128 Uneclaszed
36 IC3.21C1211 Unclassed
315 ICRZICI1.A01..  Unclassed
$24 IC11.41C84IC.. Unclassed
$25 EC1.10041.5 Uneclaszed
£33 F31R4204 . Unclassed
$40 EC1.90411 Uneclaszed
WPOS EC113C310... Unclassed
WNEG EC116C09.20... Unclassed
$44 EC111R320.. Unclassed
MET13 ICIT.1IC11.31..  Unclassed [ Export Result | [ Apply Fiels)
MNATAR Fraziri113 | Inrlazsed ¥
< >
Close l l Help l

Performing an Entity Type-based Search

The following steps describe how to perform an entity type-based search.

TASK

1. From the Edit menu, select Entity Search.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Entity Search dQ,
STEP RESULT: The Entity Search dialog appears.

2. Click the Entity Types tab.

3. From the Entity Types list, select an entity type.

ADDITIONAL INFORMATION: To sort the list by attribute, click the attribute column heading
that you want to sort by.

STEP REsuLT: A list of attributes for the selected entity type appear.
4. If you want to search by attribute, select an attribute from the Attribute list.
If you want to search by value, select a value from the Value list.

6. Click Add Filter.
STEP RESULT: The selected attribute and its corresponding value appear in the list.

7.  Repeat steps 4 and 5 until you have all the filters you want.
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8.  Click Apply Filter(s).

ADDITIONAL INFORMATION: To remove afilter, select the line in the list containing the attribute
and value you do not want to use as a filter, then click Remove Filter.

STEP REsuLT: A list of entities matching the search criteria appear showing the column
headers for the entity’s available attributes.

9. To save the results, click Export Result.
STEP RESULT: The Save dialog appears.

10. Specify the file name and the directory where you want to store the file, then click
Save.
STEP RESULT: AutoVue saves the results in a .csv (Comma Separated Values) file.

11. Toview the properties of an entity, select the entity from the Entity Types list or the
Attributes list, then right-click and select Show Entity Properties.

STEP RESULT: The Entities Properties dialog appears and displays the properties for the
selected entity.

12. To show the net connectivity, click the Attributes tab, select the entity from the
list, then right-click and select Show Net Connectivity.

STEP REsULT: The net connectivity for the selected entity is highlighted in the workspace.

13. Click Close to close the Entity Search dialog.

Performing an Attribute-based Search

The following steps describe how to perform an attribute-based search.

TASK

1. From the Edit menu, select Entity Search.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Entity Search .
STEP RESULT: The Entity Search dialog appears.

2.  Click the Attributes tab.

3.  From the Attributes list, select an attribute.

ADDITIONAL INFORMATION: To sort the list by Owner, Type, or Value, click the column heading
that you want to sort by.

STEP RESULT: The Owner, Type, and Value of the selected attribute appear in the list.
4.  If you want to search by owner, select an owner from the Owner Filter list.

If you want to search by value, select a value from the Value Filter list.

ADDITIONAL INFORMATION: You can also enter an Owner Filter or Value Filter in the text box.

3/1/11 95



WORKING WITH EDA FILES
MEASURING IN EDA FILES

6. Click Apply Filter(s).

ADDITIONAL INFORMATION: Select an item in the result list and right-click to access options like
Zoom Selected and Show Entity Properties.

STEP ResuLT: A list of entities matching the search criteria appear displaying the Owner,
Type, and Value columns.

7.  Tosave the results, click Export Result.
STEP RESULT: The Save As dialog appears.

8.  Specify the file name and the directory where you want to store the file, then click
Save.

ADDITIONAL INFORMATION: AutoVue saves the results in a .csv (Comma Separated Values) file.

9. Click Close to close the Entity Search dialog.

Measuring in EDA Files

In EDA files, you can take measurements of distances, areas, arcs, and angles. When
measuring, you have the option to “snap” to geometrical or electrical points on the drawing.

From the Analysis menu, select Measure to access the Measurement options.
NOTE: From the AutoVue toolbar, you can also click Measure .J'j

The following table outlines the available measuring options:

Name Description
Angle Measure the angle between selected points.
Arc Measure an arc entity.
Area Measure a selected area.
Distance Measure the distance between two points.
Minimum Distance Measure the minimum distance between two nets.
NOTE: This option is only available for PCB files.
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EDA Snapping Modes

The snapping modes allow you to click to precise geometrical or electrical points. For

example, when you select Snap to Pin, move the cursor over the pin you want to select until
the pin is highlighted, then click. Highlight and click a second pin to measure the distance
between them.

The snapping modes allow you to snap to the middle, center, and end-points of an entity,
as well as a pin, via, and symbol. The following table outlines the available snapping modes:

Button Snap To Description
h\@ End-point Geometric snap mode where a
snap box appears when moving
the cursor near the entity’s end
point.
Mid-point Geometric snap mode where a

snap box appears when moving
the cursor near the halfway point
of a linear entity.

(©)

Center-point

Geometric snap mode where a
snap box appears when moving
the cursor near the center of an
entity.

B Pin Electrical snap mode where a
snap box appears when the
cursor touches a pin.
Via Electrical snap mode where a
o
snap box appears when the
cursor touches a via.
s? Symbol origin Electrical snap mode where a
B snap box appears when the
cursor touches a component.
E Free snap Allows snapping at any point on
the drawing.
M Net Allows snapping to a net.
[Zi Trace Allows snapping to a trace.
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Measuring Distance

Use the Distance option to measure the distance between two specific points.

TASK
1.

From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure ,]:!
STEP RESULT: The Measurement dialog appears.

Click the Distance tab.

Select the snapping modes that you want to use for measuring.
. To select all snapping modes click All On.

. To deselect all snapping modes click All Off.

See “EDA Snapping Modes”
From the Measured Distance Units list, select the unit in which you want to
measure the distance.

ADDITIONAL INFORMATION: If you want to measure the distance along a path, select Cumula-
tive.

Click a point on the drawing to define the starting point.

Click another point on the drawing to define the end point.

ADDITIONAL INFORMATION: If you selected Cumulative, continue clicking points along the
path that you want to measure.

Right-click to complete the measurement.

ADDITIONAL INFORMATION: To make another measurement, click Reset.

STEP RESULT: The points are joined by a line. The measured distance, Delta-X, Delta-Y and
the “Manhattan Distance” appear in the Measurement dialog.

Click Close to close the Measurement dialog.

Calibrating Distance

Calibrate the distance measurement.

TASK
1.

2.

Measure distance between two points or measure cumulative distance.

From the Distance tab, click Calibrate.
STEP REsuLT: The Distance Calibration dialog appears displaying the measured distance

From the Units list, select the unit to which you want to calibrate the distance.

928
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4.  Select Calibrate to and enter a value if you want to calibrate the distance to a
value.

5.  Select Set Factor and enter a value if you want to calibrate the distance by a factor.
6. Click OK.

STEP RESULT: The calibration result appears in the Measurement dialog.

7. Click Close to close the Distance tab.

Measuring Minimum Distance

Use the Minimum Distance option to measure the minimum distance between two nets.

TASK

1. From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure ,]:!
STEP RESULT: The Measurement dialog appears.

2. Click the Min. Distance tab.

3. To measure the minimum distance between entities that are not on the same
physical layer, select Across Layers.

ADDITIONAL INFORMATION:  If a physical layer does not exist, this option determines whether
or not the minimum distance should be calculated across logical layers.

4.  Select First Set [=1 to select the entities that you want to measure from.

Select the snapping modes that you want to select as the entities for the measure-
ment.

ADDITIONAL INFORMATION: If you click Net m, you cannot select any other type of entity.
See “EDA Snapping Modes”

6. Click the first set of entities on the drawing.
ADDITIONAL INFORMATION: To clear the last set of entities you selected, click Clear Set.
STEP RESULT: The entities are highlighted.

7.  Select Second Set & to select the entities that you want to measure to.

8.  (lick the second set of entities on the drawing.

STEP RESULT: The entities are highlighted in a different color.

9.  From the Measured Min. Distance Units list, select the unit in which you want to
measure the distance.

10. Select Zoom to Result, if you want to zoom into the measurement on the drawing.
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11.

12.

Click Compute.

ADDITIONAL INFORMATION: AutoVue does not measure the distance between layers (z-dimen-
sion).

STEP RESULT: The minimum distance from the first set of entities to the second set is repre-
sented by a line. The minimum measured distance, Delta X, Delta Y, and the Manhattan
Distance appear in the Measure Min Distance section of the dialog.

Click Close to close the Measurement dialog.

Measuring Area

Use the Area option to measure the area and perimeter of a region.

TAsK
1.

10.
11.

From the Analysis menu, select Measure.

ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure .]:!

STEP RESULT: The Measurement dialog appears.
Click the Area tab.

Select Between Points if you want to measure the area between points on a
drawing. The snapping modes are displayed.

Select the snapping modes that you want to use for measuring.

Select Shape if you want to measure the area of a predefined shape on the
drawing; the snapping modes are disabled.

From the Measured Area Units list, select the unit in which you want to measure
the area.

From the Perimeter Units list, select the unit in which you want to measure the
perimeter.

In the Net Area Result section of the dialog, select Add to cumulate a net area
result of different areas.

To subtract an area from the Net Area Result, select Subtract.
Select Clear to clear the Net Area Result.

If you selected Between Points, click points on the drawing to define the area.

STEP RESULT: Each point is joined by a line. The area and perimeter measurements appear
in the Measurement dialog.
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12. If you selected Shape, click the edge of the predefined shape that you want to
measure.

ADDITIONAL INFORMATION: Click Reset to take another measurement.

STEP RESULT: The shape is highlighted. The area and perimeter measurements appear in
the Measurement dialog.

13. Click Close to close the Measurement dialog.

Measuring an Angle

Use the Angle option to measure the angle between points on a drawing.

TASK
1. From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure ,J‘j

STEP RESULT: The Measurement dialog appears.
2.  Click the Angle tab.

3. From the Angle Definition section, select one of the following:
. From 3 Points: Measure the angle between three points.

. Between 2 Lines: Measure the angle between two non-parallel lines.

4.  Select the snapping modes that you want to use for measuring.
. To select all snapping modes click All On.

. To deselect all snapping modes click All Off.
See “EDA Snapping Modes”

5.  Select Between 2 Lines if you want to measure the angle between two lines.

6. From the Measured Angle Units list, select the unit in which you want to measure
the angle.

7.  Ifyou selected From 3 Points, click three points to define the angle.

8. Ifyou selected Between 2 Lines, click two lines to define the angle.
ADDITIONAL INFORMATION: To take another measurement click Reset.

STEP RESULT: Angle arms appear with an arc connecting them. The angle measurement
appears in the Measurement dialog.

9. C(lick Close to close the Measurement dialog.
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Measuring an Arc

Use the Arc option to define or select an arc in the drawing and measure its arc length, start
and end of angle, sweep, radius, center and diameter.

TAsK

1. From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure .]'j
STEP RESULT: The Measurement dialog appears.

2.  Click the Arc tab.

3. Select From 3 Points if you want to measure the arc between three points. Snap-
ping modes are displayed.

4.  Select the snapping modes that you want to use for measuring.
. To select all snapping modes click All On.

. To deselect all snapping modes click All Off.
See “EDA Snapping Modes”

5. Select Arc Entity if you want to measure a predefined arc.

6. Fromthe ArcInformation section, select the unitin which you want to measure the
distance of the arc.

7.  From the Measured Angle Units list, select the unit in which you want to measure
the angle.
8. Ifyou selected From 3 Points, click three points to define the arc.

STEP RESULT: The points are joined by an arc. The measurements for center point coordi-
nates, radius, diameter, arc length, start and end of angle and sweep appear in the
Measurement dialog.

9. Ifyou selected Arc Entity, click the edge of the arc that you want to measure.

ADDITIONAL INFORMATION: To take another measurement click Reset.

STEPRESULT: The arcis highlighted. The measurements for center point coordinates, radius,
diameter, arc length, start and end of angle and sweep appear in the Measurement dialog.

10. Click Close to close the Measurement dialog.

Calibrating an Arc

TASK
1. Measure an arc in the drawing.

2.  From the Arc tab, click Calibrate.
STEP RESULT: The Radius Calibration dialog appears displaying the measured distance.
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3. Fromthe Units list, select a unit of measurement to which you want to calibrate the
distance.

4.  Click Calibrate to and enter a value if you want to calibrate to a value.
Click Set Factor and enter a value if you want to calibrate by a factor.

6. Click OK.
STEP RESULT: The calibration results appear in the Arc tab.

7.  Click Close to close the Measurement dialog.
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Working with 3D Files

From AutoVue’s 3D mode, you have many ways in which to manipulate the model. For
example, you can select model parts to transform independently from the rest of the model,
as well as modify the selected model part’s visibility and attributes. 3D mode also gives you
the ability to perform an entity search and compute mass properties, and it allows you to
import 3D models into the current window and export files to other formats. Additionally,
the Global Axes inform you of where the X, Y and Z axes are positioned throughout all the
operations you perform in AutoVue.

The Perspective option shows objects in three dimension with distances, planes and curved
surfaces adjusted to give a sense of depth. You have lighting options where you can adjust
the overall lighting surrounding a model or just its source light.

You can also customize operations to suit your needs. For example, you can create and save
your own views. Define cross sections and cut-throughs of 3D models. Create a customized

three-axis coordinate system that you can set as the active coordinate system for your 3D
files.

There are also features like Bill of Material (BOM), Interference Checking and Product and
Manufacturing Information (PMI) Filtering.

Models Tab and Model Tree

The Models tab displays the Model Tree. The tree displays the model’s hierarchy, inter-rela-
tion of different parts, assemblies, and bodies. The tree also indicates if a required external
reference (XRef) is missing. With the tree, you can select different parts and modify their
attributes such as color, visibility, render mode or transformation.

See “Displaying XRefs”for more information on XRefs.
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NOTE: The Models tab displays only for 3D drawings.
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Views Tab

The Views tab lists the standard, native, and user-defined views. You can switch to a stan-

dard, native, or user-defined view, as well as add or delete user-defined views.

NOTE: The Views tab displays only for 3D drawings.
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Bookmarks Tab

The Bookmarks tab lists links to specific views (Draft views, 2D plans, 3D Views of an EDA
design) or pages or bookmarks structure that is saved in files such as PDF.

Bookmarks

“Boson

L 18 30 Madel

Components | Mets | Bookmarks

Navigate between the pages or files or views by clicking the appropriate link. Bookmarks
lead to various views of CAD files such as AutoCAD file Model Space, the 3D model of a
file and associated 2D engineering drafts.

If a plus sign appears to the left of a bookmark, click it to expand and view the lower book-
mark levels. If a minus sign appears to the left of the bookmark, click it to collapse the lower
bookmark levels.

To go to a destination specified by a bookmark, click the bookmark text or the page icon
located to the left of the bookmark text.

Global Axes

By default, there is a three-axis representation in the lower left corner of the workspace. The
X-axis is red, the Y-axis is green and the Z-axis is blue. When transforming a model or
defining a viewpoint, all operations are applied with respect to these axes.
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Selecting Model Parts

You can select model parts from the Model Tree or from the workspace to highlight them
in the Model Tree and on the model. You can also select a model part and have all its iden-
tical parts appear highlighted on the model and in the Model Tree.

You can also configure the Selection Highlight.

Select Model Parts from the Workspace

TASK
1. Select a part or parts on the model in the workspace.

ADDITIONAL INFORMATION: To select more than one model part, press the Shift or Control key
while selecting.

2.  Toselect the parent entities of a selected part, press the Shift key and select the
part again.
STEP RESULT: A pop-up appears listing the parent entities of the selected part. Select an

entity from the pop-up list. The selected part or parts appear highlighted on the model
and in the Model Tree.

3. Toselect a group of parts, from the Edit menu, select Select, then click and drag
the mouse around the parts.

REesuLT: The entities within the box are selected and highlighted in the Model Tree. If the
selected entity is hidden in the Model Tree, the Model Tree expands to display the selected
entity.

Selecting All Identical Parts of a Model

Select a model part in the workspace or from the Model Tree.
Right-click and select Select Identical Parts.

All identical parts are highlighted on the model and in the Model Tree. If there are no iden-
tical parts found, a message appears indicating “No identical parts found”. You can also
select sub-assemblies and Select Identical Parts to display all identical sub-assemblies.
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Re-Centering

The Re-center option repositions the model back to the center of the View window. You can
use a model part as a central reference point to reposition a model. You can select several
model parts to use as one collective central reference point.

Re-Centering a Model to a Selected Model Part

TASK
1. Select the model part or parts that you want to re-center.

2. From the View menu, select Re-Center, and then select Selected.

ResuLT: The model is repositioned using the selected model part or parts as the central
reference point. The Selected option is only available when one or more model parts are
selected.

Re-Center All

The Re-Center All option repositions the entire model back to the center of the AutoVue
workspace.

TASK
1.  From the View menu, select Re-Center, and then select All.
STEP RESULT: The model is repositioned to the center of the workspace.

Entity Reference

You can use an entity as a central reference point to reposition a model. The entities are as

follows:
Entity Description
Vertex All vertices are highlighted. Select a vertex to use as the central reference point.
A snap box appears when moving the mouse over a vertex.
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Entity Description

Edge All edges are highlighted. Select an edge to use as the central reference point.
A snap box appears when moving the mouse over an edge.

Midedge Highlight all edges in the model. Select a mid-edge to use as the central reference point.

Arc Center Highlight all arcs and ellipses in the model. Select an arc center to use as the central
reference point.

A snap box appears when moving the mouse over an arc or ellipses, indicating the
center of the arc.

Face Select a face to use as the central reference point.
When moving the cursor along a model face, the face is highlighted.

Re-Centering a Model to an Entity

To re-center a model to an entity, perform the following:

TASK

1. From the View menu, select Re-Center, and then select Entity.
STEP RESULT: The Re-Center dialog appears.

2. Select the entity that you want to use as the central reference point.
STEP ResuLT: All instances of the entity are highlighted.

3. (lickaninstance of the entity.

STEP RESULT: The model is repositioned using the selected entity as the central reference
point.

4.  Close the Re-Center dialog.

Model Tree

The Model Tree displays the model’s hierarchy, inter-relation of different parts, assemblies,
bodies, and missing XRef notifications. With the tree, you can select different parts and
modify their attributes such as color, visibility, render mode or transformation.
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Expanding/Collapsing the Model Tree

You can expand the Model Tree to display child entities of a selected node or nodes.

You can also configure the level you want to expand the Model Tree.

TASK
1.

2.

Click the Models tab.
From the Model Tree, select the node or nodes that you want to expand, then
right-click and select Expand All Children.

ADDITIONAL INFORMATION: To select more than one node, press the Shift or Control key
while selecting.

STEP RESULT: The selected entities are highlighted. The Model Tree expands displaying the
child entities of the selected nodes.

To collapse a node, select the node, then right-click and select Collapse All Chil-
dren.

STEP RESULT: The Model Tree collapses the selected node.

ResuLT: The Model Tree collapses the selected node. You can also expand a node by clicking
+/. To collapse a node click =.

Viewing Missing XRef Notification Icon

If the loaded drawing is missing XRefs, the Missing XRef Notification icon & appears in
the Model Tree to the left of the missing XRef. To view XRefs are missing, do the following:

See Also “Displaying Details About Resources”

TASK
1.

From the status bar, click the Missing Resource icon X.

STEP RESULT: The Properties dialog appears. You can also view the missing XRef from the
File menu, and then selecting Properties.

Click the Resource Information tab.

STEP RESULT: Any missing XRefs appear in the External Reference File Reference File
Resources section of the dialog and are preceded by a .

Click OK to close the dialog.
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Selecting Model Parts from the Model Tree

TASK
1.  Click the Models tab.

2.  Select the part or parts from the Model tree.

ADDITIONAL INFORMATION: To select more than one model part, press the Shift or Control key
while selecting.

ResuLT: The selected part or parts appear highlighted on the model and in the Model Tree.

Hiding Model Parts

You can hide specific parts of a model or display specific parts and hide the rest of the
model.

TASK
1. Select the part or parts on the model or from the Model Tree.

ADDITIONAL INFORMATION: To select more than one model part, press the Shift or Control key
while selecting.

STEP RESULT: The selected part or parts appear highlighted on the model and in the Model
Tree.

2. To hide the selected part or parts, right-click a selected part on the model or from
the Model Tree and select Hide.

STEP RESULT: The selected part or parts are hidden on the model.

3. Todisplay the selected part or parts and hide the rest of the model, right-click a
selected part on the model or from the Model Tree and select Hide Rest.

STEP RESULT: The selected parts are displayed in the workspace and the rest of the model is
hidden.

Creating 3D Mockups

You can import other 3D Models into the current active file.
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The imported files must be 3D and have similar dimensions.

TAsK

1. From the File menu, select Import File for Mockup.
STEP RESULT: The Mockup dialog box appears.

2. (lick Add.
STEP RESULT: The Open dialog box appears.

Enter the file name or browse to locate the file you want to import.

4. Click Open.
STEP REsULT: The file appears in the Mockup dialog box. To import more than one file,
repeat steps 2 to 4.

5.  Click OK.

RESULT:

The file or files you imported appear in the workspace. Once open, you can position these
models in the desired manner using the Transformation tool, or align the models using Part
Alignment, or run Interference Checks.

See Also “Transformation”
> UNDEFINED CROSS-REF FORMAT [SeeAlsoList] ***
0t UNDEFINED CROSS-REF FORMAT [SeeAlsoList] ***

Deleting Models from a Mockup

The following steps explain how to delete models from a mockup.

TASK

1. From the File menu, select Import File for Mockup.
STEP RESULT: The Mockup dialog appears.

2. Select the file or files that you want to remove.

3.  Click Remove.

STEP RESULT: The file or files are removed from the list.

4.  Click OK to close the Mockup dialog.

ResuLT: The file or files disappear from the workspace.

3/1/11

113



WORKING WITH 3D FILES
CONVERTING 3D MODELS TO OTHER FORMATS

Converting 3D Models to Other Formats

Sometimes you need to translate a 3D model to be able to use it with an application it was
not created from. AutoVue provides several conversion file formats for you.

Conversion Options

Depending on the conversion type being performed, the available options in the Convert
dialog box will vary. These options are:

Option

Description

Save As

Specify the name and path of the file in which the conversion is to be
stored. This file is also known as the output file. You can use Browse
to provide AutoVue with the file’s path.

Convert to Format

A list of all the possible types of output file formats currently available
for conversion. The available formats are:
CALS GP4

Encapsulated Postscript (Raster)

HP Laserjet Printer (PCL)

Run Length RLC File

PCX Bitmap

PDF

Stereolithography (STL)

TIFF

Virtual Reality Modeling Language (VRML)
Windows Bitmap

Sub-Format

The Sub-Format list appears when you select TIFF or STL from the
Convert to Format list.
Select the Sub-Format from the list.

Color Depth

Select an option from the list:

1 = Black and white

4 =16 colors

8 =256 colors

24 = True color

auto = AutoVue selects the color depth that best matches the original
file.

Option is not available for STL and VRML formats.

Positive Triangle Values

When selected, the model is translated so that all the vertex
coordinate values are positive.
Option is only available when Convert to Format is set to STL.
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Option

Description

Convert Region

The area of the file to be converted. The available options are:

All - converts the entire file

Display - converts the image to fit on the output page For example, if
you zoomed in on a particular region of the file, the zoomed portion
of the file is converted.

Extent - converts the entire extents of the file

Selected - converts the selected model parts in the file

Options vary depending on the selected format.

Convert Pages

The number of pages to be converted. The available options are:
All - converts all pages of the file

Current - converts the current page of the file

Range - converts the pages of the file indicated in the range
Option is only enabled when converting to TIFF.

XandY Specify X and Y to define the resolution for the converted file.
X indicates the number of horizontal pixels
Y is the number of vertical pixels for the current active file contents
At times, AutoVue presets X and Y to match the specifications of the
selected conversion file format.
Converting a 3D Model
TASK
1. From the File menu, select Convert.

STEP RESULT: The Convert dialog appears.

2. Inthe Save As field, enter the path and filename or click Browse to locate the
directory where you want to convert the file to, then enter a file name.

3. From the Convert to Format list, select the format you want to convert the file to.
ADDITIONAL INFORMATION: The Output and Convert area options change according to the
type of format you choose.

4.  Select the output and convert options that you want to set for the file.

Click OK.

RESULT:

The Conversion in Progress dialog appears. The dialog disappears when the file is

converted successfully.
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Manipulating Display of a 3D Model

AutoVue provides the flexibility to manipulate the display of a 3D model. You can rotate,
scale, or translate a model or any selection of model parts. You can also navigate from one
page to another page of a multi-page file.

You can access these options from the View menu. The options are:

Menu

Sub-Menu

Description

Zoom

Zoom In

Zoom in by a factor of 2.

From the Autovue toolbar, you can also click @

Zoom Out

Zoom out by a factor of 2.

From the Autovue toolbar, you can also click Q .

Previous

Return to the previous zoom level.

&
From the Autovue toolbar, you can also click Q or
right-click in workspace and then select from the menu.

Selected

Resize the object so that the objects selected fill the window.

Dynamic Zoom

Click and drag the cursor up to zoom in or down to zoom
out.

From the Autovue toolbar, you can also click (2"

Zoom Box

Click and drag to draw a box around an object that you
want to enlarge to fill the window.

From the Autovue toolbar, you can also click 4 or
right-click in workspace and then select from the menu.

Zoom Fit

Resize object to fit window.

From the Autovue toolbar, you can also click Il or
right-click in workspace and then select from the menu.

Pan

Click and drag to reposition the model, then release the
mouse button.

L
From the Autovue toolbar, you can also click 7 or
right-click in the workspace and then select from the menu.

Rotate

Click and drag to rotate the model on all three axes, then
release the mouse button.

From the Autovue toolbar, you can also click C::f or
right-click in workspace and then select from the menu.
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Menu

Sub-Menu

Description

Spin

Click and drag the object in the direction you want the
object to spin continuously, then release mouse button. To
stop the object from spinning, click once anywhere in the
workspace.

The spin velocity is determined by the speed at which you
drag the mouse.

”
From the Autovue toolbar, you can also click &§.

Re-Center

All

Reposition the entire model back to the center of the
AutoVue workspace.
See “Re-Centering”

Selected

Only available when one or more model parts are selected.
The selected part or parts are considered as the central
reference point by which the model is repositioned.

See “Re-Centering”

Entity

Select a model part or entity as a central reference point to
reposition a model.
See “Re-Centering”

Default View

Displays view of the model when it is initially loaded.
You can also right-click in the workspace and then select
from the menu.

See “3D Views”

Camera Views

Displays different views of 3D models: Isometric, Top,
Bottom, Front, Back, Left, Right, and View Points.

You can also right-click in the workspace and then select
from the menu.

See “3D Views”

Views

Access native views of the model or access and create your
own views.

You can also right-click in the workspace and then select
from the menu.

See “3D Views”

Page

Next Page

Go to the next page of a multi-page file.
From the Autovue toolbar, you can also click I:El

Previous Page

Go to the previous page of a multi-page file.

From the Autovue toolbar, you can also click El:l

Page Number

Go to the specified page of a multi-page file.

From the Autovue toolbar, you can also click I:El
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Display Attributes

AutoVue provides several different render methods to display a 3D CAD model. You can
also adjust the degree of transparency, change color, or visibility to suit your preferences.

Render Modes

The choice of render mode varies between the level of detail and the render speed of the
model. For example, a shaded model is three-dimensional and highly detailed but requires
more time to render. The different render modes are as follows:

Method

Description

Wireframe

A skeletal model constructed using lines and curves that represent the model's
“true” edges. All internal lines are visible.

Shaded

A solid model constructed of planes and surfaces. These surfaces are shaded to
increase the illusion of three dimensions.

Hidden Line

A wireframe constructed with all internal lines hidden.

Silhouette

A wireframe constructed with all internal lines visible but including additional
silhouette edges. These are not "true” edges but help to visualize the model.

Wire Polygons

A skeletal model constructed of unfilled polygons.

Shaded Wire

An outlined solid model constructed of planes and surfaces. The outline is a solid
line and the model's surfaces are shaded to increase the illusion of three
dimensions.

Reflective

A solid model constructed of planes and surfaces. These surfaces are have a
reflective sheer to accentuate the model’s shadows.

Reflective Wire

An outlined solid model constructed of planes and surfaces. The outline is a solid
line and the model's surfaces have a reflective sheer to the model’s shadows.
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Changing the Render Mode

To change the render mode of the selected model or model parts, perform the following:

TASK

1. From the Manipulate menu, select Visual Effects, and then select Rendering.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Render Mode ).
STEP RESULT: Render mode options are listed.

2.  Select a render mode from the list.
STEP RESULT: The selected render mode is highlighted.

ResuLT: The model or selected model parts change to the selected render mode.

Changing the Visibility

You can choose to show or hide selected parts; this can be done from either the Model Tree
or the workspace.

From the Model Tree, deselect the check box beside the model part or parts that you want
to hide.

Conversely, select the check box beside the model parts that you want to set visible.

RESULT:
The selected model parts appear or disappear from the model.

NOTE: You can also hide model parts by selecting them on the model or from the Model Tree,
then right-clicking and selecting Hide. Selecting Hide Rest displays the selected model parts
and hides the rest of the model.

Changing Model Color

You can change the color of a specific model part or selected model parts.

TAsK
1. Select the model or model parts whose color you want to change.
ADDITIONAL INFORMATION: If no part is selected, the change is applied to the entire model.
2. From the Manipulate menu, select Visual Effects, and then select Color.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Color ~.
STEP RESULT: The Color dialog appears.
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Adjusting

Changing

3. Select the desired color.
4.  Click Apply.

RESULT: The selected part or parts change to the selected color.

NOTE: To set the model color to its default color, repeat steps 1 to 2 and click Reset in the Color
dialog.

the Transparency

You can adjust the degree of transparency of a model. This function only applies to shaded
and shaded wire models.

TAsSK

1. Select the model or model parts whose transparency you want to adjust.

2.  Fromthe Manipulate menu, select Visual Effects, and then select Transparency.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Transparency (.
STEP RESULT: The Set Transparency dialog appears.

To adjust the transparency, move the slider left or right.

4.  Select Apply Dynamically if you want the transparency to simultaneously change
with the movement of the slider.

ADDITIONAL INFORMATION:  Alternatively, to adjust the transparency level, you can enterin the
Value field a value from 0 to 1. Where 0 renders the model opaque (default state) and 1
renders it transparent.

5.  Click Close to apply the changes and close the Set Transparency dialog.

the Mesh Resolution

TASK
1. Select the parts that you want to change the mesh resolution.

2. From the Manipulate menu, select Visual Effects, and then select Mesh Resolu-
tion. You then have the option to select High, Medium, or Low.

RESULT:

NOTE: Changing the mesh resolution will not affect the default Mesh Resolution set in the
Configuration dialog box.
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Light Settings

The default light setting consists of a white light at the 10 o’clock position with respect to
the model. In the Lighting dialog, it appears as a grey ball of white light at the 10 o’clock
position along the circumference of the larger sphere.

Ambient lighting is the overall lighting that surrounds an object. It provides constant illu-
mination to every surface of the model. This type of lighting is particularly effective as a
fill-light for surfaces not directly illuminated by a directional light source. You can set the
intensity or source position; too high a setting tends to saturate the image and reduce its
clarity.

Using the Directional lighting option, you can adjust the position of the light source on an
object.

You can make the following modifications via the Lighting dialog:
. Set the intensity and source position of the ambient light.

. Set the direction of light.

. Add and remove a light source.

. Change light color, brightness, and specularity.

Setting Ambient Lighting

TASK
1. From the Manipulate menu, select Visual Effects, and then select Lighting.
STEP REsULT: The Lighting dialog appears.

2.  (lick and drag the Ambient Light sliding bar until you achieve the desired
lighting.

STEPRESULT: The lighting automatically changes with the movement of the sliding bar. The
Custom option is selected when you modify the ambient light.

To set the ambient lighting to its default setting, select Default.
4.  Click Close to close the Lighting dialog.
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Setting Directional Lighting

Setting the directional lighting adjusts the position of the light source on the model. You
can also add a new light source.

TASK
1.

From the Manipulate menu, select Visual Effects, and then select Lighting.
STEP RESULT: The Lighting dialog appears.

To change the direction of the light, click and drag the small ball until you achieve
the desired lighting.

ADDITIONAL INFORMATION: You can also drag the white ball outside of the large ball.

STEP REsULT: The direction of the light reflected on the 3D model automatically changes
with the movement of the white ball. The Custom option is selected when you adjust the
position of the light.

To set the light direction to its default setting, select Default.
Click Close to close the Lighting dialog.

Adding a New Light Source

TASK

1.

From the Manipulate menu, select Visual Effects, and then select Lighting.
STEP RESULT: The Lighting dialog appears.

2. Select the Two lights option.
STEP RESULT: A new light source appears as a black ball in the 5 o’clock position.

3. Toadd more light sources, right-click inside the square surrounding the ball and
select Create New Light Source from the pop-up menu.
STEP RESULT: The Custom option is selected and the new light source appears as a white
ball.

4.  Click and drag the small ball until you achieve the desired lighting.
To restore the light source to its default setting, select Default.

6. Click Close to close the Lighting dialog.

RESULT:

NOTE: You can have a total of eight light sources at a time.
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Changing the Light Properties

TASK
1.

From the Manipulate menu, select Visual Effects, and then select Lighting.
STEP RESULT: The Lighting dialog appears.

To change the properties of the light, such as color or brightness, right-click
directly on the small ball and select Light Properties.

STEP RESULT: The Light Property dialog appears.

Select a color from the Color menu.

ADDITIONAL INFORMATION: You can drag the Brightness and Specularity slide bars to modify
the brightness of the source and the brightness of the model’s reflection to light, respec-
tively.

Click OK.

ADDITIONAL INFORMATION: To set the light properties to its default setting, select Default.
STEP RESULT: The light properties modifications are applied.

Click Close to close the Lighting dialog.

Removing a Light Source

TASK
1.

From the Manipulate menu, select Visual Effects, and then select Lighting.
STEP RESULT: The Lighting dialog appears.

Right-click directly on the small ball that you want to remove and select Remove
Light.

STEP REsuLT: The small ball disappears and the light change is reflected.
You can also select Default to restore the lighting properties to its default setting.

Click Close to close the Lighting dialog.
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3D Views

You can display different views of 3D Models or create your own views. The following
sections provide information on the default view of the model, the available camera views,
native views, and user-defined views.

Default View

The Default View is the view of the model when it is initially loaded; usually it is the view
in which the model was saved. In cases where there is no saved view, AutoVue loads the
isometric view of the model.

To return to the default view of a 3D model, from the View menu, select Default View.

Setting Standard or Camera Views

Rather than entering Rotation mode, you can view various predefined rotations with the
Camera Views option from View and Markup modes.

To do so, from the View menu, select Camera Views, and then select the pre-defined view
you want to display.

The view options are Isometric, Top, Bottom, Front, Back, Left, and Right.

The model changes to the selected view. You can also click the Views tab, then click the
view from the Standard Views tree, or right-click in the workspace and select Camera
Views.

Setting Native Views

AutoVue displays views for a 3D file as saved in its native application. Native views are
present only if the file contains saved views.

From the View menu, select Views, and then select Native Views.

The model re-orients to the selected view. The view options vary depending on the file.
Examples of the view options are Last Saved View, Presentation, Front, Back, Left, Right,
Top, Bottom, Isometric, Trimetric, and Dimetric. You can also click the Views tab, and
then click the view from the Native Views tree, or right-click in the workspace and select
Views, and then select Native Views.
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Creating a User-Defined View

You may want to create and save your own views. AutoVue allows you to define a view and
add it to the User Defined Views. You can define a customized view in View or Markup
mode. Any views you apply to displayed models during Markup mode are saved as part of
the Markup file.

TASK
1. Apply your own views or transformation to the displayed model.

ADDITIONAL INFORMATION: The view states that you can apply and save for your defined view
are Extents, Rotation, Model Transformation, Explosion, Render Modes, Color, Transpar-
ency, Visibility, Sectioning, Camera Settings and views involving Mockups.

2.  From the View menu, select Views, select User Defined Views, and then select
Add View.

ADDITIONAL INFORMATION: You can also right-click in the workspace and select Views, then
select User Defined Views, and then select Add View.

STEP RESULT: The Add User Defined View dialog appears.
Enter a view name for the view that you want to define.
4.  Click OK to close the Add User Defined View dialog.

RESULT:

To see the view you defined, click the Views tab and select it from the User Defined Views
tree or select Views, select User Defined Views.

NOTE: You can also alternate between User Defined Views and Standard Views without
affecting your personalized views.

Deleting a User-Defined View

TASK

1. Under the User Defined Views tree, select the view that you want to delete, then
right-click and select Delete.

STEP RESULT: A confirmation prompt appears.
2. Click Yes.

REsuLT: The view disappears from the tree.
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Displaying the Perspective Projection of a 3D Model

The Perspective option shows objects in three dimensions with distances, planes and
curved surfaces adjusted to give a sense of depth that reflects the desired perspective to the

eye.

NOTE: You can use the Perspective option in any of the 3D Views since it is a projection mode
rather than a view point.

From the Manipulate menu, select Visual Effects, and then select Perspective.

The depth of the model changes.

Viewing a Model from a Particular View Point

To view a model from a particular point, you can specify a view point.

TASK
1.  From the View menu, select Camera Views, and then select View Points.

ADDITIONAL INFORMATION: You can also right-click in the workspace and select Camera
Views, and then select View Points.

STEP RESULT: The View Point dialog appears.

2.  Enter the coordinates for X, Y and Z:

a In the Camera Position fields, enter the coordinates to determine the position of the
camera lens.
b In the Target Position fields, enter the coordinates to determine the position of the

3D model viewed through the camera lens.

C In the Up Direction fields, change the coordinates to values between 0 and 1 to
determine the upward orientation.

3.  Click OK to close the View Point dialog.

RESULT: The entity moves to the defined view point. The Global axes and the User Coordi-
nates System change position to reflect the view point.
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Configuring Layers

Use this option to configure which layers to display from the current active file.

TAsK
1. From the Manipulate menu, select Visibility Control, and then select Layers.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Layers &.

STEP RESULT: The Select the Layers to Display dialog appears and lists the layers and layer
visibility for the current active file.

2. Tosortthe list of layers in the dialog, click the Name column header to sort alpha-
betically or numerically, or click the Status column header to group by visibility.

Select the check box beside the layers that you want to display.
4. Deselect the check box beside the layers that you want to hide.
Click OK to close the Select the Layers to Display dialog.

REesuLT: The selected layers are displayed.

Entity Properties

You can view properties such as visibility, color, transparency, mass properties, and extents
of a model or model parts.

General Attributes

The Attributes tab displays a model or model part’s attributes. The list of attributes varies
depending on the model. Some of the viewable General attributes are as follows:

Attribute Description
Color Color of the selected model part.
Density The density of the model or selected model parts.
Name The model part name or the displayed page name of the model.
Render Mode The dynamic rendering used for displaying model or model part. For

example, Shaded, Shaded Wire and Wireframe.
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Attribute Description
Transparency The value between 0 and 1 representing the model or model part’s degree of
transparency.
0 = opaque

1 = transparent

Visibility The value True (visible) or False (invisible) for a model or model part.

If you are displaying the 3D view of an EDA design, AutoVue displays the general attributes
mentioned above. In addition, AutoVue displays attributes specific to the Printed Circuit
Board (PCB), such as component name, board side, component class and device type.

If a 3D file has Product and Manufacturing Information (PMI) and a PMI entity is selected,
the PMI attributes are displayed along with the above general attributes. Some of the view-
able PMI attributes are X-Axis, Y-Axis, font color, text font name, and tolerance type.

Viewing Attributes
TAsK
1. Toview the attributes of specific model parts, select the parts from the model.
2. Toview the attributes of the entire 3D model, make sure that no parts are selected.
3. From the Analysis menu, select Show Entity Properties.
ADDITIONAL INFORMATION: You can also right-click in the workspace and select Show Entity
Properties, orin the Model Tree, select the model part or parts, then right-click and select
Show Entity Properties.
STEP RESULT: The Entity Properties dialog appears.
4.  Click the Attributes tab.
STEP RESULT: The attributes of the selected model parts are displayed in a hierarchical tree.
5.  Click Close to close the Entity Properties dialog.

Viewing Mass Properties

The Mass Properties tab displays the precise measurements for mass, volume, area, center
of gravity, moments of inertia, and inertia tensor for any model or selection.

TASK
1.

Select the part or parts for which you want to calculate the mass properties. To
select multiple parts, press the Shift or Control key while selecting.
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2.  Toview the mass properties of the entire 3D model, make sure no parts are
selected.

ADDITIONAL INFORMATION: You can also make your selection after you open the Entity Prop-
erties dialog.

3. From the Analysis menu, select Show Entity Properties.

ADDITIONAL INFORMATION: You can also right-click in the workspace and select Show Entity
Properties, or in the Model Tree, select the model part or parts, then right-click and select
Show Entity Properties.

STEP RESULT: The Entity Properties dialog appears.
4.  Click the Mass Properties tab to view the properties of the selected mass.

STEP RESULT: When a mass property cannot be calculated, “N/A” displays in red for that
property. When this is the case, you can also click Error Report for a list of mass properties
that could not be calculated.

5. Tochange the density, change measurement units, or configure computation of
inertia tensor, click Options.

STEP RESULT: The Options dialog appears.
6. Click OK to close the Options dialog.
7.  Click Close to close the Entity Properties dialog.

Configuring Mass Properties

From the Mass Properties tab, you can change the density, the measurement units or
configure the reference point of inertia tensor.

TASK
1. From the Analysis menu, select Show Entity Properties.

ADDITIONAL INFORMATION: You can also right-click in the workspace and select Show Entity
Properties, or in the Model Tree, select the model part or parts, then right-click and select
Show Entity Properties.

STEP RESULT: The Entity Properties dialog appears.
2.  Click the Mass Properties tab.

3. Click Options.
STEP RESULT: The Options dialog appears.

4.  To change the density, enter a value in the Density field.

To change the density units, select the unit for Mass and Length from their respec-
tive lists in the Units section.

6. To apply the density to model parts with unknown density, select Use Only for
Parts with Unknown Density.
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10.

11.

12.

13.

14.

To apply the density to all model parts, select Use for All Parts.

To change the display units, select the unit for Mass and Length from their respec-
tive lists in the Display Units section.

To compute the inertia tensor based on output coordinate system, select Output
Coordinate System Origin.

To compute the inertia tensor based on the center of gravity, select Center of
Gravity.
Click OK to close the Options dialog.

STEP RESULT: Mass properties are instantly calculated and displayed in the Mass Properties
tab. When a mass property cannot be calculated, “N/A" displays for that property. When
this is the case, you can also click Error Report for a list of mass properties that could not
be calculated.

To save the changes, click Save As.
STEP RESULT: The Save Mass Properties As dialog appears.

Specify the path where you want to store the file and enter the file name, then click
Save.

STEP RESULT: AutoVue saves the results in a .txt file.

Click OK to close the Entity Properties dialog.

Viewing Extents

The Extents tab displays the orientation coordinates and center coordinates of the X, Y, and
Z axes, as well as the width, height, and depth measurements for any model or selection.

TASK

1.

Select the part or parts for which you want to view Extents. To select multiple parts,
press the Shift or Control key while selecting.
To view the Extents of the entire 3D model, make sure no parts are selected.

ADDITIONAL INFORMATION: You can also make your selection after you open the Entity Prop-
erties dialog.

From the Analysis menu, select Show Entity Properties.

ADDITIONAL INFORMATION: You can also right-click in the workspace and select Show Entity
Properties, or in the Model Tree, select the model part or parts, then right-click and
select Show Entity Properties.

STEP RESULT: The Show Entity Properties dialog appears.
Click the Extents tab.
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5.

6.

You have three extents options:

a Select Transformed if you want to view the extents after you have transformed the
model.

b Select UnTransformed if you want to view the extents of the model without trans-
formation.

C Select Oriented if you want to view the X, Y, and Z coordinates of the reoriented
model or selection.

Click Close to close the Entity Properties dialog.

PMI Entities

A 3D file's Product and Manufacturing Information (PMI) is composed of annotations that
are included in design files. These annotations indicate the limits and constraints that must
be observed during the production of the object displayed in the 3D model.

At the highest level, PMI provides information about dimensions, feature control frames,
weld specifications, and surface finishes. This information is based upon key design
features which are specified through datum targets, measurement points, reference geom-
etry (for example, construction lines, surfaces, and objects), or the geometry inherent in the
object.

The following terms can be used interchangeably with the term PMI:

Datums Cosmetics

Dimensioning Cosmetics

Geometric Tolerances (GTOLs)

Geometric Dimensioning and Tolerance (GDT or GD&T)
Functional Tolerance Annotation (FTA or FTA&A)
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PMI Filtering
Use PMI Filtering to select which types of product and manufacturing information to
display.
TASK

1. From the Manipulate menu, select Visibility Control, and then select PMI
Filtering.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click PMI Filtering .
STEP RESULT: The PMI Filtering dialog appears and displays all PMI types.

2. IntheTree column, select the check box beside the items that you want to display
in the Model Tree.

3. IntheView column, select the check box beside the items that you want to display
on the 3D model.

4. Deselect the check box beside the items that you want to hide.
ADDITIONAL INFORMATION: Click All to show all items, or click None to hide all items.

5.  Click OK to close the PMI Filtering dialog.

RESULT:

Only items selected in the Tree column are displayed in the Model Tree. Only items
selected in the View column are visible on the 3D model. Visibility settings are saved and
will be restored the next time you open the PMI filtering dialog.

NOTE: AutoVue supports default PMI visibility as saved in the file. To restore default PMI
visibility, click Default in the PMI Filtering dialog.

Aligning to a PMI Entity

From the Model Tree, right-click the PMI item that you want to align to and select Align
To. AutoVue aligns to the selected PMI item.

Go to a Displayed PMI Entity

From the Model Tree, right-click the PMI item that you want to go to on the model and
select Go To. AutoVue zooms to the selected PMI item.
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PMI Configuration Entities

The Views, Captures, Reference/Grouping entities refer to specific configurations of the
model. These PMI configuration entities are listed in the Model Tree and are activated by
right-clicking the entity and then selecting Activate.

Views

The View configuration entity displays predefined views, and highlights associated PMI
entities.

TASK
1. Expand the Views tree to display the defined views.

2.  Right-click the selected view, and then select Activate.

RESULT:

The model and PMI entities display in the workspace as defined in the selected view. The
PMI entities are also highlighted in the Model Tree.

Captures

The Captures configuration entity displays predefined views.

TASK
1. Expand the Captures tree to display the defined captures.

2.  Right-click the selected captures, and then select Activate.

ResuLT: The model and PMI entities display in the workspace as defined in the selected
capture.

Reference Frames

The Reference Frames configuration entity highlights the grouped PMI entities.

TASK
1. Expand the Reference Frames tree to display the predefined reference frames.

2. Right-click the selected reference frame, and then select Activate.

ResuLT: The grouped PMI entities are highlighted in the Model Tree.
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PMI Hyperlinks

PMI entities can also include hyperlinks. To fire a PMI hyperlink, do the following:

TASK
1.

2.

From the Model Tree or workspace, right-click the PMI hyperlink entity.

From the menu, select Follow Hyperlink.

STEP RESULT: The 3D Hyperlink dialog appears if there are multiple hyperlinks associated
with the selected PMI entity.

From the 3D Hyperlink dialog, select a link and then click Fire.

ResuLT: The selected link opens.

Manipulating a 3D Model

You can rotate 3D CAD models along a specific axis. You can scale a model part up and
down, as well as translate the model.

In Manipulate Mode, you can resize, translate, and/or rotate selected parts of the model.
When you select one or more model parts, AutoVue displays a model-size representation
of the Global Axes going through the selected part or parts of the 3D model.

Panning a Model Along the X, Y and Z-Axis

TASK
1.

From the Manipulate menu, select Manipulate.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Manipulate de.
STEP RESULT: You are now in Manipulate mode.

Select the model part or parts that you want to pan.

ADDITIONAL INFORMATION: To select more than one part, press the Shift or Control key while
selecting.

STEP RESULT: A model-size representation of the Global Axes appears through the model
part or parts and are encased by a three-dimensional box.

Click and hold the mouse button on the arrow at the end of the axis that you want
to pan.
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Drag the mouse to where you want to move the part or parts.

To exit Manipulate mode, click Manipulate 4%, or from the Manipulate menu,
select Manipulate.
ADDITIONAL INFORMATION: To restore the default state of a part of the model, from the

Manipulate menu, select Transform, and then select Reset Selected. To restore the
default state for the whole model, select Reset All.

Rotating a Model Along the X, Y and Z-Axis

TASK
1.

From the Manipulate menu, select Manipulate.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Manipulate de.
STEP RESULT: You are now in Manipulate mode.

Select the model part or parts that you want to rotate.
ADDITIONAL INFORMATION: To select more than one part, press the Shift or Control key when
selecting.

STEP RESULT: A model-size representation of the Global Axes appears through the model
part or parts and are enclosed by a three-dimensional box.

Click and hold the mouse button on the sphere at the end of the axis you want to
rotate.

ADDITIONAL INFORMATION: The initial mouse movement determines which of the two axes
will mark the site of rotation. If the axis you selected does not rotate around the right axis
for the rotation that you want to make, click the sphere again and move the mouse in a
different direction.

Clicking on an axis sphere allows rotation around one of the other two axes.

Move the mouse to rotate the model by the selected axis.

ADDITIONAL INFORMATION: If you want to rotate the selection freely, as done in Rotate Mode,
press the Control key during rotation.

To exit Manipulate mode, click Manipulate 4%, or from the Manipulate menu,
select Manipulate.
ADDITIONAL INFORMATION: To restore the default state of a part of the model, from the

Manipulate menu, select Transform, and then select Reset Selected. To restore the
default state for the whole model, select Reset All.
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Scaling a Model Along the X, Y and Z-Axis

TASK
1.

From the Manipulate menu, select Manipulate.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Manipulate .
STEP RESULT: You are now in Manipulate mode.

Select the model part or parts that you want to scale.

ADDITIONAL INFORMATION: To select more than one part, press the Shift or Control key while
selecting.

STEP RESULT: A model-size representation of the Global Axes appears through the model
part or parts and are encased by a three-dimensional box.

Click and drag a corner cube of the box up or down to scale the selected model
part.

To exit Manipulate mode, click Manipulate -4, or from the Manipulate menu,
select Manipulate.

RESULT:

To restore the default state of a part of the model, from the Manipulate menu, select Trans-
form, and then select Reset Selected. To restore the default state for the whole model, select
Reset All.

Part Alignment

With the Part Alignment option, you can select a point on a model’s vertex, edge, or face
to align to another model or model part.

The Mobile point determines the precise point of alignment for the model part. The Fixed
point on the model determines the precise fixed point to which the mobile part aligns.

When aligning models parts, you can select from one of the following Constraint Types:

Option Type Description

Constraint Coincident The Mobile part is positioned so that the selected point

on the mobile part coincides with the selected part on the
Fixed part.
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Option Type Description
Parallel Align the Mobile point so that it is parallel to the Fixed
point.
Perpendicular Align the Mobile point so that it is perpendicular to the
Fixed point.
Concentric Align the Mobile point so that it has the same center as

the Fixed point

Part Alignment Constraints

The table below lists the available Constraint Types for different combinations of part

alignment.
Point Line Arc Plane Sphere Cylinder Cone
Cone Coin Par Per Con Per Con Coin Par Con | Coin
Con Con Con
Par
Cylinder Con Par Con | ParCon | Per Coin Par Con
Con
Sphere Con Coin Con Coin Coin
Con Con
Plane Coin Per Coin Par | Coin Par
Arc Con Per Con Par Con
Line Coin Coin Par
Point Coin
NOTE: The letters in the table indicate the Constraint Type:
Where:
Coin- Coincident
Par- Parallel
Per- Perpendicular
Con- Concentric
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Aligning Model Parts

NOTE: To see a preview of the alignment before applying the change, select the Show Preview
check box.

TAsK
1. From the Manipulate menu, select Align Parts.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Align Parts |
Part Alignment P§|

Pleaze select the mobile partz to align

Constraint D efinition

Constraint Tope Alignment Tope
(%) Coincident (%) Aligned

() Parallel (7 dnti-dligned
(") Perpendicular

(") Concentric

Feomety

J M obile J Fixed
Tl E2@

Constraints

Constraints | Antitlia... |

Show Preview

[ Cloze ] [ Help ]

STEP RESULT: The Part Alignment dialog appears.
2. Select the Constraint Type that you want to perform.

3. Select the Alignment Type.
. Select Aligned if you want to align the Mobile point on the model part to the Fixed
point on the model

. Select Anti_Aligned if you want to align the Mobile point on the model part so that
it is opposite to the Fixed point on the model.

4.  Select a model part from the workspace. The Mobile arrow [& is enabled.
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5.  Click Vertex , Edge , orFace to select the type of geometrical point you
want to click on the model part to be aligned.

STep ResuLT: All instances of the selected geometrical point appear highlighted.

6. Click the geometrical point on the selected model part.

STEP RESULT: The geometrical point is highlighted and the Fixed arrow lmd is enabled.

7.  ClickVertex , Edge , orFace to select the type of geometrical point you
want to click on the model part to remain fixed.

8.  Click the geometrical point on the model.

9. Toview a preview of the alignment, select Show Preview.

STEP RESULT: The selected alignment appears in the workspace.

10. To apply the constraints, click Apply.

ADDITIONAL INFORMATION: To remove a constraint, select the Constraint that you want to
remove, then click Remove. To remove all part alignments, click Remove All.

STeEP RESULT: The model part is aligned according to the selected options. The Constraint
Type and the types of geometrical points aligned appear under Constraints section of the
dialog.

11. Click Close to close the Part Alignment dialog.

ADDITIONAL INFORMATION: A prompt will appear if you did not apply the changes before
clicking Close.

12. Torestore the default state of a part of the model, from the Manipulate menu,
select Transform, and then select Reset Selected. To restore the default state for
the whole model, select Reset All.

[
Transformation

With the Transformation option, you can rotate, scale, or translate a model or any selec-
tion of model parts, by using the illustrated buttons or by entering X, Y or Z values.

From the Manipulate menu, select Transform, and then select Define.

The Transformation dialog box appears.

NOTE: From the AutoVue toolbar, you can also select Transform ﬁ .

The buttons on the left correspond to the rotational moves along the three axes.
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o The buttons on the right correspond to the translational moves along the three axes
and the scaling up and down.

Transformation E'

Tranzformation
Fotate [Degres)

s
"

£

&

Ready

Tranzlation [mm. ]

b irrar Scale

vZ ]2 [y [ Factar
[] &bsalute

11

[ Rezet l [ Cloze ] [ Help ]

Transforming a Model Using Illustration Buttons

TAsK
1.

From the Manipulate menu, select Transform, and then select Define.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also select Transform &
STEP RESULT: The Transformation dialog box appears.

Select the model part or parts that you want to rotate, translate, or scale.

ADDITIONAL INFORMATION: To select more than one model part, press the Shift or Control key
while selecting. If no part is selected, transformation is applied to the entire model.

Use the rotate or translate buttons to transform the model.
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4. Toset the translate, rotate and scale increments, click Options. The Options
dialog box appears.

a Enter the Translate Increment value in inches.
b Enter the Rotate Incrementvaluein degrees.

C Enter the Scale Increment value, then click OK.

ADDITIONAL INFORMATION: When you click a rotation, translation or scale button, the model
transforms in increments of the values entered in the Options dialog box.

5.  Click Reset to set the model to its original transformation.
6. Click Close to close the Transformation dialog box.
STEP RESULT: The transformation state remains displayed.

7.  Torestore the default state of a part of the model, from the Manipulate menu,
select Transform, and then select Reset Selected. To restore the default state for
the whole model, select Reset All.

Resetting the Transformation of a 3D Model

You can reset a model or selected parts to their original transformation.

TASK
1.  View the transformed 3D Model.

2. Toreset the entire model to its original transformation, from the Manipulate
menu, select Transform, and then select Reset All.

3.  Toreset selected model parts to their original transformation, from the Manipu-
late menu, select Transform, and then select Reset Selected.

ADDITIONAL INFORMATION: You can also reset selected model parts. To do so, from the Model
Tree, deselect the check box beside the parts in the Transformation column .

STEP RESULT: The model or selected parts changes to their original transformation.

Transforming a Model by Setting Values

TAsK

1. From the Manipulate menu, select Transform, and then select Define.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also select Transform $% .
STEP RESULT: The Transformation dialog box appears.
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2. Select the model part or parts that you want to rotate, translate or scale.
ADDITIONAL INFORMATION: To select more than one model part, press the Shift or Control key
while selecting.

3. Torotate the model by set values, enter the X, Y and Z value.

4. Totranslate the model by set values, enter the X, Y and Z value.

5.  Toview a mirror image, in the Mirror section of the dialog box, select a check box.

6. To scale the model by a factor, in Factor field, enter a scale factor.

7.  Click Apply.

8.  To apply absolute transformation instead of incremental, select the Absolute
check box.

9. (lick Apply.

10. Torepeat a transformation, deselect Absolute, then continue clicking Apply.
ADDITIONAL INFORMATION: To set the model to its original transformation click Reset.

11. Click Close to close the Transformation dialog box.

RESULT:

The transformation state remains displayed.

NOTE: To restore the default state of a part of the model, from the Manipulate menu, select

Transform, and then select Reset Selected. To restore the default state for the whole model,

select Reset All.

Sectioning

With the Sectioning feature, you can view the cross-section and cut-through of 3D models.
In the Define Section dialog, you can define the section plane position, section plane orien-
tation, and the cut-through.

Section Plane Options

In the Define Section dialog, you can use the following options to define the orientation of
the section plane:
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Option Description
XY Plane Section plane is oriented along the XY plane.
YZ Plane Section plane is oriented along the YZ plane.
XZ Plane Section plane is oriented along the XZ plane.

From 3 Vertices

Select three vertices on the object to define the orientation of the
section plane.

From Face Normal

Select a face on the object to define the orientation of the section
plane perpendicular to the face.

From Edge Tangent

Select an edge on the object to define the orientation of the section
plane perpendicular to the edge’s tangent.

Define a Plane

Define X, Y and Z coordinates to orient the section plane.

Cut Options

In the Define Section dialog, you can use the following cut options to define the

cut-through of an object:

Option Description
Don’t Cut Display the object without a cut.
Cut Object displayed is cut along the section plane.
Invert Reverse the selection, display the other part of the object.
Show Both Restore the cut part of the object.
Edges Only Display only the edges of the object along the section plane.

Defining the Section Plane and Cut-through

TASK

1. From the Manipulate menu, select Section, and then select Define.

ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Sectioning ﬁ

STEP RESULT: The Define Section dialog appears.
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From the Section Plane list, select the orientation for the section plane.
From the Cut Options list, select the cut option that you want.

To define the plane position, click and drag the Plane Position slider to the posi-
tion you want.

Select Dynamic, if you want the plane to move simultaneously with the slider.
Select Show Plane, if you want the section plane visible.

Select Fill, if you want the section plane filled.

ADDITIONAL INFORMATION: The fill color can also be set from the Configuration dialog.
STEP RESULT: The section plane is displayed as filled and the Section Area is calculated.
From the Measured Units list, select the unit in which you want to measure the
section surface.

Click Close to close the Define Section dialog.

ADDITIONAL INFORMATION: Once you have defined the section plane and closed the Define
Section dialog, among other options, you can choose whether to enable, remove, orinvert
a defined section from the Section menu.

Exporting Section Edges

You can export a copy of the section plane and save it as a .dxf or .dwg file.

TASK
1.

2.

Define a section plane.

From the Manipulate menu, select Section, and then select Export.

ADDITIONAL INFORMATION: If the Define Section dialog is already open, click Export.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Sectioning .
STEP RESULT: The Export Section As dialog appears.

Enter a file name and select a directory location to export the file.

From the Save As Type list, select whether to save the file as .dxf or .dwg format.

Click Save.

ADDITIONAL INFORMATION: To remove a section plane, from the Manipulate menu, select
Section, and then select Remove.
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Exploding

You can use the Explode option to better understand the structure of an assembly and to
analyze the dismount capability. You can also save the exploded view, as well as obtain a
printed document of the exploded product for further analysis.

Explode Options

From the Explode dialog, you can define how the explosion is to be performed and to visu-
ally explode or implode a model.

The options that you can set are:

Option Description
Maximum Depth Define up to which level you want to explode. All entities from the root
level to the specified level are exploded. All entities on the other levels will
not be exploded.
If you are exploding:

Whole model - the number of available levels depends on how many
explodable levels exist in the model. For example, if there are four levels,
with level 2 being the first level under the main assembly, then level 3 and
level 4 are added to the list.

Selected parts - the number of available levels to be added to the list
depends on the selected virtual tree.

Animated When selected, animation is shown while exploding or imploding the
model.
Show Arrows When selected, arrows are displayed in an explosion assembly. The arrow

starts from an exploded entity and points to the center point of its parent.

Scroll Explode Dragging the slider gradually displays the progression of the explosion to
show the explosion dynamics.

Explode - pressing brings the explosion level to the (n-1) level if
current explosion level is between n-1 (inclusive) and n level (exclusive).

Implode - pressing brings the explosion level to the n level if

current explosion level is between n-1 (exclusive) and n level (inclusive).
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Exploding a 3D Model

TASK
1.

From the Manipulate menu, select Explode.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also select Explode H
STEP RESULT: The Explode dialog box appears.

2. Select the parts that you want to explode.
ADDITIONAL INFORMATION: To select more than one model part, press the Shift or Control key
while selecting. To explode the entire model, ensure that no parts are selected.

3. From the Maximum Depth list, select the level to which you want the model to
explode.

4.  Select Animated if you want to see an animated view of the explosion.
ADDITIONAL INFORMATION: This option is selected by default.

5. Select Show Arrows if you want to display the arrows.

6. Toexplode the model, click the button.
STEP RESULT: The whole model or the select model parts explode.

7. Toimplode the model, click the button.
ADDITIONAL INFORMATION: To manually change the explosion state, click and drag the scroll
bar.

8.  (lick OKto close the Explode dialog box.

RESULT:

The explode state remains displayed, and the Transformation column # in the Model
Tree is updated indicating the exploded parts.

See “Resetting the Transformation of a 3D Model”

Saving an Exploded View of a 3D Model

From the Explode dialog box, you can save the exploded view of the 3D model.

TASK
1.

2.

Explode a 3D Model.

Click Save View in the Explode dialog box.
STEP REsULT: The Add User Defined View dialog box appears.

Enter a view name.
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4.  Click OK.

STEP RESULT: The view is saved and appears in the Views tab under the User Defined Views
tree.

5.  Click OK to close the Explode dialog box.

RESULT:
The exploded state is saved.

See “Resetting the Transformation of a 3D Model”

User-Defined Coordinate Systems

You have the option of creating customized three-axis coordinate systems. As with the
Global Axes and the World Coordinate System, the user-defined axes are represented by
a red X-axis, a green Y- axis, and a yellow Z-axis.

See “Global Axes”

When you set a User-Defined Coordinate System (UCS) as the active axes, operations such
as measuring, transforming a model, or defining a view point are applied with respect to
these axes.

You can create multiple UCS’s for a 3D file. For multiple-page 3D files, you can even set
active a different UCS for each page.

Position Options

When defining a UCS, you can define the point where you want to place the user coordinate
system.

The options are:

Position Description

(x, v, z) Coordinates If selected, enter a value to specify where the three axes are
positioned.
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Position

Description

Vertex

If selected, all vertices are highlighted on the model. A snap box
appears when you move the cursor on a vertex. Click the vertex point
where you want to place the user coordinate system. The x, y and z
coordinate values for the vertex are displayed. The UCS axes move to
the new position.

Edge

If selected, all edges are highlighted on the model. A snap box appears
when you move the cursor near an edge. Click at a point on an edge
where you want to place the user coordinate system. The x, y and z
coordinate values for the edge point are displayed. The UCS axes
move to the new position.

Midedge

If selected, all edges are highlighted on the model. A snap box appears
when you move the cursor near the halfway point of an edge. Click at
the mid-edge point where you want to place the user coordinate
system. The x, y and z coordinate values for the mid-edge point are
displayed. The UCS axes move to the new position.

Arc Center

If selected, all arcs and circles are highlighted on the model. A snap
box appears when you move the cursor near the center of a circle or
arc. Click on the arc center where you want to place the user
coordinate system. The x, y and z coordinate values for the arc center
are displayed. The UCS axes move to the new position.

Face

If selected, when you move the cursor along a model face, the face is
highlighted. Click at a point on the face where you want to place the
user coordinate system. The x, y and z coordinate values for the arc
center are displayed. The UCS axes move to the new position.

Orientation Options

When defining a UCS, you can define the orientation for the coordinate system.

The options are:

Position

Description

(x, v, z) Coordinates

If selected, enter a value to specify the UCS orientation according to one or more

of the three axes.

Edge Tangent

If selected, all edges are highlighted on the model. A snap box appears when you
move the cursor near an edge. First select the axis that will determine the UCS
orientation. Click at a point on an edge to define the orientation. The x, y and z

values for the edge point are displayed. The UCS axes are reoriented to the
selected edge.
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Position Description

Face Normal If selected, when you move the cursor along a model face, the face is highlighted.

First select the axis that will determine the UCS orientation. Click at a point on
an face to define the orientation. The x, y and z values for the face point are
displayed. The UCS axes are reoriented to the selected face.

2 Vertices If selected, all vertices are highlighted on the model. A snap box appears when

you move the cursor on a vertex. First select the axis that will determine the UCS
orientation. Click two vertex points to define the orientation. The x, y and z
values for the vertices are displayed. The UCS axes are reoriented to the selected
vertices.

3 Vertices If selected, all vertices are highlighted on the model. A snap box appears when

you move the cursor on a vertex. First select the axis that will determine the UCS
orientation. Click three vertex points to define the orientation. The x, yand z
values for the vertices are displayed. The UCS axes are reoriented to the selected
vertices.

Deleting a User Coordinate System

TASK
1.

From the Analysis menu, select Set User Coordinate System.
STEP RESULT: The User Coordinate Systems dialog appears.

From the Coordinate System list, select the trihedral coordinate system that you
want to delete.

Click Delete.
ADDITIONAL INFORMATION: The UCS disappears from the list.

Click OK to close the User Coordinate Systems dialog.

Modifying a User-Defined Coordinate System

TASK
1.

From the Analysis menu, select Set User Coordinate System.
STEP RESULT: The User Coordinate Systems dialog appears.

From the Coordinate Systems list, select the UCS that you want to modify.
STEP RESULT: The settings you configured for the UCS are displayed.

To change the name, highlight the name and enter the new one.
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4.

To change the position of the UCS, click the Position tab, then from the Define
From list, select the point where you want the UCS axes to appear.

To change the orientation, click the Orientation tab, then from the Define From list,
select the point where you want to orient the UCS.

To show the UCS axes, select Show Trihedron. To hide the UCS axes, deselect the
check box.

To change the UCS that it is relative to, select the UCS from the Relative To list.
Click OK to close the User Coordinate Systems dialog.

ResuLT: 1f you modified the position or orientation, the UCS axes dynamically move to the
new position. A change in Show Trihedron option will make the UCS axes appear or disap-
pear accordingly. Additionally, a name change will display the new name in the Coordinate
Systems list.

Activating a Coordinate System

When you set a User-Defined Coordinate System (UCS) as the active axes, operations such
as measuring, transforming a model, or defining a view point are applied with respect to
these axes.

TASK
1.

From the Analysis menu, select Set User Coordinate System.
STEP RESULT: The User Coordinate Systems dialog appears.

From the Coordinate System list, select the trihedral coordinate system that you
want to use.

Click Set Active.
Click OK to close the User Coordinate Systems dialog.

ResuLT: The newly active trihedral coordinate system appears bolder and larger on the
model.

Defining a User Coordinate System

TASK
1.

From the Analysis menu, select Set User Coordinate System.
STEP RESULT: The User Coordinate Systems dialog appears.
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2. Click New.

STEP REsULT: The name of the User-Defined Coordinate System (UCS1 for the first one)
appears in the Coordinate Systems list.

3.  Tochange the name that you want for the UCS, in the Name field, enter a new
name.

Click the Position tab to define the origin of the UCS.

From the Define From list, select the point where you want the UCS axes to appear.
Click Apply.

Click the Orientation tab to define the orientation of the UCS.

From the Define From list, select the point where you want to orient the UCS.

0 © N o Uk

Click Apply.
10. To hide the UCS axes on the model, deselect the Show Trihedron check box.
ADDITIONAL INFORMATION: This option is selected by default.

11. Click OK to close the User Coordinate Systems dialog.

ADDITIONAL INFORMATION: If there is more than one coordinate system for this file, select
which coordinate system the new UCS will be relative to from the Relative To list. Other-
wise, the new UCS is calculated with respect to the World Coordinate System.

RESULT:
The newly active trihedral coordinate system appears bolder and larger.
See “Modifying a User-Defined Coordinate System”

“Activating a Coordinate System”

Interference Checks

You can check for spatial interference of any two model parts.

Interference Check Options

With the Interference Checking option, you can perform different interference checks.

These checks are:
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Check Description
All Against All Check for interference of any of the parts in the model.
Set Against the Rest Check where a model part or set of model parts interfere with other
model parts.
Set Against Itself Check where a model part or set of model parts interfere with itself.

Set 1 Against Set 2

Check where a model part or set of model parts interfere with another

model part or set of model parts.

Performing an Interference Check

TASK
1.

From the Analysis menu, select Check for Interference.
STEP RESULT: The Interference Checking dialog appears.

From the Scope options, select the type of interference check that you want to
perform.

If you selected Set Against the Rest or Set Against Itself, select one or more
model parts on the model or from the Model Tree.

ADDITIONAL INFORMATION: To select more than one model part, press the Shift or Control key
while selecting.

ADDITIONAL INFORMATION: To clear the last set of selected model parts, click Clear.

STEP RESULT: The model parts appear in the Selected Set list and are highlighted on the
model and in the Model Tree.

If you selected Set 1 Against Set 2, click the Set 1 arrow [, then select one or
more model parts on the model or from the Model Tree.

ADDITIONAL INFORMATION: To clear a selected part, press the Control key and click on the part
on the model. To clear the last set of selected model parts, click Clear.

STEPREsULT: The model parts appear in the Set 1 list and are highlighted on the model and
in the Model Tree.

Click the Set 2 arrow [B then select one or more model parts on the model or from
the Model Tree.

STEPRESULT: The model parts appear in the Set 2 list and are highlighted in a different color
on the model and in the Model Tree.

In the Minimum Clearance Distance field, enter a distance. The default value is 0.

ADDITIONAL INFORMATION: Adding a minimum clearance distance not only checks if the two
model parts interfere, but also checks if they are located within a set minimum distance.

From the Units list, select the unit for the clearance distance.
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10.

11.
12.

13.

To configure the interference check results, click Options.
STEP RESULT: The Options dialog appears.

Click Compute in the Interference Checking dialog.

ADDITIONAL INFORMATION: Section plane is not taken into consideration when computing an
interface check. When the process is complete, all the instances of interfering pairs appear
in the Results list. The number of interfering pairs found appears in the Description box.

ADDITIONAL INFORMATION: To view a pair’s interference information, click the corresponding
Results line.

STEP REsULT: The Compute button changes to Stop. To stop the Interference Checking
process at any point, click Stop. The information appears in the Description box and
AutoVue zooms into the interfering area.

To save the results, click Export.
STEP RESULT: The Export Results dialog appears.
Specify the file name and the directory where you want to save the file.

Click Save to close the Export Result dialog.

ADDITIONAL INFORMATION: To perform another interference check click Reset, then click the
type of interference check.

STEP RESULT: AutoVue saves the results in a .csv (Comma Separated Values) file.

Click Close to close the Interference Checking dialog.

Interference Check Results Options

With AutoVue, you can configure the results of an Interference Check.

The configuration options are:

Option Select Description

Actions Zoom To Once the interference check is

computed and a result set is
selected from the list of results,
AutoVue zooms to the result.

Show Intersection Once the interference check is
computed and a result set is
selected from the list of results,
AutoVue shows where the
intersection of model parts
occur.
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Comparing 3D Files

Option Select Description

Selected Pair Opaque The selected pair from the list of
results appear opaque.

Transparent The selected pair from the list of
results appear transparent.

Hide The selected pair from the list of
results appear hidden.

Other Parts Transparent The rest of the model appears
transparent while the selected
pair is displayed.

Hide The rest of the model is hidden
while the selected pair is
displayed.

. Actions: Provides a close-up look at how model parts interfere.

o Selected Pair: Configure if the selected pair from the Results list should display
opaque, transparent or hidden.

. The Rest: Configure if the other parts of the model should display transparent or

hidden while the selected pair is displayed.

AutoVue provides the ability to compare two 3D files or two sets of entities from the same
file or different files and display color-coded comparative data. When you compare two
files, AutoVue displays a Compare Tree and three windows, the first containing the base
file, the second containing the file you compared the base against, and the third containing

the comparison results.

The Compare Tree displays the model’s hierarchy with a State column displaying different
icons representing the results of the file comparison. The icons indicate if an model part has

been added €=, modified &, moved & deleted =.

In the Comparison Result window, results are displayed in different colors to differentiate
the results of the file comparison. The comparison options and corresponding colors are:
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Option Color Description
View Additions Green Indicates that something has been added.
View Deletions Red Indicates that something has been deleted.
View Unchanged Blue Indicates that there is no change.
Comparing 3D Files

The following steps describe how to compare files:

TASK

1.
2.

10.

View the base file.

From the Analysis menu, select Compare.
STEP RESULT: The Open dialog appears.

Enter the file name or browse to locate the file you want to compare with the
current active file.

Click Open.

STEP RESULT: AutoVue displays the Compare Tree and three windows. The first window
displays the base file, the second displays the compare file, and the third displays the
comparison results.

To view the properties of a modified or moved entity in the base file and in the
compare file, select the modified & or moved & entity from the tree, then
right-click and select Entity 1 Properties.

STEP RESULT: The Entity Properties dialog appears displaying the properties of the entity in
the base file.

Select the entity again, then right-click and select Entity 2 Properties.

STEP RESULT: The Entity Properties dialog appears displaying the properties of the entity in
the compare file.

To compare the results of the entity in the base file to the compare file, select the
entity from tree, then right-click and select Compare Results.

STEP REsULT: The Compare Results dialog appears.
To view the attribute differences, click Attributes.

To view the transformation difference, click Transformation.

ADDITIONAL INFORMATION: If there are no attribute or transformation differences, the buttons
are disabled.

Click OK to close the Compare Results dialog.
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11.

To exit Compare mode, from the File menu, select Exit Compare.

ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also select Exit Compare [Ex7].

RESULT:

The base file appears in the workspace.

Comparing Entity Sets

From the file comparison, you can compare a set of entities from one file against a set of
entities from the another file. You can also compare sets of entities from the same file.

TASK

1.
2.

Select the files you want to compare.

From the Analysis menu, select Compare Sets.

STEP RESULT: The Compare Sets dialog appears.

Compare Sets

= 30CatiabFrontDrivedzzembly. CATE ~

= 30CatiabaCPulley. CATPart

= Page 1 = Page 1
=+ Productl B = ADCatiabaCPulley. CATPar
[=)- 3D CatizbB alahceShafl Solid.0
[=)- 3D CatiabB alancet [=)- Annotation Set.1
Solid.0 = D atumz
[=)- 3D CatiabPowersteenin Simple D atum.
[=)- 3D CatighPowerSte Dratum T arget.
Solid.0 b =) Dimenzions v
< | IS |
Set 1 Set 2
-_Elear -_Elear
Cancel l [ Help

X]

Click @ Set 1.
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Select the entities from either the tree on the left or the tree on the right.

ADDITIONAL INFORMATION: The tree on the left is the base file and the tree on the right is the
compare file.

STEP RESULT: The selected entities appear in the Set 1 list.
Click By Set 2.

Select the entities from the other tree that you did not select for Set 1.

ADDITIONAL INFORMATION: To compare entities from the same file, select the entities for Set 1
and Set 2 from either the base file or the compare file.

STEP RESULT: The selected entities appear in the Set 2 list.
Click OK.

STEP RESULT: The Compare Tree and the three windows are updated with the set compar-
ison results.

To restore the comparison files, from the Analysis menu, select Compare Files.

RESULT:

The files appear in the three windows.
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Generating a Bill of Material

For 3D files, you can obtain a list with a count of the parts required for manufacturing the
item featured in the file. To generate a Bill of Material (BOM):

TASK

1.

From the Analysis menu, select Generate Bill of Material.
STEP RESULT: The Bill of Material dialog appears.

Bill of Material X

Count Part Mame

1 Solid. 0

1 Solid. 0

1 Solid.1

1 Solid. 0

1 Solid. 0

1 Solid. 0.0

1 Solid. 0

1 Solid. 0

[ Ewport... ] [ Cloze l [ Help ]

2. Tosort the list numerically, click the Count column header.
To sort the list alphabetically, click the Part Name column header.

4. Toview a part or parts on the model, select the parts from the Part Name column.
ADDITIONAL INFORMATION: To select more than one part, press the Shift or Control key while
selecting.

STEP RESULT: The parts are highlighted on the model and in the Model Tree.

5. To save the Bill of Material, click Export.

STEP RESULT: The Export BOM dialog appears.

6.  Enterafile name or browse to locate the directory where you want to store the file,
then click Save.

STEP RESULT: AutoVue saves the results in a .csv (Comma Separated Values) or .xml file.

7.  Click Close to close the Bill of Material dialog.
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Entity Search

AutoVue allows you to search for entities in a 3D model using the Entity Search dialog.

Entity Search fz|
30 Search | Advanced 3D Search
) Attribute Filters
setection: | X ~ |
Add

Tvpe: |P.II v |

[]5how PMI parent entity in resuls

PMI filter: | All v|

PMI Eype:

Results:
Type Mame:
[ Close ] [ Help ]

You can search the whole model or selected entities on the model, perform a 3D text search,
apply attributes, entity type or PMI filters as search criteria to filter entities. You can also
search for entities by the size of an entity and location, or select entities from the results list
and have them appear highlighted in the workspace and in the Model Tree.

The search options are:
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Where

Option

Description

3D Search tab

Selection

Specity if you want to search the entire model or selected parts or
parts that are not selected.

Type

Specify the type of entity you want to search. For example, part,
body, assembly or PMI.

Show PMI
parent entity in
results

When selected, displays only the parent entity of a PMI entity that
matches search criteria.

If cleared, displays PMI entities that match search criteria in the
Results dialog.

Option is enabled if Type is set to PMI or All and file has PMI
entities.

PMI Filter

Filters the entities that have PMI information.
Option is enabled if Type is set to PMI or All.

PMI Type

Specity the specific PMI attribute you want to search.
Option is disabled if PMI Filter is set to All.

Containing Text

Specify a text string that you want to search. AutoVue searches for a
specified string in attribute names and attribute values.

Attribute Filters

Specify attributes to search for in 3D model.
See “Performing an Attribute-based Search”

Attribute Filter
dialog

Name

Specity the specific attribute you want to search. Some of the
available attributes:

Color

Density

Display_Mode

Filepath

Layer_ID

Name

Translucency

Visibility

NOTE: The attributes vary depending on the file being viewed.

See “Performing an Attribute-based Search”

Any Value

When selected, AutoVue searches for any value of the selected
attribute.

The attribute value options are disabled.

If cleared, specify the values for the selected attribute you want to
search.

The attribute value options correspond to the selected attribute.
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Where Option Description
Advanced 3D Volume Specify the size of an entity, the minimum and maximum
Search tab dimensions. The dimensions of an entity boundary box must be

between the specified dimensions to meet the search criteria.

Location Specify an axes aligned boundary box. The boundary box of an
entity must be inside it to meet the search criteria.

Performing a Search

TASK
1.

From the Edit menu, select Entity Search.

ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Entity Search €.
STEP RESULT: The Entity Search dialog appears.

Click the 3D Search tab.

From the Selection list, specify what parts of the model that you want to search.

. To search the entire model, select Al

. To search specific parts of a model, select Selected and then select the parts on the
model.

. To search the model parts that are not selected, select Not selected.

From the Type list, select the type of entity that you want to search.

ADDITIONAL INFORMATION: For 3D Models that have PMI information, the PMI search features
are enabled.

Select the Show PMI parent entity in results check box if you only want the
parent entity of the selected PMI entity or entities to appear in the Results list.
Deselect the check box if you want all PMI entities to appear in the Results list.

ADDITIONAL INFORMATION: The option is enabled if PMI or All are selected from the Type list
and the file has PMI entities.
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7. From the PMI Filter list, select the type of entities that you want to search.
. To search all entities, select AlL
. To search entities with PMI, select With PMI.

. To search entities without PMI, select Without PMI.

8.  From the PMI Type list, select the type of entity that you want to search.
ADDITIONAL INFORMATION: The PMI Type list is disabled if All is selected from the PMI Filter
list.

9.  C(lick Search to perform the entity search.

RESULT:

The search results appear in the Results list.

Performing an Attribute-based Search

From the Entity Search dialog, you can search for entities by their attributes, such as color,
density, shading, and so on.

TASK
1.

From the Edit menu, select Entity Search.

ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Entity Search ‘ﬁ\é
STEP RESULT: The Entity Search dialog appears.

Click the 3D Search tab.

Select the search criteria that you want to use for your search.
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4.

Click Add.
STEP RESULT: The Attribute Filter dialog appears.

Mame:

COLOLR. w

[ any value

Colour Yalue
Tesk:

Equals w

YWalue:

[ Ok ] [ Cancel ]

10.

11.
12.

13.

14.

From the Name list, select the attribute that you want to search.
STeP REsULT: The Value list appears corresponding to the selected attribute.

Select the Any Value check box if you want to search by any value; the associated
value options are disabled.

Deselect the Any Value check box if you want to search by a specific value; from
the Condition set condition for the search, and from the Values list select the
values that you want to search.

Click OK.

ADDITIONAL INFORMATION: To add more than one Attribute Filter, repeat steps 4 to 8.
To edit an Attribute Filter, select the filter and click Edit.

STEP RESULT: The Attribute Filter dialog appears allowing you to edit the filter.

To disable an Attribute Filter, deselect the check box beside the filter or filters that
you want to disable.

To enable an Attribute Filter, select the check box beside the filter or filters.

To remove an Attribute Filter, in the Entity Search dialog, select the filter and click
Remove.

STEP RESULT: The Attribute Filter disappears from the list.
In the Entity Search dialog, click Search.

STEP REsULT: A list of entities matching the search criteria appear in the Results list
displaying the name and type of the entities.

Click Close to close the Entity Search dialog.
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Performing an Advanced 3D Search

From the Entity Search dialog, you can search for entities using volume or location filters.
Volume specities the size of the entity: you can specify the minimum and maximum dimen-
sions an entity must be between. Location specifies an axes aligned boundary box: you can
specify the dimensions for an axes aligned boundary box that an entity must be inside.

TASK
1. From the Entity Search dialog, click the Advanced 3D Search tab.
Entity Search E|

30 Search | Adwanced 30 Search

Wolume:

[JEnabled

Minimum Cimensions:

e

I

&h

Maximum Dimensions:

A

i

2t

Lniks:

Location:

[JEnabled
Paoink 1: Paink 2:
Al kS
i i
Units:
FH &

[ Close ] [ Help ]

2. Tosearch for entities by Volume, select the Enabled check box.

ADDITIONAL INFORMATION: If you want to search for entities that match all three dimensions,
select the Completely contained check box. If the check box is deselected, then an entity
only has to match one dimension in order to appear in the Results list.

Enter the minimum and maximum dimensions in their respective fields.
4.  From the Units list, select the unit you want to set for the Volume dimensions.

To search for entities by location, select the Enabled check box.

ADDITIONAL INFORMATION: If you want to search for entities that match all three dimensions,
select the Fits completely check box. If the check box is deselected, then an entity only
has to match one dimension to appear in the Results list.

6.  From the Units list, select the unit you want to set for the Location dimensions.
7.  Enter the dimensions for Point 1 and Point 2.
8.  Click the 3D Search tab.
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9. Click Search.

STEP REsULT: A list of entities matching the search criteria appears in the Results list.

10. Click Close to close the Entity Search dialog.

Saving Search Results

TASK

1. Perform a 3D entity search.

2.  Click Search.

STEP RESULT: A list of entities matching the search criteria appear in the Results list
displaying the type and name.

3. Tosave the results, click Export.

STEP RESULT: The Save As dialog appears.

4.  Specify the path where you want to store the file and enter the file name, then click
Save.

RESULT:

AutoVue saves the results in a .csv (Comma Separated Values) file.

Measuring in 3D Files

AutoVue provides the ability to perform measurements in 3D files. When measuring,
AutoVue provides the option to “snap” to different entity types on the model.

From the Analysis menu, select Measure to access the Measurement options.

NOTE: From the AutoVue toolbar, you can also click Measure (.

The following table outlines the available measuring options:

Name

Description

Angle

Measure the precise angle between any three vertices or any two edges,
planes, faces or any combination of these entity types.
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Name Description

Arc Measure the precise radius, length and angle of any arc and calculate the
center point.

Distance Measure the precise distance between any two vertices, edges, mid-edges,
arc centers, faces or any combination of these entity types.

Minimum Distance Measure minimum distance between any two vertices, edges, mid-edges,
arc centers, faces or any combination of these entity types.

Edge Length Measure the precise length of a edge.

Face Surface Measure the precise surface area.

Vertex Coordinates Provide the coordinates of each vertex.
3D Snapping Modes

The snapping modes available allow you to select or snap to different entity types on a
model. For example, if you select Vertex, all vertices are highlighted and when you move
the cursor over a vertex, a snap box appears.

The snapping modes allow you to snap to vertices, edges, faces, planes and arcs.

Button Snap to Description

@ Edge Edges are highlighted on the model.
When moving the cursor over an edge, a snap circle
appears.

@ Face Faces are highlighted when you move the cursor over a
face and a snap triangle appears.

@ Vertex Vertices are highlighted on the model.
When moving the cursor over a vertex, a snap box
appears.

Measuring Distance

Use the Distance option to measure the precise distance between two vertices, edges,
mid-edges, arc centers, faces or any combination of these entity types. When measuring the
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distance between faces, if the faces are parallel, AutoVue compares the shortest distance
between the faces.

TASK
1.

10.

From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure ,]:!
STEP RESULT: The Measurement dialog box appears.

Click the Distance tab.

From the Measured Distance Units list, select the unit in which you want to
measure.

Click the From [E1 field to select the entity type that you want to measure from.

Select the snapping modes that you want to use for measuring.
STep ResuLT: All entities of the selected entity type are highlighted on the model.

On the model, select the entity you want to measure from.

ADDITIONAL INFORMATION: If you want to take more than one measurement from the same
starting point, click Fix Position.

Click the To &2 field to select the entity type that you want to measure to.

Select the snapping modes that you want to select as the end point for the
measurement.

STEP REsULT: All entities of the selected entity type are highlighted on the model.
On the model, select the entity you want to measure to.

ADDITIONAL INFORMATION: To take another measurement click Reset.

STEP RESULT: The points are joined by a line. The measured distance, Delta X, Delta Y and
Delta Z appear in the Measurement dialog box.

Click Close to close the Measurement dialog box.

Calibrating Distance

Calibrate the distance measurement.

TASK
1.

2.

Measure distance between two points or measure cumulative distance.

From the Distance tab, click Calibrate.
STEP RESULT: The Distance Calibration dialog appears displaying the measured distance

From the Units list, select the unit to which you want to calibrate the distance.

Select Calibrate to and enter a value if you want to calibrate the distance to a
value.
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5. Select Set Factor and enter a value if you want to calibrate the distance by a factor.

6. Click OK.
STEP RESULT: The calibration result appears in the Measurement dialog.

7. Click Close to close the Distance tab.

Measuring Minimum Distance

With the Minimum Distance option you can measure the minimum distance between
model parts, as well as any two points from the selection sets: vertices, edges, mid-edges, arc
axes, arc centers, faces or any combination of entity types.

TASK

1. From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure ,]:!
STEP RESULT: The Measurement dialog appears.

2.  Click the Min. Distance tab.
Click B4 Set 1.

4.  From the Snapping Mode section, select one of the following:
. Select Entity if you want to measure the distance between model parts. Snapping
modes are disabled.

. Select Geometry if you want to measure the distance between entity types. Snap-
ping modes are enabled.

5. If you selected Entity, select a part or parts on the model. If you selected Geom-
etry, select the snapping modes that you want to use for measuring.

ADDITIONAL INFORMATION: To reset a set, click Clear. To clear items from a set, select the items
and press the Delete key. To deselect a part or entity type on the model, press the Control
key and left-click the part or entity type.

STEP RESULT: The model parts appear in the list under Set 1 and are highlighted on the
model and in the Model Tree. All entities of the selected entity type are highlighted on the
model.

6. Click E Set 2.
7. Repeatstep 5.
STEP RESULT: The model part appears in the list under Set 2.
8.  From the Units list, select the unit in which you want to measure the distance.

9. C(Click Compute.

STEP RESULT: The minimum distance from the first set of entities to the second set is high-
lighted by a line. The measured minimum distance, X, Y, and Z coordinates for Position 1
and X, Y and Z coordinates for Position 2 appear in the Measurement dialog.
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10. To take another measurement click Reset.

11.

Click Close to close the Measurement dialog.

Measuring an Angle

Use the Angle option to measure the precise angle between any three vertices or any two
edges, planes, faces or any combination of these entity types.

TASK
1.

From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure .
STEP RESULT: The Measurement dialog appears.

Click the Angle tab.
Select the snapping modes that you want to use for measuring.
STEP RESULT: Entities of the selected types are highlighted on the model.

To measure the angle between an entity type and a plane, select the With Plane
check box, and then select the plane from the list.

From the Units list, select the unit in which you want to measure the angle.
Click two points on the model to define the angle.
STEP RESULT: Angle arms appear with an arc connecting them.

Click again to complete the measurement.

STEP REsuLT: The angle is highlighted and the value of the angle measurement appears in
the dialog.

To take another measurement click Reset.

Measuring an Arc

Use the Arc option to measure the precise radius, length and angles of any arc on the model.
You can also calculate the center point location.

TASK
1.

From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure .
STEP RESULT: The Measurement dialog appears.

Click the Arc tab.
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Select Arc Entity if you want to measure a predefined arc.

Step ResuLT: All arc and circles are highlighted on the model. Shapping modes are
disabled.

Select From 3 Points if you want to measure the arc between three points.

STEP RESULT: Snapping modes are enabled.

Select the snapping modes that you want to use for measuring.

From the Units list, select the unit in which you want to measure the arc distance.

If you selected From 3 Points, click three points to define the arc.

STEP RESULT: The points are joined by an arc. The measurements for center point coordi-
nates, radius, diameter, arc length, start and end of angle and sweep appear in the
Measurement dialog.

If you selected Arc Entity, click the edge of the arc that you want to measure.
ADDITIONAL INFORMATION: To take another measurement click Reset.

STEPRESULT: Thearcis highlighted. The measurements for center point coordinates, radius,
ratio, arc length, start and end of angle and sweep appear in the Measurement dialog.

Click Close to close the Measurement dialog.

Calibrating an Arc

TASK
1.

2.

Measure an arc in the drawing.

From the Arc tab, click Calibrate.
STEP RESULT: The Radius Calibration dialog appears displaying the measured distance.

From the Units list, select a unit of measurement to which you want to calibrate the
distance.

Click Calibrate to and enter a value if you want to calibrate to a value.
Click Set Factor and enter a value if you want to calibrate by a factor.

Click OK.
STEP RESULT: The calibration results appear in the Arc tab.

Click Close to close the Measurement dialog.
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Measuring Vertex Coordinates

The Vertex Coordinates option provides the coordinates of vertices on the model.

TAsK
1. From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure .
STEP RESULT: The Measurement dialog appears.
2. Click the Vertex tab.
STepP ResuLT: All vertices on the model are highlighted.
From the Units list, select the unit in which you want to measure.
4.  Move the cursor over the highlighted vertex that you want to measure.
STep REsuLT: The X, Y and Z coordinates appear in a tooltip.
5.  Select the vertex.
ADDITIONAL INFORMATION: To take another measurement click Reset.
STEP RESULT: The X, Y an Z coordinates appear in the Measurement dialog.

6. Click Close the close the Measurement dialog.

Measuring the Length of an Edge

Use the Edge Length option to measure the length of any edge on the model.

TAsSK
1. From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure ,I':!

STEP RESULT: The Measurement dialog appears.
2.  Click the Edge Length tab.
STEP REsULT: All edges on the model are highlighted.
3. From the Units list, select the unit in which you want to measure the edge length.

ADDITIONAL INFORMATION:  If you want to cumulate the measurement of more than one edge,
select Cumulative.

4.  Click the edge that you want to measure.
ADDITIONAL INFORMATION: To take another measurement click Reset.
STEP RESULT: The edge length measurement appears in the Measurement dialog.

5.  Click Close to close the Measurement dialog.
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Measuring Face Surface

Use the Surface option to measure the surface area of an entity face or an entire entity on
the model.

TAsK

1. From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure ,I':!
STEP RESULT: The Measurement dialog appears.

Click the Surface tab.
Select Face Surface if you want to measure the surface area of a face on an entity.

Select Entity Surfaces if you want to measure the surface area of an entire entity.

i A W N

From the Units list, select the unit in which you want to measure the surface.

ADDITIONAL INFORMATION: If you want to cumulate the measurement of more than one
surface, click Cumulative.

6. If you selected Face Surface, move the cursor on the model to highlight a face
surface, then click the face surface that you want to measure.

STEPREsULT: The face surface is highlighted. The measured surface appears in the Measure-
ment dialog.

7.  Ifyou selected Entity Surface, click the entity that you want to measure.

STEP RESULT: The entity, as well as all the faces belonging to the body are highlighted. The
measured surface of the body appears in the Measurement dialog.

8. To measure the face surface of the entity, click on the highlighted body.
STeP REsULT: A list appears displaying the entity and its parents.

9. Select the entity or a parent from the list.

ADDITIONAL INFORMATION: To measure the face surface of a parent, select the parent from the
list.

STEP RESULT: The selected entity is highlighted and the measured surface appears in the
Measurement dialog.

10. To take another measurement click Reset.

11. Click Close to close the Measurement dialog.
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Configuring AutoVue

Use the configuration options to configure the AutoVue workspace for different groups of
file formats or for all files in general. For example, you can set different background colors
for EDA, 2D, 3D, or Office files. You can also set paths to locate external resources such as
fonts, symbols, XRefs, or configure measurement options.

To access the configuration options, from the Options menu, select Configure. The
Configuration dialog appears. To implement your changes and to close the Configuration
dialog, click OK.
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General Options

To access the General configuration options:

TASK
1. From the Options menu, select Configure.
STeP REsuLT: The Configuration dialog appears.

=} Configurstion x|
Category Genaral
> XEm
® Ref Pathe CAD
& Font Paths W Text P Line Style
& Massurement
® Base Fonk ¥ Dimensions W Filing
=X > ¥ Line Wei ¥ Load External Ref
& Colors b Line Weights WL xhern BTENCES
=¥ w® [ Force b black ¥ Line CapsiJoins
& Model
& PMl
Raste
& Colors r
#® Background " Full Resolution
& Mizcellaneous
& 5
L """f.' O Fit To Window
& Anabrsis
® Colors Rendering
& Display Options [ Enable Look Ahead
@ Graphacs
& Desktop Office Resources

i Resobee Local Rescuroes

a4 | Cancel

2. From the Configuration tree, select General.

ResuLT: The CAD, Raster, and System Options appear.

Configuring Options for CAD Files

Configure how you want to display text, dimensions, line styles, and so on for CAD files.

Option Description

Text Select to display text entities.
Clear to hide text entities.
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Option Description
Dimensions Select to display all dimensional entities.
Clear to hide all dimension entities.
Line Weights Select to display varying line thicknesses.

Clear to make all lines appear equal, with a width of 1 pixel. No line weights
display for any line.

Force to Black

Select to force all colors of a drawing to black.
Clear to display the file in color.

Line Style Select to display dotted and dashed lines.
Clear to display all lines as solid.
Filling Select to display filled entities as filled rather than just an outline.

Clear to hide filling for filled entities.

Load External References

Select to display external references (XRefs) automatically.
Clear to keep external references from displaying automatically.

Raster Files

Choose how you want the raster file to display:

Select Full Resolution to display raster files at full resolution.

Select Fit to Window to display raster files to fit the current window.

System Options

Select Enable system tray hibernation if you want the AutoVue icon to remain in the
system tray even after you close AutoVue.

Double-clicking this icon lets you quickly reopen AutoVue, access recently-used files, and
so on. To completely exit AutoVue when this option is selected, you need to right-click the
AutoVue icon in the system tray and select Close AutoVue.

Deselect Enable system tray hibernation if you want AutoVue to quit completely when

you close it.

Click Registry to open the AutoVue File Registration dialog box. From the list, select the
file extensions you want to associate with AutoVue. Click OK to implement your changes
and to close the dialog box.
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Configuring Paths

Contfigure the paths for XRefs, fonts, symbols, or markups.

When working with files that need external resources, such as fonts or XRefs, you may need
to specify the path to these external resources if they do not exist in the same location as the
base file.

You may also need to access symbol libraries that are stored in a non-default location or
you may need to configure from where AutoVue reads and locates Markup files.

Path Description

XRefs The directory paths for any external reference files associated with 2D, 3D or EDA files.
See “Configuring XRef Paths”

Font The directory paths for fonts required by AutoVue’s vector files.
See “Configuring Font Paths”

Symbol The directory path for symbol libraries used by AutoVue’s Markup entities.
See “Configuring Symbol Paths”

Markup The directory paths for Markup files.
See “Configuring Markup Paths”

Configuring XRef Paths

XRef Paths are the directory paths for any external reference files associated with 2D, 3D
or EDA files.

TASK
1. From the Configuration tree, expand General, and then select XRef Paths.

2.  Click Add.
STEP RESULT: The Browse for Folder dialog box appears.

3.  Enterthe directory path, or scroll to locate the directory where the external refer-
ence files are located.

4.  To browse all subdirectories below the current path, type two asterisks ** at the
end of the file path.For example, C:\'samples\** will result in browsing all subdirec-
tories below “samples”.

5.  Tobrowse one subdirectory below the current path, type one asterisk * at the end
of thefile path. For example, C:\samples\* will result in browsing one subdirectory
below “samples”.
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Click OK.
ADDITIONAL INFORMATION: To add more than one path to the list, repeat steps 3 to 5.
STEP RESULT: The directory path appears.

To change the order, select the path you want to move, then click Up or Down to
move the path to where you want it in the list.

To remove a path, select the path and click Remove.

Configuring Font Paths

Font Paths are the directory paths for fonts required by 2D, 3D, EDA, or Office files.

TASK
1.

From the Configuration tree, expand General, and then select Font Paths.

2. (lick Add.
STEP RESULT: The Browse for Folder dialog box appears.

3.  Enter the directory path or scroll to locate the directory where the external font
files are located.

4.  To browse all subdirectories below the current path, type two asterisks ** at the
end of the file path.
ADDITIONAL INFORMATION: For example, C:\samples\** will result in browsing all subdirecto-
ries below “samples”.

5.  Tobrowse one subdirectory below the current path, type one asterisk * at the end
of the file path.
ADDITIONAL INFORMATION: For example, C:\samples\* will result in browsing one subdirec-
tory below “samples”

6. Click OK.
ADDITIONAL INFORMATION: To add more than one path to the list, repeat steps 3 to 5.
STEP RESULT: The directory path appears.

7.  Tochange the order, select the path you want to move, then click Up or Down to
move the path to where you want it in the list.

8. Toremove a path, select the path and click Remove.

RESULT:

The selected path disappears from the list.
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Configuring Symbol Paths

Symbol Paths are the directory paths for symbols libraries used by AutoVue’s Markup enti-
ties.

TASK
1. From the Configuration tree, expand General, and then select Symbol Paths.

2. Select the Auto option if you want to use the default directory to store the Symbol
libraries.

3.  Select the User-Defined option if you want to select a directory to store the
Symbol libraries. Enter the directory path where you want to store the Symbol files
or click Browse E|to locate the directory.

Configuring Markup Paths

Markup Paths are the directory paths for Markup files associated with the currently loaded
document.

TASK
1. From the Configuration tree, expand General, and then select Markup Paths.

2. Selectthe Auto option if you want to use the default directory to store the markup.
AutoVue, by default, stores the Markup files in an avred subdirectory at the loca-
tion of the base file.

3. Select the User-Defined option if you want to select a directory to store the
markup. Enter the directory path where you want to store the markup, or click
Browse |:|to locate the directory.

ResuLT: All markups will now be saved to and read from this new location.

Measurement

The Measurement options let you define the default measurement units and the number
of decimal places.

From the Configuration tree, expand General, and then select Measurement to display the
options you need.

The available options are as follows:
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Option Description

Significant Digits Lets you specify the number of decimal digits displayed for each
measurement. Enter a number from 1 to 18.

Default Units Lets you specify the default font to use for AutoVue. If a file does not have
native file units, the default file unit is used for the file.

Measurement Units Lets you specify the default font to use for measurements. This list has
the Native File Unit option in addition to the standard units. You can

select Native File Unit if you wish to measure in the native units of the
file.

Configuring the Base Font for Text Files

The Base Font option lets you define the font properties for text files.

TASK

1.

2
3
4,
5

From the Configuration tree, expand General, and then select Base Font.
Select a font from the Font list.

From the Font Style list, select Regular, Bold, Italic, or Bold Italic.

Select font size from the Size list.

From the Effects options, you can add a strikeout or underline to the text.
ADDITIONAL INFORMATION: The base font is previewed in the Sample area.

Configuring Streaming File Support

The streaming file is generated when AutoVue opens a native file for the first time.
AutoVue generates the streaming file to decrease the loading time of files. As a result, when
the file is opened subsequent times, AutoVue reads from the streaming file instead of the

n

ative file.

This option allows you to configure streaming file support.

NOTE: If the native file changes, the streaming file will be invalid and AutoVue will open from
the native file.

TASK

1.

Select the Enable Streaming File Support check box.
STEP RESULT: The Browse for Folder dialog box appears.
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2. Browse and select a folder to use for storing streaming files and then click OK.

ADDITIONAL INFORMATION: The Enable Streaming File Creation check box is selected by
default when you enable streaming file support.

STEP REsULT: The selected folder path appears in the Cache Folder field.

3.  Select the Enable Cache Size Limit check box to limit the size of the streaming file
cache folder (the default value is 0). Enter the cache size in the field to the right of

the check box.

RESULT:

NOTE: The streaming file settings changes will take effect after the application is restarted.

Configuring AutoVue for 2D Files

You can configure background color, snap and overlay extents settings for 2D files.

TAsK
1. From the Options menu, select Configure.
STeP RESULT: The Configuration dialog appears.
2. Select 2D in the tree.
STEP RESULT: The 2D options appear.

Snap Settings

In measurement mode, when you move the cursor within a predetermined snap radius, the
snap box appears for the entity to be selected. To change the snap radius, change the value
in the Snap Radius field. The snap radius is configured in pixels.

Configuring Colors

The Colors settings let you modify colors for 2D files.

From the tree, expand 2D, and then select Colors to display the following options:
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Option Description
Background Change the color of the background for 2D files.
Measurement Moditfy the color you want displayed when taking measurements on

2D files.

Configuring AutoVue for 3D Files

There are configuration options that you can set to customize the work environment when
working with 3D files.

TASK

1. From the Options menu, select Configure.

STEP RESULT: The Configuration dialog box appears.

2.  Select 3D in the tree.
STep REsuLT: The Rendering and Dynamic Rendering options appear.

Rendering

The Rendering options let you modify the manner in which the model is rendered.

Changing these options affects the level of detailed displayed. The Rendering options are:

Option

Description

Smooth Shading

Set by default. Turning this option off renders curved surfaces of shaded models
as a series of flat surfaces. The level of detail is thus reduced but render speed is
increased.

Only affects shaded models.

Back-Face Removal

If selected, instructs AutoVue not to render the back faces of the model being
displayed. This increases the render speed but the model appears less realistic
while in motion.

Only affects shaded models.
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Option

Description

Precise Hidden Line

Instruct AutoVue to precisely calculate and render all hidden lines in a model.
Selecting this option decreases render speed.

Dynamic Rendering

The Dynamic Rendering options let you select the rendering mode for a model in motion.

The options you can select are:
Menu Option Description

Fast Frame Model spins or rotates at a fast rate. The level of detail is reduced,
which enables faster rendering when the model is in motion.

Wire Frame Model is displayed as wire framed during rotation or spinning.

Flat Shading Smooth shading is not performed on curved surfaces while the model
is in motion.

Wire Polygons Render the model in wire polygon mode while in motion.

Vertex Cloud Model is displayed as a skeleton of vertices when in motion.

Bounding Box

Model parts are enclosed by bounding boxes when the model is in
motion.

Current Render Mode

Model is rendered in the same mode whether moving or static.

Model
The Model configuration options let you control the streaming method, the dynamic load
mesh resolution, and the visibility of model parts.
From the Category tree, expand 3D, and then select Model to load the Loading,and
Default Mesh Resolution options.

Loading
TAsK
1. Select the Load Mesh Data option to load available mesh data.
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2. Deselect Load Mesh Data to load BREP data.

ADDITIONAL INFORMATION: You need to reload the file for your changes to take effect.

Default Mesh Resolution

The Default Mesh Resolution slider lets you modify the number of polygons drawn when
displaying a model.

Drag the slider between Low, Medium and High resolution levels.

A low resolution level means fewer polygons are drawn giving lower detail and higher
render speed.

The Default Mesh Resolution slider only affects shaded models and wire polygon mode.

PMI Filtering

From the tree, expand 3D, and then select PMI to display the PMI options.

The PMI Filtering options let you configure which types of product and manufacturing
information to display. The check boxes in the Tree column let you select which PMI entity
types display in the 3D model tree. The check boxes in the View column let you select which
PMI entity types display in the workspace.

The following PMI Text Rendering Style options let you define the style for the PMI text:

Option Description

Native Setting (from | PMI text displays with the default setting.
file)

3D PMI text displays in 3-dimensions. It may not always face you.

Flat-to-screen PMI text always faces you.

Configuring Color

With the Color options, you can configure the color to allow easier viewing of 3D file
details.
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From the Configuration tree, expand 3D, and then select Colors to view the available Color
options. They are grouped under Common, Section Highlight, and Geometry Highlight,

as follows:
Common
Option Description
Background Set the background color for all views (except the PCB 3D view) and file types.
Selection Set the color when selecting an entity.

Section Highlight

Option Description
Edges Set the color for the section edges when defining Section Cut Options.
Fill Set the fill color when defining Section Cut Options.
Geometry Highlight
Option Description
Vertex Set the color for vertices when highlighted during measurement and markup.
Face Set the color for faces when highlighted during measurement and markup.
Edge Set the color for edges when highlighted during measurement and markup.

Configuring Background

With the Background options, you can select a gradient or an image to display in the back-
ground. From the Configuration tree, expand 3D, and then select Background. The Back-
ground Gradient and Background Images options appear.
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For the Background Gradient option

Select either Plain, Directional Gradient, or Radial Gradient. The background is
previewed to the rights of the options.

For the Background Images option

This feature adds a single or multiple background images to the workspace.

TASK
1.

Click Add.
STEP RESULT: The Background Image dialog appears.

2.  Click on the ellipses to the right of the Image File field to browse to the image file.
ADDITIONAL INFORMATION: You can only select .bmp, .jpeg, or .img files.

3. From the Stretch Type list, select whether to leave the image as is, Stretch to fill,
Zoom to fit, or Zoom to fill.

4.  From the Position in the Background list, select where to position the image and
then click OK.

5. Toadd multiple background images, repeat steps 1 through 4.

6. You can change the order of the background images. To do so, select a file from
the Background Images list and then click Up to move an image to the front and
Down to send an image to the back.

7.  Toeditthe backgroundimage, select the file from the Background Images list and
then click Edit.

STEP RESULT: The Background Image dialog appears. Edit as required.

8. Toremove a background image, from the Background Images list, select the file
and then click Remove.

9. (lick OKwhen done.

RESULT:

NOTE: The selected background image is implemented.

Miscellaneous

From the Configuration tree, expand 3D, and then select Miscellaneous to display the
Miscellaneous option:
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Display

The Show Global Axes option is active by default. Disable this option to remove the axes
that display in the bottom-right corner of the workspace.

You can change the size of the global axes by moving the Size of Axes slider. Move the slider
to the left to minimize the axes and to right to maximize.

Model Tree

Enter a value in the Expand Level field to define the level at which you want the Model Tree
to display when opening a 3D file. The default level is 3.

Alternately, select Expand On Demand to the collapse the whole tree.

Manipulator

Enable the Align with current UCS option to automatically align the manipulators with
the current User-defined Coordinate System.

Highlight Selection

The following Highlight Selection options let you define how AutoVue indicates that an
object is selected.

Option Description
Highlight Bounding Box Selection is enclosed in a wireframe box.
Highlight Entity Selection is indicated by changing color.
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Configuring AutoVue for EDA Files

There are configuration options that allow you to customize your work environment when
working with EDA files. To access the EDA configuration options, from the Options menu,
select Configure. In the Configuration dialog that appears, select EDA in the tree.

Customizing Selections

Configure how you want selected components to be highlighted. From the Configuration
tree, select EDA. There are two selection options: Highlight Entity and Dim Unselected.

Highlight Entity
Activate this option to highlight all entities that you select. This option is enabled by default.
NOTE: The default highlight color is yellow.
See Also “Modifying Colors”

Dim Unselected

Activate this option to dim all the entities that are not selected. Selected entities retain their
original entity color.

From the AutoVue toolbar, you can also click Dim Unselected .

When you select Dim Unselected, you can set the dimness level for entities that are not
selected. Drag the slider to the right to increase the dimness level and to the left to decrease
the dimness level. The icon to the right of the dimness settings in the Configuration dialog
lets you preview the dimness level.

Additionally, with Dim Unselected, you can select the Thicken Highlighted Entity check
box. This option makes the selected entity appear more pronounced. Deselect the check
box to return the entity to its default thickness.
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Displaying Tooltips

When you hover the mouse over an entity, a tooltip appears to show you information about
the entity. You can disable or enable these tooltips.

TASK
1.

From the tree, select EDA.

2. Underthe Mouse Hover heading, select or deselect the Show Entity Information
Tooltip option.
3. Click OK.
Modifying 3D View

You can configure the board thickness and component height for the 3D PCB view of EDA
files. Note that these Board Thickness and Component Height values are used only if the
underlying EDA file does not contain board thickness and component height information.

TASK
1.

2.

From the Configuration tree, select EDA.

Enter a value in the Default Board Thickness field to change the board'’s thick-
ness.

ADDITIONAL INFORMATION: The Default Board Thickness option only affects boards that
have no board thickness defined in the design. If a board has a defined thickness, this
option does not affect that board.

Enter a value in the Default Component Height field to change the component
height.
ADDITIONAL INFORMATION: The Default Component Height option affects components that

do not have height defined in the design. If a component has a defined height, this option
does not affect that component.

To work with a different unit of measurement, select another unit from the Default
Units list. This is the unit of measurement used for values set in the Default Board
Thickness and Default Component Height fields.

Reload the file to see your changes.

188

3/1/11



CONFIGURING AUTOVUE
CONFIGURING AUTOVUE FOR EDA FILES

Synchronizing Layers when Comparing Files

When you compare files, you can synchronize all layer settings. When the layer settings are
synchronized, changing one setting changes the same setting for both files you are
comparing.

NOTE: This option is selected by default and is only applicable for PCB drawings.

TAsK
1. From the tree, expand EDA, and then select Analysis.

2.  Selectthe Layer Settings option to synchronize all layer settings when comparing
files.

Configuring Zoom Behavior when Cross Probing

You can configure the zoom options when you cross probe files.

TASK
1. From the tree, expand EDA, and then select Analysis.

2. Select one of the following Cross Probe Action options:

a Select Keep Current Zoom Level. When this option is active, the view of the target
files remains the same while you cross probe.

b Select Zoom Selected to automatically zoom in on selected entities while you cross
probe. This option is enabled by default.

C Select Zoom Fit to automatically adjust the contents of a file along the horizontal
and vertical axis to fully display within the current window.

Modifying Colors

You can configure the colors for EDA files.
From the tree, expand EDA, and then select Colors.

In the Color Options dialog, the options that you can configure are grouped under
Common, PCB, and 3D View as follows:
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Common
Option Description
Background Set the background color for all views (except the PCB 3D view) and file types.
Selection Set the color when selecting an entity.
PCB
Option Description

Min. Distance Set 1

Set color for the first minimum distance set.

Min. Distance Set 2

Set color for the second minimum distance set.

Plated Drill Hole

Set color for plated drill holes. The default color is black.
To override the native color, select Override Native Color.

NOTE: Applicable to Cadence Allegro format only.

Non-plated Drill Hole

Set color for non-plated drill holes. The default color is black.

To override the native color, select Override Native Color.

NOTE: Applicable to Cadence Allegro format only.

3D View

Option

Description

Default Board Color

Configure the color of the board in 3D view.

Default Component Color

Configure the component color in 3D view.

Enhanced Display Options

You can configure the following enhanced display options for EDA files.
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Main Menu

Option

Description

Display Options

Plated Hole Visibility

Select whether to use the native
settings or turn on /off the plated hole
visibility.

NOTE: Applicable to Cadence Allegro
format only.

Non-plated Hole Visibility

Select whether to use the native
settings or turn on /off the non-plated
hole visibility.

NOTE: Applicable to Cadence Allegro
format only.

Pad Filling

Select whether to use the native
settings or turn on/off pad filling.

NOTE: Applicable to Cadence Allegro
format only.

Line Caps/Joins

Select whether to use the native
settings or turn on/off line caps/joins.

NOTE: Applicable to Cadence Allegro
format only.

Global Transparency

Move slider to select global
transparency level.

Configuring Background Colors for Graphic

Files

Specify background colors for mono raster files and color raster files.

TASK

1.

STEP REsuLT: The Configuration dialog that appears.

From the Options menu, select Configure.

Select Graphics in the tree.

From their respective Background lists, select colors for monochrome raster files
and color raster files.
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Configuring Background Colors for Desktop
Office

Specity background colors for the following types of Desktop Office files: Document,

Spreadsheet, Database and Archive.

TASK
1. From the Options menu, select Configure.
STeP RESULT: The Configuration dialog appears.

2.  Select Desktop Office in the tree.
3. Select a background color for each Desktop Office file type.
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Markups

AutoVue has the ability to view hundreds of different file formats and to create markups
for all its readable file formats without the document's authoring application.

Marking up refers to drawing and writing on an electronic document. When you create a
markup for a file, the markup is created on top of the original file. Markups are saved in
separate files.

NOTE: By default, markups are disabled for office formats. Office formats render differently
on different machines due to differences in fonts. As a result, markups may appear misplaced
with respect to the underlying text in the documents. If you want to re-enable markup
creation for office formats, you must ensure that all machines viewing the office formats have
the same fonts installed.

If a file has existing Markup files, the Markup Indicator icon # appears in the status bar
at the bottom of the AutoVue workspace. Clicking the Markup Indicator opens the Markup
Files dialog and allows you to select the Markup files to display.

Markup Files

Select Markup Filels)

Mame
aradz006.002
aradz2006.001 Import

When you open a Markup file, AutoVue layers the markup over the original file.
In Markup mode you can:
. Create entities such as text, arcs, boxes, circles, clouds, lines, arrows, and polygons.

. Add a stamp or information to an entity by adding a text or a note.
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. Create, name, and color layers to organize your work.

. Create a new Markup file that combines copies of selected layers of different Markup
files.

. Create measurement markup entities that can be moved or resized.

. Navigate markups through a hierarchy tree, view markup properties, and sort the tree
according to each property.

e View markup layers individually or in combination.

«  Press Esc at any point to cancel the markup creation.

NOTE: By default, markups are disabled for Office documents. For information on how to

enable markups for Office documents, refer to the “INI Options” chapter in the Installation
and Administration Manual.

Markup Navigation Tree

When you are in Markup mode, a Markup Navigation Tree appears below the workspace.
If the tree does not appear, from the Options menu, select Show Panel, and then select

Markup Panel.
Markups *
I arkup Entity |.t‘-\uth0r |LastM0dified iy |F'age |La_l,.ler |
= ( Untitled2

AI Text JobnDoe 04/09/200817:51:05 4k 1 ]

_’_ﬂ Leader JohnDoe 04/03/2008 11:51:08 &M 1 a

2| bnb JobnDioe 04/09/2008 11:51:22 Ak 1 ]

& Highlight JobnDoe 04/09/200817:57: 24 &M 1 ]

[ Beox JobinDoe 04/09/2008171:51:29 4 1 a

S Line JobnDoe 04/09/200817:51:31 Ak 1 ]

The tree displays a hierarchy of markups or comments created by users. You can navigate
through the markups. A set of properties is generated for each markup. You can sort the

markups in the tree according to each property by clicking the column headers. These
properties are:

Property Description
Markup Entity Type of markup entity created.
Author The name of the user who created the markup entity.
Last Modified The date and time the markup entity was last modified.

194

3/1/11



MARKUPS
FILTERING MAARKUPS

Property Description
Page Page number of the original document on which the markup entity is created.
Layer Markup layer on which the markup entity is created.

When a markup entity is created, it appears in the tree and the information is recorded and
saved in the Markup file.

NOTE: Hover your mouse over an entity to display its author and date properties.

Filtering Markups

When viewing markups, you have the option to filter the Markup files or entities that are
displayed based on their metadata information.

To do so, from the Markup menu, select Filter and then select one of the following options:
By Author, By Entity Types, By Last Modified, By Page, and By Layer. The Filter Markup
Visibility dialog appears.

NOTE: From the Markup Properties toolbar, you can also click Markup Filter ¥ .

. To display markups created by a specific author, click the Author tab and select the
check box next to the author’s name. To remove an author’s markup from the filter,
deselect the associated check box. In the Markup Navigation Tree, a filter icon
appears in the Author column header.

. To display markups by entity type, click the Markup Entity tab and select the check
box next to the markup entity or entities. To remove a markup entity from the filter,
deselect the associated check box. In the Markup Navigation Tree, a filter icon
appears in the Markup Entity column header.

. To display markups based on when they were last modified, click the Last Modified
tab. From the list, select one of the following options:

Option Description
Anytime Displays all markup entities.
Before Displays all markup entities modified before the

selected date.

After Displays all markup entities modified after the
selected date.
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Option Description

On Displays all markup entities modified on the
selected date.

Between Displays all markup entities modified between the
selected dates.

In the Markup Navigation Tree, a filter icon appears in the Last Modified column header.

«  To display markups by page location, click the Page tab and select one of the

following:
Option Description
All pages Displays markup entities on all the pages.
Current page Displays markup entities on the currently selected
page.
Page range Displays the markup entities on the selected page
range.

o  Todisplay markups by layers, click the Layer tab and select the check box next to the
layer or layers. To remove a layer from the filter, deselect the associated check box. In
the Markup Navigation Tree, a filter icon appears in the Layer column header.

NOTE: To remove the filters, from the Markup menu, select Filter, and then select Show All.

Working with Markup Files

Markups can be saved as separate Markup files while working with the same document.
You have the option to add user information to the Markup file, save and create separate
Markup files with different markup IDs, import and export Markup files, or change the
active Markup file.

Saved States

When you create and save a Markup file, the view state of the file is also saved. View states
include zoom level (extents), rotation and flip settings, transformation, section plane, and
visibility. When creating markups for 3D files containing imported models, the imported
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design becomes part of the view state. For EDA files, you can save user-defined layers sets
with markups.

See “Creating a User-Defined View”

State information is also saved with each markup entity. For instance, if you were at a
certain zoom level when you created a markup entity, AutoVue saves the information with
the markup entity. To “Go To” the state you were at when you created or modified the
markup entity, from the Markup tree, right-click the markup entity and then select Go To.

Creating a Markup File

To create a Markup file:

TASK
1. View a file that you want to markup.

2. From the Markup menu, select New.

ADDITIONAL INFORMATION: From the Markup Properties toolbar, you can also click New
Markup = .

RESULT:

AutoVue enters Markup mode and a new Markup file appears in the Markup Navigation
Tree.

See Also “Creating a Markup Layer”

Entering Markup Information

When creating a markup you can provide user information that you can save with the
markup.

From the Markup menu, select Properties. The Markup Information dialog appears.

Enter a user name, department, company name, company location, and telephone number.
Click OK to save your markup information and to close the dialog.
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Saving a New Markup File

To save a new Markup file:

TASK
1. From the Markup menu, select Save.

ADDITIONAL INFORMATION: From the Markup Properties toolbar, you can also click Save
Markup .

STEP RESULT: The Save Markup File As dialog appears displaying the Markup Information
that you entered when creating the markup.

Save Markup File As rg|
Markup I0: || K
Markup Information
Department
Cormpany
Lacation
Telephone #

2. Inthe Markup ID field, enter an ID consisting of any combination of characters or
numbers.

3. Click OK.

REsULT: The Markup file is saved. The markups and the Markup file remain displayed in the
workspace and in the Markup Navigation tree.

Opening Markup Files

To open a Markup file:

TASK
1. View afile that has existing markups.
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From the Markup menu, select Open.

ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Open Markup(s)
=, or from the bottom-left corner of the status bar, you can click Markup Indicator .

ADDITIONAL INFORMATION: If the Markup Indicator icon does not display, then the file you
opened has no existing markups associated to it.

STEP RESULT: The Markup Files dialog appears.

From the Markup list, select the check box next to Markup file you want to open.

ADDITIONAL INFORMATION: If you select more than one Markup file, the Active Markup menu
lets you select which one of them is initially active. See “Setting the Active Markup File” for
more information.

Click OK.

RESULT: The selected markup or markups appear in the workspace on top of the original

file.

NOTE: When you select more than one Markup file, the markups display simultaneously.

Saving an Existing Markup File

To save a modified existing Markup file, from the Markup menu, select Save.

NOTE: From the Markup Properties toolbar, you can also click Save Markup .

If you have multiple markups open that you have modified and want to save them all, from
the Markup menu, select Save All.

To save an existing markup as a new markup, from the Markup menu, select Save As.

Importing a Markup File

To import a Markup file on top of the original file:

TAsK
1.

From the Markup menu, select Open.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Open Markup(s)

>

STEP RESULT: The Markup Files dialog appears.

Click Import.
STEP RESULT: The Select Markup File to Import dialog appears.
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3.  Navigate to the markup file that you want to import and select it.
4. Click Open.

ResuLT: The imported Markup file appears in the workspace on top of the original file.

Exporting a Markup File

To export a Markup file:

TAsK
1. From the Markup menu, select Save As.
ADDITIONAL INFORMATION: For a new Markup file, you can also click Save Markup )
STEP RESULT: The Save Markup File As dialog appears.
2.  Click Export.
STEP RESULT: The Save As dialog appears.
Navigate to the location where you want to export the Markup file.
4.  Enterfile name.

Click Save.

RESULT:
The Markup file is exported to the selected directory.

The default format saved is Markup Files (*.*), but you can select another one. In the Save
as Type list, there are six formats to choose from:

. Markup Files (*.*)

. DXF Output (*.dfx)

. AutoCAD DWG (*.dwg)

. Microstation DGN Output (*.dgn)
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Setting the Active Markup File

A file can have several Markup files. When you open several Markup files simultaneously,
you can set one as the active Markup file. Any changes you make is applied to the current
active markup.

TASK
1. From the Markup menu, select Open.

ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Open Markup(s) =,
or from the bottom-left corner of the status bar, you can click Markup Indicator #. If the
Markup Indicator icon does not display, the file you opened has no existing markups asso-
ciated toit.

STEP RESULT: The Markup Files dialog appears.
2. From the Markup list, select the markup or markups you want to open.

3. From the Active Markup list, select the markup you want to make active.
ADDITIONAL INFORMATION: An active markup displays in bold in the Markup Navigation Tree.

4.  Click OK.

RESULT:

The selected markups appear in the AutoVue workspace.

Changing the Active Markup File

When you have multiple Markup files open, you can change the active markup.
NOTE: An active markup displays in bold in the Markup Navigation Tree.
Take one of the following steps:

. In the tree, right-click the name of the Markup file you want to make active, then
select Set Active.

. From the Markup toolbar, you can set the active markup by selecting a markup from
the list on the Markup Properties toolbar.

o  Take the following steps:

From the Markup menu, select Set Active.The Set Active Markup dialog appears.From the
Select Active Markup list, select the markup you want to make active. Click OK to make the
selected Markup file active.
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Working with Markup Layers

Markup files can be divided into layers with each layer having its own unique name. You
can create, name, and color layers to organize your work. For example, different colors can
indicate time priorities and each layer can contain markups with a common purpose.

When working with markup layers, you can view layers individually or in combination,
add, rename, or delete layers. You can also specify a different color for each layer.

NOTE: The default layer color is red.

See Also “Moving a Markup Entity to Another Layer”

Creating a Markup Layer

From the Markup Layers dialog, you can create a markup layer.

TASK
1. From the Markup menu, select Markup Layers.

STEP RESULT: The Markup Layers dialog appears.

Markup Layers PX|
Markup Lavers
Markup M...  Laver Mame | COLOR Al on
acadz006.002 [0 Red
acadz006,001 |0 Fed Al Cff
Linkitled 0 Fed
Lntitleds 0 Red
Mew, ..
Currently Active Layer |III W
[ oK l [ Cancel

2.  Click New.
STEP RESULT: The New Markup Layer dialog appears.

3.  Enter a name for the markup layer.
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Click OK.
STEP RESULT: The new markup layer is added to the list in the Markup Layers dialog.

To change the color of the new layer, click Color.
STEP RESULT: The Layer Color dialog appears. The default layer color is red.

Select a color and click OK.

Click OK to close the Markup Layers dialog.

Setting the Active Markup Layer

A markup can have several layers and you can set a layer as the active markup layer. When
a markup layer is active, all modifications you make are applied to that markup layer. There
are two ways in which to set a layer as active:

TASK
1.

From the Markup menu, select Markup Layers.
STEP RESULT: The Markup Layers dialog appears.

You can perform one of the following:

. From the Markup Layers list, select the layer you want to make active, and click Set
Active.

. From the Currently Active Layer list, select the layer you want to make active.

Click OK.

Changing the Color of a Markup Layer

After you create a markup layer, you have the option to change the color of its markup enti-

ties.

TASK

1. From the Markup menu, select Markup Layers. The Markup Layers dialog
appears.

2. From the Markup Layers list, select the markup layer whose color you want to
change.

3. (lick Color.
STEP RESULT: The Layer Color dialog appears.

4.  Selecta Color.
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Click OK.

ADDITIONAL INFORMATION: Only the entities that were created with the By/ayerg color
defined in the Markup Layers dialog will change color. Any entities that were created
using the color options from the Markup Properties toolbar, will override the Bylayer g
color and will not change.

Click OK to close the Markup Layers dialog.

Renaming a Markup Layer

After you create a markup layer, you have the option to rename the layer.

TASK
1.

From the Markup menu, select Markup Layers. The Markup Layers dialog
appears.

From the Markup Layers list, select the markup layer you want to rename.
Click Rename.

STEP RESULT: The New Markup Layer dialog appears.

Enter the new layer name.

Click OK.

STEP RESULT: The markup layer is assigned the new name.

Click OK to close the Markup Layers dialog.

Toggling between Markup Layers

From the Markup Layers dialog, you can choose to show or hide a layer and its associated
markup entities.

TASK
1.

From the Markup menu, select Markup Layers. The Markup Layers dialog
appears.
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2. Toshowr/hide a layer or layers, perform one of the following:

a Select a layer and click Toggle. The layer’s check box will switch between selected
and deselected. To view all the markup layers, click All On. To hide all markup layers
click All Off.

b From the Markup Layers list, select the check box next to the layer or layers you want
visible, and deselect the check box next to the layer or layers you want to hide.

3. Click OK.
RESULT:

The markup entities belonging to the selected layer or layers appear in the workspace on
top of the original file.

Deleting a Markup Layer

From the Markup Layers dialog, you can choose to delete a selected layer and its associated
markup entities.

TASK
1.

From the Markup menu, select Markup Layers.
STEP RESULT: The Markup Layers dialog appears.

2. From the Markup Layers list, select the markup layer you want to delete.
Click Delete.

4.  Click OK.

RESULT:

The layer or layers are deleted along their associated entities.

Moving a Markup Entity to Another Layer

Once you create a markup entity, it is possible to assign it to a pre-existing markup layer.

TASK
1.

2.

Select the markup entity or entities that you want to move.

From the Markup menu, select Format, and then select Move to Layer.

ADDITIONAL INFORMATION: You can also right-click the markup entity, select Format, and
then select Move to Layer.

STEP RESULT: The Move to Layer dialog appears.
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3. From the Layers list, select the destination layer.
4. Click OK.

RESULT:

The selected markup entity or entities are moved to the selected layer. Only markup entities
using the ByLayer color will change to the new layer’s color.

See Also “Working with Markup Entities”

Consolidating Markup Files

The Consolidate option allows you to create a new Markup file that combines copies of
selected layers of different Markup files. During the review cycle, consolidation simplifies
document revisions by providing the author with one combined Markup file instead of
several Markup files. Note that the Consolidate option is only active when more than one
Markup file is opened.

TASK
1. Open the Markup files that you want to consolidate.

2. From the Markup menu, select Consolidate.
STEP RESULT: The Consolidate Markups dialog appears.

3. Select the markup layers that you want to consolidate into one file. To select
multiple layers, press the Shift or Control key while selecting.

ADDITIONAL INFORMATION: To select all the layers click Select All, and to deselect all the layers
click UnSelect All.

4.  Inthe Markup ID field, enter an ID for the new Markup file.

If you want to open the newly consolidated markup as the active markup, select
the Open as Active Markup check box.

6. Click OK.

RESULT:

The consolidated Markup file is saved. If you selected Open as Active Markup, the consol-
idated markup opens and is set as the active markup.
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Marking up 2D and 3D Files

AutoVue provides a number of markup options that display the same behavior when
marking up 2D or 3D files. You can add markup entities such as attachments, hyperlinks,

signoffs, and stamps.

See Also “2D-Specific Markups” for information on markup entities that are specific to 2D

files.

See Also “3D-Specific Markups” for information on markup entities that are specific to 3D

files.

NOTE: When you are creating a markup entity, you can press the Escape key to cancel.

The following table lists common markup entities for 2D and 3D files.

Option

Description

Attachment

Add an attachment entity to the markup.

From the Markup Entity toolbar, you can also click Attachment %\ .
See “Adding an Attachment”

Hyperlink

Click the workspace to attach a hyperlink.

From the Markup Entity toolbar, you can also click Hyperlink %,
See “Adding a Hyperlink”

Intellistamp

Add a stamp on a document in a connected and disconnected environment.
Includes specific document and user information (metadata) pulled directly
from the DMS/ERP/PLM/UCM system.

From the Markup Entity toolbar, you can also click Intellistamp 2}

See “AutoVue Mobile”
“Adding an Intellistamp”

Signoff

Create an approval stamp containing information about the markup author, date
and time of creation.

5
From the Markup Entity toolbar, you can also click Signoff #~ .
See “Adding Signoff Entities”

Stamp

Click and drag a stamp from the dialog box to the workspace.

From the Markup Entity toolbar, you can also click Stamp %% .
See “Adding a Stamp”
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Adding an Attachment

You can attach a file of any type (for example, text, audio, or video) as a markup entity. The
attachment is embedded into the markup entity and displays as an icon the display.

TAsK
1. From the Markup menu, select Add Entity, and then select Attachment.
ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Attachment

2.  Click on the drawing where you want to add an attachment.
STEP RESULT: The Attach File dialog box appears.

3. Inthe Attachment Name field, enter a name for the attachment. Optionally, you
can also provide a brief description of the attachment in the Description box.

4. Inthe Data File field, enter the path to the file or click Browse.The Open dialog
box appears.

5.  Select the file and click Open.
ADDITIONAL INFORMATION: You can attach any local file.

6. Select Open with AutoVue to open the attachment. Deselect Open with
AutoVue to open the file in its native program.

7. Todisplay the attachment as an specificimage, click Set Icon.The Open dialog box
appears.

8.  Select the image and click Open.
ADDITIONAL INFORMATION: You can only select bitmap images (.bomp).

9. Click OK to close the Attach File dialog box.

STEP RESULT: The attachment appears on the markup workspace and in the Markup Navi-
gation Tree.lf you selected Set Icon, the selected icon appears as the attachment on the
markup.

10. Right-click in the workspace to complete the attachment.

ADDITIONAL INFORMATION: To open the attachment, double-click on it. It will open in the
application selected in step 6.

Opening an Attachment

In the Markup Navigation tree, right-click the attachment entity, select Attachment, and
then select one of the following:

. Open: If Open With AutoVue was selected while attaching the file, it will open in a
new AutoVue window. Otherwise, it will in its native application.
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Open With: You have the option to open the attachment with AutoVue, Desktop
Version or Associated Application.

Editing an Attachment

TASK
1.

In the Markup Navigation Tree, right-click the attachment and select Edit, or
double-click the markup entity.

STEP RESULT:  The Attach File dialog appears.

2. Make your changes and click to OK.
STeP RESULT: The dialog closes and modifications are implemented.
Adding a Hyperlink

A hyperlink is a link between the current file and a new file or application. You can create
hyperlinks in your current file so that your files and applications outside AutoVue are only
a click away. The main benefit of adding hyperlinks is that the files are accessible from one
location but the information is referenced, not duplicated. This ensures a manageable file
size when loading. If changes need to be made to a linked file, they need to be done in one
location—the linked file itself.

Creating a Hyperlink

TASK
1.

From the Markup menu, select Add Entity, and then select Hyperlink.
ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Hyperlink %,

Click a point on the document where you want to place the hyperlink.
STEP RESULT: The Establish Hyperlink dialog box appears.

Enter a Link Name.

Optionally, enter a Link Description.
ADDITIONAL INFORMATION: From the Link To list, select the type of link.
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Link To Description
Data File Opens a document file.
Application Opens an application other than AutoVue.
AutoVue Script Runs the script command entered in the linked file.
DDE Server Connects to a DDE server and executes command entered in linked
file.
DLL Function Evokes a function defined in the DLL.

STEP RESULT: The link changes according to the selected link.

5.  Click Browse to locate the data file or application and its path that you want to link
to, or enter the information manually.

ADDITIONAL INFORMATION: For Application, ensure that the executable file is selected. For
example, mspaint.exe.

6. To change the hyperlink icon, click Set Icon. The Open dialog box appears.

7.  Enter the file name or browse to locate the bitmap file that you want to use as the
icon, then click Open.
8.  (lick OKto close the Establish Hyperlink dialog box.

ADDITIONAL INFORMATION: If you changed the icon, the selected icon appears as the hyperlink
on the markup.

STEP RESULT: The hyperlink appears on the markup.

Opening a Hyperlink

To open a hyperlink, double-click on it from the workspace.

The hyperlink file opens in the window you selected in the Establish Hyperlink dialog.

Editing a Hyperlink

TASK

1. Inthe Markup Navigation Tree or from the workspace, select the hyperlink that
you want to edit.
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From the Markup menu, select Format, and then select Edit Hyperlink.

ADDITIONAL INFORMATION: You can also right-click the hyperlink and select Format, and then
select Edit Hyperlink.

STEP RESULT: The Establish Hyperlink dialog appears.
Edit the information that you want.

Click OK to close the Establish Hyperlink dialog.

RESULT:

The changes are saved.

Deleting a Hyperlink

TASK
1.

In the Markup Navigation Tree or from the workspace, select the hyperlink that
you want to delete.

2. From the Markup menu, select Format, and then select Remove Hyperlink.
ADDITIONAL INFORMATION: ' You can also right-click the hyperlink and select Format, and then
select Remove Hyperlink. You can also delete the hyperlink by selecting the hyperlink
and pressing the Delete key on your keyboard.

RESULT:

The hyperlink is deleted.

Adding Signoff Entities

The Signoff entity is an approval stamp containing information about the markup author,
date, and time of creation. You create a signoft entity when the Markup file is finalized.

NOTE: If a markup is modified after a signoff is created, the signoff disappears (is rescinded)
from the workspace but remains in the Markup Navigation tree. Double-click on the signoff
entity in the tree to view the signoff history—the person who rescinded the signoff, the creation
date, and the drop date.

TASK

1.

From the Markup menu, select Add Entity, and then select Signoff.
s
ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Signoff «~
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2.  (lick and drag to create a box on the drawing where you want the signoff.
STEP REsuLT: The Signoff dialog appears displaying details of the signoff.

3.  Click OK.

RESULT:

The signoff entity appears on the drawing and in the tree, and displays the author, creation
date, and approval date.

Rescinding the Signoff

You can rescind a signoff on a drawing.

TASK

1. Inthe Markup Navigation tree or in the workspace, double-click the signoff
markup entity.

4
ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Signoff .
STEP RESULT: The Signoff dialog appears.

2.  Click Rescind.

RESULT:

The signoff disappears from the drawing but remains in the Markup Navigation Tree.

Re-Approving a Signoff

To re-approve the signoff that has been rescinded:

TASK
1. Inthe tree, double-click the signoff markup entity. The Signoff dialog appears

2. Click Approve.

RESULT:

The signoff entity re-appears on the drawing and the tree.
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Viewing the History of a Signoff

TASK
1. From the Markup menu, select Add Entity, and then select Signoff.
4
ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Signoff # .
2. C(lick History.

STEP RESULT: The Signoff History dialog appears displaying the author, date and time the
signoff was created.

3.  Click Cancel to close the Signoff dialog.

Adding an Intellistamp

The Intellistamp markup entity lets you create a stamp that includes document and user
information (metadata) pulled directly from the backend DMS/ERP/PLM/UCM system.
To add an Intellistamp markup entity to a document, do the following:

NOTE: With the Desktop Version, you can add an Intellistamp only when you are marking
up a Mobile Pack, and only if the Mobile Pack was created from a backend system that
contains an Intellistamp definition.

See “AutoVue Mobile”

TASK
1. Enter Markup mode.

2. From the Markup menu, select Add Entity, and then select Intellistamp.
ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Intellistamp

)

_ 30

3. Inthe workspace, click and drag a box to the desired Intellistamp size.
STEP RESULT: The Intellistamp dialog appears.

4.  From the Choose Stamp box, select the desired Intellistamp.
ADDITIONAL INFORMATION: To resize the Intellistamp, select Enable Resizing.

5. Click OK.

STEP RESULT: The Intellistamp dialog closes and the Intellistamp appears in workspace and
in the Markup Entity Tree.

6.  Right-click the workspace to complete the Intellistamp placement.
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Viewing/Modifying Intellistamp Attributes

You can view the attributes of an Intellistamp by double-clicking the Intellistamp markup
entity. The DMS Attributes dialog appears listing all attributes of the Intellistamp.

NOTE: All attributes tagged hidden will also display in the Attributes dialog box.

The dialog box contains three columns that include attribute values defined in the design
stage:

. The Name column displays the attribute name as defined in the design stage. It will
either display the backend DMS/ERP/PLM/UCM system-defined attribute name or
the user-defined name.

o The Value column displays the assigned value. If the attribute is not marked as
read-only in the design stage, you can modify the value.

o The Value from DMS column displays the value assigned from the backend system.
The DMS dialog contains two buttons: Commit Changes and Reset:

. Click the Commit Changes button to upload the changes made to the DMS Attri-
butes dialog to the Mobile Pack.

. Click the Reset button to reset the Intellistamp attribute values to those defined in the
Mobile Pack.

When you are done modifying the attribute, click OK to finalize your changes and to close
the DMS Attributes dialog.

Adding a Stamp

A Stamp is a graphical entity, such as a company logo. Before a graphic entity can be used
as a stamp, it must be added to a Stamp Library. You can create a Stamp Library and add
stamps to it. You can also add or remove stamps from existing libraries.
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NOTE: If you need to add a stamp that includes any document or user information, you must
use the Intellistamp markup.

From the Markup menu, select Add Entity, and then select Stamp.
ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Stamp % .

STEP RESULT: The Stamps dialog appears.

Stamps

Skamp Library

|Status b |

Drag and drop stamp inko Aukobiue

APPROLED:

Draft

<

Scaling

() Isotropic () Anisotropic
Selected Stamp:

Source File:

Skamp Mame:

Descripkion:

Click the Stamps tab.

From the Stamp Library list, select the library from which you want to select a

stamp.

STEP RESULT: The stamps appear for the selected library.

Click Isotropic if you want to scale the stamp proportionately.

Click Anisotropic if you want to scale the stamp disproportionately.

3/1/11

215



MARKUPS
MARKING UP 2D AND 3D FILES

6. Drag the stamp onto the workspace.
ADDITIONAL INFORMATION: To add more stamps, repeat steps 3 to 5.
STEP RESULT: The stamp appears on the drawing and in the Markup Navigation Tree.

7.  Close the Stamps dialog.

Creating a New Stamp Library

TASK

1. From the Markup menu, select Add Entity, and then select Stamp.The Stamps
dialog appears.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Stamp = .
2. (lick the Libraries tab.

3.  Click Create.
STEP RESULT: The Stamp Library dialog appears.

Stamp Library El

Selected Files

Marne: |

Aukhor: |

|
Description: | |
|
|

kKeywaords: |

[ O ][ Cancel ][ Help ]

4.  Enterthelibrary name, description, author, and keywords in their respective fields.

5. Toadd astamp to the library, click Add.
STEP RESULT: The Open dialog appears.
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6. Browse to locate the stamp you want to add, and then click Open.

ADDITIONAL INFORMATION: To add more stamps, repeat steps 4 to 6. To remove a stamp,
select the stamp and click Remove.

STEP REsULT: The file appears in the Stamp Files list.

7.  Close the Stamps dialog.

Adding a Stamp to a Library

TASK

1. From the Markup menu, select Add Entity, and then select Stamp.The Stamps
dialog appears.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Stamp % .
2. Click the Stamps tab.

From the Stamp Library list, select the library that you want to add a stamp.
4. Click Add Stamp.

STEP RESULT: The Stamp Definition dialog appears.

5.  Enterthe sourcefile, stamp Name, and description in their respective fields, or click
Browse to locate the source file.

6. Click OK.
ADDITIONAL INFORMATION: To add more than one stamp, repeat steps 4 and 5.

STEP RESULT: The stamp appears under the Drag and Drop a Stamp onto AutoVue section
in the Stamps dialog.

7.  Close the Stamps dialog.

Deleting a Stamp from a Library

TASK

1. From the Markup menu, select Add Entity, and then select Stamp.The Stamps
dialog appears.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Stamp %«
2.  Click the Stamps tab.

3. From the Stamp Library list, select the library which contains the stamp you want
to delete.

4.  The stamps appear in the Drag and Drop a Stamp onto AutoVue section.
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5.  Select the stamp you want to delete, then click Delete.
STEP RESULT: The stamp disappears from the library.

6. Close the Stamps dialog.

Editing Stamp Library Information

TASK

1. From the Markup menu, select Add Entity, and then select Stamp.
ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Stamp %« .
STEP RESULT: The Stamps dialog appears.

2. Click the Libraries tab.
From the Stamp Libraries list, select the library that you want edit.

4.  Click Edit.
STEP RESULT: The Stamp Library dialog appears.

5.  Edit the information.
6. Click OK.
7.  Close the Stamps dialog.

Deleting a Stamp Library

TASK

1. From the Markup menu, select Add Entity, and then select Stamp.The Stamps
dialog appears.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Stamp % .
2. (lick the Libraries tab.
From the Stamp Libraries list, select the library that you want to delete.

4.  Click Delete.

STEP RESULT: The library disappears from the list and from the Stamp Library list under the
Stamps tab.

5.  Close the Stamps dialog.
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2D-Specific Markups

AutoVue provides a variety of user-friendly markup options that you can use when
marking up 2D files. You can create entities such as arcs, boxes, circles, clouds, lines, and
polygons. You can draw a leader with multi-line segments and add text to it.

NOTE: When you are creating a markup entity, you can press the Escape key to cancel.

2D Markup Entities

You can create many different types of markup entities. To access the markup entities, from
the Markup menu, select Add Entity. The markup entities are:

Option

Description

workspace.

To complete a markup entity (for example, to finish creating a box), simply right-click in the AutoVue

Arc

Click and drag the mouse to draw an Arc.

From the Markup Entity toolbar, you can also click Arc o)

Attachment

Add an attachment entity to the markup.

From the Markup Entity toolbar, you can also click Attachment %\ .
See “Adding an Attachment”

Box

Click and drag to draw a rectangle.

From the Markup Entity toolbar, you can also click Box [].
To draw a square instead of a rectangle, press and hold the Shift key while you
click and drag.

Cloud

Click and drag to draw a Cloud.
From the Markup Entity toolbar, you can also click Cloud .

Circle

Click and drag to draw a circle.

From the Markup Entity toolbar, you can also click Circle Q.
To draw a circle instead of an ellipse, press and hold the Shift key while you click
and drag.

Freestyle

Click, release mouse button, then drag to draw an entity.

From the Markup Entity toolbar, you can also click Freestyle %
You can create a contiguous or non-contiguous freestyle entity.
See “Adding a Freestyle Entity”
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Option Description

Highlight Click and drag to highlight a boxed area.

From the Markup Entity toolbar, you can also click Highlight &,
The highlighted box will be filled with a transparent color.

Hyperlink Click the workspace to attach a hyperlink.

From the Markup Entity toolbar, you can also click Hyperlink %
See “Adding a Hyperlink”

Intellistamp Add a stamp on a document in a connected and disconnected environment.
Includes specific document and user information (metadata) pulled directly
from the DMS/ERP/PLM/UCM system.

From the Markup Entity toolbar, you can also click Intellistamp S,?.

Leader Click and drag to draw a leader.

From the Markup Entity toolbar, you can also click Leader .

To force a line segment in a Leader entity to be aligned to the closer axis,
horizontal or vertical axis, hold the Shift key while you click and drag for that
line segment.

See “Adding a Leader”

Line Click and drag to draw a line.

From the Markup Entity toolbar, you can also click Line / .

To draw a line and force it to be aligned to the closer axis, horizontal or vertical,
press and hold the Shift key while you click and drag.

See “Aligning a Line Segment to the Vertical or Horizontal Axes”

Measurement Create markup measure entities.
. . . —> P
From the Markup Entity toolbar, you can also click Distance ==, Area i,

Angle i , Arc M , or Minimum Distance {1,

See “Creating 2D non-Vector Markup Measure Entities”
“Creating 2D Vector Markup Measure Entities”
“Creating EDA Markup Measure Entities”

Note Add a note to the markup.

From the Markup Entity toolbar, you can also click Note —= .
See “Adding a Note”

Polygon Click and drag to draw a polygon.
From the Markup Entity toolbar, you can also click Polygon A
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Option

Description

Polyline

Click and drag to draw a polyline.

From the Markup Entity toolbar, you can also click Polyline - |

To force a line segment in a Polyline entity to be aligned to the closer axis,
horizontal or vertical, press and hold the Shift key while you click and drag for
that line segment.

See “Aligning a Line Segment to the Vertical or Horizontal Axes”

Signoff

Create an approval stamp containing information about the markup author, date
and time of creation.

5
From the Markup Entity toolbar, you can also click Signoff # .
See “Adding Signoff Entities”

Stamp

Click and drag a stamp to the markup.

From the Markup Entity toolbar, you can also click Stamp %% .
See “Adding a Stamp”

Text

Add text to the markup.

From the Markup Entity toolbar, you can also click Text Al
See “Adding Text”

Adding a Freestyle Entity

You can create a freestyle markup entity. You have the option of making the entity
non-contiguous or contiguous.

Creating a Non-Contiguous Freestyle Entity

TASK

1.

v A WN

From the Markup menu, select Add Entity, and then select Freestyle.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Freestyle Ze,

Click a point on the drawing where you want to start the Freestyle entity.
Move the cursor to create the Freestyle entity.
Click a point on the drawing where you want to interrupt the Freestyle entity.

Click another point on the drawing where you want to restart the Freestyle entity.

ADDITIONAL INFORMATION: You can interrupt the Freestyle entity as many times as you like by
repeating steps 4 and 5.

Right-click to end the Freestyle entity.
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2. Click a point on the drawing where you want to start the Freestyle entity.
Move the cursor to create the Freestyle entity.

4. Right-click to end the Freestyle entity.

Adding a Leader

TASK

1. From the Markup menu, select Add Entity, and then select Leader.
ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Leader .

2. (lick a point on the document where define the Leader anchor point.

3. Move the cursor to draw the Leader.
ADDITIONAL INFORMATION: To draw a Leader segment and force it to be aligned to the closest
axis, vertical or horizontal, hold the Shift key while moving the cursor.

4. Todraw aLeader with multiple line segments, repeat steps 2 and 3 as often as you
like. You can click, then drag as often as you like.

5. Right-click to end the Leader. A text box appears at the end of the Leader.

6. Inthe text box, enter the text you want to attach to the Leader.
STEP RESULT: The height of the text box will resize to fit the entered text.

7.  Tochange text box font properties, from the Markup menu, select Format, and
then select Font.
ADDITIONAL INFORMATION: From the respective font property lists on the Markup Properties
toolbar, you can also modify the font type, style, and size
STEP RESULT: The Font dialog appears allowing you to change the font type, style, and size.

8. Click OK to implement the font changes and to close the Font dialog.

9. Tochange the line properties or fill color of the Leader, select the Leader, then

Creating a Contiguous Freestyle Entity

TAsK
1.

From the Markup menu, select Add Entity, and then select Freestyle.
ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Freestyle %,

from the Markup menu, select Format, and then select the property or properties
you want to change.

ADDITIONAL INFORMATION: From the respective line property lists on the Markup Properties
toolbar, you can also modify the line style, line thickness, fill types, and fill colors.

222

3/1/11



MARKUPS
2D-SPECIFIC MARKUPS

10. Right-click outside the text area to complete the modification.

ADDITIONAL INFORMATION: To edit the Leader text, double-click the Leaderin the tree orin the
workspace.

STEP RESULT: The text appears on the drawing and in the Markup Navigation Tree.

Aligning a Line Segment to the Vertical or Horizontal Axes

A line segment drawn with the Free Snap snapping mod can be forced to align with the
closer horizontal or vertical axis. You can also take an existing line segment and have it
align with the closer axis. The types of line segments that you can align are lines, line
segments of leaders and polylines, and measure entities.

See “2D Vector Snapping Modes”for more information Free Snap.

TASK

1. Todraw and force a line segment, press and hold the Shift key while you click and
drag for that line segment.

2. Toforce an existing line segment, click and hold the left mouse button on the line
segment, then press and hold the Shift key.

3. Whenyou see that the line segment is horizontal or vertical, release the left mouse
button, then release the Shift key.

Creating 2D non-Vector Markup Measure Entities

When marking up 2D non-vector files, in addition to all the markup options available for
2D files, you can create markup measure entities. The measure options in Markup mode
work a bit differently than in View mode.

See “2D-Specific Markups”

When measuring in Markup mode, the specified measurement lines and values are
displayed on the current active markup layer as entities. These entities can be moved,
resized, or deleted. You can also modify the font of a measure entity, align a “free snap”
measure entity to the horizontal or vertical axis, as well as add units of measure and symbols
to a measurement and have them appear on the drawing.

NOTE: When you are creating a markup entity, you can press the Escape key to cancel.

Measure options vary between vector and non-vector files. For vector files, AutoVue
provides the option to “snap” to fixed points on the drawing. For non-vector files, you can
only “free snap”.

3/1/11

223



MARKUPS
2D-SPECIFIC MARKUPS

In Markup mode, you can choose from several measure options to create markup measure
entities. From the Markup menu, select Add Entity, and then select Measurement to
access the following measure options:

Option Description

Angle Measure the angle between selected points.

From the Markup Entity toolbar, you can also click Angle =

Arc Measure an arc entity.

From the Markup Entity toolbar, you can also click Arc | &

Area Measure a selected area.

From the Markup Entity toolbar, you can also click Area =

Distance Measure the distance between two points.

From the Markup Entity toolbar, you can also click Distance .

Measuring Distance

Use the Distance option to measure the distance between two specific points.

See “Changing Measurement Units and Symbols”

“Changing Font”

TASK

1. From the Markup menu, select Add entity, select Measurement, and then select
Distance.

ADDITIONAL INFORMATION: The Measurement Entities dialog appears.From the Markup Entity

2. From the Measured Distance Units list, select the unit in which you want to
measure the distance.

Click a point on the drawing to define the starting point.

4.  Click another point on the drawing to define the end point.
STEP RESULT: The measured line path appears as an entity on the current active markup.
5. Move the cursor and click a location on the drawing to display the measure
distance.

STEP RESULT: The measurement and unit appear in a value box entity on the current active
markup layer. The measured distance, Delta-X, and Delta-Y appear in the Measurement
Entities dialog.

6. To resize the value box, select it and then click and drag the frame handles.
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7.

8.

You can click and drag the text box anywhere on the drawing.

ADDITIONAL INFORMATION: To make another measurement, click Reset.

Click Close to close the Measurement Entities dialog.

Measuring Cumulative Distance

Use the Cumulative Distance option to measure the distance along a path of multi-faceted
(adjoining) points.

TAsK
1.

From the Markup menu, select Add entity, select Measurement, and then select
Distance.

ADDITIONAL INFORMATION: The Measurement Entities dialog appears.From the Markup Entity

From the Measured Distance Units list, select the unit in which you want to
measure the distance.

Select Cumulative.
Click a point on the drawing to define the starting point.

Continue clicking points along the path that you want to measure.
STEP RESULT: Each point is joined by a line.

Right-click to complete the measurement.
ADDITIONAL INFORMATION: To make another measurement, click Reset.

STEP RESULT: The measured line path, cumulated measurement and unit appear in a value
box entity on the current active markup layer. The cumulated measured distance, Delta-X,
and Delta-Y appear in the Measurement Entities dialog.

Click Close to close the Measurement Entities dialog.

Calibrating Distance

Calibrate the distance measurement.

TASK
1.

2.

Measure distance between two points or measure cumulative distance.

From the Distance tab, click Calibrate.
STEP RESULT: The Distance Calibration dialog appears displaying the measured distance

From the Units list, select the unit to which you want to calibrate the distance.
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4.  Select Calibrate to and enter a value if you want to calibrate the distance to a
value.

5.  Select Set Factor and enter a value if you want to calibrate the distance by a factor.
6. Click OK.

STEP RESULT: The calibration result appears in the Measurement dialog.

7. Click Close to close the Distance tab.

Measuring Area

Use the Area option to measure the area and perimeter of a region.

TASK

1. From the Markup menu, select Add entity, select Measurement, and then select
Area.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Area <.

STEP RESULT: The Measurement Entities dialog appears.

2. From the Measured Area Units list, select the unit in which you want to measure
the area.

3. From the Perimeter Units list, select the unit in which you want to measure the
perimeter.

To cumulate a Net Area Result of different areas, select Add.
To subtract an area from the Net Area Result, select Subtract.
Select Clear to clear the Net Area Result field.

Click a point on the drawing to define the starting point.

®© N o v »

Continue clicking points on the drawing to define the area you want to measure.
STEP RESULT: Each point is joined by a line.

9. Rightclick to complete the measurement.
ADDITIONAL INFORMATION: To make another measurement, click Reset.

STEP RESULT: The measured line path, measurement and unit appear in a value box entity
on the current active markup layer. The area and perimeter measurements appear in the
Measurement Entities dialog.

10. Click Close to close the Measurement Entities dialog.
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Measuring an Angle

Use the Angle option to measure the angle between points on a drawing.

TASK
1.

From the Markup menu, select Add entity, select Measurement, and then select
Angle.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Angle ~=}
STEP RESULT: The Measurement Entities dialog appears.

From the Measured Angle Units list, select the unit in which you want to measure
the angle.

Click points on the drawing to define the angle you want to measure:

. The first click defines the starting point of the angle measurement.
. The second click defines the vertex of the angle measurement.

. The third click defines the endpoint of the angle measurement.

. The points are joined by angle arms with an arc connecting them.

Move the cursor to increase or decrease the radial and arc length.

Click again to complete the measurement.

STEP RESULT: The measured line path, angle measurement and unit appear in a value box
entity on the current active markup layer. The measured angle also appears in the
Measurement Entities dialog.

To resize the value box, select it and then click and drag the frame handles.

You can click and drag the value box anywhere on the drawing.

ADDITIONAL INFORMATION: To make another measurement, click Reset.

Click Close to close the Measurement Entities dialog.

Measuring an Arc

Use the Arc option to define an arc in the drawing and measure its radius, center and diam-

eter.

TASK
1.

From the Markup menu, select Add entity, select Measurement, and then select
Arc.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Arc 2.
STEP RESULT: The Measurement Entities dialog appears.

From the Arc Info Length list, select the unit in which you want to measure the arc.
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3. From the Measured Angle Units list, select the unit in which you want to measure
the angle. The options are degrees or radians.

4.  Select Add Radius if you want to measure the radius of the arc.
Select Add Diameter if you want to measure the diameter of the arc.

6.  Click three points on the drawing to define the arc you want to measure.
STEP RESULT: The points are joined by an arc.

7.  Click again to complete the measurement.

STEP RESULT: The measured line path, arc measurement and unit appear in a value box
entity on the current active markup layer and in the Measurement Entities dialog.

To resize the value box, select it and then click and drag the frame handles.

9.  Youcan click and drag the text box anywhere on the drawing.
ADDITIONAL INFORMATION: To make another measurement, click Reset.

10. Click Close to close the Measurement Entities dialog.

Calibrating an Arc

TASK
1. Measure an arc in the drawing.

2. From the Arc tab, click Calibrate.
STEP RESULT: The Radius Calibration dialog appears displaying the measured distance.

3. Fromthe Units list, select a unit of measurement to which you want to calibrate the
distance.

4.  Click Calibrate to and enter a value if you want to calibrate to a value.
Click Set Factor and enter a value if you want to calibrate by a factor.

6. Click OK.
STEP RESULT: The calibration results appear in the Arc tab.

7.  Click Close to close the Measurement dialog.

Creating 2D Vector Markup Measure Entities

When marking up 2D vector files, in addition to all the markup options available for 2D
files, you can create markup measure entities. The measure options in Markup mode work
slightly different than in View mode.
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Measure options vary between vector and non-vector files. For vector files, AutoVue
provides the option to “snap” to fixed points on the drawing. For non-vector files, you can
only “free snap”.

When measuring in Markup mode, the specified measurement lines and values are
displayed on the current active markup layer as entities. These entities can be moved,
resized, hidden or deleted. You can also modify the font of a measure entity, align a “free
snap” measure entity to the horizontal or vertical axis, as well as add units of measure and
symbols to a measurement and have them appear on the drawing.

NOTE: When you are creating a markup entity, you can press the Escape key to cancel.

In Markup mode, you can choose from several measure options to create markup measure
entities. From the Markup menu, select Add Entity, and then select Measurement to
access the following measure options:

Option Description

Angle Measure the angle between selected points.

From the Markup Entity toolbar, you can also click Angle 5.

Arc Measure an arc entity.

Area Measure a selected area.

From the Markup Entity toolbar, you can also click Area = |

Distance Measure the distance between two points.

From the Markup Entity toolbar, you can also click Distance .

2D Vector Snapping Modes

The available snapping modes allow you to click to precise geometrical points on a
drawing. For example, if you select Snap to End-Point and you move the cursor over an
end-point of a line, the end-point will be highlighted by a snap box.

The snapping modes allow you to snap to the mid, center, and end-points of an entity:

Button Snap to Description
;-\;} End-point Geometric snap mode where a snap box appears when moving
the cursor near a linear component’s end point.

\@l Mid-point Geometric snap mode where a snap box appears when moving
the cursor near the halfway point of a linear component.
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Button Snap to Description
@ Center-point Geometric snap mode where a snap box appears when moving
the cursor near the center of an elliptical component.

E Free snap Allow snapping at any point on the drawing.

NOTE: When selecting a snapping mode you also have the option to select all snapping modes
(All On) or to turn off snapping modes (All Off)

The below table lists snapping locations for certain measurements:

Measurement Snapping Location
Area Snaps to a shape on the drawing.
Arc Snaps to an arc on the drawing.
Angle Snap to two non-parallel lines.

Measuring Distance

Use the Distance option to measure the distance between two specific points.

TASK

1. From the Markup menu, select Add entity, select Measurement, and then select
Distance.

ADDITIONAL INFORMATION: The Measurement Entities dialog appears.From the Markup Entity
toolbar, you can also click Distance .

2. Select the snapping modes that you want to use for measuring.
To select all snapping modes click All On. To clear all snapping modes click All Off.

4.  From the Measured Distance Units list, select the unit in which you want to
measure the distance.

5.  Click a point on the drawing to define the starting point.

6.  Click another point on the drawing to define the end point.

ADDITIONAL INFORMATION: If you selected Cumulative, continue clicking points along the
path that you want to measure.

STEP RESULT: The measured line path appears as an entity on the current active markup.
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7.  Move the cursor and click a location on the drawing to display the measure
distance.

STEP RESULT: The measurement and unit appear in a value box entity on the current active
markup layer. The measured distance, Delta-X, and Delta-Y appear in the Measurement
Entities dialog.

8. Toresize the value box, select it and then click and drag the frame handles.

You can click and drag the text box anywhere on the drawing.
ADDITIONAL INFORMATION: To make another measurement, click Reset.

10. Click Close to close the Measurement Entities dialog.

Measuring Cumulative Distance

Use the Cumulative Distance option to measure the distance along a path of multi-faceted
(adjoining) points.

TASK

1. From the Markup menu, select Add entity, select Measurement, and then select
Distance.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Distance =.
STEP RESULT: The Measurement Entities dialog appears.

2. Select the snapping modes that you want to use for measuring.

3. Toselectall snapping modes, click AllOn. To deselect all snapping modes, click All
Off.

4.  From the Measured Distance Units list, select the unit in which you want to
measure the distance.

5. Select Cumulative.
6.  Click the first entity to define the starting point.

7. Continue clicking points along the path that you want to measure.
STEP RESULT: Each point is joined by a line.

8.  Right-click to complete the measurement.
ADDITIONAL INFORMATION: Click Reset to take another measurement.

STEP RESULT: The measured line path, measurement and unit appear in a value box entity
on the current active markup layer. The measured distance, Delta-X, Delta-Y and the
“Manhattan Distance” appear in the Measurement Entities dialog.

9. Click Close to close the Measurement Entities dialog.
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Calibrating Distance

Calibrate the distance measurement.

TASK
1. Measure distance between two points or measure cumulative distance.

2. From the Distance tab, click Calibrate.
STeP REsuLT: The Distance Calibration dialog appears displaying the measured distance

From the Units list, select the unit to which you want to calibrate the distance.

4.  Select Calibrate to and enter a value if you want to calibrate the distance to a
value.

5.  Select Set Factor and enter a value if you want to calibrate the distance by a factor.

6. Click OK.
STEP RESULT: The calibration result appears in the Measurement dialog.

7.  Click Close to close the Distance tab.

Measuring Area

Use the Area option to measure the area and perimeter of a region.

TASK

1. From the Analysis menu, select Measure.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Measure .I':!
STEP RESULT: The Measurement dialog appears.

2.  Click the Area tab.

3.  Select Between Points if you want to measure the area between points on a
drawing. The snapping modes are displayed.

4.  Select the snapping modes that you want to use for measuring.

Select Shape if you want to measure the area of a predefined shape on the
drawing; the snapping modes are disabled.

6.  From the Measured Area Units list, select the unit in which you want to measure
the area.

7. From the Perimeter Units list, select the unit in which you want to measure the
perimeter.

8. Inthe Net Area Result section of the dialog, select Add to cumulate a net area
result of different areas.

9. To subtract an area from the Net Area Result, select Subtract.
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10. Select Clear to clear the Net Area Result.

11. If you selected Between Points, click points on the drawing to define the area.

STEP RESULT: Each point is joined by a line. The area and perimeter measurements appear
in the Measurement dialog.

12. If you selected Shape, click the edge of the predefined shape that you want to
measure.
ADDITIONAL INFORMATION: Click Reset to take another measurement.

STEP RESULT: The shape is highlighted. The area and perimeter measurements appear in
the Measurement dialog.

13. Click Close to close the Measurement dialog.

Measuring an Angle

Use the Angle option to measure the precise angle between points on a drawing.

TASK

1. From the Markup menu, select Add Entity, and then select Angle.
ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Angle &
STEP RESULT: The Measurement Entities dialog appears.

2. Select From 3 Points if you want to measure the angle between three points. The
snapping modes are displayed.
STEP RESULT: The snapping modes are displayed.

Select the snapping modes that you want to use for measuring.
4. Select Between 2 lines if you want to measure the angle between two lines.

From the Measured Angle Units list, select the unit in which you want to measure
the angle.

6. If you selected From 3 Points, click three points on the drawing to define the
angle. If you selected Between 2 lines click two lines on the drawing to define the
angle.

STEP RESULT: Angle arms appear with an arc connecting them.
7.  Click again to complete the measurement.

STEP RESULT: The measured line path, measurement and unit appear in a value box entity
on the current active markup layer. The measurement appears in the Measurement Enti-
ties dialog.

8. To change the size of the arc, click and drag it to the desired size.

To move the value box, click and drag it to anywhere on the markup.
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10. To resize the value box, select it and then click and drag the frame handles.

ADDITIONAL INFORMATION: Click Reset to take another measurement.

11. Click Close to close the Measurement Entities dialog.

Measuring an Arc

Use the Arc option to measure the precise radius, length and angles of any arc on the model.
It also calculates the center point location.

TASK
1. From the Markup menu, select Add Entity, Measurement, and then Arc.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Arc =

STEP RESULT: The Measurement Entities dialog appears.

2. Select Arc Entity if you want to measure a predefined arc.

Step ResuLT: All arc and circles are highlighted on the model. Shapping modes are
disabled.

3. Select From 3 Points if you want to measure the arc between three points. Snap-
ping modes are displayed.

4,  Select the snapping modes that you want to use for measuring.
STep ResuLT: All entities of the selected entity types are highlighted on the model.

5. From the Dist. Units list, select the unit in which you want to measure the arc
distance.

6. From the Angles Units list, select the unit in which you want to measure the angle.
7. Ifyou selected From 3 Points, click three points to define the arc.

STEP RESULT: The points are joined by an arc.
8. Ifyou selected Arc Entity, click the edge of an arc.

STEP RESULT: The arc is highlighted.

9.  Click to complete the measurement.

STEP RESULT: The measured line path, measurement and unit appear in a value box entity
on the current active markup layer. The measurements for arc center coordinates, radius,
diameter, ratio, arc length, start and end of angle and sweep appear in the Measurement
Entities dialog.

10. To move the value box, click and drag it to anywhere on the markup.

11. Toresize the value box, select it and then click and drag the frame handles.

ADDITIONAL INFORMATION: Click Reset to take another measurement.

12. Click Close to close the Measurement Entities dialog.
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Calibrating an Arc

TASK
1. Measure an arc in the drawing.

2.  From the Arc tab, click Calibrate.
STEP RESULT: The Radius Calibration dialog appears displaying the measured distance.

3. Fromthe Units list, select a unit of measurement to which you want to calibrate the
distance.

4.  Click Calibrate to and enter a value if you want to calibrate to a value.
Click Set Factor and enter a value if you want to calibrate by a factor.

6. Click OK.
STEP RESULT: The calibration results appear in the Arc tab.

7.  Click Close to close the Measurement dialog.

Creating EDA Markup Measure Entities

When marking up EDA files, in addition to all the markup options available for 2D files,
you can create markup measure entities. The measure options in Markup mode work
slightly different than in View mode.

See “2D-Specitic Markups”
NOTE: When you are creating a markup entity, you can press the Escape key to cancel.

When measuring in Markup mode, the specified measurement lines and values are
displayed on the current active markup layer as entities. These entities can be moved,
resized, or deleted. You can also modify the font of a measure entity, align a “free snap”
measure entity to the horizontal or vertical axis, as well as add units of measure and symbols
to a measurement and have them appear on the drawing.

AutoVue provides the option to “snap” to geometrical or electrical points on the drawing.

In Markup mode, you can choose from several measure options to create markup measure
entities. From the Markup menu, select Add Entity, and then select Measurement to
access the following measure options:
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Option Description

Angle Measure the angle between selected points.

From the Markup Entity toolbar, you can also click Angle 5.

Arc Measure an arc entity.

Area Measure a selected area.

From the Markup Entity toolbar, you can also click Area =~ |

Distance Measure the distance between two points.

From the Markup Entity toolbar, you can also click Distance &=

Minimum Distance Measure the minimum distance between entities.

From the Markup Entity toolbar, click Minimum Distance .

EDA Snapping Modes

The snapping modes allow you to click to precise geometrical or electrical points. For
example, when you select Snap to Pin, move the cursor over the pin you want to select until
the pin is highlighted, then click. Highlight and click a second pin to measure the distance
between them.

The snapping modes allow you to snap to the middle, center, and end-points of an entity,
as well as a pin, via, and symbol. The following table outlines the available snapping modes:

Button Snap To Description

E End-point Geometric snap mode where a

snap box appears when moving
the cursor near the entity’s end
point.

E Mid-point Geometric snap mode where a

snap box appears when moving
the cursor near the halfway point
of a linear entity.

@ Center-point Geometric snap mode where a

snap box appears when moving
the cursor near the center of an
entity.
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Button Snap To Description

Pin Electrical snap mode where a
snap box appears when the
cursor touches a pin.

(@

Via Electrical snap mode where a
snap box appears when the
cursor touches a via.

&

Symbol origin Electrical snap mode where a
snap box appears when the
cursor touches a component.

K Free snap Allows snapping at any point on
= the drawing.

M Net Allows snapping to a net.

[ZI"' Trace Allows snapping to a trace.

Measuring Distance

Use the Distance option to measure the distance between two specific points.

TASK
1.

From the Markup menu, select Add entity, select Measurement, and then select
Distance.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Distance S,

STEP RESULT: The Measurement Entities dialog appears.
Select the snapping modes that you want to use for measuring.

To select all snapping modes, click All On. To deselect all snapping modes, click All
Off.

From the Measured Distance Units list, select the unit in which you want to
measure the distance.

Click a point on the drawing to define the starting point.

Click another point on the drawing to define the end point.

STEP RESULT: The points are joined by a line. The measured line path appears as an entity
on the current active markup.

Drag to move the measured line path.
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8.

10.

Click on the measured line path.

STEP RESULT: The measurement and unit appear in a value box entity on the current active
markup layer. The measured distance, Delta-X, Delta-Y and the “Manhattan Distance”
appear in the Measurement Entities dialog.

To resize the value box, select it and then click and drag the frame handles.
ADDITIONAL INFORMATION: Click Reset to take another measurement.

Click Close to close the Measurement Entities dialog.

Measuring Cumulative Distance

Use the Cumulative Distance option to measure the distance along a path of multi-faceted
(adjoining) points.

TASK

1.

From the Markup menu, select Add entity, select Measurement, and then select
Distance.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Distance =

STEP RESULT: The Measurement Entities dialog appears.
Select the snapping modes that you want to use for measuring.

To select all snapping modes, click All On. To deselect all snapping modes, click All
Off.

From the Measured Distance Units list, select the unit in which you want to
measure the distance.

Select Cumulative.

Click the first entity to define the starting point.

Continue clicking points along the path that you want to measure.
STEP RESULT: Each point is joined by a line.

Right-click to complete the measurement.
ADDITIONAL INFORMATION: Click Reset to take another measurement.

STEP RESULT: The measured line path, measurement and unit appear in a value box entity
on the current active markup layer. The measured distance, Delta-X, Delta-Y and the
“Manhattan Distance” appear in the Measurement Entities dialog.

Click Close to close the Measurement Entities dialog.
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Calibrating Distance

Calibrate the distance measurement.

TASK
1. Measure distance between two points or measure cumulative distance.

2. From the Distance tab, click Calibrate.
STEP RESULT: The Distance Calibration dialog appears displaying the measured distance

From the Units list, select the unit to which you want to calibrate the distance.

4.  Select Calibrate to and enter a value if you want to calibrate the distance to a
value.

Select Set Factor and enter a value if you want to calibrate the distance by a factor.
6. Click OK.

STEP RESULT: The calibration result appears in the Measurement dialog.

7. Click Close to close the Distance tab.

Measuring Area

Use the Area option to measure the area and perimeter of a region.

TASK

1. From the Markup menu, select Add entity, select Measurement, and then select
Area.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Area =
STEP RESULT: The Measurement Entities dialog appears.

2.  Select Between Points if you want to measure the area between points on a
drawing. Snapping modes are displayed.

3. Select the snapping modes that you want to use for measuring.

ADDITIONAL INFORMATION: To select all snapping modes, click All On. To deselect all snap-
ping modes, click All Off.

4.  Select Shape if you want to measure the area of a predefined shape on the
drawing.

5. From the Measured Area Units list, select the unit in which you want to measure
the area.

6.  From the Perimeter Units list, select the unit in which you want to measure the
perimeter.
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7. To cumulate a Net Area Result of different areas, select Add in the Measurement
Entities dialog.

8. Tosubtract an area from the Net Area Result, select Subtract.
9. Select Clear to clear the Net Area Result field.

10. If you selected Between Points, click points on the drawing to define the area.

STEP RESULT: Each point is joined by a line and the measurement appears in the Measure-
ment Entities dialog.

11. If you selected Shape, click the edge of a predefined shape on the drawing.
STEP RESULT: The shape is highlighted.
12. Right-click to complete the measurement.

ADDITIONAL INFORMATION: Click Reset to take another measurement.

STEP RESULT: The measured line path, measurement and unit appear in a value box entity
on the current active markup layer. The area and perimeter measurements appear in the
Measurement Entities dialog.

13. Click Close to close the Measurement Entities dialog.

Measuring an Angle

Use the Angle option to measure the angle between points on a drawing.

TASK

1. From the Markup menu, select Add entity, select Measurement, and then select
Angle.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Angle <.
STEP RESULT: The Measurement Entities dialog appears.

2. Select From 3 Points if you want to measure the angle between three points.
Snapping modes are displayed.

3. Select the snapping modes that you want to use for measuring.

ADDITIONAL INFORMATION: To select all snapping modes, click All On. To deselect all snap-
ping modes, click All Off.

4.  Select Between 2 lines if you want to measure the angle between two lines.

From the Measured Angle Units list, select the unit in which you want to measure
the angle.

6. If you selected From 3 Points, click three points to define the angle.

7.  Ifyou selected Between 2 Lines, click two lines to define the angle.
STEP RESULT: Angle arms appear with an arc connecting them.
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8.  Right-click to complete the measurement.

STEP RESULT: The measured line path, measurement and unit appear in a value box entity
on the current active markup layer. The measured angle appears in the Measurement Enti-
ties dialog.

9. Tochange the size of the arc, click and drag the it to the desired size.
10. To move the value box, click and drag it to anywhere on the drawing.

11. Toresize the value box, select it and then click and drag the frame handles.
ADDITIONAL INFORMATION: Click Reset to take another measurement.

12. Click Close to close the Measurement Entities dialog.

Measuring an Arc

Use the Arc option to define an arc in the drawing and measure its radius, center and diam-
eter.

TASK

1. From the Markup menu, select Add entity, select Measurement, and then select
Arc.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Arc 2.
STEP RESULT: The Measurement Entities dialog appears.

2. Select From 3 Points if you want to measure the arc between three points. Snap-
ping modes are displayed.

3. Select the snapping modes that you want to use for measuring.

ADDITIONAL INFORMATION: To select all snapping modes, click All On. To deselect all snap-
ping modes, click All Off.

4.  Select Arc Entity if you want to measure a predefined arc.

From the Arc Info list, select the unit in which you want to measure the distance of
the arc.

6. From the Measured Angle Units list, select the unitin which you want to measure
the angle.

7.  Select Add Radius if you want measure the radius.
Select Add Diameter if you want to measure the diameter.

9. Ifyou selected From 3 Points, click three points to define the arc.
STEP RESULT: The points are joined by an arc.

10. If you selected an Arc Entity, click an edge of the arc.
STEP RESULT: The arc is highlighted.
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11. Click to complete the measurement.

STEP RESULT: The measured line path, measurement and unit appear in a value box entity
on the current active markup layer.The measurements for center point coordinates,
radius, diameter, arc length, start and end of angle and sweep appear in the Measurement
Entities dialog.

12.  To move the value box, click and drag it to anywhere on the drawing.

13. Toresize the value box, select it and then click and drag the frame handles.

ADDITIONAL INFORMATION: Click Reset to take another measurement.

14. Click Close to close the Measurement Entities dialog.

Calibrating an Arc

TASK
1. Measure an arc in the drawing.

2.  From the Arc tab, click Calibrate.
STEP RESULT: The Radius Calibration dialog appears displaying the measured distance.

3. Fromthe Units list, select a unit of measurement to which you want to calibrate the
distance.

4.  Click Calibrate to and enter a value if you want to calibrate to a value.
Click Set Factor and enter a value if you want to calibrate by a factor.

6. Click OK.
STEP RESULT: The calibration results appear in the Arc tab.

7.  Click Close to close the Measurement dialog.

Measuring Minimum Distance

Use the Minimum Distance option to measure the minimum distance between entities.
The available entities for snapping are nets, pins, vias and traces.
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NOTE: To measure the minimum distance between entities on separate layers, select Across
Layers. If a physical layer does not exist, this option determines whether or not the minimum
distance should be calculated across logical layers.

TASK

1. From the Markup menu, select Add entity, select Measurement, and then select
Minimum Distance.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Minimum
Distance 2.

STEP RESULT: The Measurement Entities dialog appears.
2.  Click =4 First Set to select the entities that you want to measure from.
3.  Select the snapping modes that you want to use for measuring.
ADDITIONAL INFORMATION: If you select Net, you cannot select any other type of entity.

4.  Click the first set of entities on the drawing.
ADDITIONAL INFORMATION: To clear the last set of entities you selected, click Clear Set.
STEP RESULT: The entities are highlighted.

5. Click =1 Second Set to select the entities that you want to measure to.

6. Click the second set of entities on the drawing.
STEP RESULT: The entities are highlighted in a different color.

7.  Fromthe Measured Min. Distance list, select the unit in which you want to measure
the distance.

8. Select Zoom to Result, if you want to zoom in on the measured value on the
drawing.
9. (lick Compute.

STEP REsuULT: The minimum distance from the first set of entities to the second set is high-
lighted by a line. The measured line path, measurement and unit appear in a value box
entity on the current active markup layer. The measurement, Delta-X, Delta-Y, and the
Manhattan Distance appear in the Measurement Entities dialog.

10. To move the value box, click and drag it to anywhere on the drawing.

11. Toresize the value box, select it and then click and drag the frame handles.

ADDITIONAL INFORMATION: Click Reset to take another measurement.

12. Click Close to close the Measurement Entities dialog.
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Adding Text

With AutoVue, you can add a text box entity to a markup.

TASK
1. From the Markup menu, select Add Entity, and then select Text.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Text AL.
2.  Click and drag on the drawing to define the dimensions of the text box.

3.  (lickin the text box and enter the text you want to add.
ADDITIONAL INFORMATION: The height of the text box will adjust to accommodate the text.

4.  To change text box font properties, from the Markup menu, select Format, and
then select Font.

ADDITIONAL INFORMATION: From the respective font property lists on the Markup Properties
toolbar, you can also modify the font type, style, and size.

STEP REsuLT: The Font dialog appears allowing you to change the font type, style, and size.
5.  Click OK to implement the font changes and to close the Font dialog.

6. To change the line properties or fill color of the text box, select the text box, then
from the Markup menu, select Format, and then select the property or properties
you want to change.

ADDITIONAL INFORMATION: From the respective line property lists on the Markup Properties
toolbar, you can also modify the line style, line thickness, fill types, and fill colors.

7.  Right-click outside the text area to complete the modification.
STEP RESULT: The text appears on the drawing and in the Markup Navigation Tree.
8. Tomove the text box click and drag it.

Click and drag the frame handles of the text box to enlarge it.

ADDITIONAL INFORMATION: To edit the text, double-click the text box in the tree or in the
workspace.

Hiding the box surrounding the text

TASK
1. Select the text box entity.

2. From the Markup menu, select Format, and then select Markup Entity Attri-
butes.

STEP RESULT: The Markup Entity Properties dialog appears.
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From the Text Box Visibility list, select OFF.

4.  Click OK.
ADDITIONAL INFORMATION: To undo, repeat steps 1 through 4, except select ON.
STEP RESULT: The dialog closes and the text box is hidden.

Adding a Note

You can attach longer comments as a markup note with AutoVue’s Markup Control Note
Editor. A note displays in the workspace as a standard size graphical symbol <_#. Each note
is labelled as Note<n>—where n represents the numerical order of occurrence of the note
(for example, the first note is labelled as Notel). To read the note, double-click the entity to
open it or move the mouse over the entity to display the tooltip.

TASK
1. From the Markup menu, select Add Entity, and then select Note.
ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Note .

2.  Click a point on the document where you want to insert the note.
STEP RESULT: The Markup Control Note Editor dialog box appears.
Enter the text that you want in the note.
4. To modify the text, select Formatting and the format you want to apply.
From the File menu, select Information.
STEP RESULT: The Note Information dialog box appears.
6. In Name, Author and Key Words fields, enter the required text for the note.
7.  Click OK.
8.  Close the Markup Control Note Editor dialog box.
STEP RESULT: The note appears on the drawing and in the Markup Navigation Tree.
9.  Right-click outside the note area to complete the modification.

10. To move the note, click and drag it.

ADDITIONAL INFORMATION: To edit a note, double-click the note symbol @ in the workspace.
You can also select the note in the tree, right-click, and select Edit, or double-click the
note.
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Viewing and Printing the List of Notes

You can view a list of the notes you added to a file. You can also print the notes or find a
note in the workspace.

TAsK
1. From the Markup menu, select Print Notes.
STEP RESULT: The List Notes dialog box appears.

2. Tofind a note, select the note from the list and click Go To.

ADDITIONAL INFORMATION: You can also select the note from the Markup Navigation Tree,
right-click, and select Go To.

STEP RESULT: AutoVue zooms into the selected note in the workspace.
3. To print a note, select the note from the list.

ADDITIONAL INFORMATION: To print more than one note, press the Shift or Control key while
selecting. To print all the notes in the list, click Select All.

4.  Click Print.

ADDITIONAL INFORMATION: To print each selected note on a separate page, select One Note
Per Page.

STEP RESULT: The Note Print Options dialog box appears.
5.  Configure the print options, then click OK.

STEPRESULT: The selected notes are printed with their unique headers (for example, Note1,
Note2, and so on.)

6. Click OK to close the List Notes dialog box.

Nesting Markup Entities

You can add the Attachment or Hyperlink markup entities as a nested child to any markup
entity.

TASK
1. Add a markup entity to a 3D file (for example, a Text entity).

2. From the workspace or Markup Tree, select the Text entity.
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3. From the Markup menu, select Attachment or Hyperlink.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Attachment
%) or Hyperlink Q'-‘.

RESULT:

In the Markup Tree, the selected markup entity appears as a child of the Text (parent)
entity.

3D-Specific Markups

When marking up 3D files, you can attach text or a note, as well as create markup measure
entities. The measure options in Markup mode work slightly different than in View mode.

NOTE: When you are creating a markup entity, you can press the Escape key to cancel.

3D Markup Entities

You can create many different types of markup entities. To access the markup entities, from
the Markup menu, select Add Entity. The markup entities are:

Option Description

To complete a markup entity (for example, to finish creating a box), simply right-click in the AutoVue

workspace.

Text Add text to the markup.
From the Markup Entity toolbar, you can also click 3D Text .
See “Adding Text”

Attachment Add an attachment entity to the markup.
From the Markup Entity toolbar, you can also click Attachment %\ .
See “Adding an Attachment”

Hyperlink Click the workspace to attach a hyperlink.
From the Markup Entity toolbar, you can also click Hyperlink %,
See “Adding a Hyperlink”
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Option Description

Intellistamp Add a stamp on a document in a connected and disconnected
environment. Includes specific document and user information (metadata)
pulled directly from the DMS/ERP/PLM/UCM system.

From the Markup Entity toolbar, you can also click Intellistamp :L}).

Measurement Create markup measure entities.

From the Markup Entity toolbar, you can also click Distance o, Area

E , Angle = , Arc -@-, or Minimum Distance '“_.'{ .

See “Creating 3D Markup Measure Entities”

Note Add a note to the markup.

From the Markup Entity toolbar, you can also click Note —.
See “Adding a Note”

Signoff Create an approval stamp containing information about the markup author,
date and time of creation.

4
From the Markup Entity toolbar, you can also click Signoff #~ .
See “Adding Signoff Entities”

Stamp Click and drag a stamp to the markup.

From the Markup Entity toolbar, you can also click Stamp %= .
See “Adding a Stamp”

Creating 3D Markup Measure Entities

When marking up 3D files, you can create markup measure entities. The measure options
in Markup mode work slightly different than in View mode.

When measuring in Markup mode, the specified measurement lines and values are
displayed on the current active markup layer as entities. These entities can be moved,
resized, or deleted.

NOTE: If you manipulate a part of a model, the measure entity values do not update accord-
ingly.

AutoVue provides the option to “snap” to different entity types on the model.

In Markup mode, you can choose from several measurement options to create markup

measure entities. From the Markup menu, select Add Entity, and then select Measure-
ment to access the following measure options:
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Name Description

Angle Measure the precise angle between three vertices or any two edges, planes
or faces.

From the Markup Entity toolbar, you can also click Angle 5.

Arc Measure the precise radius, length and angle of any arc and calculate the
center point location.

Distance Measure the precise distance between any two Vertex, Edge, Midedge, Arc
Center or Face.

Minimum Distance Measure minimum distance between any two Vertex, Edge, Midedge, Arc
Center or Face.
From the Markup Entity toolbar, you can also click Minimum Distance

You cannot create a markup measure entity when measuring minimum
distance.

Vertex Coordinates Provide the coordinates of each vertex.
From the Markup Entity toolbar, you can also click Vertex Coordinates

¥
X}z,

3D Snapping Modes

The snapping modes available allow you to select or snap to different entity types on a
model. For example, if you select Vertex, all vertices are highlighted and when you move
the cursor over a vertex, a snap box appears.

The snapping modes allow you to snap to vertices, edges, faces, planes and arcs.

Button Snap to Description

@ Edge Edges are highlighted on the model.
When moving the cursor over an edge, a snap circle
appears.

@ Face Faces are highlighted when you move the cursor over a
face and a snap triangle appears.

m Vertex Vertices are highlighted on the model.
When moving the cursor over a vertex, a snap box
appears.
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Measuring Distance

Use the Distance option to measure the precise distance between two vertices, edges,
mid-edges, arc centers, faces, or any combination of entity types.

NOTE: When measuring the distance between faces, if the faces are parallel, AutoVue
compares the shortest distance between the parallel faces.

TASK
1. From the Markup menu, select Add Entity, and then select Distance.
ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Distance .

STEP RESULT: The Measurement Entities dialog appears.

2. From the Measured Distance Units list, select the unit in which you want to
measure the distance.

3. Select the snapping modes that you want to use for measuring.
STep ResuLT: All entities of the selected entity types are highlighted on the model.

4.  Onthe model, select the entity you want to measure from.

ADDITIONAL INFORMATION:  If you want to take more than one measurement from the same
starting point, select the Fix Position check box.

STEP REsULT: The location of the entity appears in the From = field.
5. Clickinside the To k=d field to select the entity type that you want to measure to.

6. Select the snapping mode that you want to select as the end point for the
measurement.

STep ResuLT: All entities of the selected entity types are highlighted on the model.

7. Onthe model, select the entity you want to measure to.
STEP RESULT: The location of the entity appears in the To k=d field.

8.  Click again to complete the measurement.

STEP RESULT: The measured line path appears in a value box entity on the current active
markup. The measured distance, Delta-X, Delta-Y and Delta-Z appear in the Measurement
Entities dialog.

9.  Drag to move the measured line path.
10. Click on the measured line path.
11.  To move the value box, click and drag it to anywhere on the drawing.

12. Toresize the value box, select it and then click and drag the frame handles.

ADDITIONAL INFORMATION: Click Reset to take another measurement.

13. Click Close to close the Measurement Entities dialog.
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Calibrating Distance

Calibrate the distance measurement.

TASK
1. Measure distance between two points or measure cumulative distance.

2. From the Distance tab, click Calibrate.
STeP REsuLT: The Distance Calibration dialog appears displaying the measured distance

From the Units list, select the unit to which you want to calibrate the distance.

4.  Select Calibrate to and enter a value if you want to calibrate the distance to a
value.

5.  Select Set Factor and enter a value if you want to calibrate the distance by a factor.

6. Click OK.
STEP RESULT: The calibration result appears in the Measurement dialog.

7.  Click Close to close the Distance tab.

Measuring an Angle

Use the Angle option to measure the precise angle between points on a drawing.

TASK

1. From the Markup menu, select Add entity, select Measurement, and then select

Angle.
ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Angle 2.

STEP RESULT: The Measurement Entities dialog appears.
2.  Click the Angle tab.

3. Select the snapping modes that you want to use for measuring.
STEP ResuLT: Entities of the selected types are highlighted on the model.

4. To measure the angle between an entity type and a plane, select the With Plane
check box, and then select the plane from the list.

5. From the Measured Angle Units list, select the unit in which you want to measure
the angle.

6. Click two points on the model to define the angle.
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7. Ifyou selected a Plane, click the vertex, edge or face whose angle you want to
measure between the plane.

ADDITIONAL INFORMATION: To take another measurement click Reset.

STEP RESULT: Angle arms appears indicating the angle.The measurement appears in the
Measurement dialog.

8. Click Close to close the Measurement dialog.

Measuring an Arc

Use the Arc option to measure the precise radius, length and angles of any arc on the model.
It also calculates the center point location.

TASK
1. From the Markup menu, select Add Entity, Measurement, and then Arc.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Arc =

STEP RESULT: The Measurement Entities dialog appears.

2. Select Arc Entity if you want to measure a predefined arc.

Step ResuLT: All arc and circles are highlighted on the model. Snapping modes are
disabled.

3. Select From 3 Points if you want to measure the arc between three points. Snap-
ping modes are displayed.

4.  Select the snapping modes that you want to use for measuring.
STEP REsULT: All entities of the selected entity types are highlighted on the model.

5. From the Dist. Units list, select the unit in which you want to measure the arc
distance.

6. From the Angles Units list, select the unit in which you want to measure the angle.
7.  Ifyou selected From 3 Points, click three points to define the arc.

STEP RESULT: The points are joined by an arc.
8. Ifyou selected Arc Entity, click the edge of an arc.

STEP RESULT: The arc is highlighted.

9. C(lick to complete the measurement.

STEP RESULT: The measured line path, measurement and unit appear in a value box entity
on the current active markup layer. The measurements for arc center coordinates, radius,
diameter, ratio, arc length, start and end of angle and sweep appear in the Measurement
Entities dialog.

10. To move the value box, click and drag it to anywhere on the markup.
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11. Toresize the value box, select it and then click and drag the frame handles.

ADDITIONAL INFORMATION: Click Reset to take another measurement.

12. Click Close to close the Measurement Entities dialog.

Calibrating an Arc

TASK
1. Measure an arc in the drawing.

2.  From the Arc tab, click Calibrate.
STEP RESULT: The Radius Calibration dialog appears displaying the measured distance.

3. Fromthe Units list, select a unit of measurement to which you want to calibrate the
distance.

4,  Click Calibrate to and enter a value if you want to calibrate to a value.
Click Set Factor and enter a value if you want to calibrate by a factor.

6. Click OK.
STEP RESULT: The calibration results appear in the Arc tab.

7.  Click Close to close the Measurement dialog.

Measuring Minimum Distance

With the Minimum Distance option you can measure the minimum distance between
model parts, as well as any two points from the selection sets: vertices, edges, mid-edges, arc
centers, faces or any combination of entity types.

TASK
1. From the Markup menu, select Add Entity, and then select Minimum Distance.

ADDITIONAL INeORMATION: From the Markup Entity toolbar, you can also click Minimum
Distance .

STEP RESULT: The Measurement Entities dialog box appears.
2. Click @ set1.

3. Select Entity if you want to measure the distance between model parts. Snapping
modes are displayed.

4. Select Geometry if you want to measure the distance between entity types.

If you selected Entity, select a part or parts on the model.

STEP RESULT: The model part or parts appear in the list under Set 1 and are highlighted on
the model and in the Model Tree.
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6. If you selected Geometry, select the snapping modes that you want to use for
measuring.

STEP REsULT: All entities of the selected entity type are highlighted on the model.

7.  Select the entity or entities on the model.

ADDITIONAL INFORMATION: To reset a Set, click Clear. To clear items from a Set, select the
items and press the Delete key. To deselect a part or entity type on the model, press the
Control key and left-click the part or entity type.

STEPRESULT: The selected entities appears in the listunder Set 1 and are highlighted on the
model.

8. Click B Set 2.
9. Repeat steps 4 through 6.
STEP RESULT: The model part appears in the list under Set 2.

10. From the Measured Min. Distance Units list, select the unit in which you want to
measure the distance.
11. Click Compute.

STEP RESULT: The minimum distance from the first set of entities to the second set is high-
lighted by a line. The measured line path, measurement and unit appear in a value box
entity on the current active markup layer. The X, Y and Z coordinates for Position 1 and X,
Y and Z coordinates for Position 2 appear in the Measurement Entities dialog box.

12. Click and drag the value box anywhere on the markup.

13. Toresize the value box, select it and then click and drag the frame handles.
ADDITIONAL INFORMATION: Click Reset to take another measurement.

14. Click Close to close the Measurement Entities dialog box.

Measuring Vertex Coordinates

The Vertex Coordinates option provides the coordinates of vertices on the model.

TASK

1. From the Markup menu, select Add Entity, Measurement, and then Vertex
Coordinate.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Vertex Coordi-
nate X3Z.
STEP RESULT: The Measurement Entities dialog appears. All vertices on the model are high-
lighted.

2. Scroll over the vertex whose coordinates you want to add to the markup.
STEP RESULT: The X, Y, and Z coordinates appear in a tooltip.
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Click the vertex.

STEP RESULT: The X, Y, an Z coordinates and unit appear a value box entity on the current
active markup layer and in the Measurement Entities dialog.

Click and drag the value box anywhere on the markup.
ADDITIONAL INFORMATION: Click Reset to take another measurement.
STep ResuLT: Click and drag the frame handles to enlarge the value box.

To remove the highlighted vertices on the model, click Close in the Measurement
Entities dialog.

Adding Text

With AutoVue, you can add a 3D text box entity to a markup.

TASK
1.

From the Markup menu, select Add Entity, and then select Text.
ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click 3D Text &,

The Attach To dialog appears and provides six snapping options:
ADDITIONAL INFORMATION:

Option Description

None Does not snap to the model.

Vertex Snaps to a vertex on the model.

Edge

Snaps to an edge on the model.

Face

Snaps to a face on the model.

Mid Edge Snaps to the middle of an edge on the model.

Ar Center Snaps to the center point of an arc on the model.

Toinsert a text box that snaps to a part of the drawing with a leader line, select one
of the snapping modes.

Click and drag on the drawing to define the dimensions of the text box.

Click in the text box and enter the text you want to add.
ADDITIONAL INFORMATION: The height of the text box will change to accommodate the text.
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6. To change text box font properties, from the Markup menu, select Format, and
then select Font.

ADDITIONAL INFORMATION: From the respective font property lists on the Markup Properties
toolbar, you can also modify the font type, style, and size.

STEP RESULT: The Font dialog appears allowing you to change the font type, style, and size.
7.  Click OK to implement the font changes and to close the Font dialog.

8. To change the line properties or fill color of the text box, select the text box, then
from the Markup menu, select Format, and then select the property or properties
you want to change.

ADDITIONAL INFORMATION: From the respective line property lists on the Markup Properties
toolbar, you can also modify the line style, line thickness, fill types, and fill colors.

9.  Right-click outside the text area to complete the modification.
STEP RESULT: The text appears on the drawing and in the Markup Navigation Tree.
10. To move the text box, click and drag it to anywhere on the drawing.

11. Toresize the text box, select it and then click and drag the frame handles.

ADDITIONAL INFORMATION: To edit the text, double-click the text box in the tree or in the
workspace.

Adding a Note

You can attach longer comments as a markup note with AutoVue’s Markup Control Note
Editor. A note displays in the workspace as a standard size graphical symbol ﬁ . Each note
is labelled as Note<n>—where n represents the numerical order of occurrence of the note
(for example, the first note is labelled as Notel). To read the note, double-click the entity to
open it or move the mouse over the entity to display the tooltip.

TAsK
1. From the Markup menu, select Add Entity, and then select Note.
ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Note L= .

2. (lick a point on the document where you want to insert the note.
STEP RESULT: The Markup Control Note Editor dialog box appears.

Enter the text that you want in the note.
4.  To modify the text, select Formatting and the format you want to apply.

From the File menu, select Information.
STEP RESULT: The Note Information dialog box appears.

6. In Name, Author and Key Words fields, enter the required text for the note.
7.  Click OK.
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8.  Close the Markup Control Note Editor dialog box.
STEP RESULT: The note appears on the drawing and in the Markup Navigation Tree.

9. Right-click outside the note area to complete the modification.

10. To move the note, click and drag it.

ADDITIONAL INFORMATION: To edit a note, double-click the note symbol @ in the workspace.
You can also select the note in the tree, right-click, and select Edit, or double-click the
note.

Viewing and Printing the List of Notes

You can view a list of the notes you added to a file. You can also print the notes or find a
note in the workspace.

TAsK
1. From the Markup menu, select Print Notes.
STEP RESULT: The List Notes dialog box appears.

2. Tofind a note, select the note from the list and click Go To.

ADDITIONAL INFORMATION: You can also select the note from the Markup Navigation Tree,
right-click, and select Go To.

STEP RESULT: AutoVue zooms into the selected note in the workspace.
3. To print a note, select the note from the list.

ADDITIONAL INFORMATION: To print more than one note, press the Shift or Control key while
selecting. To print all the notes in the list, click Select All.

4.  Click Print.

ADDITIONAL INFORMATION: To print each selected note on a separate page, select One Note
Per Page.

STEP RESULT: The Note Print Options dialog box appears.
5.  Configure the print options, then click OK.

STEPRESULT: The selected notes are printed with their unique headers (for example, Note1,
Note2, and so on.)

6. Click OK to close the List Notes dialog box.
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Nesting Markup Entities

You can add the Attachment or Hyperlink markup entities as a nested child to any markup
entity.

TASK
1. Add a markup entity to a 3D file (for example, a Text entity).
2. From the workspace or Markup Tree, select the Text entity.

3. From the Markup menu, select Attachment or Hyperlink.

ADDITIONAL INFORMATION: From the Markup Entity toolbar, you can also click Attachment
%) or Hyperlink %.

RESULT:

In the Markup Tree, the selected markup entity appears as a child of the Text (parent)
entity.

Working with Markup Entities

With AutoVue, you can assign a markup entity its own color, the same color as the current
active layer, or a custom color. You also have the option of grouping markup entities. When
you group markup entities, you can manage the group as you would a single entity.

In Markup mode, there are several options for modifying an entity. You can apply these
options to selected pre-existing entities or to new entities that you add.

NOTE: You can edit certain markup entities after they have been created. To do so, in the
Markup Navigation Tree, right-click the markup entity and then select Edit.

Go To a Markup Entity

The Go To feature restores the view state to when an entity was first created. Opening an
existing Markup file also restores the last saved view state.

From the Markup Navigation Tree, right-click the markup entity that you want to view and
select Go To.

AutoVue displays the markup page containing the entity.
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If you selected a markup entity that is on another page of the Markup file, the page
containing that entity will be displayed.

Selecting Markup Entities

To select a markup entity, click the markup entity’s outer edge.

To select multiple entities, press the Shift or Control key while selecting. The markup
entity or entities are selected. You can also select the markup entities from the Markup
Navigation Tree. To select multiple entities, press the Shift or Control key while selecting.

Moving a Markup Entity

In the Markup Navigation Tree or in the workspace, select the markup entity or entities that
you want to move.

To select multiple entities, press the Shift or Control key while selecting.

In the workspace, click and drag the selected markup entity or entities to anywhere in the
workspace.

Transforming Markup Entities

NOTE: This menu option is only available for 2D and EDA files.

AutoVue provides the option to flip or rotate markup entities.

Rotating all Markup Entities

From the Markup menu, select Transform, and then select Rotate. From the menu that
appears, you have one of two options to select from:

. Rotate Clockwise: Rotates the markup entity 90 degrees in the clockwise direction.

«  Rotate Counter Clockwise: Rotates the markup entity 90 degrees in the
counter-clockwise direction.

NOTE: The markup entities rotate with respect to the center point of the drawing.
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Rotating a selected Markup Entity

This feature is only supported for the Text and Stamp markup entities.

TASK

1. From the workspace or the Markup Navigation Tree, select the markup entity to
rotate.

ADDITIONAL INFORMATION: It is not possible to select multiple markup entities to rotate.
2. From the Markup menu, select Object, and then select Rotate.

3.  Rotate the markup entity by clicking and dragging its control points. Pressing the
Shift key while dragging will snap the rotation to 45 degree intervals.

Flipping all Markup Entities

From the Markup menu, select Transform, and then select Flip. From the menu that
appears, you have one of two options to select from:
. Flip Horizontal Axis: Flips the direction of the horizontal axis of the markup entity.

. Flip Vertical Axis: Flips the direction of the vertical axis of the markup entity.

NOTE: The horizontal and vertical axes are aligned with the center of the drawing.

Hiding All Markup Entities

To hide all markup entities, do the following:

TASK
1. From the Markup menu, select Hide Markups.

ADDITIONAL INFORMATION: A check mark appears next to the Hide Markups option and the
markup entities are hidden on the Markup file.

2. Toundo the hide option, from the Markup menu, deselect Hide Markups.

Grouping and Ungrouping Markup Entities

When you group markup entities, you can move, delete, copy and paste, transform, or
perform any modification on the group of entities that you would on a single markup
entity.
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NOTE: You can only group markup entities created on the same page.

Grouping Markup Entities

TASK

1. Inthe Markup Navigation Tree or from the workspace, select the markup entities
that you want to group.

2. From the Markup menu, select Object, and then select Group.

ADDITIONAL INFORMATION: You can also right-click the selected markup entities and then
select Group.

STEP REsULT: The group of entities appear in the tree under Group.

3. Perform any modifications.

ResuLT: The modifications are applied to all the entities in the group.

Ungrouping Markup Entities

TASK

1. Inthe Markup Navigation Tree or the workspace, select the group that you want to
ungroup.

2. From the Markup menu, select Object, and then select UnGroup.

REsULT: The group of entities appear on the markup as individual entities.

Deleting Markup Entities

TASK

1. Select the markup entity that you want to delete. To select multiple markup enti-
ties, press the Shift or Control keys while selecting.

2. From the Markup Properties toolbar, click Delete Markups g

RESULT:
The selected entity or entities are deleted from the current active file.

NOTE: You can also press the Delete key to delete the markup entities. Alternatively,
right-click the entity in the workspace or Markup Navigation Tree, and select Delete.
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Formatting Markup Entity Properties

With AutoVue, you can modify the formatting of a markup entity via the Format option
from the Markup menu, or via the Markup Entity Properties dialog.

See “Using the Markup Entity Properties Dialog”

When creating a markup entity, you have the option to change the line color, line style, line
thickness, arrow style, fill color, and fill type. Additionally, you can assign the markup
entity the same color as the layer.

Changing Line Color

TASK

1. Select the markup entity or entities for which you want to change the line color.

2. From the Markup menu, select Format, and then select Line Color.
AnnTIONAL INFORMATION: From the Markup Properties toolbar, you can also click Line Color
2. Alternatively, right-click the entity in the workspace or Markup Navigation Tree,
select Format, and then select Line Color.
STEP RESULT: The Line Color dialog appears.

3.  From the Line Color list, select the color that you want for the entity.
ADDITIONAL INFORMATION: Selecting Bylayer g changes the markup entity color to the
color of the layer.

4. To define a custom line color, from the Line Color list, select Custom Color F4.
From the Color dialog that appears, select a color and click OK.

6. Click OK to close the Line Color dialog.

RESULT:

The line color changes for the selected markup entity or entities.

NOTE: Any new entities that you create will have the new line color.
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Changing Line Style

The current line style is highlighted in the Line Style option.

TASK
1. Select the markup entity or entities for which you want to change the line style.

2. Fromthe Markup menu, select Format, and then select Line Style. Select the new
line style from the options provided.

RESULT:

The line style changes for the selected markup entity or entities.

NOTE: From the Markup Properties toolbar, you can also click Line Style ===. Alternatively,
right-click the entity in the workspace or Markup Navigation Tree, select Format, and then
select Line Style.

NOTE: Any new entities that you create will have the new line style.

Changing Line Thickness

The current line thickness is highlighted in the Line Thickness option.

TASK
1. Select the markup entity or entities for which you want to change the line thick-
ness.

2. From the Markup menu, select Format, and then select Line Thickness. Select
the new line thickness from the options provided. The line thickness changes for
the selected markup entity or entities.

ADDITIONAL INFORMATION: From the Markup Properties toolbar, you can also click Line Thick-
ness ==. Alternatively, right-click the entity in the workspace or Markup Navigation Tree,
select Format, and then select Line Thickness.

3. Todefine a custom line thickness, from the Markup menu, select Format, select
Line Thickness, and then select Customize.

STEP RESULT: The Custom Thickness dialog appears.
4. Inthe Line Thickness field, enter an integer value in pixels.

Click OK to close the Custom Thickness dialog.

ADDITIONAL INFORMATION: Any new markup entities that you create will have the new line
thickness.
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Changing Arrow Style

AutoVue gives you the option to add an arrow head to certain markup entities. For
example, you can change the arrow style of the line, polyline, arc, freestyle, and polygon
markup entities.

TASK
1. Select the markup line entity or entities for which you want to change the arrow
style.

2. From the Markup menu, select Format, and then select Arrow Style. Select the
new arrow style from the options provided.

RESULT:
The arrow style changes for the selected markup line entity or entities.

NOTE: From the Markup Properties toolbar, you can also click Arrow Style . Alternatively,
right-click the entity in the workspace or Markup Navigation Tree, select Format, and then
select Arrow Style.

NOTE: Any new entities that you create will have the new arrow style.

Changing Fill Type

TASK
1. Select the markup entity or entities for which you want to change the fill type.

2. From the Markup menu, select Format, and then select Fill Type.

ADDITIONAL INFORMATION: From the Markup Properties toolbar, you can also click Fill Type
1. Alternatively, right-click the entity in the workspace or Markup Navigation Tree, select
Format, and then select Fill Type.

STEP RESULT: The Fill Type dialog appears.

3. From the Fill Type list, select the fill type that you want for the markup entity:
. Select Solid Fill, if you want the fill color to be solid.

. Select Transparent Fill, if you want the fill color to be transparent.
. Select No Fill, if you do not want any fill color.
4. Click OK.

ResuLT: The fill type changes for the selected markup entity or entities. Any new markup
entities that you create will have the new fill type.
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Changing Fill Color

TASK
1.

2.

Select the markup entity or entities for which you want to change the fill color.

From the Markup menu, select Format, and then select Fill Color.

ADDITIONAL INFORMATION: From the Markup Properties toolbar, you can also click Fill Color
g Alternatively, right-click the entity in the workspace or Markup Navigation Tree, select
Format, and then select Fill Color.

STep ResuLT: The Fill Color dialog appears.
From the Fill Color list, select the color that you want for the markup entity.

. P — .
ADDITIONAL INFORMATION: Selecting Bylayer é charn~as the markup entity color to the
color of the layer it is on and selecting Line Color 2 assigns the same color as the
markup entity’s line.

To define a custom line color, from the Line Color list, select Custom Color Fd.
From the Color dialog that appears, select a color and click OK.
STep ResuLT: The fill color changes for the selected markup entity or entities.

Click OK to close the Fill Color dialog.

ADDITIONAL INFORMATION: Any new markup entities that you create will have the new fill
color.

Assigning a Markup Entity the Same Color as the Layer

TASK
1.

Select the markup entity or entities for which you want to assign the color of the
layer that they belong to.
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2.

To assign the line color:
. From the Markup menu, select Format, and then select Line Color.The Line
Color dialog appears.

NOTE: From the Markup Properties toolbar, you can also click Line Color . Alter-
natively, right-click the entity in the workspace or Markup Navigation Tree, select
Format, and then select Line Color.

'—J4
. From the Line Color list, select Bylayer g

To assign the fill color:
. From the Markup menu, select Format, and then select Fill Color.The Fill Color
dialog appears.

NOTE: From the Markup Properties toolbar, you can also click Fill Color g

=
. From the Fill Color list, select Bylayer é
Click OK.

ResuLT: The selected markup entity or entities change to the color of the layer that the entity
belongs to.

Changing Font

You can change the font of the text box, leader, and measurement entities.

TASK
1.

2.

Create the markup entity that you want.

From the workspace or the Markup Navigation Tree, select the markup entity for

which you want to modify the font then do one of the following:

. From Markup menu, select Format, and then select Font. The Font dialog
appears. From the lists select the font, font style, and font size. You also can
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select to add a strikeout and underline by selecting their check boxes. Click OK
to the close the dialog and implement the changes.

. From the Markup Entity toolbar, select the font, font size, and font style (bold, italic,
and underline) from their respective lists and buttons. The font changes are imple-
mented.

Changing Measurement Units and Symbols

You can change the unit of measure and add a symbol to a measurement and have it appear
on the drawing.

TAsK
1.

2.

Create the markup measure entity that you want.

Double-click the measurement that you want to change the unit of measure or
add a symbol to.

STEP RESULT: The appropriate Measure dialog appears.

Deselect Display Unit check box if you want to hide the unit on the drawing. It is
selected by default.

From the Units list, select the unit that you want to change the measurement to.
From the Symbol list, select the symbol that you want to add to the measurement.
Click OK.

RESULT: The unit of measure changes and the selected symbol is added to the measurement
and appears in the workspace.

Using the Markup Entity Properties Dialog

You can use the Markup Entity Properties dialog to modify markup entities.

TASK
1.

Select the markup entity you want to modify. To select multiple markup entities,
press the Shift or Control key while selecting.

From the Markup menu, select Format, and then select Markup Entity Attri-
butes.

ADDITIONAL INFORMATION: You can also right-click a markup entity in the Markup Navigation
Tree or the workspace, select Format, and then select Markup Entity Attributes.

STEP RESULT: The Markup Entity Properties dialog appears.
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Line Color

Change the line color the selected markup entity or entities.

TASK
1.

2.

Select the markup entity or entities for which you want to change the line color.

From the Line Color list, select the color that you want for the entity.

F—u
ADDITIONAL INFORMATION: Selecting Bylayer él changes the entity color to the color of the
layer.

Click OK to close the Markup Entity Properties dialog.

Defining a Custom Line Color

To define a custom line color, take the following steps:

TAsK
1.

From the Line Color list, select Custom Color 4.
STEP RESULT: The Color dialog appears.

2. Select a color and click OK.

3.  (lick OKto close the Markup Entity Properties dialog.
ADDITIONAL INFORMATION: If you selected markup entities prior to specifying a custom color,
only the selected entities will have the new line color. To apply the new line color to any
new markup entity you create, make sure no markup entity is selected before opening the
Markup Entity Properties dialog.

RESULT:

The line color changes for the selected markup entity or entities.

Line Style

Change the line style for a selected markup entity or entities.

TASK
1.

2.

Select the markup entity you want to change the line style. To select multiple
markup entities, press the Shift or Control key while selecting.

From the Line Style list, select the required line style.
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3.  Click OKto close the Markup Entity Properties dialog.

ADDITIONAL INFORMATION: Any new markup entities that you create will have the new line
style.

RESULT:

The line style changes for the selected markup entity or entities.

Line Thickness

Change the line thickness for a selected markup entity or entities.

TASK

1. Select the markup entity for which you want to change the line thickness. To select
multiple markup entities, press the Shift or Control key while selecting.

2.  From the Line Thickness list, select the required line thickness.
STeEP RESULT: The line thickness changes for the selected markup entity or entities.

Defining a Custom Line Thickness

To define a custom line thickness, take the following steps:

TASK
1.  From the Line Thickness list, select Customize.

2.  Inthe Width (Pixels) field, enter the desired width.
3.  (lick OKto close the Markup Entity Properties dialog.

REsuLT:
The line thickness changes for the selected markup entity or entities.

NOTE: Any new markup entities that you create will have the new line thickness.

Width (Pixels)

Customize the line thickness when Customize is selected in the Line Thickness list. When
other line thicknesses are selected, this field displays its value in pixels but cannot be edited.
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Arrow Style

Add an arrow head at one or both ends of a markup line entity.

TASK
1.

Select the markup line entity you want to change the arrow style. To select
multiple markup line entities, press the Shift or Control key while selecting.

2. From the Arrow Style list, select the style of arrow that you want for the markup
line entity.

3.  Click OK to close the Markup Entity Properties dialog.

RESULT:

The arrow style changes for the selected markup line entity or entities.

NOTE: Any new markup line entities that you create will have the new arrow style.

Fill Type

Change the transparency for selected markup entity or entities.

TASK
1.

Select the markup entity you want to change the fill type. To select multiple
markup entities, press the Shift or Control key while selecting.

2. From the Fill Type list, select the fill type that you want for the markup entity:
. Select Solid Fill, if you want the fill color to be solid.
. Select Transparent Fill, if you want the fill color to be transparent.
. Select No Fill, if you do not want any fill color.

3.  Click OK to close the Markup Entity Properties dialog.

RESULT:

The fill type changes for the selected markup entity or entities.

NOTE: Any new markup entities that you create will have the new fill type.
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Fill Color

Change the line color, fill color, and fill type for a selected markup entity or entities.

TASK

1. Select the markup entity you want to change the fill color. To select multiple
markup entities, press the Shift or Control key while selecting.

2. From the Fill Color list, select the color that you want for the markup entity.

=
ADDITIONAL INFORMATION: Selecting Bylayer é‘ changes the markup entity color to the
color of the layer.

Defining a Custom Color

To define your own color, take the following steps:

TASK

1. From the Fill Color list, select Custom Color 4.
STEP RESULT: The Color dialog appears.

2. Select a color and click OK.

STep ResuLT: The fill color changes for the selected markup entity or entities.

3.  (lick OKto close the Markup Entity Properties dialog.

RESULT:
The fill type changes for the selected markup entity or entities.

NOTE: Any new markup entities that you create will have the new fill color.

Markup Layers

You can move selected markup entities to a specific layer—the markup entities will inherit
the properties of the layer.

TASK
1. From the Markup Layer list, select the layer you want to make active.

2. Click OKto close the Markup Entity Properties dialog.

ResuLT: The selected layer appears in the workspace.

See “Setting the Active Markup Layer”
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Leader Alignment

With the Leader markup entity, you can adjust the location of the leader line’s anchor point
to the text box. The Leader Alignment list has the following option for anchor point loca-
tion with respect to the text box: Top Left, Top Center, Top Right, Center Left, Center,
Center Right, Bottom Left, Bottom Center, and Bottom Right.

Text Box Visibility

You can choose to hide the surrounding box for the Leader, Text, and 3D Text markup enti-
ties.
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Printing

With AutoVue, you can print and preview files. Original files can be printed on their own
or with associated markups and overlays. You can also choose which markup layers to
make visible so that they can print.

With the Batch Print option, you can send a list of files to print at the same time.

When printing a file, there are print properties that you can define. From the File menu,
select Print to display the following properties:

Option Description

Print Define the print options.
See “Print Options”

Margins Define the margin settings.
See “Print Margins”

Headers/Footers Define the headers/footers to be included on every page printed.
See “Header/Footer”

Watermark Define the watermark to be included on every page printed.
See “Watermarks”

Stamps Define the stamp to be included on every page printed.
See “Adding a Stamp”

Pen Settings Change the thickness assigned to a pen.
See “Assigning Pen Settings”

Print Options

With the Options tab, you can define print options for the printed file. The options are:
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Option

Type

Description

Print to File

Click to print to file and not to a printer.

Modify

Sets printer properties, such as printer, paper size,
orientation, and so on.

Scaling

Fit to page

Scales the image to fit on the output page.

Factor

Scales the image according to the scaling factors that you
have manually entered in the input fields.
Units can be entered as inches, millimeters or pixels.

Scale

Scales the image according to percentage. You can select
a predefined scaling factor or manually enter a customer
scaling factor.

Decimal places are excepted.

Document Pages

Sets the document pages to print: All, Current or
Range.

Alignment/Offset

Specifies where the drawing will appear on the print out.

Page Area

Extents

Prints the extents of the document.

Displayed

Prints the area displayed in the View window.

Limits

Limits printing to one page when the scaling options
selected causes a single document page to span over

multiple printer pages.

Option is only enabled when Current is selected for

Document Pages.

Selected

Prints the area selected in the View window.
Option will only be enabled when Current is selected for
Document Pages.

Force all colors to black

Forces all colors to black.

Output a single page

Prints file on a single page.

Print Row Headers

Prints row headers.
Option is only enabled for spreadsheets, archive and
database files.

Print Column Headers

Prints column headers.
Option is only enabled for spreadsheets, archive and
database files.

Partial Preview

Displays a view of the printer page, highlighting the
printable area.
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Option

Type

Description

Number of Copies

Select the number of copies you want to print of the file.

Configuring the Print Options

TASK

1.  From the File menu, select Print.

ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Print &2,

STEP RESULT: The Print Properties dialog appears.

i d W

Click the Options tab.
Configure the print options.

Configure other print options.

To view a partial view of the file, click Partial Preview.

STEP RESULT: The Partial Print Preview dialog appears.

6. Click OK to print.

ResuLT: The Print dialog appears indicating the document is printing.

Print Margins

With the Margin tab, you can define the top, bottom, right and left margins for the printed

file. You can define:

Option Description
Margins Set the value for the Left, Top, Right, and Bottom margins.
Minimum Sets the acceptable minimum margins for the selected printer.
Override If selected, overrides the minimum margins for the selected printer.
printer-minimum margins

3/1/11

275



PRINTING

HEADER/FOOTER
Option Description
Units Specify the unit for the margins.
Setting the Margins
TASK
1. From the File menu, select Print.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Print =)
STEP RESULT: The Print Properties dialog box appears.
2.  Click the Margins tab.
3.  Enter the margin size that you want for Left, Top, Right, and Bottom or click
Minimum if you want to set the margins to the minimum acceptable for the
selected printer.
ADDITIONAL INFORMATION: When you click Minimum, the minimum margins allowable auto-
matically appear in the Margins.
4.  Select Override printer-minimum margins if you want to override the minimum
margins set for the printer.
From the Units list, select the unit to which you want to set the margins.
6.  Configure other print options.
7. Toview a partial view of the file, click Partial Preview.
STEP RESULT: The Partial Print Preview dialog box appears.
8.  Click OK to print.
ResuLT: The Print dialog box appears indicating the document is printing.
Header/Footer

From the Headers/Footers tab of the Print Properties dialog box, you can define the
headers and footers that you want to print on every page of the document. You can enter
the text manually or choose from a list of Insert Codes.

The list of insert codes are:

%f: Full path of document
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. %v: Document Drive

. %d: Document Directory

. %Db: Document Base name

. %e: Document file extension
. %n: Total document pages

. %p: Current page number

. %N: Total tiled-pages

. %P: Current tile number
. %Y: Date: Year

. %M: Date: Month

. %D: Date: Day

. %W: Date: Day of week
. %H: Time: Hour

. %U: Time: Minute

. %S: Time: Seconds

. %r: New line

. %F: Native Print Settings (Excel)

NOTE: A literal percentage mark is entered manually as %%.

Adding a Header and Footer

In the Headers/Footers tab, you can manually enter text or choose from a list of Insert
Codes to appear in the headers and footers. You can also print system variables.

TASK

1. From the File menu, select Print.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Print &,
STEP RESULT: The Print Properties dialog appears.

2.  Click the Headers/Footers tab.

3.  (lickin the Left, Center or Right field and enter the text that you want to appear
in the header and footer, or choose an Insert Code or Insert Variable.

4. Tolnsert Code in the header or footer, click Left, Center or Right, then select a
code from the list.
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11.

12.

To Insert Variable in the header or footer, click Left, Center or Right, then select
a variable from the list.

To change the Font, click Set Font. The Font dialog appears.
From the Font list, select the type of font.

From the Size list, select the size of font.

To set the font Style, click Bold or Italic or both, then click OK.
In the Print Properties dialog, configure other print properties.

To view a partial view of the file, click Partial Preview.
STEP RESULT: The Partial Preview dialog appears.

Click OK to print.

ResuLT: The Print dialog appears indicating the document is printing.

Native Print Settings

You can choose to include predefined headers and footers when printing an Excel file from
AutoVue.

TASK
1.

2.

From the Print Properties dialog, click the Headers/Footers tab.

Under Headers and Footers, click inside the Left, Center, and Right boxes corre-
sponding to the header or footer position in the original file.

Select %F: Native Print Settings (Excel) from the Insert Code list.
Click OK to print.

REsULT: The Excel file’s headers and footers are printed.

Watermarks

With the Watermark tab, you can specify a watermark that will appear on a printed file.
When printing a watermark, it appears transparent on the file contents. You can choose a
horizontally or vertically oriented watermark.

In addition to entering text, you can:
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. set the type, size and style of font
. insert Watermark information
. print system variables

To insert Watermark information, AutoVue provides a list of codes that you can choose
from. These codes are:

. %f: Full path of document

. %v: Document Drive

. %d: Document Directory

. %Db: Document Base name

. %e: Document file extension
. %n: Total document pages

. %p: Current page number

. %N: Total tiled-pages

. %P: Current tile number
. %Y: Date: Year

. %M: Date: Month

. %D: Date: Day

. %W: Date: Day of week
. %H: Time: Hour

. %U: Time: Minute

. %S: Time: seconds

. %r: New line

NOTE: A literal percentage mark is entered manually as %%.

Adding a Watermark

TASK

1. From the File menu, select Print.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Print &,
STEP RESULT: The Print Properties dialog box appears.

2.  Click the Watermark tab.
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Enter the Watermark Text that you want to appear on the file.
4. Toinsert a code in the watermark, select a code from the Insert Code list.

For example, if you select %n: Total document pages, the total number of pages
for the selected file will appear in the watermark.

ADDITIONAL INFORMATION: You can insert more than one code.

To set the orientation of the watermark, click Diagonal, Horizontal, or Vertical.
To change the Font, click Font. The Font dialog box appears.

Configure the font, then click OK.

v o N o

In the Print Properties dialog box, configure other print properties.

10. To view a partial view of the file, click Partial Preview.
STEP RESULT: The Partial Print Preview dialog box appears.

11. Click OK to print.

RESULT:

The Print dialog box appears indicating the document is printing.

Adding a Stamp

With the Stamps tab, you can set the position and size of a stamp to print over the current
file. You also have the option to include the stamp on every page of the printed file. When
printing, the stamp hides any area of the print file that it covers.

TAsK
1.  From the File menu, select Print.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Print =)
STEP RESULT: The Print Properties dialog box appears.
2.  Click the Stamps tab.
3. Click Add.
STEP RESULT: The Open dialog box appears.
4.  Enter afile name or browse to locate the file that you want to use as a stamp.

STEP RESULT: The file appears in the Print Properties dialog box.

5.  Selectthe Page selections to specify the pages that you want the stamp to appear
on.
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6. To set the Position of the stamp, enter the width in the first field, then length in
the second.

ADDITIONAL INFORMATION: You can also change the position by clicking and dragging the
box in the Preview window.

7. Toset the Size of the stamp, enter the width in the first field, then length in the
second.

ADDITIONAL INFORMATION: You can also change the size by clicking and dragging the handles
on the box in the Preview window.

STEP RESULT: The size of the stamp is represented in the Preview area.

8.  From the Units list, select the unit in which you want to set for the width and
length of the stamp.

9. Toadd more than one stamp to a file, repeat steps 3 to 8.
10. Toremove a stamp, select the stamp and click Remove.
11. Inthe Print Properties dialog box, configure other print properties.

12. Toview a partial view of the file, click Partial Preview.
STEP RESULT: The Partial Print Preview dialog box appears.

13. Click OK to print.

ResuLT: The Print dialog box appears indicating the document is printing.

Assigning Pen Settings

From the Pen Settings tab of the Print Properties dialog box, you can set the thickness of
the color indices for the print file.

NOTE: AutoVue uses the default pen color indices of the native document for the vector file
being viewed. You will not be able to change the color assigned to a pen with AutoVue.

TAsK

1.  From the File menu, select Print.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Print =)
STEP RESULT: The Print Properties dialog box appears.

2.  Click the Pen Settings tab.
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3. Under From/To, select the Color Index that you want to assign a new pen thick-
ness.
ADDITIONAL INFORMATION: To change more than one color indices, press the Shift or Control
key while selecting.

4.  From the Units list, select the unit of measure that you want to set the thickness.
Enter the new thickness.
STEP RESULT: The new Thickness appears beside the Color Index.

6. Inthe Print Properties dialog box, configure other print properties

7.  Configure other print options.

8. Toview a partial view of the file, click Partial Preview.
STEP RESULT: The Partial Print Preview dialog box appears.

9. Click OK to print.
STEP RESULT: The Print dialog box appears indicating the document is printing.

RESULT:

NOTE: Pen settings are stored in .c2t files. The Current Pen Settings list displays all existing
.c2t files for the current file. The default pen settings are stored in default.c2t and alternate
pen settings are stored in alt.c2t.

Creating a New Pen Setting

TASK
1.

2.
3.

Set the thickness for the color indices that you want.
Click Save As. The Save As dialog appears.

Enter a file name with a .c2t extension, then click OK.
STEP RESULT: The new pen setting appears in the Current Pen Settings list.

In the Print Properties dialog, click OK to print.

ResuLT: The Print dialog appears indicating the document is printing.

Deleting a Pen Setting

TASK

1.

Select the pen setting that you want to delete from the Current Pen Settings.
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2.  Click Delete.
STEP REsULT: The pen setting disappears from the list.

3.  Click Cancel to close the Print Properties dialog.

Partial Preview of a File

The Partial Print Preview dialog displays the printable area on top of the page area so that
users can have a clear idea of what will be printed.

NOTE: Option is only enabled when Current is selected from Document Pages.

TASK
1. Configure the print properties.

2.  Click Partial Preview in the Print Properties dialog.

STEP RESULT: The Partial Print Preview dialog appears and highlights the area that will be
printed. The Paper size, Printable Area, and Drawing Area are displayed.

3.  Click OK to close the Partial Print Preview dialog.

Previewing a File Before Printing

You can preview a print copy of the current active file on screen according to your printer’s
capabilities and the print property settings.

TAsK
1. View the file in AutoVue.
2.  From the File menu, select Print Preview.
ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Print Preview &2,

STEP RESULT: The Print Properties dialog box appears.

3.  Configure the print properties.
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Click OK.

ADDITIONAL INFORMATION: You can print the file from the Print Preview window by clicking
Print. You can also zoom in and out of a file, as well as navigate from one page to another
of a multi-page file.

STEP RESULT: The file appears in Print Preview Mode in the Print Preview window.

Click Close to close the Print Preview window.

Printing a File

You can print original files along with their Markup files and selected markup layers
together so that they appear as one file.

TASK
1.

2.
3.

Open the file you want to print.
To print the associated markups, open the Markup file or files you want to print.

If you are printing Markup files and you want to print the visible layers, from the
Markup menu, select Markup Layers.

STEP RESULT: The Markup Layers dialog appears.

Select the markup layers you want visible.

Click OK to close the Markup Layers dialog.

From the File menu, select Print.

ADDITIONAL INFORMATION: From the AutoVue toolbar, you can also click Print =
STEP RESULT: The Print Properties dialog appears.

Configure the print properties.

To view a partial view of the file, click Partial Preview.

STEP RESULT: The Partial Print Preview dialog appears.

Click OK to print.

ResuLT: The Print dialog appears indicating the document is printing.
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Batch Printing

With the Batch Print option you can send a list of files to print at the same time. You can
also generate a batch by simultaneously opening all the files included in the batch print.

TASK
1.

From the File menu, select Batch Print.
STEP RESULT: The Batch Print dialog appears.

To add a file to be printed, click Add.
STEP RESULT: The Open dialog appears.

Enter the file name or browse to locate the file or files that you want to add, then
click Open.

ADDITIONAL INFORMATION: To add more files to the list, repeat steps 2 to 4. To remove a file(s),
select the file from the List of files to be printed and click Remove.

STEP RESULT: The files appear in the List of files to be printed.

Click OK in the Batch Print dialog.
STEP RESULT: The Print Properties dialog appears.

Configure the print properties.
Click OK to print.

ResuLT: The Print dialog appears indicating the document is printing.
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Conversion

Sometimes you need to convert a file to be able to use it with an application it was not
created from. AutoVue provides several conversion file formats for you.

Conversion Options

Depending on the conversion type being performed, the available options in the Convert
dialog box will vary. These options are:

Option Description

Save As Specify the name and path of the file in which the conversion is to be
stored. This file is also known as the output file. You can use Browse
to provide AutoVue with the file’s path.

Convert to Format A list of all the possible types of output file formats currently available
for conversion. The available formats are:
CALS GP4

Encapsulated Postscript (Raster)

HP Laserjet Printer (PCL)

Run Length RLC File

PCX Bitmap

PDF

Stereolithography (STL)

TIFF

Virtual Reality Modeling Language (VRML)
Windows Bitmap

Sub-Format The Sub-Format list appears when you select TIFF or STL from the
Convert to Format list.
Select the Sub-Format from the list.
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Option Description
Color Depth Select an option from the list:
1 = Black and white
4 =16 colors

8 =256 colors

24 = True color

auto = AutoVue selects the color depth that best matches the original
file.

Option is not available for STL and VRML formats.

Positive Triangle Values When selected, the model is translated so that all the vertex
coordinate values are positive.
Option is only available when Convert to Format is set to STL.

Convert Region The area of the file to be converted. The available options are:

All - converts the entire file

Display - converts the image to fit on the output page For example, if
you zoomed in on a particular region of the file, the zoomed portion
of the file is converted.

Extent - converts the entire extents of the file

Selected - converts the selected model parts in the file

Options vary depending on the selected format.

Convert Pages The number of pages to be converted. The available options are:
All - converts all pages of the file

Current - converts the current page of the file

Range - converts the pages of the file indicated in the range
Option is only enabled when converting to TIFF.

XandY Specify X and Y to define the resolution for the converted file.

X indicates the number of horizontal pixels

Y is the number of vertical pixels for the current active file contents
At times, AutoVue presets X and Y to match the specifications of the
selected conversion file format.

PDF

With AutoVue it is possible to convert Office, 2D and EDA formats to PDF. When
converted from Markup Mode, markups are added to the contents of the base PDF file.
When you open the PDF, you will see the base file along with all markups.
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XandyY

Three factors affect the resolution of an image: the type of image you are scanning, the
output device and the acceptable file size. High-resolution scans often require large files,
causing longer processing and print time. Note that a high-resolution may not produce a
better-quality printed image if your output device does not recognize the higher resolution
information stored in the file. To keep file sizes manageable, select the lowest resolution
that provides acceptable quality on your output device.

With some file types, the Size option appears giving you a choice between millimeters and
inches. Page sizes can be selected from the Size list or you can customize page sizes by
configuring the Initialization file. For more information, refer to the Installation and

Configuration Guide.

Technical Drawing Page Sizes

ISO Paper Format

A8.5” X 11.0” (216 mm X 279 mm)

B11.0” X 17.0” (279 mm X 432 mm)
C17.0” X 22.0” (432 mm X 559 mm)
D22.0” X 34.0” (559 mm X 864 mm)

E34.0” X 44.0” (864 mm X 1118 mm)

A4 285 mm X 198 mm

A3 396 mm X 273 mm

A2 570 mm X 396 mm

Al 817 mm X 570 mm

A0 1165 mm X 817 mm

Converting a File

TASK

1.  From the File menu, select Convert.

ADDITIONAL INFORMATION: The Input area varies according to the type of file. For example, a
word-processing file displays the file and format, a raster file displays the file path/name,
format and size, and vector and database files display the size, file type and dimensions.

STEP RESULT: The Convert dialog appears.

2. Inthe Save As field, enter the path and filename or click Browse to locate the
directory where you want to save the converted file.

ADDITIONAL INFORMATION: If writing on to an existing file, the contents of the output file will

be overwritten.
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Specify the conversion options.

4.  Click OK. The file is converted and appears in the specified directory.

ADDITIONAL INFORMATION: You can convert several selected pages of a multi-page fileto a
multi-page TIFF.

Changing the Pen Settings

With AutoVue, you can specify a thickness for each pen color when doing a conversion.
This option only applies to vector files.

TAsK
1.  From the File menu, select Convert.
STEP RESULT: The Convert dialog appears.
2. Click Pens.
STEP RESULT: The pen Thickness dialog appears.

3. Inthe From/To section of the Pen Thickness dialog, select the Color Index for
which you want to modify the thickness.

ADDITIONAL INFORMATION: To select more than one Color Index, press the Shift or Control
keys while selecting.

4.  From the Units list, select the unit in which you want to set the thickness.
In the Thickness field, enter a thickness value.

6.  Press the Enter key.

STEP RESULT: The new thickness value appears beside the selected Color Index in the
From/To section of the Pen Thickness dialog.

7.  Tosave the changes that you made, click Save As.
STEP RESULT: The Save As dialog appears.
8.  Enter afile name for the new pen settings.

9. Click OK.

ADDITIONAL INFORMATION: To modify an existing pen setting, select the pen setting from the
Current Pen Settings list, make the changes, then click Save.

STEP RESULT: The new pen settings are saved and appear in the Current Pen Settings list.

10. Click OK to close the Pen Thickness dialog.
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Batch Conversion

You can save time by simultaneously converting files with the same output file format.

TASK
1.

From the File menu, select Convert.

STep ResuLT: The Convert dialog box appears.The Convert dialog box appears.The Convert
dialog box appears.

2. Click Batch Convert.
STEP RESULT: The Batch Convert dialog box appears.

3. (lick Add.
STEP RESULT: The Open dialog box appears.

4.  Enter the file name or browse to locate the file that you want to add, then click
Open.
ADDITIONAL INFORMATION: To add more files, repeat steps 3 to 4.To remove a file, select the
file from Input File List and click Remove.
STEP RESULT: The file appears in Input File List.The file appears in Input File List.

5.  Customize the convert options.

6. Click OK.

RESULT:

AutoVue stores the newly converted files in the same directory as the first file you entered
in Input File List.
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Customizing AutoVue

There are configuration options that allow you to customize the AutoVue work environ-
ment. You can create tools to automate a variety of functions, including creating a hot key
or access key, and also customize toolbars and thumbnails to display according to your
preferences. You can access the configuration options from the Options menu.

Defining the Clipboard

With the Clipboard Options you can define the type of information copied to the clip-
board for later transfer to other applications.

The types of information that you can copy for raster, vector, spreadsheet, document and
database files are:

Type Description

DIB The acronym for Device Independent Bitmap and refers to the hardware
information that is used to create a conversion bitmap.

Bitmap A rectangular array of colors representing a pixel bit map image.
Palette Refers to color image information.
Metafile A file storing the commands necessary for a Windows application to

recreate a vector format image.

Text Refers to ASCII formatted text.

RTF Acronym for Rich Text Format and refers to the formatting information
found in documents that allow fonts, margins and tabs to remain in
documents.

Include Headings Refers to displaying the row and column titles for databases and
spreadsheets.
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To define clipboard options:

TASK
1.

From the Options menu, select Configure Clipboard.
STEP RESULT: The Clipboard Options dialog box appears.

Under the different file types, click the type of information that you want to copy
to the clipboard.

Click OK.

Copying Information

TASK
1.

2.
3.

From the Edit menu, select Select.
Click and drag to select the area you want to copy.

From the Edit menu, select Copy.
STEP RESULT: The information is copied to the clipboard.

Launch the application that you want to copy the information to.

Paste the information.

Tools

Tools are shortcuts for commonly repeated tasks. You can create tools to automate a variety
of function such as importing objects, files and applications into the user interface; running
a script file; connecting AutoVue to Dynamic Data Exchange (DDE) servers and linking to
Dynamic Link Library (DLL) loads.

Adding a Tools Menu Item

TASK
1.

From the Options menu, select Customize Tools.
STeEP RESULT: The Add Tool Menu Item dialog box appears.
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2. Click Add.
STEP RESULT: The Configure Tools Menu Item dialog box appears.

In the Menu Item Name field, enter a name.

4.  Select one of the following from the Menu Item Action section:
a Application to launch an outside application.
b Script File to launch a script file.
' DDE Server to send DDE commands to a server application.
d DLL to invoke a DLL.

5. Inthe field to right of the Menu Item Name options, enter the name and path of
the executable file. Otherwise, click Browse to locate the specific file or applica-
tion.

6. If you select Application, click Configure. The Link to Application dialog box
appears. Enter the command line to launch an application, then click OK.

7.  Ifyou select Script File, click OK.

8. Ifyou select DDE Server, click Configure. The Link to DDE dialog box appears.
Enter the Topic and Commands, click Start Application, then click OK.

9. Ifyouselect DLL Load, click Configure. The Link to DLL dialog box appears. Enter
the Entry Function to invoke a DLL, then click OK.

10. Inthe Menu Item Description field, enter a menu item description.

11. Click OK.

12.  From the Options menu, click Customize Tools to view new menu item.
13. Click OK to close the Add Tool Menu Item dialog box.

Creating a Hot Key

TASK
1. From the Options menu, select Customize Tools.
STEP RESULT: The Add Tool Menu Item dialog box appears.
2. (lick Add.
STEP RESULT: The Configure Tools Menu Item dialog box appears.
3.  Enter an ampersand (&) before the Menu Item Name.

ADDITIONAL INFORMATION: For example, if you entered the menu item name &Application.
The letter A after the & will be the hotkey.

4. Click OK.
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From the Options menu, click Customize Tools to view new menu item.
ADDITIONAL INFORMATION: It has the letter A underlined.

Click OK to close the Add Tool Menu Item dialog box.

ADDITIONAL INFORMATION: To activate the hotkey, hold the Alt key while pressing T and then
A.

Modifying a Tools Menu Item

TAsK
1.

From the Options menu, select Customize Tools.
STeP RESULT: The Add Tool Menu Item dialog box appears.

Under Menu Contents, select the item that you want to modify.

Click Modify.
STEP RESULT: The Configure Tools Menu Item dialog box appears.

Make the necessary changes.
Click OK.
Click OK to close the Add Tool Menu Item dialog box.

Moving a Tools Menu Item

TASK
1.

From the Options menu, select Customize Tools.
STepP REsuLT: The Add Tool Menu Item dialog box appears.

From the Menu Contents list, select the item that you want to move.
Click Up or Down to move the item to where you want in the list.
Click OK to close the Add Tool Menu Item dialog box.

Deleting a Tools Menu Item

TASK

1.

From the Options menu, select Customize Tools.
STeP REsULT: The Add Tool Menu Item dialog box appears.

296

3/1/11



CUSTOMIZING AUTOVUE
CUSTOMIZING TOOLBARS

2. From the Menu Contents list, select the item that you want to delete.

3. (lick Delete.
STEP RESULT: The item disappears from the list.

4.  Click OK to close the Add Tool Menu Item dialog box.

Customizing Toolbars

You have the option to hide or display toolbars and to changed the size of the toolbar
buttons.

TASK
1. From the Options menu, select Customize Toolbars.
STEP RESULT: The Toolbar Settings dialog box appears.

2. Select the check box beside the toolbars that you want to display or deselect the
check box beside the toolbars that you want to hide.

3.  Select the Toolbar Button Size that you want the buttons to appear on the tool-
bars.

4, Click OK.

ResuLT: The selected toolbars are changed.

Configuring the Mail Utility

At the time of installation, AutoVue integrates with MAPI compliant mail utilities that are
installed on your computer, such as Microsoft Outlook. Electronic mail can then be
accessed from within AutoVue, with the option to send a message only, send a message
with links to Markup files or send a message with copies of Markup files.

The graphical interface and mailing options that are available to you are determined by the
MAPI compliant mail utility you are using. AutoVue automatically attaches the current
active file to messages when the Mail option is activated. However, Markup files associated
with the original file are left for you to select and attached to your mail message.
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To configure the mail utility:

TASK
1. From the Options, select Configure Email.
STEP RESULT: The Mail Options dialog box appears.

2. From the Mail Using list, select the type of MAPI compliant mail utility you are
using.

Select the Mailing Preferences that you want.
4.  Click OK to close the Mail Options dialog box.
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Thumbnails

Thumbnails allow you to build a visual representation of the entire contents of a directory
in a thumbnails folder. Miniature visuals of the thumbnails folder file contents is created to
help you preview files.

Also available is a generic customized icon that is particularly helpful for identifying files
that are more readily acknowledged by their file type. For example, a word-processing
document located in a directory where the majority of the files are graphic formats. As files
are modified, their thumbnails can be updated quickly and easily. AutoVue stores thumb-
nails information in the avwin/folders directory.

Creating a Thumbnail Folder

If a thumbnails folder already exists for the current directory, the Thumbnails window will
appear displaying the thumbnails.

TASK
1. From the File menu, select Thumbnails.
STEP REsULT: The New Folder dialog box appears.

2.  Click Create.

ADDITIONAL INFORMATION: This may take a few minutes depending on the size and number
of files in the folder. If the thumbnails folder is taking to long to create, you can skip it by
clicking Skip in the New Folder dialog box. To resume creating the folder, from Thumb-
nail menu, select Update All.

STEP RESULT: AutoVue creates the thumbnails folder for the current directory and the
Thumbnails window appears displaying the thumbnails for that folder.

3. Toclose the Thumbnails window, from the Thumbnail menu, select Exit Thumb-
nails.
ADDITIONAL INFORMATION: From the Thumbnail toolbar, you can also click Exit Thumbnails

Ed.

3/1/11

299



THUMBNAILS
CUSTOMIZING THUMBNAILS

Customizing Thumbnails

You can customize thumbnails to display according to your preferences.

TASK

1. From the File menu, select Thumbnails.
STEP REsULT: The Thumbnails window appears.

2. From the Options menu, select Configure Thumbnails.
STEP RESULT: The Configure Thumbnails dialog box appears.

3.  Select the Size in pixels of the thumbnails.

ADDITIONAL INFORMATION: You can customize the size of the thumbnails by clicking Custom
and entering a value.

4.  Enter the Space between thumbnails.

ADDITIONAL INFORMATION: The space between thumbnails must be between 2 and 20.

5.  Select the File Details that you want to display in the thumbnail.

. Select Full if you want to display the filename, size, date and time of creation.
. Select Partial if you want to only display the filename.

6. Click OK.

7. Toclose the Thumbnails window, from the Thumbnail menu, select Exit Thumb-
nails.

ADDITIONAL INFORMATION: From the Thumbnail toolbar, you can also click Exit Thumbnails

Ed.

Viewing a Thumbnail Folder

You can display thumbnail folders from View or Markup mode. If a thumbnails folder does
not exist for the current directory, the New Folder dialog box appears with the option to
create a new folder.

TASK
1. From the File menu, select Thumbnails.
STEP RESULT: The Thumbnails window appears.
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From the Thumbnail menu, select Browse for Folder.

ADDITIONAL INFORMATION:  From the Thumbnail toolbar, you can also click Browse for Folder
|

STEP RESULT: The Browse for Folder dialog box appears.

Browse to locate the thumbnails folder that you want to view.

Click OK.

STEP RESULT: The thumbnails for the selected folder appear in the Thumbnails window.

To close the Thumbnails window, from the Thumbnail menu, select Exit Thumb-
nails.

ADDITIONAL INFORMATION: From the Thumbnail toolbar, you can also click Exit Thumbnails

Ed.

Sorting a Thumbnail Folder

From the File menu, select Thumbnails.
STEP RESULT: The Thumbnails window appears.

From the Thumbnail menu, select Browse for Folder.

ADDITIONAL INFORMATION: - From the Thumbnail toolbar, you can also click Browse for Folder
it ]

STEP RESULT: The Browse for Folder dialog box appears.
Browse to locate the thumbnails folder that you want to sort.

Click OK.
STEP RESULT: The thumbnails for the selected folder appear in the Thumbnails window.

From the Thumbnail menu, select Sort and the option that you want to sort by.

ADDITIONAL INFORMATION: A check mark beside the sort option indicates the current sort
order.

To sort the thumbnails in ascending or descending order, from the Thumbnail
menu, select Sort Order, and then select Ascending or Descending.

To close the Thumbnails window, from the Thumbnail menu, select Exit Thumb-
nails.
ADDITIONAL INFORMATION: From the Thumbnail toolbar, you can also click Exit Thumbnails

Ed.
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Viewing a Thumbnail

Files are instantly accessible from the Thumbnails window.

TASK
1.

From the File menu, select Thumbnails.
ADDITIONAL INFORMATION: The Thumbnails window appears.

From the Thumbnail menu, select Browse for Folder.
ADDITIONAL INFORMATION:  From the Thumbnail toolbar, you can also click Browse for Folder

51

STEP RESULT: The Browse for Folder dialog box appears.
Browse to locate the thumbnails folder that you want to view.

Click OK.
STEP RESULT: The thumbnails for the selected folder appear in the Thumbnails window.

Double-click the thumbnail that you want to view.

ResuLT: The thumbnail is launched in the AutoVue workspace.

Updating Thumbnails

You can update all the thumbnails in the current folder or update one or more thumbnails
in the current folder.

TASK
1.

From the File menu, select Thumbnails.
ADDITIONAL INFORMATION: The Thumbnails window appears.

From the Thumbnail menu, select Browse for Folder.
ADDITIONAL INFORMATION:  From the Thumbnail toolbar, you can also click Browse for Folder

51

STEP RESULT: The Browse for Folder dialog box appears.
Browse to locate the thumbnails folder that you want to view.

Click OK.
STEP RESULT: The thumbnails for the selected folder appear in the Thumbnails window.
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5. Select the thumbnail or thumbnails that you want update.

ADDITIONAL INFORMATION: To select more than one thumbnail, press the Shift or Control key
while selecting.

6. From the Thumbnail menu, select Updated Selected.

ADDITIONAL INFORMATION: To update all thumbnails, from the Thumbnail menu. select
Update All, or from the Thumbnail toolbar, click Update Thumbnail Folder &£

STEP RESULT: The selected thumbnails are updated in the current folder.

7. Toclose the Thumbnails window, from the Thumbnail menu, select Exit Thumb-
nails.
ADDITIONAL INFORMATION: From the Thumbnail toolbar, you can also click Exit Thumbnails

£

Converting Thumbnails

TASK
1. From the File menu, select Thumbnails.
ADDITIONAL INFORMATION: The Thumbnails window appears.
2. From the Thumbnail menu, select Browse for Folder.
AJDnDITIONAL INFORMATION: From the Thumbnail toolbar, you can also click Browse for Folder

STEP RESULT: The Browse for Folder dialog box appears.
Scroll to locate the thumbnails folder that you want to convert.
4.  Click OK.
STEP RESULT: The thumbnails for the selected folder appear in the Thumbnails window.

5. Select the thumbnail or thumbnails that you want to convert.

ADDITIONAL INFORMATION: To select more than one thumbnail, press the Shift or Control key
while selecting.

6. From the Thumbnail menu, select Convert.
STEP RESULT: The Batch Convert dialog box appears.

7.  Customize the conversion options.
8. Click OK.
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9. Toclose the Thumbnails window, from the Thumbnail menu, select Exit Thumb-
nails.

ADDITIONAL INFORMATION: From the Thumbnail toolbar, you can also click Exit Thumbnails
Mode EZ.

Printing Thumbnails

TAsK
1. From the File menu, select Thumbnails.
ADDITIONAL INFORMATION: The Thumbnails window appears.
2. From the Thumbnail menu, select Browse for Folder.
A{P_QDIT/ONAL INFORMATION: From the Thumbnail toolbar, you can also click Browse for Folder

<)

STEP RESULT: The Browse for Folder dialog box appears.
Scroll to locate the thumbnails folder that you want to print.
4. Click OK.
STEP RESULT: The thumbnails for the selected folder appear in the Thumbnails window.

5. Select the thumbnail or thumbnails that you want to print.

ADDITIONAL INFORMATION: To select more than one thumbnail, press the Shift or Control key
while selecting.

6. From the Thumbnail toolbar, click Print &.
STEP RESULT: The Print dialog box appears.

7. Click OK.
8. Toclose the Thumbnails window, from the Thumbnail menu, select Exit Thumb-
nails.

ADDITIONAL INFORMATION: From the Thumbnail toolbar, you can also click Exit Thumbnails
Mode ET.
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Full Text Extraction

The Full Text Extraction application provides a facility for obtaining all the textual infor-
mation from a selected file. This may be used by a search engine to provide document
indexing services. It eliminates duplicates and enables the search for all type of documents,
including CAD.

NOTE: Auto Text Extraction is not available for raster files.

Using the Full Text Extraction Utility

TASK
1.  From the Tools menu, select Auto Text Extraction.

ADDITIONAL INFORMATION: You can also open the Auto Text Extraction dialog box by opening
the file Outtext.exe located in the directory C:\Program Files\av\avwin.

STEP RESULT: The Automatic Text Extraction dialog box appears.

2. Inthe From field, enter the path and filename of the file from which the text is to
be extracted.

3. Inthe To field, enter the path and filename or click Browse to locate the file to
which the text is to be copied.

ADDITIONAL INFORMATION: File extensions include .txt and .out. The default is text.out
located in the temp directory. If the file does not exist, the file will be created for you.

4.  Select Display Output Contents if you want to preview the extracted text under
Contents.

5.  Click Extract.
STEP RESULT: The path and filename, and the text appears in the Output Contents.

6. Click Close to close the Automatic Text Extraction dialog box.
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CAD Information Extraction

This utility allows users to extract XRef information from a CAD file. This is useful for
batch importing AutoCAD, MicroStation and various other types of CAD files into a docu-
ment management system.

TASK
1.

From the Tools menu, select Auto Text Extraction.
STEP REsuLT: The CAD/Doc Text Extraction dialog box appears.

In the From field, enter the path and file name of the file from which the text is to
be extracted.

In the To field, enter the path and file name or click Browse to locate the file to
which the text is to be copied.

ADDITIONAL INFORMATION: File extensions include .txt and .out. The default is text.out
located in the temp directory. If the file does not exist, the file will be created for you.

Select Display Output Contents if you want to preview the extracted text under
Contents.

Click Extract.
STEP RESULT: The path and filename, and the text appears in the Output Contents.

Click Close to close the CAD/Doc Text Extraction dialog box.

ADDITIONAL INFORMATION: Examples of integrations can be found in the Integrat directory of
the media pack.

306

3/1/11



AutoVue Mobile

AutoVue Mobile provides the ability to view and add markups to files in a disconnected
environment. Whether you are travelling or need to share files with an external partner,
you can still view files, markups, and add new markups. Additionally, when connected, you
can update your backend DMS/PLM/ERP/UCM system with edits you make offline.

Using the AutoVue Mobile feature in AutoVue, you can create a Mobile Pack (a "packaged"
file that contains the base file, all the external resources—fonts, XRefs—needed to fully
display the file, and existing markups for the file). The streaming files and renditions can
also be included when creating the Mobile Pack.

Once a Mobile Pack is created, you can view your drawing and markups by viewing the
Mobile Pack. You can create new markups, consolidate them with existing markups into
one markup, or create a master Markup file that loads up automatically when you view the
Mobile Pack.

In a disconnected environment, depending on the markup policy defined during Mobile
Pack creation, you can add markups using AutoVue Desktop Version or the Desktop
deployment of AutoVue. Markup policies define whether or not users can create/save new
or existing markups, modify/delete (DMS only) existing markups, or automatically upload
markups.

When you have access to your backend system, from AutoVue, you can update all the
markups into the backend system. These markups are imported into the system and are
associated with the base file from which you originally created the Mobile Pack.

The following sections provide details on creating a Mobile Pack, creating markups in
AutoVue Mobile, understanding markup policies, and updating Markup files from Mobile
Pack.

Creating a Mobile Pack

The Mobile Pack includes the native file or streaming file, metadata, Intellistamp designs,
all reference files (XRefs), and associated markups. Optionally, you can include renditions
such as TIFF or PDF.
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The following steps explain how to create a Mobile Pack for a file with attached Markup

files:

TASK
1. Open the base file.

2.  From the AutoVue menu bar, select Collaborate, and then select Create Mobile

Pack.

STEP RESULT: The Create Mobile Pack dialog appears. It displays the General and Advanced
tabs, which contain the basic and advanced options for creating a Mobile Pack, respec-

tively.
3.  Click the General tab.
Create Mobile Pack [z
 General!| advanced

Base File: |

Select Resource File(s)
Resouce Type |Resource File
REF acadfont.map ~
FOMT AutoCAD_smalls, uff =
SHAPE AuboiCAl_shape?,uff
1 FomT e kA smalllnfF b
< | >

Select Markup File(s)
Password Marme
IF] AUECAD. 777

Ckpuk
Save As | | [ Brawse
[] E-Mail

[] Password Protected

[ (0] 4 l [ Zancel ] [ Help ]

ADDITIONAL INFORMATION: The following table lists the options available in the General tab:

Option Description

Base File Displays the file path of the base file.
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Option Description

Select Resource File(s) Lists all the fonts, XRefs, and other external resources that are used to fully

display the base file.
As a default, all resource files are selected.

Select Markup File(s) Lists all Markup files associated with the base file.

You can password protect single or multiple Markup files.

Output You can select the output location for the Mobile Pack, and also send the

file using your default e-mail client.

Password Protected You can password protect the Mobile Pack.

4.  From the Select Resource File(s) box, select the resource files to include in the
Mobile Pack.

5.  From the Select Markup File(s) box, select the Markup files to include in the
Mobile Pack.

6. If you wish to password protect the Markup files, select the Password check box
next to the Markup file.
a In the Password field, enter a password of any length and character.
b In the Confirm Password field, re-enter the password.
d Click OK to close the Password dialog.

7.  Tosave the Mobile Pack locally, from the Output options, specify the location and
name:
a Click Browse to locate the directory where you want to save, or in the Save As field,

enter the file path.

b Specify a name for the Mobile Pack.

8.  If you wish to send the Mobile Pack using your default e-mail client, select the
E-Mail check box.

9. Ifyou wish to password protect the Mobile Pack, select the Password Protected
check box.
a In the Password field, enter a password of any length and character.
b In the Confirm Password field, re-enter the password.
C Click OK to close the Password dialog.

10. To select Advanced options such as including streaming file and setting an expiry
date on the Mobile Pack, continue to the next step.

11.  If you do not wish to modify advanced options, click Finish to complete Mobile

Pack creation.
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12. Click the Advanced tab.

ADDITIONAL INFORMATION: Depending on the Company Wide Policy settings, the Advanced
tab options might be disabled. For more information on Company Wide Policy, refer to the
Installation and Configuration Guide.

Create Mobile Pack §|

General |§

Publishing

[] Expiry Date

1

Streaming File
(%) Include Mative File
{73 Include Streaming File

Renditicn

(%) Don't Include Rendition
(") Include POF Rendition
("3 Include TIFF Rendition

[ (0] 4 H Zancel ][ Help ]

ADDITIONAL INFORMATION: The following table lists the options available in the Advanced tab:

Option Description

Publishing Lets you specify an expiry date for the Mobile Pack. After the expiry date, the
content of the Mobile Pack will not be accessible.

Streaming File Lets you choose to include the native file or the streaming file in the Mobile Pack.
There are certain limitations when loading streaming files:

Streaming files do not support blocks and views options.

Streaming file requirements change with each release of AutoVue. As a result, a
streaming file from a previous version of AutoVue cannot be loaded in the latest
release.

For 3D files, including the streaming file reduces the file size of the Mobile Pack.
Also, since native files are not released, including the streaming file increases
security.

See Also “Streaming Files”
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Option Description

Rendition Lets you choose to include a PDF or TIFF rendition in the Mobile Pack.

13. If you wish to set an expiry date for the Mobile Pack, from the Publishing option,
select the Expiry Date check box and then select a date. The Mobile Pack cannot
be opened after this expiry date.

14. If you wish to include a streaming file, from the Streaming File option, select
whether to include a native file or streaming file in the Mobile Pack.

15.  If you wish, from the Rendition option, you can include a PDF or TIFF rendition in
the Mobile Pack.

16. Click OK to complete Mobile Pack creation.

ResuLT: If you selected the E-Mail check box, your default e-mail client opens with the
Mobile Pack (*.avp) as an attachment. Otherwise, the Mobile Pack is output to the specified
location.

Viewing Mobile Packs

Mobile Packs are opened in the same way as ordinary files. Users have access to all the
external reference files (XRefs), resource files, and markups bundled with the base file.
Additionally, users have the option to modify existing markups or create new ones to be
associated with the Mobile Pack.

You can open a Mobile Pack as you would open any other file in AutoVue:

TASK
1. From the AutoVue menu bar, select File, and then select Open.
STEP RESULT: The Open dialog appears.

2.  Browse to the location of the Mobile Pack (*.avp), and then select Open.
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10.

If the Mobile Pack is password-protected during creation, the Password dialog
appears. In the Password field, enter the password and then click OK.

ADDITIONAL INFORMATION: The native file or streaming file opens in AutoVue with all associ-
ated XRefs, resource files, markups, and renditions.

There are certain limitations when loading a streaming file:

. Streaming files do not support blocks or viewing options.

. Streaming file constraints change with each version of AutoVue. As a result, the
streaming file from an earlier version of AutoVue cannot be opened in a later
version.

. Streaming files are platform-specific. Therefore, a streaming file created on a

Windows platform cannot work on a UNIX platform, and vice versa.

If the Rendition option is selected during the creation of the Mobile Pack, from the
AutoVue menu bar, select Collaborate, and then select View Rendition from
Mobile Pack.

ADDITIONAL INFORMATION: It is not possible to add markups to a rendition.

STEP RESULT: The rendition appears in a new AutoVue window.

If there are associated Markups files, the Markup Indicator icon # appears in the
status bar. To open the Markup files, click the Markup Indicator icon #.

ADDITIONAL INFORMATION: From the menu bar, you can also click Open Markup(s) z.
STEP RESULT: The Choose a New or an Existing Markup dialog appears.

If you wish to create a new Markup file to include in the Mobile Pack, click Create
a new Markup file.

If you wish to open Markup files included in the Mobile Pack, click Choose an
existing Markup file, and then select the Markup files.

If the Markup file is password-protected during creation, The Password dialog
appears. In the Password field, enter the password and then click OK.

If you wish to import a Markup file from your local machine, click Import.
STEP RESULT: The File Open dialog appears.

Select the Markup file and click Open.

Creating Markup Files

When marking up a Mobile Pack, you can create new markups or consolidate existing
markups to a new markup. You cannot modify markups that are bundled during Mobile
Pack creation.
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When working with a Mobile Pack in the Desktop deployment of AutoVue, you may be
restricted from saving new markups, editing markups, deleting markups, opening
markups, and filtering as a result of the markup policy. The markup policy, which is defined
in Client/Server deployment of AutoVue, includes a set of rules to determine certain
restrictions and privileges for users of the Mobile Pack.

To save a new Markup file with a Mobile Pack, do the following:

TASK

1. Create markups.

2. From the AutoVue toolbar, click Save Markup 5.
STEP RESULT: The Save Markup dialog appears.
Enter a name for the Markup file in the Name field.

4,  If you wish to password protect the Markup file, select the Password Protected
check box.

5. If you wish to save the Markup file to a location on a local computer, click Export.
6. Click OK.

7. If you wish to send the updated Mobile Pack with your default e-mail client, from
the AutoVue menu bar, select Collaborate, and then select Reply to Mobile Pack.

RESULT: Your default e-mail client opens with the Mobile Pack (*.avp) as an attachment.

Updating from Mobile Pack

When you are finished working with the Mobile Pack, you can update your changes to the
backend DMS/ERP/PLM/UCM system. You can synchronize all of the markups created in
the Mobile Pack to your backend system. These markups will be associated with the file in
the backend system from which you originally created the Mobile Pack.

NOTE: This feature is only available in Cient/Server deployment of AutoVue.
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Appendix A: EDA Terms and

Definitions

The following table presents commonly used EDA terms and their corresponding defini-

tions.

EDA Term

Definition

Annular ring

A circular strip of conductive material that remains
after a hole has been drilled through the pad of a
printed circuit board.

Anti-copper

An area within a fill zone in which copper cannot
be placed.

Aperture

An opening, similar to the aperture of a camera,
that is used for photo-plotting. Apertures are
available in various sizes and shapes.

Aperture list

A text file containing the dimensions for each of
the apertures used to photo-plot PCB artwork.

Clusters

Components that are grouped according to their
interrelationships and placed in close proximity on
the board. This keeps the connections on the PCB
short so that the board is easier to work with.

Component

An element or a part of a PCB.

Component density

The quantity of components on a unit area of a
PCB.

Component hole

A hole in the printed circuit board that
corresponds to a pin or wire of a component. This
hole serves the dual function of attaching the
component to the board and establishing the
electrical connection between the pin or wire and
the remainder of the board circuitry.

Component library

A computer data file that contains the footprint
patterns for a number of components.
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EDA Term

Definition

Component side

The uppermost or top layer of a board on which
most components are placed.

Component silkscreen

The silkscreen markings of the printed circuit
board that appear on the component side. The
silkscreen is applied over the solder mask.

Component solder mask

The colored, usually translucent, coating applied to
the board over the etched copper. It protects the
selected areas from the soldering process.

Connection An unrouted, partially routed, or completely
routed path between two pads. In a net with n pads,
there are exactly n-1 connections.

Copper pour A method by which a copper zone is filled with a

specified pattern, with objects that cross the zone
or lie within the zone being avoided.

Copper zone

An area on a board designed to be covered by a
layer of copper when manufactured. Also known as
a "metal zone".

Cross hatching

The breaking up of large conductive areas by the
use of a pattern of lines and spaces in the
conductive material.

Datum

A specific location (a point) that serves as a
reference to locate a PCB pattern or layer for
manufacture.

Density

On a PCB, the degree to which components are
packed on the board. Generally, the density is given
as the number of square inches per equivalent, i.e.,
a lower number indicates a more dense board.

Discrete components

Components with three or fewer electrical
connections (for example, resistors or capacitors).

Electrical check The process of checking the PCB to ensure that the
connections they are on match those specified in
the net list.

Fill zone A zone that defines an area to be filled with copper.

Fine pitch A class of surface-mount components that is

characterized by pins measuring 0.025 inches or
less from pad center to pad center.
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EDA Term

Definition

Footprint

The physical description of a component. It
consists of three elements: padstacks, representing
the pads of the component; obstacles, representing
among other things, the physical outline of the
component, silkscreens, keepouts/keepins, and
assembly drawing data; and text documenting the
footprint information (for example, the component
name). You may want each project to have its own
footprint library containing all the footprints used
in that project.

Ground plane

A large area on the PCB, usually an entire layer,
that provides a common ground connection for all
component ground pins and other ground
connections.

Heatsink

A mechanical device made of a high thermal
conductivity material that dissipates heat generated
by a component or assembly.

Heuristics

A method of routing that consists of repeated
attempts to apply very simple routing patterns to
unrouted connections in order to complete the
routing quickly and cleanly. Typically, heuristics are
used for memory and short point-to-point routing.

Hole

The area where board material must be removed by
drilling or milling.

Isolation

The clearance around a pad, track, zone, or via that
defines the nearest approach allowed by
conductors of another signal set.

Jumper wire

A discrete electrical component or wire used to
make electrical connections between points that
have no copper etch due to board density or some
other factor.

Keepout An area fill within which no routing is allowed.
Land The copper pad needed for a surface mount pin.
Layer The copper pad needed for a surface mount pin.

Manual routing

Individual connections, in the form of traces,
vertices, arcs, and so on, which are entered
manually into the PCB design.

Mounting hole

A hole used for the mechanical support of a PCB or
for the mechanical attachment of components to a
PCB.
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EDA Term

Definition

Multi-layer board

A PCB that has multiple layers, separated by
dielectric material, with connectivity between
layers established by vias or through-holes. This
term usually refers to a board with more than two
layers.

Net

A logical construct (circuit) that originates in a
schematic and is transferred to a board to describe
required electrical connections. The connections
may be completed by using vias, tracks, or zones.

Net list

List of names of symbols or parts and their
connection points which are logically connected in
each net of a circuit. A net list can be extracted
electronically on a computer from a properly
prepared schematic.

Obstacle

An outline representing an object on the board. It
must be taken into account during routing,
placement, or copper pour.

Pad

On a PCB, a copper shape on one or more layers
(there may be a hole and an isolation surrounding
the copper) used for connecting a component pin
to the PCB. The pad indicates where pins of a
component are placed.

Padstack

A numbered list of pad descriptions. Each
description contains a pad definition, including
layer, style, drill diameter, size, offset, and solder
mask guard width.

PCB - Printed Circuit Board

A PCB is a board made up of components affixed
to a common surface and connected by copper
tracks.

Pin The portion of a component to which an electrical
connection can be made.

Polarity Positive polarity refers to visible items. Negative
polarity refers to items that become transparent to
reveal underlaying layers or background color.

Ratsnest A number of unrouted straight-line connections

between two or more pads that represent the
electrical connections in the netlist. The ratsnest
serves as a reminder that the pads must be
connected, and that, currently, there is no track on
the board to make that connection.
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EDA Term

Definition

Reference designator

A character string denoting the type of component
and a number that is specific to that component.

Routing

Placing conductive interconnects between
components on a PCB layout. The process of
turning nets into tracks.

Schematic

A graphical description of an electrical circuit.

Segment

The partial track that exists between two adjacent
vertices or between a vertex and a pin. Sometimes
the track between two pins is also called a segment,
although connection is usually the more
appropriate term here.

Signal

An electrical impulse of a predetermined voltage,
current, polarity, and pulse width.

Silkscreen

Text or outlines (in ink) on the solder mask, on the
top, and sometimes on the bottom of board
modules. A silkscreen is used for component and
identification placement on a PCB and usually
includes component outlines, reference
designators, polarity indicators, pin one markings,
part numbers, the company name, and copyright
info.

SMT - Surface Mount Technology

PCB technology whereby the leads on the chips
and components are soldered onto the surface of
the board rather than inserted into it. The use of
SMT results in smaller and faster printed circuit
boards.

Solder mask

A negative plot of pads with a guard band around
the pads. Also, a lacquer applied to prevent solder
from adhering to unwanted areas on the PCB.

Solder paste A pattern that serves as a template for solder paste
application when the board is manufactured.

Solder side The PCB surface opposite the one on which most
components are mounted (component side). Also,
the bottom layer of the board.

Test point A special point of access to an electrical circuit that

is used for electrical testing purposes.

Through-hole via

A via that connects the surface layers on a PCB.
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EDA Term

Definition

Trace (Track)

The copper trails (electrical connection between
two or more points) on the PCB and the onscreen
representation of that copper.

Venting patterns Patterns etched in the board that allow gases
formed during fabrication to escape.
Vertex A logical point at which a track is ended and

restarted. A vertex is located at each change of
direction on the track.

Via (feed-through hole)

A hole connecting layers of a PCB. A through-hole
via connects the surface layers of a board. On
multilayer boards, a via not reaching a surface layer
on one side is called a blind via, and a via not
reaching a surface layer on either side, thus being
externally invisible, is called a buried via.

Viastack A numbered list of via descriptions. Each
description contains a via definition, including
layer, style, drill diameter, size, offset, and solder
mask guard width.

Via string The copper etch that exists between a SMT pad and

a corresponding fanout via.

Zero-length connection

An unrouted connection between layers where the
end points in the connection have the same X- and
Y- coordinates.

Zone

An area on a PCB layer designated as copper or
anti-copper. Copper zones may have net names,
while anti-copper zones may not.
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The Gerber Layer File (GBL) format allows you to open multiple Gerber files at once in
AutoVue. This file format also allows you to analyze multiple Gerber files for net connec-
tivity by creating net entities in AutoVue to connect the different traces and pins.

A GBL is divided into four main sections:

. Header section

. INI configuration section

. Aperture file section (optional)
. Gerber layers section

Header

The header is used to recognize a file as a Gerber Layer File (GBL). All GBLs must begin
with the following line:

GBL FILE (CSI)

If a file does not begin with this line, it will not be treated as a GBL.

INI Configuration

The INI configuration section allows you to configure the following INI options that are
used when processing each Gerber layer and Gerber Layer File.

. APERTURE_FORMAT_FILEPATH
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. INCREMENTALMODE
. NUMDECIMALS

. NUMDIGITS

. TRAILINGZEROS

. TOOLFILEPATH

. TOOLFILETYPE

. TOOL_UNIT

. UNITS

These INT options are the same as the Gerber-specific options. For more information, refer
to the “Gerber Formats” section of the Oracle AutoVue Installation and Administration
Manual.

Aperture File

The aperture file section is used to specify the aperture file required by Gerber files. If you
do not provide an aperture file in the Gerber Layer File, then the aperture file specified in
AutoVue’s INI file is used.

The aperture file section is a single line in the GBL and follows this structure:

APP <aperture file path> <aperture file type>

Where:

o APPisakeyword to indicate that the current line refers to aperture information.

. <aperture_file_path> is the absolute or relative file system path of the aperture file.
This field is mandatory.

. <aperture_file_type> is an optional field that indicates the format used to store the

aperture information. The following table provides a list of possible values.

File Type Typical File Extension Description
0 .too AutoVue default aperture file
type.
1 .app OrCAD Layout file aperture file
type.
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File Type Typical File Extension Description
2 .gap ECAM aperture file type.
3 .rep Protel/Altium Designer aperture
file type.
4 .apt Artwork aperture file type.
5 xt Allegro aperture file type.

For example:
APP aperture.txt 5

This example specifies an Allegro-type aperture file, aperture.txt, in the same folder as the
GBL.

Gerber Layers

The Gerber layers section is used to list the Gerber files to be opened as layers in the Gerber
Layer File and includes two fields: OPTIONALATTRIBUTES and LAYER.

OPTIONALATTRIBUTES is an optional field used to list the names of the attributes that
are provided for each Gerber layer. It is specified as a semicolon (;) separated list.

For example:
OPTIONALATTRIBUTES=<attributel>;<attribute2>;..

There are currently seven supported attributes: COLOR, LAYERNAME, LAYERTYPE,
OFFSET, VISIBLE, POLARITY and UNITS.

. COLOR: Used to provide the color of the layer. The color can be given either as a
color index (refer to the following table) or as an RGB color.

The following table provides a list of possible color indices:
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Index Color

Black

Red

Yellow

Green

Cyan

Blue

Magenta

White

Dark grey

RGB colors are specified as follows:

RGB (<r_components>,<g component>,<b components>)

LAYERNAME: Used to provide the name of the layer that appears in the logical layer
dialog.

LAYERTYPE: Used to provide the type of the layer. This is used to construct the net
connectivity. There are three possible values:

- signal
- nonsignal
- plane

Only the signal and plane layer types are considered when constructing the net
connectivity. Any value other than these three is treated as a nonsignal.

OFFSET: Used to provide the offset of the layer in native units.
Syntax: (x,y)
For example: (10.0, 20.0)

VISIBLE: Used to provide the initial visibility of a layer. To set a layer as invisible, the
value of this attribute should be set to false (case-sensitive). Any other values are
treated as true.

POLARITY: Used to provide the initial polarity of a layer. To set a layer’s polarity to
negative, the value of this attribute must be set to negative. Note that the attribute
value is case-sensitive.
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. UNITS: Used to provide the units of a layer. Possible values are in for inches, mm for
millimeters, and mil for microns.

NOTE: To include whitespaces, the argument should be enclosed between double quotes ().

As the following example shows, the order of the attributes are not important and their
names are not case sensitive (that is, COLOR is the same as color).

OPTIONALATTRIBUTES=COLOR; LAYERTYPE

OPTIONALATTRIBUTES=layerName;Color;layerTYPE

The LAYER field entry represents a Gerber file that makes up a layer in the GBL. It is spec-
ified as follows:

LAYER <optional attributes> <Gerber filename>

Where:
o LAYERis the keyword for this field.

o <optional_attributes> is a list of attributes in the order given by the OPTIONALAT-
TRIBUTES field. All attributes given in the OPTIONALATTRIBUTES field must be
provided for each LAYER entry in the same order.

. <Gerber_filename> is the absolute or relative file system path of the Gerber file.
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Appendix C: AutoVue Product
Variations - Feature Matrix

The following tables list the available features of the AutoVue Enterprise Visualization Desktop Version product family
on the Windows platform. The tables are organized by the following features: general features, 2-D and EDA common
features, 2-D features, EDA features, 3-D features, markup features, and AutoVue Mobile features.

Note that several of the following features are supported only if the file that is being viewed in AutoVue contains relevant
information.

General Features

Feature AutoVue Office AutoVu? 2D AutoVue 3D Professional AutoVue' EDA AutoVue Electrc.:-MechanicaI
Professional Advanced (A EES T E] Professional
Edit, Select, Copy & Clipboard X X X X X
File Properties X X X X X
Page Navigation X X X X X
Thumnails X X X X X
Toolbar Customization X X X X X
Folder Navigation
Browse X X X X X
Browse Next File X X X X X
Browse Previous File X X X X X
Print
Batch Print X X X X X
Print X X X X X
Print Preview X X X X X
Conversion
Basic Conversion X X X X X
Conversion to 3-D X X X
Converstion to PDF'’ X X X X X
Convert a batch of files X X X X X
Configuration? X X X X X

Not supported for 3-D designs.

ZAutoVue provides different configuration options for different file types

327 3/1/11



APPENDIX C: AUTOVUE PRODUCT VARIATIONS — FEATURE MATRIX

2-D Common Features (Raster/Graphics, 2-D Vector, Desktop/Office, EDA)

: AutoVue 2D AutoVue 3D Professional AutoVue EDA AutoVue Electro-Mechanical
Feature AutoVue Office ) ! .
Professional Advanced Professional Professional
Overlays X X X X X
Text Extraction® X X X X X
Text Search3 X X X X X

Basic Manipulation

Flip X X X X X
Rotate X X X X X
Zoom X X X X X

Special View Modes

Magnify Glass X X X X X

Magnify Window X X X X X

Pan X X X X X

Pan and Zoom Window X X X X X
Compare

Compare Files X X X X X

3Not supported for raster formats

Raster/Graphics Features

AutoVue 2D AutoVue 3D Professional AutoVue EDA AutoVue Electro-Mechanical

AELE ALEITRIED Professional Advanced Professional Professional

Image Enhancements

Anti-Alias X X X X X
Contrast X X X X X
Invert* X X X X X

4Applies to raster formats and to raster overlays in other formats
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2-D (Vector Features)

Feature AutoVue Office AutoVu_e 2D AutoVue 3D Professional AutoVue_ EDA AutoVue EIectrg-MechanicaI
Professional Advanced Professional Professional

Measurements

Entity Snapping X X X X

Angle X X X X X

Arc X X X X X

Area X X X X X

Calibration X X X X X

Distance X X X X X

2-D CAD Features

Blocks X X X

CAD/Doc Text Extraction X X X

Drawing Information X X X

Layers X X X

Views X X X

XRefs X X X
Conversion

Change Pen Settings X X X
Printing

Create/Assign Pen Settings X X X
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EDA Features

Feature AutoVue Office AutoVufe 2D AutoVue 3D Professional AutoVue_ EDA AutoVue Electrc?-MechanicaI
Professional Advanced Professional Professional
Bill of Material (BOM) X X
Blocks X X
Cross Probe X X
Design Hierarchy Navigation X X
Design Verification X X
EDA Layers X X
Entity Filters X X
Entity Properties X X
Entity Search X X
Entity Selection X X
Go to Net Instance X X
Layer Sets X X
EDA Measurement
Entity Snapping X X
Angle X X
Arc X X
Area X X
Calibration X X
Distance X X
Minimum Distance X X
Compare
Layer State Propagation X X

330 3/111



APPENDIX C: AUTOVUE PRODUCT VARIATIONS — FEATURE MATRIX

3-D Features

AutoVue 2D AutoVue 3D Professional AutoVue EDA AutoVue Electro-Mechanical

AELE AIDITAIED Professional Advanced Professional Professional

Basic 3-D Manipulation

3-D Render Modes X X0 X
Change Part Color X X0 X
Change Transparency X x5 X
Free Rotate X x5 X
Expand/Collapse Tree X x5 X
ldnetical Part Detection X X0 X
Light Settings X x5 X
Manipulators X x° X
Re-center X X0 X
Selection X x5 X
Spin X x° X

Advanced 3-D Manipulation

3-D Digital Mockup X X
3-D Search X X0 X
3-D Entity Properties X x5 X
Bill of Material (BOM) X x5 X
Electro-Mechanical Digital Mockup X
Explode X X0 X
Interference Checks X x5 X
Part Alignment X X0 X
PMI Filtering X X
Section X X0 X
Transformation X X0 X
User-Defined Coordinate Systems X X0 X
User-Defined View X x5 X

3-D Measurements

Entity Snapping X X0 X

Angle X X0 X

5The 3-D features in AutoVue EDA Professional are only available when viewing 3-D PCBs.
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3-D Features

Feature AutoVue Office AutoVug 2D AutoVue 3D Professional AutoVue_ EDA AutoVue EIectrc?-MechanicaI
Professional Advanced (I CESTE]] Professional

Arc X x° X
Calibrate X x5 X
Distance X x5 X
Edge X x5 X
Minimum Distance X X0 X
Surface X x5 X
Vertex Coordinates X x5 X

Compare
Compare 3-D Designs X x5 X
Compare Sets X x5 X

5The 3-D features in AutoVue EDA Professional are only available when viewing 3-D PCBs.

Markup Features

Feature AutoVue Office AutoVu_e 2D AutoVue 3D Professional AutoVue_ EDA AutoVue EIectrc?-MechanicaI
Professional Advanced Professional Professional
Create and Save X X X X X
Consolidate X X X X X
Import/Export X X X X X
Layers X X X X X
Markup Filtering X X X X X
Markup Information X X X X X
Modify X X X X X
Saved States X X X X X
Markup Entities
Attachment X X X X X
Hyperlink X X X X X
Intellistamp X X X X X
Leader X X X X X
Note X X X X X
Signoff X X X X X
Stamp X X X X X
Stamp Library X X X X X
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Markup Features

AutoVue 2D AutoVue 3D Professional AutoVue EDA AutoVue Electro-Mechanical

AELE AUDITACED Professional Advanced Professional Professional

Text X X X X X

2-D Markup Entities

Arc X X X X X
Box X X X X X
Circle X X X X X
Cloud X X X X X
Freestyle X X X X X
Highlight X X X X X
Line X X X X X
Polygon X X X X X
Polyline X X X X X

Markup Measurement Entities

2-D Measurement X X X X X
3-D Measurement X xb X
EDA Measurement X X

8The 3-D features in AutoVue EDA Professional are only available when viewing 3-D PCBs.

AutoVue Mobile

. AutoVue 2D AutoVue 3D Professional AutoVue EDA AutoVue Electro-Mechanical
Feature AutoVue Office ) ! .
Professional Advanced Professional Professional
Markup Mobile Pack X X X X X
View Mobile Pack X X X X X

Note: For the list of features for ActiveX, refer to ActiveXFeatures.pdf
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Feedback

If at any time you have questions or concerns regarding AutoVue, call or e-mail us.

General Inquiries

Telephone: +1.514.905.8400 or +1.800.363.5805
E-mail: autovuesales_ww@oracle.com
Web Site: http://www.oracle.com/us/products/applications/autoVue/index.html

Sales Inquiries

Telephone:

+1.514.905.8400 or +1.800.363.5805

E-mail:

autovuesales_ww@oracle.com
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FEEDBACK
CUSTOMER SUPPORT

Customer Support

Web Site:

http://www.oracle.com/autovue/index.html
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232,239,251
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snapping modes 166, 249
vertex coordinates 171
mockups
delete 113
Model Tree 110, 111, 112
hiding 112
XRefs 111
Models tab 27, 105
part alignment 136
align 138
constraints 137
PMI entities 131
recentering 109, 110
entity reference 109
render modes 118, 119
sectioning 142
cut options 143
exporting 144
options 142
section plane 143
selecting model parts 108
text markup 255
transformation 139
buttons 140
reset 141
setting values 141
user-defined coordinate system 147
Views tab 28, 106
3D dynamic rendering 182
3D files
configure 181
3D mockups
create 113
3D Model Tree 27, 105
3D views 124
camera view 124
default view 124
layers 127
native views 124
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perspective 126

user-defined view 125
delete 125

view points 126
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About dialog 20
version and buid information 21
archive files 33
arrow style 270
attributes
change mesh resolution 120
AutoVue 17
basics 19
customize 293
AutoVue GUI 22
AutoVue properties toolbar 23
AutoVue toolbar 23
Markup entity toolbar 24
menu bar 22
toolbars 23
AutoVue Mobile 307
Mobile Pack 307
create 308
create Markup files 313
updating from Mobile Pack 313
view 311
AutoVue properties toolbar 23
AutoVue toolbar 23

Batch Conversion 291
batch print 273, 285

Bill of Material (BOM) 86
Bookmarks tab 25, 65, 107
browse files 32

build information 21
bylayer 265

C
CAD information 306

calibrating arc 59, 102, 170, 228, 235, 242,253
calibrating distance 54, 98, 167, 225,232, 239,
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markup layer 203
Changing locale of AutoVue 20
Co mponents tab 63
compare
3D files 154
Components tab 26
configure 173
2D 180
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snap settings 180
3D
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background images 185
color 183
default mesh resolution 183
dynamic rendering 182
geometry highlight 184
highlight selection 186
load mesh data 182
miscellaneous 185
model 182
PMl filtering 183
rendering 181
section highlight 184
show global axes 186
tree level 186
3D files 181
base font 179
CAD file options 174
common 184, 190
desktop office 192
EDA 187
3D PCB view 188
3D view 190
colors 189
cross probing 189
dim unselected 187
highlight entity 187
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thicken highlighted entity 187
tooltips 188
font paths 177
general options 174
graphic files 191
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markup paths 178
measurement 178
paths 176
raster files 175
symbol paths 178
XRef paths 176
convert 287
file 289
options 114, 287
PDF 288
pen settings 290
size 289
create
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cross probing 82, 83
net connectivity 84
two or more EDA files 82
zoom behavior 189
zooming 84
custom color 271
custom line color 268
custom line thickness 269
customize AutoVue 293
clipboard options 293
copy information 294
define clipboard 293
hot key 295
mail utility 297
toolbars
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customize 297
tools 294
add 294
tools menu item 296

D

delete
markup layer 205
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exporting results 92

drawing information 50
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EDA 61
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BOM 86
comparing PCB 85
cross probing 82
design hierarchy 72
design verification 87
entitiy properties 70
entity properties 68
entity search 93, 94, 95
filtering entity types 67
layer sets 78
layers 73
manipulating views 81
measuring 96
angle 101
arc 102
calibrating arc 59, 102, 170, 228, 235,
242,253
calibrating distance 54, 98, 167, 225,
232,239,251
distance 98
minimum distance 99
snapping modes 97, 236
net connectivity 70
net instances 71
net properties 71
selecting entities 65, 66
entity seach dialog 67
terms and definitions 315
zooming to an entity 68
entity properties 127
attributes 127, 128
extents 130
mass properites 129
mass properties 128
entity properties dialog box 68
entity reference 109
entity search dialog 67
Exiting AutoVue 20
export
Markup file 200
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browse 32
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file properties 33
open 30
print 284
select 2D files 36
file properties 33
file version information 21
files
archive 33
properties 33
streaming file 32
fill color 265, 271
fill type 270
filtering entity types 67
font 266
configure paths 177
From 51
Full Text Extraction 305

G

GBL 321
Gerber Layer File 321

H

header/footer 276
help 20
Help About... 20

import
Markup file 199

L

layer sets 78
user-defined layers sets
create 79
delete 80
save with markups 80
viewing 79
layers 73, 127, 189
changing color 77
changing order 74
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logical layer visibility 76
logical layers 73
sorting 78
physical layer visibility 75
physical layers 73
leader alignment 272
line color 265, 268
line style 268
line thickness 269

M

magnify glass 40
magnify window 41
mail utility
customize 297
makrups
hyperlink 247, 258
Markup Entity Properties dialog 267
Markup entity toolbar 24
Markup file 18
create 313
Markup files 196
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Markup Indicator 30, 193
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configure 178
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2D 219
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232,239,251
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3D 247
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create 209
delete 211
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toggle 204
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markup layers 271
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selecting markups 259
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stamp 215
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delete 218
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text 244
text box visibility 244
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ungrouping 261
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mass properties 128, 129
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menu bar 22
mesh resolution 120
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missing resources 45
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Mobile Pack 307, 313
Model tab 27, 105
Model Tree 27, 105, 110, 111, 112
hiding 112
XRefs 111
Models tab 27, 105
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native print settings 278
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Bookmarks tab 25, 65, 107
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customizing 62
Models tab and Model Tree 27, 105
Models tab and ModelTree 27, 105
Nets tab 26, 64
Views tab 28, 106

net connectivity 70

Nets tab 26, 64

(o)

open
file 30
Markup file 198
multiple files 31

options 273
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pan and zoom window 41
partial print preview 283
pen settings 281
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configuring 133
captures 133
reference frames 133
views 133
filtering 132
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PMl filtering 183
preview file 283
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pen settings
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add 279
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render modes 118
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save
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snap settings 180
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3D 166, 249
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	• Deselect the check box to hide the entity types.
	3. Under the Selection column, perform one of the following:

	• Select the check box beside the entity types that you want to be able to select in the workspace.
	• Deselect the check box beside the entity types that you do not want to select.
	4. Click Apply to apply the changes.
	5. Close OK to close the Entity Filter dialog.


	Zooming to a Selected Entity
	1. If you selected an entity from the workspace or Navigation panel, right-click and select Zoom Selected.
	2. If you selected an entity from the Entity Search dialog, right-click and select Zoom Selected.

	Entity Properties
	Viewing the Properties of an Entity
	1. Select the entity in the workspace or from the Navigation Panel or Entity Search dialog.
	2. Right-click and select Show Entity Properties.
	3. Select any associated entity in the tree to display its attributes.
	4. To view all associated entities for any given entity in the tree, select the entity and click Expand.
	5. Click OK to close the Entity Properties dialog.
	Showing Net Connectivity
	1. Select an entity such as a pin, via, or trace from the workspace or the Navigation Panel.
	2. From the View menu, select Show Net Connectivity.

	Displaying the Entity Properties of a Net
	1. Select an entity such as a pin, via, or trace from the workspace or the Navigation Panel.
	2. From the workspace or Navigation Panel, right-click the selected net, and then select Show Entity Properties.
	3. Click OK to close the Entity Properties dialog.

	Show Net Instances
	1. From the Navigation Panel, click the Nets tab and select the net you want to view.
	2. From the View menu, select Go to Net Instances, or right-click the highlighted net from the Navigation Panel or workspace and select Go to Net Instances.
	3. Select the page on which you want to view the net instance, then click OK.



	Navigating Design Hierarchy
	Navigating using Descend Hierarchy
	Navigating using Ascend Hierarchy

	Layers
	Physical and Logical Layers Sections
	Changing the Order of Layers
	1. From the Manipulate menu, select Visibility Control, and then select Layers .
	2. If the Logical Layers section is not open, click Expand .
	3. Select the layer or layers that you want to move. To do so, you can do one of the following:
	• Select a physical layer from the Physical Layers section. Logical layers associated with the selected physical layer are also selected. When you make changes to a selected physical layer, the logical layers associated with it are also affected.
	• Select one or multiple logical layers from the Logical Layers section. To select multiple logical layers, press the Shift or Control key while selecting.
	4. Click one of the following buttons:

	• Click Bring to Front to move all selected layers to the front in the workspace. In the Logical Layers section, these layers move to the top of the list.
	• Click Up to move selected layers up one layer.
	• Click Down to move selected layers down one layer.
	5. Click Apply to see the changes in the workspace.
	6. You can now save your changes as a user-defined layer set.
	7. Click Close to close the Layers dialog.


	Modifying Visibility for Physical Layers
	1. From the Manipulate menu, select Visibility Control, and then select Layers.
	2. In the Physical Layers section, you can show or hide the following:
	3. Click Apply to view the changes in the workspace.
	4. You can now save your changes as a user-defined layer set.
	5. Click Close to close the Layers dialog.

	Modifying Visibility for Logical Layers
	1. From the Manipulate menu, select Visibility Control, and then select Layers.
	2. If the Logical Layers section is not open, click Expand .
	3. In the Logical Layers section, you can show or hide the following:
	4. Click Apply to view the changes in the workspace.
	5. You can now save your changes as a user-defined layer set.
	6. Click Close to close the Layers dialog.

	Modifying Polarity
	1. Select the layer and then click the Polarity icon to toggle the polarity, or select/deselect the checkbox in the Polarity column.
	• When positive polarity is selected, the layer appears as is.
	• When negative polarity is selected, the layer image is inverted; the entities in the layer are displayed as transparent and the remainder of the layer appears as a solid color.

	Changing Layer Color
	1. From the Manipulate menu, select Visibility Control, and then select Layers.
	2. If necessary, click Expand to open the Logical Layers section.
	3. After you select a layer, you can do one of the following to modify its color:
	• Click Modify Color and then select a color from the palette. Use this button if you want to change the color of all logical layers associated with a selected physical layer, or to change the color of many selected logical layers at the same time.
	• Double-click a square in the Color column of the Logical Layers section and then select a color from the palette. Use this option to change the color of individual logical layers.
	4. Click Apply to save the changes.
	5. You can now save your changes as a user-defined layer set.
	6. Click Close to close the Layers dialog.


	Sorting Logical Layers
	1. From the Manipulate menu, select Visibility Control, and then select Layers.
	2. If the Logical Layers section is not open, click Expand .
	3. Click the column header of an attribute.


	Layer Sets
	Viewing Layer Sets
	1. From the Manipulate menu, select Visibility Control, and then select Layers.
	2. From the Layer Sets list, select the layer set you want to display.
	3. Click Apply.
	4. To restore the default layer set, from the Layer Sets list, select (Default).
	5. Click Close to close the Layers dialog.

	Creating User-Defined Layer Sets
	1. From the Manipulate menu, select Visibility Control, and then select Layers.
	2. Click Add.
	3. Enter the layer set name.
	4. Click OK.
	5. To modify the attributes of the new layer set, select one or more layers and change the Visibility, Order, or Color.
	6. Click Apply to save the changes and to display the new layer set in the workspace.
	7. To define more layer sets, repeat steps 2 to 6.
	8. Click Close to close the Layers dialog.

	Deleting User-Defined Layer Sets
	1. From the Manipulate menu, select Visibility Control, and then select Layers.
	2. From the Layer Sets list, select the user-defined layer set you want to delete.
	3. Click Delete.
	4. Click Apply to save the changes.
	5. Click Close to close the Layers dialog.

	Saving User-Defined Layers Sets with Markups
	1. Create custom layer sets.
	2. From the Markup menu, select New.
	3. Create any markup entities that you need.
	4. From the Markup menu, select Save As.
	5. Enter the markup information and click OK to close the Save Markup File As dialog.


	Manipulating EDA Views
	3D View
	1. In the Navigation Panel, click the Bookmarks tab.
	2. Select 3D Model from the navigation tree.

	Cross Probing
	Cross Probing Between Two or More EDA Files
	1. Open an EDA file to cross probe.
	2. From the Analysis menu, select Cross Probe.
	3. Click Add File.
	4. In the Open dialog that appears, enter the file name or browse to locate the file you want to cross probe, then click Open.
	5. Click OK.
	6. If you cross probe a schematic and PCB, one window automatically displays a 2D PCB and the other window displays a schematic. The same is true if either file contains a PCB and a schematic. Whereas, if files A and B contain both a schematic and a ...
	7. If you cross probe two PCBs, one window automatically displays a 2D PCB and the other window displays a 3D PCB.
	8. If you cross probe two schematics, both are set to schematic.
	9. To change the view of a file in a window, do the following:
	a Deselect the Automatic option in the dialog for the window you want to change.
	b From the Type list, select Schematic, PCB, or PCB 3D View. These options are available in the Type list only when the views are present in the file.

	10. To switch between multiple occurrences of a selected component, do the following:
	a From the Navigation Panel, select a component in one file that has multiple component occurrences in the other file.
	b From the dialog of the file with multiple component occurrences, select one of the components from the Occurrences list or click Next or Previous to switch between component occurrences.

	11. Select any entity in the schematic drawing.

	Cross Probing Between 2D and 3D Views of the Same File
	1. From the Analysis menu, select Cross Probe.
	2. Click Add File.
	3. In the Open dialog that appears, select the same file, then click Open.
	4. In the Cross Probe dialog, click OK.
	5. If the file does not contain a schematic, one window shows the 2-dimensional view of the PCB and the other shows the 3-dimensional view of the PCB.
	6. If the file contains a schematic as well as a PCB, the schematic view displays in one window and the 2D PCB view displays in the other window. In this case, take the following steps to see the 2D and 3D views of the PCB:
	a In the window’s dialog, deselect the Automatic option.
	b Select a different view from the TYPE list. For example, you can switch between Schematic and PCB 3D View.

	7. Select an entity in the 3D view.

	Showing the Net Connectivity when Cross Probing
	1. Select an entity or entities in any open file.
	2. Right-click and select Show Net Connectivity.

	Zooming when Cross Probing
	1. Select an entity or entities in either one of the open files or views.
	2. Right-click and select Zoom Selected.


	Comparing a PCB with Artwork
	1. Open the PCB file that you want to compare with the artwork.
	2. From the Analysis menu, select Compare.
	3. Enter the file name or browse to locate the artwork file you want to compare with the PCB file.
	4. Click Open.
	5. From the box, select the PCB Physical layer that represents the artwork.
	6. Click OK.
	7. To exit Compare mode, from the File menu, select Exit Compare.

	Generating Bill of Material (BOM)
	1. From the Analysis menu, select Generate Bill of Material.
	2. Click OK after making your selection.
	3. Select the attributes that you want to appear in the report.
	4. Click Generate.
	5. To save the BOM, click Export.
	6. Specify the directory where you want to store the file, the file name and extension, then click Save.
	7. Click Close to close the Bill of Material dialog.

	Design Verification
	Design Rule Checks
	Verifying a Design
	1. From the Analysis menu, select Verify Design.
	2. To enable a design rule, select the associated check box in the Design Rules section of the dialog.
	3. To disable a design rule, deselect the check box.
	4. To add a value to the selected design rule, double-click the corresponding row of the Value column and enter a value.
	5. In the Maximum Violations field, enter the maximum number of results you want to display in the Results list.
	6. From the Distance Units list, select the unit you want to use as the unit of measure.
	7. Click Verify.
	8. To view the description of a violation result, select the violation from the Results list.
	9. Continue to select violation results to view its description.
	10. Click Close to close the Verify Design dialog.

	Exporting the Design Verification Results
	1. Verify the design.
	2. In the Verify Design dialog, click Export.
	3. Navigate and select the directory where you want to export the results.
	4. Enter a file name.
	5. Click Save.
	6. Click Close to close the Verify Design dialog.


	Searching Using Entity Search
	Performing an Entity Type-based Search
	1. From the Edit menu, select Entity Search.
	2. Click the Entity Types tab.
	3. From the Entity Types list, select an entity type.
	4. If you want to search by attribute, select an attribute from the Attribute list.
	5. If you want to search by value, select a value from the Value list.
	6. Click Add Filter.
	7. Repeat steps 4 and 5 until you have all the filters you want.
	8. Click Apply Filter(s).
	9. To save the results, click Export Result.
	10. Specify the file name and the directory where you want to store the file, then click Save.
	11. To view the properties of an entity, select the entity from the Entity Types list or the Attributes list, then right-click and select Show Entity Properties.
	12. To show the net connectivity, click the Attributes tab, select the entity from the list, then right-click and select Show Net Connectivity.
	13. Click Close to close the Entity Search dialog.

	Performing an Attribute-based Search
	1. From the Edit menu, select Entity Search.
	2. Click the Attributes tab.
	3. From the Attributes list, select an attribute.
	4. If you want to search by owner, select an owner from the Owner Filter list.
	5. If you want to search by value, select a value from the Value Filter list.
	6. Click Apply Filter(s).
	7. To save the results, click Export Result.
	8. Specify the file name and the directory where you want to store the file, then click Save.
	9. Click Close to close the Entity Search dialog.


	Measuring in EDA Files
	EDA Snapping Modes
	Measuring Distance
	1. From the Analysis menu, select Measure.
	2. Click the Distance tab.
	3. Select the snapping modes that you want to use for measuring.
	• To select all snapping modes click All On.
	• To deselect all snapping modes click All Off.
	See “EDA Snapping Modes”
	4. From the Measured Distance Units list, select the unit in which you want to measure the distance.
	5. Click a point on the drawing to define the starting point.
	6. Click another point on the drawing to define the end point.
	7. Right-click to complete the measurement.
	8. Click Close to close the Measurement dialog.


	Calibrating Distance
	1. Measure distance between two points or measure cumulative distance.
	2. From the Distance tab, click Calibrate.
	3. From the Units list, select the unit to which you want to calibrate the distance.
	4. Select Calibrate to and enter a value if you want to calibrate the distance to a value.
	5. Select Set Factor and enter a value if you want to calibrate the distance by a factor.
	6. Click OK.
	7. Click Close to close the Distance tab.

	Measuring Minimum Distance
	1. From the Analysis menu, select Measure.
	2. Click the Min. Distance tab.
	3. To measure the minimum distance between entities that are not on the same physical layer, select Across Layers.
	4. Select First Set to select the entities that you want to measure from.
	5. Select the snapping modes that you want to select as the entities for the measurement.
	6. Click the first set of entities on the drawing.
	7. Select Second Set to select the entities that you want to measure to.
	8. Click the second set of entities on the drawing.
	9. From the Measured Min. Distance Units list, select the unit in which you want to measure the distance.
	10. Select Zoom to Result, if you want to zoom into the measurement on the drawing.
	11. Click Compute.
	12. Click Close to close the Measurement dialog.

	Measuring Area
	1. From the Analysis menu, select Measure.
	2. Click the Area tab.
	3. Select Between Points if you want to measure the area between points on a drawing. The snapping modes are displayed.
	4. Select the snapping modes that you want to use for measuring.
	5. Select Shape if you want to measure the area of a predefined shape on the drawing; the snapping modes are disabled.
	6. From the Measured Area Units list, select the unit in which you want to measure the area.
	7. From the Perimeter Units list, select the unit in which you want to measure the perimeter.
	8. In the Net Area Result section of the dialog, select Add to cumulate a net area result of different areas.
	9. To subtract an area from the Net Area Result, select Subtract.
	10. Select Clear to clear the Net Area Result.
	11. If you selected Between Points, click points on the drawing to define the area.
	12. If you selected Shape, click the edge of the predefined shape that you want to measure.
	13. Click Close to close the Measurement dialog.

	Measuring an Angle
	1. From the Analysis menu, select Measure.
	2. Click the Angle tab.
	3. From the Angle Definition section, select one of the following:
	• From 3 Points: Measure the angle between three points.
	• Between 2 Lines: Measure the angle between two non-parallel lines.
	4. Select the snapping modes that you want to use for measuring.

	• To select all snapping modes click All On.
	• To deselect all snapping modes click All Off.
	See “EDA Snapping Modes”
	5. Select Between 2 Lines if you want to measure the angle between two lines.
	6. From the Measured Angle Units list, select the unit in which you want to measure the angle.
	7. If you selected From 3 Points, click three points to define the angle.
	8. If you selected Between 2 Lines, click two lines to define the angle.
	9. Click Close to close the Measurement dialog.


	Measuring an Arc
	1. From the Analysis menu, select Measure.
	2. Click the Arc tab.
	3. Select From 3 Points if you want to measure the arc between three points. Snapping modes are displayed.
	4. Select the snapping modes that you want to use for measuring.
	• To select all snapping modes click All On.
	• To deselect all snapping modes click All Off.
	See “EDA Snapping Modes”
	5. Select Arc Entity if you want to measure a predefined arc.
	6. From the Arc Information section, select the unit in which you want to measure the distance of the arc.
	7. From the Measured Angle Units list, select the unit in which you want to measure the angle.
	8. If you selected From 3 Points, click three points to define the arc.
	9. If you selected Arc Entity, click the edge of the arc that you want to measure.
	10. Click Close to close the Measurement dialog.


	Calibrating an Arc
	1. Measure an arc in the drawing.
	2. From the Arc tab, click Calibrate.
	3. From the Units list, select a unit of measurement to which you want to calibrate the distance.
	4. Click Calibrate to and enter a value if you want to calibrate to a value.
	5. Click Set Factor and enter a value if you want to calibrate by a factor.
	6. Click OK.
	7. Click Close to close the Measurement dialog.



	Working with 3D Files
	Models Tab and Model Tree
	Views Tab
	Bookmarks Tab
	Global Axes
	Selecting Model Parts
	Select Model Parts from the Workspace
	1. Select a part or parts on the model in the workspace.
	2. To select the parent entities of a selected part, press the Shift key and select the part again.
	3. To select a group of parts, from the Edit menu, select Select, then click and drag the mouse around the parts.

	Selecting All Identical Parts of a Model

	Re-Centering
	Re-Centering a Model to a Selected Model Part
	1. Select the model part or parts that you want to re-center.
	2. From the View menu, select Re-Center, and then select Selected.

	Re-Center All
	1. From the View menu, select Re-Center, and then select All.

	Entity Reference
	Re-Centering a Model to an Entity
	1. From the View menu, select Re-Center, and then select Entity.
	2. Select the entity that you want to use as the central reference point.
	3. Click an instance of the entity.
	4. Close the Re-Center dialog.


	Model Tree
	Expanding/Collapsing the Model Tree
	1. Click the Models tab.
	2. From the Model Tree, select the node or nodes that you want to expand, then right-click and select Expand All Children.
	3. To collapse a node, select the node, then right-click and select Collapse All Children.

	Viewing Missing XRef Notification Icon
	1. From the status bar, click the Missing Resource icon .
	2. Click the Resource Information tab.
	3. Click OK to close the dialog.

	Selecting Model Parts from the Model Tree
	1. Click the Models tab.
	2. Select the part or parts from the Model tree.

	Hiding Model Parts
	1. Select the part or parts on the model or from the Model Tree.
	2. To hide the selected part or parts, right-click a selected part on the model or from the Model Tree and select Hide.
	3. To display the selected part or parts and hide the rest of the model, right-click a selected part on the model or from the Model Tree and select Hide Rest.


	Creating 3D Mockups
	1. From the File menu, select Import File for Mockup.
	2. Click Add.
	3. Enter the file name or browse to locate the file you want to import.
	4. Click Open.
	5. Click OK.
	Deleting Models from a Mockup
	1. From the File menu, select Import File for Mockup.
	2. Select the file or files that you want to remove.
	3. Click Remove.
	4. Click OK to close the Mockup dialog.


	Converting 3D Models to Other Formats
	Conversion Options
	Converting a 3D Model
	1. From the File menu, select Convert.
	2. In the Save As field, enter the path and filename or click Browse to locate the directory where you want to convert the file to, then enter a file name.
	3. From the Convert to Format list, select the format you want to convert the file to.
	4. Select the output and convert options that you want to set for the file.
	5. Click OK.


	Manipulating Display of a 3D Model
	Display Attributes
	Render Modes
	Changing the Render Mode
	1. From the Manipulate menu, select Visual Effects, and then select Rendering.
	2. Select a render mode from the list.


	Changing the Visibility
	Changing Model Color
	1. Select the model or model parts whose color you want to change.
	2. From the Manipulate menu, select Visual Effects, and then select Color.
	3. Select the desired color.
	4. Click Apply.

	Adjusting the Transparency
	1. Select the model or model parts whose transparency you want to adjust.
	2. From the Manipulate menu, select Visual Effects, and then select Transparency.
	3. To adjust the transparency, move the slider left or right.
	4. Select Apply Dynamically if you want the transparency to simultaneously change with the movement of the slider.
	5. Click Close to apply the changes and close the Set Transparency dialog.

	Changing the Mesh Resolution
	1. Select the parts that you want to change the mesh resolution.
	2. From the Manipulate menu, select Visual Effects, and then select Mesh Resolution. You then have the option to select High, Medium, or Low.


	Light Settings
	Setting Ambient Lighting
	1. From the Manipulate menu, select Visual Effects, and then select Lighting.
	2. Click and drag the Ambient Light sliding bar until you achieve the desired lighting.
	3. To set the ambient lighting to its default setting, select Default.
	4. Click Close to close the Lighting dialog.

	Setting Directional Lighting
	1. From the Manipulate menu, select Visual Effects, and then select Lighting.
	2. To change the direction of the light, click and drag the small ball until you achieve the desired lighting.
	3. To set the light direction to its default setting, select Default.
	4. Click Close to close the Lighting dialog.

	Adding a New Light Source
	1. From the Manipulate menu, select Visual Effects, and then select Lighting.
	2. Select the Two lights option.
	3. To add more light sources, right-click inside the square surrounding the ball and select Create New Light Source from the pop-up menu.
	4. Click and drag the small ball until you achieve the desired lighting.
	5. To restore the light source to its default setting, select Default.
	6. Click Close to close the Lighting dialog.

	Changing the Light Properties
	1. From the Manipulate menu, select Visual Effects, and then select Lighting.
	2. To change the properties of the light, such as color or brightness, right-click directly on the small ball and select Light Properties.
	3. Select a color from the Color menu.
	4. Click OK.
	5. Click Close to close the Lighting dialog.

	Removing a Light Source
	1. From the Manipulate menu, select Visual Effects, and then select Lighting.
	2. Right-click directly on the small ball that you want to remove and select Remove Light.
	3. You can also select Default to restore the lighting properties to its default setting.
	4. Click Close to close the Lighting dialog.


	3D Views
	Default View
	Setting Standard or Camera Views
	Setting Native Views
	Creating a User-Defined View
	1. Apply your own views or transformation to the displayed model.
	2. From the View menu, select Views, select User Defined Views, and then select Add View.
	3. Enter a view name for the view that you want to define.
	4. Click OK to close the Add User Defined View dialog.

	Deleting a User-Defined View
	1. Under the User Defined Views tree, select the view that you want to delete, then right-click and select Delete.
	2. Click Yes.

	Displaying the Perspective Projection of a 3D Model
	Viewing a Model from a Particular View Point
	1. From the View menu, select Camera Views, and then select View Points.
	2. Enter the coordinates for X, Y and Z:
	a In the Camera Position fields, enter the coordinates to determine the position of the camera lens.
	b In the Target Position fields, enter the coordinates to determine the position of the 3D model viewed through the camera lens.
	c In the Up Direction fields, change the coordinates to values between 0 and 1 to determine the upward orientation.

	3. Click OK to close the View Point dialog.

	Configuring Layers
	1. From the Manipulate menu, select Visibility Control, and then select Layers.
	2. To sort the list of layers in the dialog, click the Name column header to sort alphabetically or numerically, or click the Status column header to group by visibility.
	3. Select the check box beside the layers that you want to display.
	4. Deselect the check box beside the layers that you want to hide.
	5. Click OK to close the Select the Layers to Display dialog.


	Entity Properties
	General Attributes
	Viewing Attributes
	1. To view the attributes of specific model parts, select the parts from the model.
	2. To view the attributes of the entire 3D model, make sure that no parts are selected.
	3. From the Analysis menu, select Show Entity Properties.
	4. Click the Attributes tab.
	5. Click Close to close the Entity Properties dialog.

	Viewing Mass Properties
	1. Select the part or parts for which you want to calculate the mass properties. To select multiple parts, press the Shift or Control key while selecting.
	2. To view the mass properties of the entire 3D model, make sure no parts are selected.
	3. From the Analysis menu, select Show Entity Properties.
	4. Click the Mass Properties tab to view the properties of the selected mass.
	5. To change the density, change measurement units, or configure computation of inertia tensor, click Options.
	6. Click OK to close the Options dialog.
	7. Click Close to close the Entity Properties dialog.

	Configuring Mass Properties
	1. From the Analysis menu, select Show Entity Properties.
	2. Click the Mass Properties tab.
	3. Click Options.
	4. To change the density, enter a value in the Density field.
	5. To change the density units, select the unit for Mass and Length from their respective lists in the Units section.
	6. To apply the density to model parts with unknown density, select Use Only for Parts with Unknown Density.
	7. To apply the density to all model parts, select Use for All Parts.
	8. To change the display units, select the unit for Mass and Length from their respective lists in the Display Units section.
	9. To compute the inertia tensor based on output coordinate system, select Output Coordinate System Origin.
	10. To compute the inertia tensor based on the center of gravity, select Center of Gravity.
	11. Click OK to close the Options dialog.
	12. To save the changes, click Save As.
	13. Specify the path where you want to store the file and enter the file name, then click Save.
	14. Click OK to close the Entity Properties dialog.

	Viewing Extents
	1. Select the part or parts for which you want to view Extents. To select multiple parts, press the Shift or Control key while selecting.
	2. To view the Extents of the entire 3D model, make sure no parts are selected.
	3. From the Analysis menu, select Show Entity Properties.
	4. Click the Extents tab.
	5. You have three extents options:
	a Select Transformed if you want to view the extents after you have transformed the model.
	b Select UnTransformed if you want to view the extents of the model without transformation.
	c Select Oriented if you want to view the X, Y, and Z coordinates of the reoriented model or selection.

	6. Click Close to close the Entity Properties dialog.


	PMI Entities
	PMI Filtering
	1. From the Manipulate menu, select Visibility Control, and then select PMI Filtering.
	2. In the Tree column, select the check box beside the items that you want to display in the Model Tree.
	3. In the View column, select the check box beside the items that you want to display on the 3D model.
	4. Deselect the check box beside the items that you want to hide.
	5. Click OK to close the PMI Filtering dialog.

	Aligning to a PMI Entity
	Go to a Displayed PMI Entity
	PMI Configuration Entities
	Views
	1. Expand the Views tree to display the defined views.
	2. Right-click the selected view, and then select Activate.

	Captures
	1. Expand the Captures tree to display the defined captures.
	2. Right-click the selected captures, and then select Activate.

	Reference Frames
	1. Expand the Reference Frames tree to display the predefined reference frames.
	2. Right-click the selected reference frame, and then select Activate.


	PMI Hyperlinks
	1. From the Model Tree or workspace, right-click the PMI hyperlink entity.
	2. From the menu, select Follow Hyperlink.
	3. From the 3D Hyperlink dialog, select a link and then click Fire.


	Manipulating a 3D Model
	Panning a Model Along the X, Y and Z-Axis
	1. From the Manipulate menu, select Manipulate.
	2. Select the model part or parts that you want to pan.
	3. Click and hold the mouse button on the arrow at the end of the axis that you want to pan.
	4. Drag the mouse to where you want to move the part or parts.
	5. To exit Manipulate mode, click Manipulate , or from the Manipulate menu, select Manipulate.

	Rotating a Model Along the X, Y and Z-Axis
	1. From the Manipulate menu, select Manipulate.
	2. Select the model part or parts that you want to rotate.
	3. Click and hold the mouse button on the sphere at the end of the axis you want to rotate.
	4. Clicking on an axis sphere allows rotation around one of the other two axes.
	5. Move the mouse to rotate the model by the selected axis.
	6. To exit Manipulate mode, click Manipulate , or from the Manipulate menu, select Manipulate.

	Scaling a Model Along the X, Y and Z-Axis
	1. From the Manipulate menu, select Manipulate.
	2. Select the model part or parts that you want to scale.
	3. Click and drag a corner cube of the box up or down to scale the selected model part.
	4. To exit Manipulate mode, click Manipulate , or from the Manipulate menu, select Manipulate.


	Part Alignment
	Part Alignment Constraints
	Aligning Model Parts
	1. From the Manipulate menu, select Align Parts.
	2. Select the Constraint Type that you want to perform.
	3. Select the Alignment Type.
	• Select Aligned if you want to align the Mobile point on the model part to the Fixed point on the model
	• Select Anti_Aligned if you want to align the Mobile point on the model part so that it is opposite to the Fixed point on the model.
	4. Select a model part from the workspace. The Mobile arrow is enabled.
	5. Click Vertex , Edge , or Face to select the type of geometrical point you want to click on the model part to be aligned.
	6. Click the geometrical point on the selected model part.
	7. Click Vertex , Edge , or Face to select the type of geometrical point you want to click on the model part to remain fixed.
	8. Click the geometrical point on the model.
	9. To view a preview of the alignment, select Show Preview.
	10. To apply the constraints, click Apply.
	11. Click Close to close the Part Alignment dialog.
	12. To restore the default state of a part of the model, from the Manipulate menu, select Transform, and then select Reset Selected. To restore the default state for the whole model, select Reset All.



	Transformation
	Transforming a Model Using Illustration Buttons
	1. From the Manipulate menu, select Transform, and then select Define.
	2. Select the model part or parts that you want to rotate, translate, or scale.
	3. Use the rotate or translate buttons to transform the model.
	4. To set the translate, rotate and scale increments, click Options. The Options dialog box appears.
	a Enter the Translate Increment value in inches.
	b Enter the Rotate Incrementvaluein degrees.
	c Enter the Scale Increment value, then click OK.

	5. Click Reset to set the model to its original transformation.
	6. Click Close to close the Transformation dialog box.
	7. To restore the default state of a part of the model, from the Manipulate menu, select Transform, and then select Reset Selected. To restore the default state for the whole model, select Reset All.

	Resetting the Transformation of a 3D Model
	1. View the transformed 3D Model.
	2. To reset the entire model to its original transformation, from the Manipulate menu, select Transform, and then select Reset All.
	3. To reset selected model parts to their original transformation, from the Manipulate menu, select Transform, and then select Reset Selected.

	Transforming a Model by Setting Values
	1. From the Manipulate menu, select Transform, and then select Define.
	2. Select the model part or parts that you want to rotate, translate or scale.
	3. To rotate the model by set values, enter the X, Y and Z value.
	4. To translate the model by set values, enter the X, Y and Z value.
	5. To view a mirror image, in the Mirror section of the dialog box, select a check box.
	6. To scale the model by a factor, in Factor field, enter a scale factor.
	7. Click Apply.
	8. To apply absolute transformation instead of incremental, select the Absolute check box.
	9. Click Apply.
	10. To repeat a transformation, deselect Absolute, then continue clicking Apply.
	11. Click Close to close the Transformation dialog box.


	Sectioning
	Section Plane Options
	Cut Options
	Defining the Section Plane and Cut-through
	1. From the Manipulate menu, select Section, and then select Define.
	2. From the Section Plane list, select the orientation for the section plane.
	3. From the Cut Options list, select the cut option that you want.
	4. To define the plane position, click and drag the Plane Position slider to the position you want.
	5. Select Dynamic, if you want the plane to move simultaneously with the slider.
	6. Select Show Plane, if you want the section plane visible.
	7. Select Fill, if you want the section plane filled.
	8. From the Measured Units list, select the unit in which you want to measure the section surface.
	9. Click Close to close the Define Section dialog.

	Exporting Section Edges
	1. Define a section plane.
	2. From the Manipulate menu, select Section, and then select Export.
	3. Enter a file name and select a directory location to export the file.
	4. From the Save As Type list, select whether to save the file as .dxf or .dwg format.
	5. Click Save.


	Exploding
	Explode Options
	Exploding a 3D Model
	1. From the Manipulate menu, select Explode.
	2. Select the parts that you want to explode.
	3. From the Maximum Depth list, select the level to which you want the model to explode.
	4. Select Animated if you want to see an animated view of the explosion.
	5. Select Show Arrows if you want to display the arrows.
	6. To explode the model, click the button.
	7. To implode the model, click the button.
	8. Click OK to close the Explode dialog box.

	Saving an Exploded View of a 3D Model
	1. Explode a 3D Model.
	2. Click Save View in the Explode dialog box.
	3. Enter a view name.
	4. Click OK.
	5. Click OK to close the Explode dialog box.


	User-Defined Coordinate Systems
	Position Options
	Orientation Options
	Deleting a User Coordinate System
	1. From the Analysis menu, select Set User Coordinate System.
	2. From the Coordinate System list, select the trihedral coordinate system that you want to delete.
	3. Click Delete.
	4. Click OK to close the User Coordinate Systems dialog.

	Modifying a User-Defined Coordinate System
	1. From the Analysis menu, select Set User Coordinate System.
	2. From the Coordinate Systems list, select the UCS that you want to modify.
	3. To change the name, highlight the name and enter the new one.
	4. To change the position of the UCS, click the Position tab, then from the Define From list, select the point where you want the UCS axes to appear.
	5. To change the orientation, click the Orientation tab, then from the Define From list, select the point where you want to orient the UCS.
	6. To show the UCS axes, select Show Trihedron. To hide the UCS axes, deselect the check box.
	7. To change the UCS that it is relative to, select the UCS from the Relative To list.
	8. Click OK to close the User Coordinate Systems dialog.

	Activating a Coordinate System
	1. From the Analysis menu, select Set User Coordinate System.
	2. From the Coordinate System list, select the trihedral coordinate system that you want to use.
	3. Click Set Active.
	4. Click OK to close the User Coordinate Systems dialog.

	Defining a User Coordinate System
	1. From the Analysis menu, select Set User Coordinate System.
	2. Click New.
	3. To change the name that you want for the UCS, in the Name field, enter a new name.
	4. Click the Position tab to define the origin of the UCS.
	5. From the Define From list, select the point where you want the UCS axes to appear.
	6. Click Apply.
	7. Click the Orientation tab to define the orientation of the UCS.
	8. From the Define From list, select the point where you want to orient the UCS.
	9. Click Apply.
	10. To hide the UCS axes on the model, deselect the Show Trihedron check box.
	11. Click OK to close the User Coordinate Systems dialog.


	Interference Checks
	Interference Check Options
	Performing an Interference Check
	1. From the Analysis menu, select Check for Interference.
	2. From the Scope options, select the type of interference check that you want to perform.
	3. If you selected Set Against the Rest or Set Against Itself, select one or more model parts on the model or from the Model Tree.
	4. If you selected Set 1 Against Set 2, click the Set 1 arrow , then select one or more model parts on the model or from the Model Tree.
	5. Click the Set 2 arrow then select one or more model parts on the model or from the Model Tree.
	6. In the Minimum Clearance Distance field, enter a distance. The default value is 0.
	7. From the Units list, select the unit for the clearance distance.
	8. To configure the interference check results, click Options.
	9. Click Compute in the Interference Checking dialog.
	10. To save the results, click Export.
	11. Specify the file name and the directory where you want to save the file.
	12. Click Save to close the Export Result dialog.
	13. Click Close to close the Interference Checking dialog.

	Interference Check Results Options

	Comparing 3D Files
	Comparing 3D Files
	1. View the base file.
	2. From the Analysis menu, select Compare.
	3. Enter the file name or browse to locate the file you want to compare with the current active file.
	4. Click Open.
	5. To view the properties of a modified or moved entity in the base file and in the compare file, select the modified or moved entity from the tree, then right-click and select Entity 1 Properties.
	6. Select the entity again, then right-click and select Entity 2 Properties.
	7. To compare the results of the entity in the base file to the compare file, select the entity from tree, then right-click and select Compare Results.
	8. To view the attribute differences, click Attributes.
	9. To view the transformation difference, click Transformation.
	10. Click OK to close the Compare Results dialog.
	11. To exit Compare mode, from the File menu, select Exit Compare.

	Comparing Entity Sets
	1. Select the files you want to compare.
	2. From the Analysis menu, select Compare Sets.
	3. Click Set 1.
	4. Select the entities from either the tree on the left or the tree on the right.
	5. Click Set 2.
	6. Select the entities from the other tree that you did not select for Set 1.
	7. Click OK.
	8. To restore the comparison files, from the Analysis menu, select Compare Files.


	Generating a Bill of Material
	1. From the Analysis menu, select Generate Bill of Material.
	2. To sort the list numerically, click the Count column header.
	3. To sort the list alphabetically, click the Part Name column header.
	4. To view a part or parts on the model, select the parts from the Part Name column.
	5. To save the Bill of Material, click Export.
	6. Enter a file name or browse to locate the directory where you want to store the file, then click Save.
	7. Click Close to close the Bill of Material dialog.

	Entity Search
	Performing a Search
	1. From the Edit menu, select Entity Search.
	2. Click the 3D Search tab.
	3. From the Selection list, specify what parts of the model that you want to search.
	• To search the entire model, select All.
	• To search specific parts of a model, select Selected and then select the parts on the model.
	• To search the model parts that are not selected, select Not selected.
	4. From the Type list, select the type of entity that you want to search.
	5. Select the Show PMI parent entity in results check box if you only want the parent entity of the selected PMI entity or entities to appear in the Results list.
	6. Deselect the check box if you want all PMI entities to appear in the Results list.
	7. From the PMI Filter list, select the type of entities that you want to search.

	• To search all entities, select All.
	• To search entities with PMI, select With PMI.
	• To search entities without PMI, select Without PMI.
	8. From the PMI Type list, select the type of entity that you want to search.
	9. Click Search to perform the entity search.


	Performing an Attribute-based Search
	1. From the Edit menu, select Entity Search.
	2. Click the 3D Search tab.
	3. Select the search criteria that you want to use for your search.
	4. Click Add.
	5. From the Name list, select the attribute that you want to search.
	6. Select the Any Value check box if you want to search by any value; the associated value options are disabled.
	7. Deselect the Any Value check box if you want to search by a specific value; from the Condition set condition for the search, and from the Values list select the values that you want to search.
	8. Click OK.
	9. To edit an Attribute Filter, select the filter and click Edit.
	10. To disable an Attribute Filter, deselect the check box beside the filter or filters that you want to disable.
	11. To enable an Attribute Filter, select the check box beside the filter or filters.
	12. To remove an Attribute Filter, in the Entity Search dialog, select the filter and click Remove.
	13. In the Entity Search dialog, click Search.
	14. Click Close to close the Entity Search dialog.


	Performing an Advanced 3D Search
	1. From the Entity Search dialog, click the Advanced 3D Search tab.
	2. To search for entities by Volume, select the Enabled check box.
	3. Enter the minimum and maximum dimensions in their respective fields.
	4. From the Units list, select the unit you want to set for the Volume dimensions.
	5. To search for entities by location, select the Enabled check box.
	6. From the Units list, select the unit you want to set for the Location dimensions.
	7. Enter the dimensions for Point 1 and Point 2.
	8. Click the 3D Search tab.
	9. Click Search.
	10. Click Close to close the Entity Search dialog.
	Saving Search Results
	1. Perform a 3D entity search.
	2. Click Search.
	3. To save the results, click Export.
	4. Specify the path where you want to store the file and enter the file name, then click Save.


	Measuring in 3D Files
	3D Snapping Modes
	Measuring Distance
	1. From the Analysis menu, select Measure.
	2. Click the Distance tab.
	3. From the Measured Distance Units list, select the unit in which you want to measure.
	4. Click the From field to select the entity type that you want to measure from.
	5. Select the snapping modes that you want to use for measuring.
	6. On the model, select the entity you want to measure from.
	7. Click the To field to select the entity type that you want to measure to.
	8. Select the snapping modes that you want to select as the end point for the measurement.
	9. On the model, select the entity you want to measure to.
	10. Click Close to close the Measurement dialog box.

	Calibrating Distance
	1. Measure distance between two points or measure cumulative distance.
	2. From the Distance tab, click Calibrate.
	3. From the Units list, select the unit to which you want to calibrate the distance.
	4. Select Calibrate to and enter a value if you want to calibrate the distance to a value.
	5. Select Set Factor and enter a value if you want to calibrate the distance by a factor.
	6. Click OK.
	7. Click Close to close the Distance tab.

	Measuring Minimum Distance
	1. From the Analysis menu, select Measure.
	2. Click the Min. Distance tab.
	3. Click Set 1.
	4. From the Snapping Mode section, select one of the following:
	• Select Entity if you want to measure the distance between model parts. Snapping modes are disabled.
	• Select Geometry if you want to measure the distance between entity types. Snapping modes are enabled.
	5. If you selected Entity, select a part or parts on the model. If you selected Geometry, select the snapping modes that you want to use for measuring.
	6. Click Set 2.
	7. Repeat step 5.
	8. From the Units list, select the unit in which you want to measure the distance.
	9. Click Compute.
	10. To take another measurement click Reset.
	11. Click Close to close the Measurement dialog.


	Measuring an Angle
	1. From the Analysis menu, select Measure.
	2. Click the Angle tab.
	3. Select the snapping modes that you want to use for measuring.
	4. To measure the angle between an entity type and a plane, select the With Plane check box, and then select the plane from the list.
	5. From the Units list, select the unit in which you want to measure the angle.
	6. Click two points on the model to define the angle.
	7. Click again to complete the measurement.
	8. To take another measurement click Reset.

	Measuring an Arc
	1. From the Analysis menu, select Measure.
	2. Click the Arc tab.
	3. Select Arc Entity if you want to measure a predefined arc.
	4. Select From 3 Points if you want to measure the arc between three points.
	5. Select the snapping modes that you want to use for measuring.
	6. From the Units list, select the unit in which you want to measure the arc distance.
	7. If you selected From 3 Points, click three points to define the arc.
	8. If you selected Arc Entity, click the edge of the arc that you want to measure.
	9. Click Close to close the Measurement dialog.

	Calibrating an Arc
	1. Measure an arc in the drawing.
	2. From the Arc tab, click Calibrate.
	3. From the Units list, select a unit of measurement to which you want to calibrate the distance.
	4. Click Calibrate to and enter a value if you want to calibrate to a value.
	5. Click Set Factor and enter a value if you want to calibrate by a factor.
	6. Click OK.
	7. Click Close to close the Measurement dialog.

	Measuring Vertex Coordinates
	1. From the Analysis menu, select Measure.
	2. Click the Vertex tab.
	3. From the Units list, select the unit in which you want to measure.
	4. Move the cursor over the highlighted vertex that you want to measure.
	5. Select the vertex.
	6. Click Close the close the Measurement dialog.

	Measuring the Length of an Edge
	1. From the Analysis menu, select Measure.
	2. Click the Edge Length tab.
	3. From the Units list, select the unit in which you want to measure the edge length.
	4. Click the edge that you want to measure.
	5. Click Close to close the Measurement dialog.

	Measuring Face Surface
	1. From the Analysis menu, select Measure.
	2. Click the Surface tab.
	3. Select Face Surface if you want to measure the surface area of a face on an entity.
	4. Select Entity Surfaces if you want to measure the surface area of an entire entity.
	5. From the Units list, select the unit in which you want to measure the surface.
	6. If you selected Face Surface, move the cursor on the model to highlight a face surface, then click the face surface that you want to measure.
	7. If you selected Entity Surface, click the entity that you want to measure.
	8. To measure the face surface of the entity, click on the highlighted body.
	9. Select the entity or a parent from the list.
	10. To take another measurement click Reset.
	11. Click Close to close the Measurement dialog.



	Configuring AutoVue
	General Options
	1. From the Options menu, select Configure.
	2. From the Configuration tree, select General.
	Configuring Options for CAD Files
	Raster Files
	System Options
	Configuring Paths
	Configuring XRef Paths
	1. From the Configuration tree, expand General, and then select XRef Paths.
	2. Click Add.
	3. Enter the directory path, or scroll to locate the directory where the external reference files are located.
	4. To browse all subdirectories below the current path, type two asterisks ** at the end of the file path.For example, C:\samples\** will result in browsing all subdirectories below “samples”.
	5. To browse one subdirectory below the current path, type one asterisk * at the end of the file path. For example, C:\samples\* will result in browsing one subdirectory below “samples”.
	6. Click OK.
	7. To change the order, select the path you want to move, then click Up or Down to move the path to where you want it in the list.
	8. To remove a path, select the path and click Remove.

	Configuring Font Paths
	1. From the Configuration tree, expand General, and then select Font Paths.
	2. Click Add.
	3. Enter the directory path or scroll to locate the directory where the external font files are located.
	4. To browse all subdirectories below the current path, type two asterisks ** at the end of the file path.
	5. To browse one subdirectory below the current path, type one asterisk * at the end of the file path.
	6. Click OK.
	7. To change the order, select the path you want to move, then click Up or Down to move the path to where you want it in the list.
	8. To remove a path, select the path and click Remove.

	Configuring Symbol Paths
	1. From the Configuration tree, expand General, and then select Symbol Paths.
	2. Select the Auto option if you want to use the default directory to store the Symbol libraries.
	3. Select the User-Defined option if you want to select a directory to store the Symbol libraries. Enter the directory path where you want to store the Symbol files or click Browse to locate the directory.

	Configuring Markup Paths
	1. From the Configuration tree, expand General, and then select Markup Paths.
	2. Select the Auto option if you want to use the default directory to store the markup. AutoVue, by default, stores the Markup files in an avred subdirectory at the location of the base file.
	3. Select the User-Defined option if you want to select a directory to store the markup. Enter the directory path where you want to store the markup, or click Browse to locate the directory.


	Measurement
	Configuring the Base Font for Text Files
	1. From the Configuration tree, expand General, and then select Base Font.
	2. Select a font from the Font list.
	3. From the Font Style list, select Regular, Bold, Italic, or Bold Italic.
	4. Select font size from the Size list.
	5. From the Effects options, you can add a strikeout or underline to the text.

	Configuring Streaming File Support
	1. Select the Enable Streaming File Support check box.
	2. Browse and select a folder to use for storing streaming files and then click OK.
	3. Select the Enable Cache Size Limit check box to limit the size of the streaming file cache folder (the default value is 0). Enter the cache size in the field to the right of the check box.


	Configuring AutoVue for 2D Files
	1. From the Options menu, select Configure.
	2. Select 2D in the tree.
	Snap Settings
	Configuring Colors

	Configuring AutoVue for 3D Files
	1. From the Options menu, select Configure.
	2. Select 3D in the tree.
	Rendering
	Dynamic Rendering
	Model
	Loading
	1. Select the Load Mesh Data option to load available mesh data.
	2. Deselect Load Mesh Data to load BREP data.

	Default Mesh Resolution
	PMI Filtering
	Configuring Color
	Common
	Section Highlight
	Geometry Highlight

	Configuring Background
	For the Background Gradient option
	For the Background Images option
	1. Click Add.
	2. Click on the ellipses to the right of the Image File field to browse to the image file.
	3. From the Stretch Type list, select whether to leave the image as is, Stretch to fill, Zoom to fit, or Zoom to fill.
	4. From the Position in the Background list, select where to position the image and then click OK.
	5. To add multiple background images, repeat steps 1 through 4.
	6. You can change the order of the background images. To do so, select a file from the Background Images list and then click Up to move an image to the front and Down to send an image to the back.
	7. To edit the background image, select the file from the Background Images list and then click Edit.
	8. To remove a background image, from the Background Images list, select the file and then click Remove.
	9. Click OK when done.


	Miscellaneous
	Display
	Model Tree
	Manipulator
	Highlight Selection


	Configuring AutoVue for EDA Files
	Customizing Selections
	Highlight Entity
	Dim Unselected

	Displaying Tooltips
	1. From the tree, select EDA.
	2. Under the Mouse Hover heading, select or deselect the Show Entity Information Tooltip option.
	3. Click OK.

	Modifying 3D View
	1. From the Configuration tree, select EDA.
	2. Enter a value in the Default Board Thickness field to change the board’s thickness.
	3. Enter a value in the Default Component Height field to change the component height.
	4. To work with a different unit of measurement, select another unit from the Default Units list. This is the unit of measurement used for values set in the Default Board Thickness and Default Component Height fields.
	5. Reload the file to see your changes.

	Synchronizing Layers when Comparing Files
	1. From the tree, expand EDA, and then select Analysis.
	2. Select the Layer Settings option to synchronize all layer settings when comparing files.

	Configuring Zoom Behavior when Cross Probing
	1. From the tree, expand EDA, and then select Analysis.
	2. Select one of the following Cross Probe Action options:
	a Select Keep Current Zoom Level. When this option is active, the view of the target files remains the same while you cross probe.
	b Select Zoom Selected to automatically zoom in on selected entities while you cross probe. This option is enabled by default.
	c Select Zoom Fit to automatically adjust the contents of a file along the horizontal and vertical axis to fully display within the current window.


	Modifying Colors
	Common
	PCB
	3D View

	Enhanced Display Options

	Configuring Background Colors for Graphic Files
	1. From the Options menu, select Configure.
	2. Select Graphics in the tree.
	3. From their respective Background lists, select colors for monochrome raster files and color raster files.

	Configuring Background Colors for Desktop Office
	1. From the Options menu, select Configure.
	2. Select Desktop Office in the tree.
	3. Select a background color for each Desktop Office file type.


	Markups
	Markup Navigation Tree
	Filtering Markups
	Working with Markup Files
	Saved States
	Creating a Markup File
	1. View a file that you want to markup.
	2. From the Markup menu, select New.

	Entering Markup Information
	Saving a New Markup File
	1. From the Markup menu, select Save.
	2. In the Markup ID field, enter an ID consisting of any combination of characters or numbers.
	3. Click OK.

	Opening Markup Files
	1. View a file that has existing markups.
	2. From the Markup menu, select Open.
	3. From the Markup list, select the check box next to Markup file you want to open.
	4. Click OK.

	Saving an Existing Markup File
	Importing a Markup File
	1. From the Markup menu, select Open.
	2. Click Import.
	3. Navigate to the markup file that you want to import and select it.
	4. Click Open.

	Exporting a Markup File
	1. From the Markup menu, select Save As.
	2. Click Export.
	3. Navigate to the location where you want to export the Markup file.
	4. Enter file name.
	5. Click Save.

	Setting the Active Markup File
	1. From the Markup menu, select Open.
	2. From the Markup list, select the markup or markups you want to open.
	3. From the Active Markup list, select the markup you want to make active.
	4. Click OK.

	Changing the Active Markup File

	Working with Markup Layers
	Creating a Markup Layer
	1. From the Markup menu, select Markup Layers.
	2. Click New.
	3. Enter a name for the markup layer.
	4. Click OK.
	5. To change the color of the new layer, click Color.
	6. Select a color and click OK.
	7. Click OK to close the Markup Layers dialog.

	Setting the Active Markup Layer
	1. From the Markup menu, select Markup Layers.
	2. You can perform one of the following:
	• From the Markup Layers list, select the layer you want to make active, and click Set Active.
	• From the Currently Active Layer list, select the layer you want to make active.
	3. Click OK.


	Changing the Color of a Markup Layer
	1. From the Markup menu, select Markup Layers. The Markup Layers dialog appears.
	2. From the Markup Layers list, select the markup layer whose color you want to change.
	3. Click Color.
	4. Select a Color.
	5. Click OK.
	6. Click OK to close the Markup Layers dialog.

	Renaming a Markup Layer
	1. From the Markup menu, select Markup Layers. The Markup Layers dialog appears.
	2. From the Markup Layers list, select the markup layer you want to rename.
	3. Click Rename.
	4. Enter the new layer name.
	5. Click OK.
	6. Click OK to close the Markup Layers dialog.

	Toggling between Markup Layers
	1. From the Markup menu, select Markup Layers. The Markup Layers dialog appears.
	2. To show/hide a layer or layers, perform one of the following:
	a Select a layer and click Toggle. The layer’s check box will switch between selected and deselected. To view all the markup layers, click All On. To hide all markup layers click All Off.
	b From the Markup Layers list, select the check box next to the layer or layers you want visible, and deselect the check box next to the layer or layers you want to hide.

	3. Click OK.

	Deleting a Markup Layer
	1. From the Markup menu, select Markup Layers.
	2. From the Markup Layers list, select the markup layer you want to delete.
	3. Click Delete.
	4. Click OK.

	Moving a Markup Entity to Another Layer
	1. Select the markup entity or entities that you want to move.
	2. From the Markup menu, select Format, and then select Move to Layer.
	3. From the Layers list, select the destination layer.
	4. Click OK.


	Consolidating Markup Files
	1. Open the Markup files that you want to consolidate.
	2. From the Markup menu, select Consolidate.
	3. Select the markup layers that you want to consolidate into one file. To select multiple layers, press the Shift or Control key while selecting.
	4. In the Markup ID field, enter an ID for the new Markup file.
	5. If you want to open the newly consolidated markup as the active markup, select the Open as Active Markup check box.
	6. Click OK.

	Marking up 2D and 3D Files
	Adding an Attachment
	1. From the Markup menu, select Add Entity, and then select Attachment.
	2. Click on the drawing where you want to add an attachment.
	3. In the Attachment Name field, enter a name for the attachment. Optionally, you can also provide a brief description of the attachment in the Description box.
	4. In the Data File field, enter the path to the file or click Browse.The Open dialog box appears.
	5. Select the file and click Open.
	6. Select Open with AutoVue to open the attachment. Deselect Open with AutoVue to open the file in its native program.
	7. To display the attachment as an specific image, click Set Icon.The Open dialog box appears.
	8. Select the image and click Open.
	9. Click OK to close the Attach File dialog box.
	10. Right-click in the workspace to complete the attachment.

	Opening an Attachment
	Editing an Attachment
	1. In the Markup Navigation Tree, right-click the attachment and select Edit, or double-click the markup entity.
	2. Make your changes and click to OK.

	Adding a Hyperlink
	Creating a Hyperlink
	1. From the Markup menu, select Add Entity, and then select Hyperlink.
	2. Click a point on the document where you want to place the hyperlink.
	3. Enter a Link Name.
	4. Optionally, enter a Link Description.
	5. Click Browse to locate the data file or application and its path that you want to link to, or enter the information manually.
	6. To change the hyperlink icon, click Set Icon. The Open dialog box appears.
	7. Enter the file name or browse to locate the bitmap file that you want to use as the icon, then click Open.
	8. Click OK to close the Establish Hyperlink dialog box.

	Opening a Hyperlink
	Editing a Hyperlink
	1. In the Markup Navigation Tree or from the workspace, select the hyperlink that you want to edit.
	2. From the Markup menu, select Format, and then select Edit Hyperlink.
	3. Edit the information that you want.
	4. Click OK to close the Establish Hyperlink dialog.

	Deleting a Hyperlink
	1. In the Markup Navigation Tree or from the workspace, select the hyperlink that you want to delete.
	2. From the Markup menu, select Format, and then select Remove Hyperlink.

	Adding Signoff Entities
	1. From the Markup menu, select Add Entity, and then select Signoff.
	2. Click and drag to create a box on the drawing where you want the signoff.
	3. Click OK.

	Rescinding the Signoff
	1. In the Markup Navigation tree or in the workspace, double-click the signoff markup entity.
	2. Click Rescind.

	Re-Approving a Signoff
	1. In the tree, double-click the signoff markup entity. The Signoff dialog appears
	2. Click Approve.

	Viewing the History of a Signoff
	1. From the Markup menu, select Add Entity, and then select Signoff.
	2. Click History.
	3. Click Cancel to close the Signoff dialog.

	Adding an Intellistamp
	1. Enter Markup mode.
	2. From the Markup menu, select Add Entity, and then select Intellistamp.
	3. In the workspace, click and drag a box to the desired Intellistamp size.
	4. From the Choose Stamp box, select the desired Intellistamp.
	5. Click OK.
	6. Right-click the workspace to complete the Intellistamp placement.

	Viewing/Modifying Intellistamp Attributes
	Adding a Stamp
	1. From the Markup menu, select Add Entity, and then select Stamp.
	2. Click the Stamps tab.
	3. From the Stamp Library list, select the library from which you want to select a stamp.
	4. Click Isotropic if you want to scale the stamp proportionately.
	5. Click Anisotropic if you want to scale the stamp disproportionately.
	6. Drag the stamp onto the workspace.
	7. Close the Stamps dialog.

	Creating a New Stamp Library
	1. From the Markup menu, select Add Entity, and then select Stamp.The Stamps dialog appears.
	2. Click the Libraries tab.
	3. Click Create.
	4. Enter the library name, description, author, and keywords in their respective fields.
	5. To add a stamp to the library, click Add.
	6. Browse to locate the stamp you want to add, and then click Open.
	7. Close the Stamps dialog.

	Adding a Stamp to a Library
	1. From the Markup menu, select Add Entity, and then select Stamp.The Stamps dialog appears.
	2. Click the Stamps tab.
	3. From the Stamp Library list, select the library that you want to add a stamp.
	4. Click Add Stamp.
	5. Enter the source file, stamp Name, and description in their respective fields, or click Browse to locate the source file.
	6. Click OK.
	7. Close the Stamps dialog.

	Deleting a Stamp from a Library
	1. From the Markup menu, select Add Entity, and then select Stamp.The Stamps dialog appears.
	2. Click the Stamps tab.
	3. From the Stamp Library list, select the library which contains the stamp you want to delete.
	4. The stamps appear in the Drag and Drop a Stamp onto AutoVue section.
	5. Select the stamp you want to delete, then click Delete.
	6. Close the Stamps dialog.

	Editing Stamp Library Information
	1. From the Markup menu, select Add Entity, and then select Stamp.
	2. Click the Libraries tab.
	3. From the Stamp Libraries list, select the library that you want edit.
	4. Click Edit.
	5. Edit the information.
	6. Click OK.
	7. Close the Stamps dialog.

	Deleting a Stamp Library
	1. From the Markup menu, select Add Entity, and then select Stamp.The Stamps dialog appears.
	2. Click the Libraries tab.
	3. From the Stamp Libraries list, select the library that you want to delete.
	4. Click Delete.
	5. Close the Stamps dialog.


	2D-Specific Markups
	2D Markup Entities
	Adding a Freestyle Entity
	Creating a Non-Contiguous Freestyle Entity
	1. From the Markup menu, select Add Entity, and then select Freestyle.
	2. Click a point on the drawing where you want to start the Freestyle entity.
	3. Move the cursor to create the Freestyle entity.
	4. Click a point on the drawing where you want to interrupt the Freestyle entity.
	5. Click another point on the drawing where you want to restart the Freestyle entity.
	6. Right-click to end the Freestyle entity.

	Creating a Contiguous Freestyle Entity
	1. From the Markup menu, select Add Entity, and then select Freestyle.
	2. Click a point on the drawing where you want to start the Freestyle entity.
	3. Move the cursor to create the Freestyle entity.
	4. Right-click to end the Freestyle entity.


	Adding a Leader
	1. From the Markup menu, select Add Entity, and then select Leader.
	2. Click a point on the document where define the Leader anchor point.
	3. Move the cursor to draw the Leader.
	4. To draw a Leader with multiple line segments, repeat steps 2 and 3 as often as you like. You can click, then drag as often as you like.
	5. Right-click to end the Leader. A text box appears at the end of the Leader.
	6. In the text box, enter the text you want to attach to the Leader.
	7. To change text box font properties, from the Markup menu, select Format, and then select Font.
	8. Click OK to implement the font changes and to close the Font dialog.
	9. To change the line properties or fill color of the Leader, select the Leader, then from the Markup menu, select Format, and then select the property or properties you want to change.
	10. Right-click outside the text area to complete the modification.

	Aligning a Line Segment to the Vertical or Horizontal Axes
	1. To draw and force a line segment, press and hold the Shift key while you click and drag for that line segment.
	2. To force an existing line segment, click and hold the left mouse button on the line segment, then press and hold the Shift key.
	3. When you see that the line segment is horizontal or vertical, release the left mouse button, then release the Shift key.

	Creating 2D non-Vector Markup Measure Entities
	Measuring Distance
	1. From the Markup menu, select Add entity, select Measurement, and then select Distance.
	2. From the Measured Distance Units list, select the unit in which you want to measure the distance.
	3. Click a point on the drawing to define the starting point.
	4. Click another point on the drawing to define the end point.
	5. Move the cursor and click a location on the drawing to display the measure distance.
	6. To resize the value box, select it and then click and drag the frame handles.
	7. You can click and drag the text box anywhere on the drawing.
	8. Click Close to close the Measurement Entities dialog.

	Measuring Cumulative Distance
	1. From the Markup menu, select Add entity, select Measurement, and then select Distance.
	2. From the Measured Distance Units list, select the unit in which you want to measure the distance.
	3. Select Cumulative.
	4. Click a point on the drawing to define the starting point.
	5. Continue clicking points along the path that you want to measure.
	6. Right-click to complete the measurement.
	7. Click Close to close the Measurement Entities dialog.

	Calibrating Distance
	1. Measure distance between two points or measure cumulative distance.
	2. From the Distance tab, click Calibrate.
	3. From the Units list, select the unit to which you want to calibrate the distance.
	4. Select Calibrate to and enter a value if you want to calibrate the distance to a value.
	5. Select Set Factor and enter a value if you want to calibrate the distance by a factor.
	6. Click OK.
	7. Click Close to close the Distance tab.

	Measuring Area
	1. From the Markup menu, select Add entity, select Measurement, and then select Area.
	2. From the Measured Area Units list, select the unit in which you want to measure the area.
	3. From the Perimeter Units list, select the unit in which you want to measure the perimeter.
	4. To cumulate a Net Area Result of different areas, select Add.
	5. To subtract an area from the Net Area Result, select Subtract.
	6. Select Clear to clear the Net Area Result field.
	7. Click a point on the drawing to define the starting point.
	8. Continue clicking points on the drawing to define the area you want to measure.
	9. Right click to complete the measurement.
	10. Click Close to close the Measurement Entities dialog.

	Measuring an Angle
	1. From the Markup menu, select Add entity, select Measurement, and then select Angle.
	2. From the Measured Angle Units list, select the unit in which you want to measure the angle.
	3. Click points on the drawing to define the angle you want to measure:
	• The first click defines the starting point of the angle measurement.
	• The second click defines the vertex of the angle measurement.
	• The third click defines the endpoint of the angle measurement.
	• The points are joined by angle arms with an arc connecting them.
	4. Move the cursor to increase or decrease the radial and arc length.
	5. Click again to complete the measurement.
	6. To resize the value box, select it and then click and drag the frame handles.
	7. You can click and drag the value box anywhere on the drawing.
	8. Click Close to close the Measurement Entities dialog.


	Measuring an Arc
	1. From the Markup menu, select Add entity, select Measurement, and then select Arc.
	2. From the Arc Info Length list, select the unit in which you want to measure the arc.
	3. From the Measured Angle Units list, select the unit in which you want to measure the angle. The options are degrees or radians.
	4. Select Add Radius if you want to measure the radius of the arc.
	5. Select Add Diameter if you want to measure the diameter of the arc.
	6. Click three points on the drawing to define the arc you want to measure.
	7. Click again to complete the measurement.
	8. To resize the value box, select it and then click and drag the frame handles.
	9. You can click and drag the text box anywhere on the drawing.
	10. Click Close to close the Measurement Entities dialog.

	Calibrating an Arc
	1. Measure an arc in the drawing.
	2. From the Arc tab, click Calibrate.
	3. From the Units list, select a unit of measurement to which you want to calibrate the distance.
	4. Click Calibrate to and enter a value if you want to calibrate to a value.
	5. Click Set Factor and enter a value if you want to calibrate by a factor.
	6. Click OK.
	7. Click Close to close the Measurement dialog.


	Creating 2D Vector Markup Measure Entities
	2D Vector Snapping Modes
	Measuring Distance
	1. From the Markup menu, select Add entity, select Measurement, and then select Distance.
	2. Select the snapping modes that you want to use for measuring.
	3. To select all snapping modes click All On. To clear all snapping modes click All Off.
	4. From the Measured Distance Units list, select the unit in which you want to measure the distance.
	5. Click a point on the drawing to define the starting point.
	6. Click another point on the drawing to define the end point.
	7. Move the cursor and click a location on the drawing to display the measure distance.
	8. To resize the value box, select it and then click and drag the frame handles.
	9. You can click and drag the text box anywhere on the drawing.
	10. Click Close to close the Measurement Entities dialog.

	Measuring Cumulative Distance
	1. From the Markup menu, select Add entity, select Measurement, and then select Distance.
	2. Select the snapping modes that you want to use for measuring.
	3. To select all snapping modes, click All On. To deselect all snapping modes, click All Off.
	4. From the Measured Distance Units list, select the unit in which you want to measure the distance.
	5. Select Cumulative.
	6. Click the first entity to define the starting point.
	7. Continue clicking points along the path that you want to measure.
	8. Right-click to complete the measurement.
	9. Click Close to close the Measurement Entities dialog.

	Calibrating Distance
	1. Measure distance between two points or measure cumulative distance.
	2. From the Distance tab, click Calibrate.
	3. From the Units list, select the unit to which you want to calibrate the distance.
	4. Select Calibrate to and enter a value if you want to calibrate the distance to a value.
	5. Select Set Factor and enter a value if you want to calibrate the distance by a factor.
	6. Click OK.
	7. Click Close to close the Distance tab.

	Measuring Area
	1. From the Analysis menu, select Measure.
	2. Click the Area tab.
	3. Select Between Points if you want to measure the area between points on a drawing. The snapping modes are displayed.
	4. Select the snapping modes that you want to use for measuring.
	5. Select Shape if you want to measure the area of a predefined shape on the drawing; the snapping modes are disabled.
	6. From the Measured Area Units list, select the unit in which you want to measure the area.
	7. From the Perimeter Units list, select the unit in which you want to measure the perimeter.
	8. In the Net Area Result section of the dialog, select Add to cumulate a net area result of different areas.
	9. To subtract an area from the Net Area Result, select Subtract.
	10. Select Clear to clear the Net Area Result.
	11. If you selected Between Points, click points on the drawing to define the area.
	12. If you selected Shape, click the edge of the predefined shape that you want to measure.
	13. Click Close to close the Measurement dialog.

	Measuring an Angle
	1. From the Markup menu, select Add Entity, and then select Angle.
	2. Select From 3 Points if you want to measure the angle between three points. The snapping modes are displayed.
	3. Select the snapping modes that you want to use for measuring.
	4. Select Between 2 lines if you want to measure the angle between two lines.
	5. From the Measured Angle Units list, select the unit in which you want to measure the angle.
	6. If you selected From 3 Points, click three points on the drawing to define the angle. If you selected Between 2 lines click two lines on the drawing to define the angle.
	7. Click again to complete the measurement.
	8. To change the size of the arc, click and drag it to the desired size.
	9. To move the value box, click and drag it to anywhere on the markup.
	10. To resize the value box, select it and then click and drag the frame handles.
	11. Click Close to close the Measurement Entities dialog.

	Measuring an Arc
	1. From the Markup menu, select Add Entity, Measurement, and then Arc.
	2. Select Arc Entity if you want to measure a predefined arc.
	3. Select From 3 Points if you want to measure the arc between three points. Snapping modes are displayed.
	4. Select the snapping modes that you want to use for measuring.
	5. From the Dist. Units list, select the unit in which you want to measure the arc distance.
	6. From the Angles Units list, select the unit in which you want to measure the angle.
	7. If you selected From 3 Points, click three points to define the arc.
	8. If you selected Arc Entity, click the edge of an arc.
	9. Click to complete the measurement.
	10. To move the value box, click and drag it to anywhere on the markup.
	11. To resize the value box, select it and then click and drag the frame handles.
	12. Click Close to close the Measurement Entities dialog.

	Calibrating an Arc
	1. Measure an arc in the drawing.
	2. From the Arc tab, click Calibrate.
	3. From the Units list, select a unit of measurement to which you want to calibrate the distance.
	4. Click Calibrate to and enter a value if you want to calibrate to a value.
	5. Click Set Factor and enter a value if you want to calibrate by a factor.
	6. Click OK.
	7. Click Close to close the Measurement dialog.



	Creating EDA Markup Measure Entities
	EDA Snapping Modes
	Measuring Distance
	1. From the Markup menu, select Add entity, select Measurement, and then select Distance.
	2. Select the snapping modes that you want to use for measuring.
	3. To select all snapping modes, click All On. To deselect all snapping modes, click All Off.
	4. From the Measured Distance Units list, select the unit in which you want to measure the distance.
	5. Click a point on the drawing to define the starting point.
	6. Click another point on the drawing to define the end point.
	7. Drag to move the measured line path.
	8. Click on the measured line path.
	9. To resize the value box, select it and then click and drag the frame handles.
	10. Click Close to close the Measurement Entities dialog.

	Measuring Cumulative Distance
	1. From the Markup menu, select Add entity, select Measurement, and then select Distance.
	2. Select the snapping modes that you want to use for measuring.
	3. To select all snapping modes, click All On. To deselect all snapping modes, click All Off.
	4. From the Measured Distance Units list, select the unit in which you want to measure the distance.
	5. Select Cumulative.
	6. Click the first entity to define the starting point.
	7. Continue clicking points along the path that you want to measure.
	8. Right-click to complete the measurement.
	9. Click Close to close the Measurement Entities dialog.

	Calibrating Distance
	1. Measure distance between two points or measure cumulative distance.
	2. From the Distance tab, click Calibrate.
	3. From the Units list, select the unit to which you want to calibrate the distance.
	4. Select Calibrate to and enter a value if you want to calibrate the distance to a value.
	5. Select Set Factor and enter a value if you want to calibrate the distance by a factor.
	6. Click OK.
	7. Click Close to close the Distance tab.

	Measuring Area
	1. From the Markup menu, select Add entity, select Measurement, and then select Area.
	2. Select Between Points if you want to measure the area between points on a drawing. Snapping modes are displayed.
	3. Select the snapping modes that you want to use for measuring.
	4. Select Shape if you want to measure the area of a predefined shape on the drawing.
	5. From the Measured Area Units list, select the unit in which you want to measure the area.
	6. From the Perimeter Units list, select the unit in which you want to measure the perimeter.
	7. To cumulate a Net Area Result of different areas, select Add in the Measurement Entities dialog.
	8. To subtract an area from the Net Area Result, select Subtract.
	9. Select Clear to clear the Net Area Result field.
	10. If you selected Between Points, click points on the drawing to define the area.
	11. If you selected Shape, click the edge of a predefined shape on the drawing.
	12. Right-click to complete the measurement.
	13. Click Close to close the Measurement Entities dialog.

	Measuring an Angle
	1. From the Markup menu, select Add entity, select Measurement, and then select Angle.
	2. Select From 3 Points if you want to measure the angle between three points. Snapping modes are displayed.
	3. Select the snapping modes that you want to use for measuring.
	4. Select Between 2 lines if you want to measure the angle between two lines.
	5. From the Measured Angle Units list, select the unit in which you want to measure the angle.
	6. If you selected From 3 Points, click three points to define the angle.
	7. If you selected Between 2 Lines, click two lines to define the angle.
	8. Right-click to complete the measurement.
	9. To change the size of the arc, click and drag the it to the desired size.
	10. To move the value box, click and drag it to anywhere on the drawing.
	11. To resize the value box, select it and then click and drag the frame handles.
	12. Click Close to close the Measurement Entities dialog.

	Measuring an Arc
	1. From the Markup menu, select Add entity, select Measurement, and then select Arc.
	2. Select From 3 Points if you want to measure the arc between three points. Snapping modes are displayed.
	3. Select the snapping modes that you want to use for measuring.
	4. Select Arc Entity if you want to measure a predefined arc.
	5. From the Arc Info list, select the unit in which you want to measure the distance of the arc.
	6. From the Measured Angle Units list, select the unit in which you want to measure the angle.
	7. Select Add Radius if you want measure the radius.
	8. Select Add Diameter if you want to measure the diameter.
	9. If you selected From 3 Points, click three points to define the arc.
	10. If you selected an Arc Entity, click an edge of the arc.
	11. Click to complete the measurement.
	12. To move the value box, click and drag it to anywhere on the drawing.
	13. To resize the value box, select it and then click and drag the frame handles.
	14. Click Close to close the Measurement Entities dialog.

	Calibrating an Arc
	1. Measure an arc in the drawing.
	2. From the Arc tab, click Calibrate.
	3. From the Units list, select a unit of measurement to which you want to calibrate the distance.
	4. Click Calibrate to and enter a value if you want to calibrate to a value.
	5. Click Set Factor and enter a value if you want to calibrate by a factor.
	6. Click OK.
	7. Click Close to close the Measurement dialog.

	Measuring Minimum Distance
	1. From the Markup menu, select Add entity, select Measurement, and then select Minimum Distance.
	2. Click First Set to select the entities that you want to measure from.
	3. Select the snapping modes that you want to use for measuring.
	4. Click the first set of entities on the drawing.
	5. Click Second Set to select the entities that you want to measure to.
	6. Click the second set of entities on the drawing.
	7. From the Measured Min. Distance list, select the unit in which you want to measure the distance.
	8. Select Zoom to Result, if you want to zoom in on the measured value on the drawing.
	9. Click Compute.
	10. To move the value box, click and drag it to anywhere on the drawing.
	11. To resize the value box, select it and then click and drag the frame handles.
	12. Click Close to close the Measurement Entities dialog.


	Adding Text
	1. From the Markup menu, select Add Entity, and then select Text.
	2. Click and drag on the drawing to define the dimensions of the text box.
	3. Click in the text box and enter the text you want to add.
	4. To change text box font properties, from the Markup menu, select Format, and then select Font.
	5. Click OK to implement the font changes and to close the Font dialog.
	6. To change the line properties or fill color of the text box, select the text box, then from the Markup menu, select Format, and then select the property or properties you want to change.
	7. Right-click outside the text area to complete the modification.
	8. To move the text box click and drag it.
	9. Click and drag the frame handles of the text box to enlarge it.
	Hiding the box surrounding the text
	1. Select the text box entity.
	2. From the Markup menu, select Format, and then select Markup Entity Attributes.
	3. From the Text Box Visibility list, select OFF.
	4. Click OK.


	Adding a Note
	1. From the Markup menu, select Add Entity, and then select Note.
	2. Click a point on the document where you want to insert the note.
	3. Enter the text that you want in the note.
	4. To modify the text, select Formatting and the format you want to apply.
	5. From the File menu, select Information.
	6. In Name, Author and Key Words fields, enter the required text for the note.
	7. Click OK.
	8. Close the Markup Control Note Editor dialog box.
	9. Right-click outside the note area to complete the modification.
	10. To move the note, click and drag it.
	Viewing and Printing the List of Notes
	1. From the Markup menu, select Print Notes.
	2. To find a note, select the note from the list and click Go To.
	3. To print a note, select the note from the list.
	4. Click Print.
	5. Configure the print options, then click OK.
	6. Click OK to close the List Notes dialog box.


	Nesting Markup Entities
	1. Add a markup entity to a 3D file (for example, a Text entity).
	2. From the workspace or Markup Tree, select the Text entity.
	3. From the Markup menu, select Attachment or Hyperlink.

	3D-Specific Markups
	3D Markup Entities
	Creating 3D Markup Measure Entities
	3D Snapping Modes
	Measuring Distance
	1. From the Markup menu, select Add Entity, and then select Distance.
	2. From the Measured Distance Units list, select the unit in which you want to measure the distance.
	3. Select the snapping modes that you want to use for measuring.
	4. On the model, select the entity you want to measure from.
	5. Click inside the To field to select the entity type that you want to measure to.
	6. Select the snapping mode that you want to select as the end point for the measurement.
	7. On the model, select the entity you want to measure to.
	8. Click again to complete the measurement.
	9. Drag to move the measured line path.
	10. Click on the measured line path.
	11. To move the value box, click and drag it to anywhere on the drawing.
	12. To resize the value box, select it and then click and drag the frame handles.
	13. Click Close to close the Measurement Entities dialog.

	Calibrating Distance
	1. Measure distance between two points or measure cumulative distance.
	2. From the Distance tab, click Calibrate.
	3. From the Units list, select the unit to which you want to calibrate the distance.
	4. Select Calibrate to and enter a value if you want to calibrate the distance to a value.
	5. Select Set Factor and enter a value if you want to calibrate the distance by a factor.
	6. Click OK.
	7. Click Close to close the Distance tab.

	Measuring an Angle
	1. From the Markup menu, select Add entity, select Measurement, and then select Angle.
	2. Click the Angle tab.
	3. Select the snapping modes that you want to use for measuring.
	4. To measure the angle between an entity type and a plane, select the With Plane check box, and then select the plane from the list.
	5. From the Measured Angle Units list, select the unit in which you want to measure the angle.
	6. Click two points on the model to define the angle.
	7. If you selected a Plane, click the vertex, edge or face whose angle you want to measure between the plane.
	8. Click Close to close the Measurement dialog.

	Measuring an Arc
	1. From the Markup menu, select Add Entity, Measurement, and then Arc.
	2. Select Arc Entity if you want to measure a predefined arc.
	3. Select From 3 Points if you want to measure the arc between three points. Snapping modes are displayed.
	4. Select the snapping modes that you want to use for measuring.
	5. From the Dist. Units list, select the unit in which you want to measure the arc distance.
	6. From the Angles Units list, select the unit in which you want to measure the angle.
	7. If you selected From 3 Points, click three points to define the arc.
	8. If you selected Arc Entity, click the edge of an arc.
	9. Click to complete the measurement.
	10. To move the value box, click and drag it to anywhere on the markup.
	11. To resize the value box, select it and then click and drag the frame handles.
	12. Click Close to close the Measurement Entities dialog.

	Calibrating an Arc
	1. Measure an arc in the drawing.
	2. From the Arc tab, click Calibrate.
	3. From the Units list, select a unit of measurement to which you want to calibrate the distance.
	4. Click Calibrate to and enter a value if you want to calibrate to a value.
	5. Click Set Factor and enter a value if you want to calibrate by a factor.
	6. Click OK.
	7. Click Close to close the Measurement dialog.

	Measuring Minimum Distance
	1. From the Markup menu, select Add Entity, and then select Minimum Distance.
	2. Click Set 1.
	3. Select Entity if you want to measure the distance between model parts. Snapping modes are displayed.
	4. Select Geometry if you want to measure the distance between entity types.
	5. If you selected Entity, select a part or parts on the model.
	6. If you selected Geometry, select the snapping modes that you want to use for measuring.
	7. Select the entity or entities on the model.
	8. Click Set 2.
	9. Repeat steps 4 through 6.
	10. From the Measured Min. Distance Units list, select the unit in which you want to measure the distance.
	11. Click Compute.
	12. Click and drag the value box anywhere on the markup.
	13. To resize the value box, select it and then click and drag the frame handles.
	14. Click Close to close the Measurement Entities dialog box.

	Measuring Vertex Coordinates
	1. From the Markup menu, select Add Entity, Measurement, and then Vertex Coordinate.
	2. Scroll over the vertex whose coordinates you want to add to the markup.
	3. Click the vertex.
	4. Click and drag the value box anywhere on the markup.
	5. To remove the highlighted vertices on the model, click Close in the Measurement Entities dialog.


	Adding Text
	1. From the Markup menu, select Add Entity, and then select Text.
	2. The Attach To dialog appears and provides six snapping options:
	3. To insert a text box that snaps to a part of the drawing with a leader line, select one of the snapping modes.
	4. Click and drag on the drawing to define the dimensions of the text box.
	5. Click in the text box and enter the text you want to add.
	6. To change text box font properties, from the Markup menu, select Format, and then select Font.
	7. Click OK to implement the font changes and to close the Font dialog.
	8. To change the line properties or fill color of the text box, select the text box, then from the Markup menu, select Format, and then select the property or properties you want to change.
	9. Right-click outside the text area to complete the modification.
	10. To move the text box, click and drag it to anywhere on the drawing.
	11. To resize the text box, select it and then click and drag the frame handles.

	Adding a Note
	1. From the Markup menu, select Add Entity, and then select Note.
	2. Click a point on the document where you want to insert the note.
	3. Enter the text that you want in the note.
	4. To modify the text, select Formatting and the format you want to apply.
	5. From the File menu, select Information.
	6. In Name, Author and Key Words fields, enter the required text for the note.
	7. Click OK.
	8. Close the Markup Control Note Editor dialog box.
	9. Right-click outside the note area to complete the modification.
	10. To move the note, click and drag it.
	Viewing and Printing the List of Notes
	1. From the Markup menu, select Print Notes.
	2. To find a note, select the note from the list and click Go To.
	3. To print a note, select the note from the list.
	4. Click Print.
	5. Configure the print options, then click OK.
	6. Click OK to close the List Notes dialog box.


	Nesting Markup Entities
	1. Add a markup entity to a 3D file (for example, a Text entity).
	2. From the workspace or Markup Tree, select the Text entity.
	3. From the Markup menu, select Attachment or Hyperlink.


	Working with Markup Entities
	Go To a Markup Entity
	Selecting Markup Entities
	Moving a Markup Entity
	Transforming Markup Entities
	Rotating all Markup Entities
	Rotating a selected Markup Entity
	1. From the workspace or the Markup Navigation Tree, select the markup entity to rotate.
	2. From the Markup menu, select Object, and then select Rotate.
	3. Rotate the markup entity by clicking and dragging its control points. Pressing the Shift key while dragging will snap the rotation to 45 degree intervals.

	Flipping all Markup Entities
	Hiding All Markup Entities
	1. From the Markup menu, select Hide Markups.
	2. To undo the hide option, from the Markup menu, deselect Hide Markups.

	Grouping and Ungrouping Markup Entities
	Grouping Markup Entities
	1. In the Markup Navigation Tree or from the workspace, select the markup entities that you want to group.
	2. From the Markup menu, select Object, and then select Group.
	3. Perform any modifications.

	Ungrouping Markup Entities
	1. In the Markup Navigation Tree or the workspace, select the group that you want to ungroup.
	2. From the Markup menu, select Object, and then select UnGroup.


	Deleting Markup Entities
	1. Select the markup entity that you want to delete. To select multiple markup entities, press the Shift or Control keys while selecting.
	2. From the Markup Properties toolbar, click Delete Markups .


	Formatting Markup Entity Properties
	Changing Line Color
	1. Select the markup entity or entities for which you want to change the line color.
	2. From the Markup menu, select Format, and then select Line Color.
	3. From the Line Color list, select the color that you want for the entity.
	4. To define a custom line color, from the Line Color list, select Custom Color .
	5. From the Color dialog that appears, select a color and click OK.
	6. Click OK to close the Line Color dialog.

	Changing Line Style
	1. Select the markup entity or entities for which you want to change the line style.
	2. From the Markup menu, select Format, and then select Line Style. Select the new line style from the options provided.

	Changing Line Thickness
	1. Select the markup entity or entities for which you want to change the line thickness.
	2. From the Markup menu, select Format, and then select Line Thickness. Select the new line thickness from the options provided. The line thickness changes for the selected markup entity or entities.
	3. To define a custom line thickness, from the Markup menu, select Format, select Line Thickness, and then select Customize.
	4. In the Line Thickness field, enter an integer value in pixels.
	5. Click OK to close the Custom Thickness dialog.

	Changing Arrow Style
	1. Select the markup line entity or entities for which you want to change the arrow style.
	2. From the Markup menu, select Format, and then select Arrow Style. Select the new arrow style from the options provided.

	Changing Fill Type
	1. Select the markup entity or entities for which you want to change the fill type.
	2. From the Markup menu, select Format, and then select Fill Type.
	3. From the Fill Type list, select the fill type that you want for the markup entity:
	• Select Solid Fill, if you want the fill color to be solid.
	• Select Transparent Fill, if you want the fill color to be transparent.
	• Select No Fill, if you do not want any fill color.
	4. Click OK.


	Changing Fill Color
	1. Select the markup entity or entities for which you want to change the fill color.
	2. From the Markup menu, select Format, and then select Fill Color.
	3. From the Fill Color list, select the color that you want for the markup entity.
	4. To define a custom line color, from the Line Color list, select Custom Color .
	5. From the Color dialog that appears, select a color and click OK.
	6. Click OK to close the Fill Color dialog.

	Assigning a Markup Entity the Same Color as the Layer
	1. Select the markup entity or entities for which you want to assign the color of the layer that they belong to.
	2. To assign the line color:
	• From the Markup menu, select Format, and then select Line Color.The Line Color dialog appears.
	• From the Line Color list, select Bylayer .
	3. To assign the fill color:

	• From the Markup menu, select Format, and then select Fill Color.The Fill Color dialog appears.
	• From the Fill Color list, select Bylayer .
	4. Click OK.


	Changing Font
	1. Create the markup entity that you want.
	2. From the workspace or the Markup Navigation Tree, select the markup entity for which you want to modify the font then do one of the following:
	• From Markup menu, select Format, and then select Font. The Font dialog appears. From the lists select the font, font style, and font size. You also can select to add a strikeout and underline by selecting their check boxes. Click OK to the close ...
	• From the Markup Entity toolbar, select the font, font size, and font style (bold, italic, and underline) from their respective lists and buttons. The font changes are implemented.

	Changing Measurement Units and Symbols
	1. Create the markup measure entity that you want.
	2. Double-click the measurement that you want to change the unit of measure or add a symbol to.
	3. Deselect Display Unit check box if you want to hide the unit on the drawing. It is selected by default.
	4. From the Units list, select the unit that you want to change the measurement to.
	5. From the Symbol list, select the symbol that you want to add to the measurement.
	6. Click OK.

	Using the Markup Entity Properties Dialog
	1. Select the markup entity you want to modify. To select multiple markup entities, press the Shift or Control key while selecting.
	2. From the Markup menu, select Format, and then select Markup Entity Attributes.
	Line Color
	1. Select the markup entity or entities for which you want to change the line color.
	2. From the Line Color list, select the color that you want for the entity.
	3. Click OK to close the Markup Entity Properties dialog.

	Defining a Custom Line Color
	1. From the Line Color list, select Custom Color .
	2. Select a color and click OK.
	3. Click OK to close the Markup Entity Properties dialog.

	Line Style
	1. Select the markup entity you want to change the line style. To select multiple markup entities, press the Shift or Control key while selecting.
	2. From the Line Style list, select the required line style.
	3. Click OK to close the Markup Entity Properties dialog.

	Line Thickness
	1. Select the markup entity for which you want to change the line thickness. To select multiple markup entities, press the Shift or Control key while selecting.
	2. From the Line Thickness list, select the required line thickness.

	Defining a Custom Line Thickness
	1. From the Line Thickness list, select Customize.
	2. In the Width (Pixels) field, enter the desired width.
	3. Click OK to close the Markup Entity Properties dialog.

	Width (Pixels)
	Arrow Style
	1. Select the markup line entity you want to change the arrow style. To select multiple markup line entities, press the Shift or Control key while selecting.
	2. From the Arrow Style list, select the style of arrow that you want for the markup line entity.
	3. Click OK to close the Markup Entity Properties dialog.

	Fill Type
	1. Select the markup entity you want to change the fill type. To select multiple markup entities, press the Shift or Control key while selecting.
	2. From the Fill Type list, select the fill type that you want for the markup entity:
	• Select Solid Fill, if you want the fill color to be solid.
	• Select Transparent Fill, if you want the fill color to be transparent.
	• Select No Fill, if you do not want any fill color.
	3. Click OK to close the Markup Entity Properties dialog.


	Fill Color
	1. Select the markup entity you want to change the fill color. To select multiple markup entities, press the Shift or Control key while selecting.
	2. From the Fill Color list, select the color that you want for the markup entity.

	Defining a Custom Color
	1. From the Fill Color list, select Custom Color .
	2. Select a color and click OK.
	3. Click OK to close the Markup Entity Properties dialog.

	Markup Layers
	1. From the Markup Layer list, select the layer you want to make active.
	2. Click OK to close the Markup Entity Properties dialog.

	Leader Alignment
	Text Box Visibility



	Printing
	Print Options
	Configuring the Print Options
	1. From the File menu, select Print.
	2. Click the Options tab.
	3. Configure the print options.
	4. Configure other print options.
	5. To view a partial view of the file, click Partial Preview.
	6. Click OK to print.

	Print Margins
	Setting the Margins
	1. From the File menu, select Print.
	2. Click the Margins tab.
	3. Enter the margin size that you want for Left, Top, Right, and Bottom or click Minimum if you want to set the margins to the minimum acceptable for the selected printer.
	4. Select Override printer-minimum margins if you want to override the minimum margins set for the printer.
	5. From the Units list, select the unit to which you want to set the margins.
	6. Configure other print options.
	7. To view a partial view of the file, click Partial Preview.
	8. Click OK to print.


	Header/Footer
	Adding a Header and Footer
	1. From the File menu, select Print.
	2. Click the Headers/Footers tab.
	3. Click in the Left, Center or Right field and enter the text that you want to appear in the header and footer, or choose an Insert Code or Insert Variable.
	4. To Insert Code in the header or footer, click Left, Center or Right, then select a code from the list.
	5. To Insert Variable in the header or footer, click Left, Center or Right, then select a variable from the list.
	6. To change the Font, click Set Font. The Font dialog appears.
	7. From the Font list, select the type of font.
	8. From the Size list, select the size of font.
	9. To set the font Style, click Bold or Italic or both, then click OK.
	10. In the Print Properties dialog, configure other print properties.
	11. To view a partial view of the file, click Partial Preview.
	12. Click OK to print.

	Native Print Settings
	1. From the Print Properties dialog, click the Headers/Footers tab.
	2. Under Headers and Footers, click inside the Left, Center, and Right boxes corresponding to the header or footer position in the original file.
	3. Select %F: Native Print Settings (Excel) from the Insert Code list.
	4. Click OK to print.


	Watermarks
	Adding a Watermark
	1. From the File menu, select Print.
	2. Click the Watermark tab.
	3. Enter the Watermark Text that you want to appear on the file.
	4. To insert a code in the watermark, select a code from the Insert Code list.
	5. For example, if you select %n: Total document pages, the total number of pages for the selected file will appear in the watermark.
	6. To set the orientation of the watermark, click Diagonal, Horizontal, or Vertical.
	7. To change the Font, click Font. The Font dialog box appears.
	8. Configure the font, then click OK.
	9. In the Print Properties dialog box, configure other print properties.
	10. To view a partial view of the file, click Partial Preview.
	11. Click OK to print.


	Adding a Stamp
	1. From the File menu, select Print.
	2. Click the Stamps tab.
	3. Click Add.
	4. Enter a file name or browse to locate the file that you want to use as a stamp.
	5. Select the Page selections to specify the pages that you want the stamp to appear on.
	6. To set the Position of the stamp, enter the width in the first field, then length in the second.
	7. To set the Size of the stamp, enter the width in the first field, then length in the second.
	8. From the Units list, select the unit in which you want to set for the width and length of the stamp.
	9. To add more than one stamp to a file, repeat steps 3 to 8.
	10. To remove a stamp, select the stamp and click Remove.
	11. In the Print Properties dialog box, configure other print properties.
	12. To view a partial view of the file, click Partial Preview.
	13. Click OK to print.

	Assigning Pen Settings
	1. From the File menu, select Print.
	2. Click the Pen Settings tab.
	3. Under From/To, select the Color Index that you want to assign a new pen thickness.
	4. From the Units list, select the unit of measure that you want to set the thickness.
	5. Enter the new thickness.
	6. In the Print Properties dialog box, configure other print properties
	7. Configure other print options.
	8. To view a partial view of the file, click Partial Preview.
	9. Click OK to print.
	Creating a New Pen Setting
	1. Set the thickness for the color indices that you want.
	2. Click Save As. The Save As dialog appears.
	3. Enter a file name with a .c2t extension, then click OK.
	4. In the Print Properties dialog, click OK to print.

	Deleting a Pen Setting
	1. Select the pen setting that you want to delete from the Current Pen Settings.
	2. Click Delete.
	3. Click Cancel to close the Print Properties dialog.


	Partial Preview of a File
	1. Configure the print properties.
	2. Click Partial Preview in the Print Properties dialog.
	3. Click OK to close the Partial Print Preview dialog.

	Previewing a File Before Printing
	1. View the file in AutoVue.
	2. From the File menu, select Print Preview.
	3. Configure the print properties.
	4. Click OK.
	5. Click Close to close the Print Preview window.

	Printing a File
	1. Open the file you want to print.
	2. To print the associated markups, open the Markup file or files you want to print.
	3. If you are printing Markup files and you want to print the visible layers, from the Markup menu, select Markup Layers.
	4. Select the markup layers you want visible.
	5. Click OK to close the Markup Layers dialog.
	6. From the File menu, select Print.
	7. Configure the print properties.
	8. To view a partial view of the file, click Partial Preview.
	9. Click OK to print.

	Batch Printing
	1. From the File menu, select Batch Print.
	2. To add a file to be printed, click Add.
	3. Enter the file name or browse to locate the file or files that you want to add, then click Open.
	4. Click OK in the Batch Print dialog.
	5. Configure the print properties.
	6. Click OK to print.


	Conversion
	Conversion Options
	PDF
	X and Y
	Converting a File
	1. From the File menu, select Convert.
	2. In the Save As field, enter the path and filename or click Browse to locate the directory where you want to save the converted file.
	3. Specify the conversion options.
	4. Click OK. The file is converted and appears in the specified directory.

	Changing the Pen Settings
	1. From the File menu, select Convert.
	2. Click Pens.
	3. In the From/To section of the Pen Thickness dialog, select the Color Index for which you want to modify the thickness.
	4. From the Units list, select the unit in which you want to set the thickness.
	5. In the Thickness field, enter a thickness value.
	6. Press the Enter key.
	7. To save the changes that you made, click Save As.
	8. Enter a file name for the new pen settings.
	9. Click OK.
	10. Click OK to close the Pen Thickness dialog.

	Batch Conversion
	1. From the File menu, select Convert.
	2. Click Batch Convert.
	3. Click Add.
	4. Enter the file name or browse to locate the file that you want to add, then click Open.
	5. Customize the convert options.
	6. Click OK.


	Customizing AutoVue
	Defining the Clipboard
	1. From the Options menu, select Configure Clipboard.
	2. Under the different file types, click the type of information that you want to copy to the clipboard.
	3. Click OK.
	Copying Information
	1. From the Edit menu, select Select.
	2. Click and drag to select the area you want to copy.
	3. From the Edit menu, select Copy.
	4. Launch the application that you want to copy the information to.
	5. Paste the information.


	Tools
	Adding a Tools Menu Item
	1. From the Options menu, select Customize Tools.
	2. Click Add.
	3. In the Menu Item Name field, enter a name.
	4. Select one of the following from the Menu Item Action section:
	a Application to launch an outside application.
	b Script File to launch a script file.
	c DDE Server to send DDE commands to a server application.
	d DLL to invoke a DLL.

	5. In the field to right of the Menu Item Name options, enter the name and path of the executable file. Otherwise, click Browse to locate the specific file or application.
	6. If you select Application, click Configure. The Link to Application dialog box appears. Enter the command line to launch an application, then click OK.
	7. If you select Script File, click OK.
	8. If you select DDE Server, click Configure. The Link to DDE dialog box appears. Enter the Topic and Commands, click Start Application, then click OK.
	9. If you select DLL Load, click Configure. The Link to DLL dialog box appears. Enter the Entry Function to invoke a DLL, then click OK.
	10. In the Menu Item Description field, enter a menu item description.
	11. Click OK.
	12. From the Options menu, click Customize Tools to view new menu item.
	13. Click OK to close the Add Tool Menu Item dialog box.

	Creating a Hot Key
	1. From the Options menu, select Customize Tools.
	2. Click Add.
	3. Enter an ampersand (&) before the Menu Item Name.
	4. Click OK.
	5. From the Options menu, click Customize Tools to view new menu item.
	6. Click OK to close the Add Tool Menu Item dialog box.

	Modifying a Tools Menu Item
	1. From the Options menu, select Customize Tools.
	2. Under Menu Contents, select the item that you want to modify.
	3. Click Modify.
	4. Make the necessary changes.
	5. Click OK.
	6. Click OK to close the Add Tool Menu Item dialog box.

	Moving a Tools Menu Item
	1. From the Options menu, select Customize Tools.
	2. From the Menu Contents list, select the item that you want to move.
	3. Click Up or Down to move the item to where you want in the list.
	4. Click OK to close the Add Tool Menu Item dialog box.

	Deleting a Tools Menu Item
	1. From the Options menu, select Customize Tools.
	2. From the Menu Contents list, select the item that you want to delete.
	3. Click Delete.
	4. Click OK to close the Add Tool Menu Item dialog box.


	Customizing Toolbars
	1. From the Options menu, select Customize Toolbars.
	2. Select the check box beside the toolbars that you want to display or deselect the check box beside the toolbars that you want to hide.
	3. Select the Toolbar Button Size that you want the buttons to appear on the toolbars.
	4. Click OK.

	Configuring the Mail Utility
	1. From the Options, select Configure Email.
	2. From the Mail Using list, select the type of MAPI compliant mail utility you are using.
	3. Select the Mailing Preferences that you want.
	4. Click OK to close the Mail Options dialog box.


	Thumbnails
	Creating a Thumbnail Folder
	1. From the File menu, select Thumbnails.
	2. Click Create.
	3. To close the Thumbnails window, from the Thumbnail menu, select Exit Thumbnails.

	Customizing Thumbnails
	1. From the File menu, select Thumbnails.
	2. From the Options menu, select Configure Thumbnails.
	3. Select the Size in pixels of the thumbnails.
	4. Enter the Space between thumbnails.
	5. Select the File Details that you want to display in the thumbnail.
	• Select Full if you want to display the filename, size, date and time of creation.
	• Select Partial if you want to only display the filename.
	6. Click OK.
	7. To close the Thumbnails window, from the Thumbnail menu, select Exit Thumbnails.


	Viewing a Thumbnail Folder
	1. From the File menu, select Thumbnails.
	2. From the Thumbnail menu, select Browse for Folder.
	3. Browse to locate the thumbnails folder that you want to view.
	4. Click OK.
	5. To close the Thumbnails window, from the Thumbnail menu, select Exit Thumbnails.

	Sorting a Thumbnail Folder
	1. From the File menu, select Thumbnails.
	2. From the Thumbnail menu, select Browse for Folder.
	3. Browse to locate the thumbnails folder that you want to sort.
	4. Click OK.
	5. From the Thumbnail menu, select Sort and the option that you want to sort by.
	6. To sort the thumbnails in ascending or descending order, from the Thumbnail menu, select Sort Order, and then select Ascending or Descending.
	7. To close the Thumbnails window, from the Thumbnail menu, select Exit Thumbnails.

	Viewing a Thumbnail
	1. From the File menu, select Thumbnails.
	2. From the Thumbnail menu, select Browse for Folder.
	3. Browse to locate the thumbnails folder that you want to view.
	4. Click OK.
	5. Double-click the thumbnail that you want to view.

	Updating Thumbnails
	1. From the File menu, select Thumbnails.
	2. From the Thumbnail menu, select Browse for Folder.
	3. Browse to locate the thumbnails folder that you want to view.
	4. Click OK.
	5. Select the thumbnail or thumbnails that you want update.
	6. From the Thumbnail menu, select Updated Selected.
	7. To close the Thumbnails window, from the Thumbnail menu, select Exit Thumbnails.

	Converting Thumbnails
	1. From the File menu, select Thumbnails.
	2. From the Thumbnail menu, select Browse for Folder.
	3. Scroll to locate the thumbnails folder that you want to convert.
	4. Click OK.
	5. Select the thumbnail or thumbnails that you want to convert.
	6. From the Thumbnail menu, select Convert.
	7. Customize the conversion options.
	8. Click OK.
	9. To close the Thumbnails window, from the Thumbnail menu, select Exit Thumbnails.

	Printing Thumbnails
	1. From the File menu, select Thumbnails.
	2. From the Thumbnail menu, select Browse for Folder.
	3. Scroll to locate the thumbnails folder that you want to print.
	4. Click OK.
	5. Select the thumbnail or thumbnails that you want to print.
	6. From the Thumbnail toolbar, click Print .
	7. Click OK.
	8. To close the Thumbnails window, from the Thumbnail menu, select Exit Thumbnails.


	Full Text Extraction
	Using the Full Text Extraction Utility
	1. From the Tools menu, select Auto Text Extraction.
	2. In the From field, enter the path and filename of the file from which the text is to be extracted.
	3. In the To field, enter the path and filename or click Browse to locate the file to which the text is to be copied.
	4. Select Display Output Contents if you want to preview the extracted text under Contents.
	5. Click Extract.
	6. Click Close to close the Automatic Text Extraction dialog box.

	CAD Information Extraction
	1. From the Tools menu, select Auto Text Extraction.
	2. In the From field, enter the path and file name of the file from which the text is to be extracted.
	3. In the To field, enter the path and file name or click Browse to locate the file to which the text is to be copied.
	4. Select Display Output Contents if you want to preview the extracted text under Contents.
	5. Click Extract.
	6. Click Close to close the CAD/Doc Text Extraction dialog box.


	AutoVue Mobile
	Creating a Mobile Pack
	1. Open the base file.
	2. From the AutoVue menu bar, select Collaborate, and then select Create Mobile Pack.
	3. Click the General tab.
	4. From the Select Resource File(s) box, select the resource files to include in the Mobile Pack.
	5. From the Select Markup File(s) box, select the Markup files to include in the Mobile Pack.
	6. If you wish to password protect the Markup files, select the Password check box next to the Markup file.
	a In the Password field, enter a password of any length and character.
	b In the Confirm Password field, re-enter the password.
	c Click OK to close the Password dialog.

	7. To save the Mobile Pack locally, from the Output options, specify the location and name:
	a Click Browse to locate the directory where you want to save, or in the Save As field, enter the file path.
	b Specify a name for the Mobile Pack.

	8. If you wish to send the Mobile Pack using your default e-mail client, select the E-Mail check box.
	9. If you wish to password protect the Mobile Pack, select the Password Protected check box.
	a In the Password field, enter a password of any length and character.
	b In the Confirm Password field, re-enter the password.
	c Click OK to close the Password dialog.

	10. To select Advanced options such as including streaming file and setting an expiry date on the Mobile Pack, continue to the next step.
	11. If you do not wish to modify advanced options, click Finish to complete Mobile Pack creation.
	12. Click the Advanced tab.
	13. If you wish to set an expiry date for the Mobile Pack, from the Publishing option, select the Expiry Date check box and then select a date. The Mobile Pack cannot be opened after this expiry date.
	14. If you wish to include a streaming file, from the Streaming File option, select whether to include a native file or streaming file in the Mobile Pack.
	15. If you wish, from the Rendition option, you can include a PDF or TIFF rendition in the Mobile Pack.
	16. Click OK to complete Mobile Pack creation.

	Viewing Mobile Packs
	1. From the AutoVue menu bar, select File, and then select Open.
	2. Browse to the location of the Mobile Pack (*.avp), and then select Open.
	3. If the Mobile Pack is password-protected during creation, the Password dialog appears. In the Password field, enter the password and then click OK.
	• Streaming files do not support blocks or viewing options.
	• Streaming file constraints change with each version of AutoVue. As a result, the streaming file from an earlier version of AutoVue cannot be opened in a later version.
	• Streaming files are platform-specific. Therefore, a streaming file created on a Windows platform cannot work on a UNIX platform, and vice versa.
	4. If the Rendition option is selected during the creation of the Mobile Pack, from the AutoVue menu bar, select Collaborate, and then select View Rendition from Mobile Pack.
	5. If there are associated Markups files, the Markup Indicator icon appears in the status bar. To open the Markup files, click the Markup Indicator icon .
	6. If you wish to create a new Markup file to include in the Mobile Pack, click Create a new Markup file.
	7. If you wish to open Markup files included in the Mobile Pack, click Choose an existing Markup file, and then select the Markup files.
	8. If the Markup file is password-protected during creation, The Password dialog appears. In the Password field, enter the password and then click OK.
	9. If you wish to import a Markup file from your local machine, click Import.
	10. Select the Markup file and click Open.


	Creating Markup Files
	1. Create markups.
	2. From the AutoVue toolbar, click Save Markup .
	3. Enter a name for the Markup file in the Name field.
	4. If you wish to password protect the Markup file, select the Password Protected check box.
	5. If you wish to save the Markup file to a location on a local computer, click Export.
	6. Click OK.
	7. If you wish to send the updated Mobile Pack with your default e-mail client, from the AutoVue menu bar, select Collaborate, and then select Reply to Mobile Pack.

	Updating from Mobile Pack
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